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Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help

You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft
Online Help is updated on a regular schedule, ensuring that you have access to the most current
documentation. This reduces the need to view separate documentation posts for application maintenance
on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center,
see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed Help

If you’re setting up an on-premise PeopleSoft environment, and your organization has firewall restrictions
that prevent you from using the hosted PeopleSoft Online Help, you can install the online help locally.
See Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files

You can access downloadable PDF versions of the help content in the traditional PeopleBook format on
the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft
Online Help, but it has a different structure and it does not include the interactive navigation features that
are available in the online help.

Common Help Documentation

Common help documentation contains information that applies to multiple applications. The two main
types of common help are:

*  Application Fundamentals
» Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for
fundamental implementation tasks.
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In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using
PeopleSoft applications.

Field and Control Definitions

PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the
documentation for some pages.

Typographical Conventions

The following table describes the typographical conventions that are used in the online help.

Typographical Convention Description

Key+Key Indicates a key combination action. For example, a plus sign
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

... (ellipses) Indicate that the preceding item or series can be repeated any
number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode syntax.
Options are separated by a pipe (| ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.

> This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes

PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.
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ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY CD TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry Identifiers

Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

¢ Asia Pacific
*  Europe
e Latin America

¢ North America

Industry Identifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

e USF (U.S. Federal)

¢ E&G (Education and Government)

Translations and Embedded Help

PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We

are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.
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Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see
information on the following topics:

» Using the PeopleSoft Online Help.
* Managing hosted Online Help.

* Managing locally installed PeopleSoft Online Help.

PeopleTools Related Links

PeopleTools 8.59 Home Page

PeopleSoft Search and Insights Home Page

“PeopleTools Product/Feature PeopleBook Index” (Getting Started with PeopleTools)

PeopleSoft Online Help

PeopleSoft Information Portal

PeopleSoft Spotlight Series

PeopleSoft Training and Certification | Oracle University

My Oracle Support

Oracle Help Center

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com.

Please include the applications update image or PeopleTools release that you’re using.

Follow Us

Icon Link

@ Watch PeopleSoft on YouTube
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Icon Link
N Follow @PeopleSoft Info on X.
A\

Read PeopleSoft Blogs

Connect with PeopleSoft on LinkedIn
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Chapter 1

Getting Started with PeopleSoft Test
Framework

Understanding PeopleSoft Test Framework

PTF automates various tasks within the PeopleSoft application, primarily functional testing. Automating
functional testing enables testers to run more tests with greater accuracy during a shorter time.

PTF works by replicating the actions of a single user run functional tests against the PeopleSoft browser-
based application. Users can record manual test procedures and save them within the framework. Later
(perhaps after an application upgrade or patch), those tests can be run against the application to verify
whether the application still behaves as expected. This method for capturing and running tests is often
called the record and playback approach to automation.

Test assets (tests and test cases) are stored in a database as Application Designer objects. As a result, test
assets are PeopleTools-managed objects, which can be managed along with other PeopleTools-managed
objects through PeopleSoft Lifecycle Management.

PTF includes a number of features not available in other commercially available record and playback
automation tools, including:

» The ability to validate recorded objects against PeopleSoft object metadata definitions.

As aresult, the tester is able to assertively verify the existence of test objects before running a test
rather than running the test to identify invalid object definitions by trial and error.

See Understanding Change Impacts.

» Features that help users manipulate data within the PeopleSoft rowset-oriented data structure.

See Incorporating Scroll Handling.

* Functionality that automates numerous PeopleSoft-specific functions, such as running processes
through Process Scheduler.

See Process.

» Functionality that interfaces with other PeopleSoft automation tools, such as Data Mover and
PsQuery.

See Query.

See DataMover.

You should be aware that PTF is not designed to:
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* Validate certain types of information, such as image appearance and relative position of data and
online objects. PTF is a functional test tool rather than a user interface or browser testing tool.

* Be aload testing tool; it replicates the experience of a single user running the application.
* Replicate certain types of user actions, such as drag-and-drop mouse actions.

* Recognize or validate certain types of objects you might find in third-party or external applications,
such as Flash/Flex objects, data displayed in HTML regions, and so on. PTF is designed to validate
objects in the PeopleSoft application.

Terminology

This table defines some PTF terms:

Field or Control Description
Asset See Test Asset.
Runtime Options A list of application environments available to the tester.

Runtime options store application environment information
such as URL, user ID, password, and Process Scheduler
server, and information needed to run DataMover. PTF
supplies this information to the test by default when a test does
not explicitly specify such information.

Explorer See PTF Explorer.
Grid See Scroll.
Hook Establish a connection between a PTF test and a PeopleSoft

application browser.

Library Similar to a test, a library contains one or more steps that
together automate some discrete amount of test functionality.
Unlike a test, a library is never run by itself. Rather, libraries
are meant to be called (sometimes repetitively) by tests.

Log An object that saves the experience of a single test run event.
Logs report the success or failure of the testing process and
include messages and screen shots to indicate where errors
occurred.

Log Manager A tool that enables PTF administrators to purge unneeded logs
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Field or Control

Description

Maintenance

The process of updating PTF tests and test cases to reflect
object modifications present in upgrades or changes to the
PeopleSoft application. This is done by way of a direct
connection to the PeopleSoft metadata, not by running the
test. For example, if a field is renamed in an upgrade, the PTF
maintenance process can warn the user that a test containing a
reference to the old field name will likely fail to find the object
by the old identification method. The maintenance process
can help the user find the obsolete field reference and replace
it with the valid (renamed) field reference before running the
test.

Mass Updated

A tool that enables you to modify test steps across multiple
tests using search and replace.

Project

A PeopleTools Application Designer project. Projects are the
primary means for moving PTF Tests and Test Case objects
between databases.

PTF Client

An instance of the PTF runnable program installed on an
individual user’s machine.

PTF Environment

An instance of a PeopleSoft application that has been
configured to exchange data with one or more PTF clients,
enabling clients to save and retrieve test assets from the
application database.

PTF Explorer

A view of the PTF test assets stored within an application
database. The system stores assets in a tree structure with
collapsible folders for organizing the test assets. The pane
containing the tree is the first pane visible to the user after
start up and will always be the leftmost pane in the PTF
user interface. It is labeled with the name of the application
database.

Recognition

The means that the PTF client uses to identify (or find) HTML
objects within the application. Often, this is the HTML ID
property of the object.

Recorder

A feature of the PTF tool that is the primary means for
creating new tests. While the Recorder is active, the PTF tool
converts all of the user’s manual test steps into steps that can
be saved as an automated test.

Screen Shot

An image generated during test run. A screen shot can be
generated automatically by PTF to show the application
window immediately after an error condition, or as a result of
a step that uses the Log.Snapshot step.
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Field or Control

Description

Scroll

A scroll represents a rowset, which is a set of rows of data
uniquely identified by one or more key fields. Rows in a scroll
can contain child rowsets. Scrolls are rendered on PeopleSoft
pages as grids of data or as a grouping of fields in a scroll area.

Scroll Area

See Scroll.

Step

The smallest unit of test functionality in PTF. A test will
contain a number of steps. A step typically corresponds to a
single manual test step or test instruction.

Test Asset

An object used in PTF to automate a functional test. PTF

test assets are saved in the application database and can be
retrieved at any time to help automate tests. The five types of
test assets are:

*  Runtime Options

+  Libraries

* Logs

. Tests

e Test Cases

Test

The primary type of test asset in PTF. Tests contain steps that
replicate the action of a tester running a functional test against
the PeopleSoft application.

Test Case

A set of data associated with a test corresponding to the values
entered or verified in the application. For example, if a hire
test hires three similar employees into the PeopleSoft system,
a user might elect to record one test and to configure that test
to call three test cases, one for each employee hired. A test can
have multiple test cases associated with it.

Test Editor

A space within the PTF user interface where users can edit
individual tests and test cases. The Test Editor displays a test
as a series of steps presented as rows within the test. Users
can open multiple Test Editor panes to edit multiple tests
simultaneously.

Variable

A variable is a reference to a section of computer memory that
can be used to store information that is subject to change or
modification. PTF tests often use variables to store values that
are not known until the test is run. For example, you could use
a variable to store an ID number generated by the PeopleSoft
application during the test. Later in the test, the value of the
variable could be manipulated, if necessary, and then used

to set or validate other information within the PeopleSoft
application.

22
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Installing and Configuring PTF

Understanding the PTF Development Environment

The following diagram illustrates the PeopleSoft Test Framework (PTF) development environment:

This diagram illustrates the PTF development environment.

FTF Client

F

SURSAR, W

-
L

FlA,

Integration Broker
Web Services

< HTTRHTTPS

>
II

Wieh Server

1

A PTF development environment consists of the following elements:

¢ A PTF client instance.

* An internet browser instance.

* A connection to a PeopleSoft application that is to be tested through the Integration Broker Web

Services.

PeopleSoft Test Framework (PTF) client is a standalone program that runs on a Microsoft Windows 64 bit

machine.
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To record tests, use Chrome or Microsoft Edge. The browsers Chrome, Firefox, and Microsoft Edge are
supported to run tests. Refer to the Certifications tab on My Oracle Support for current information on
supported browsers.

To record tests, use Internet Explorer 11, Chrome or Microsoft Edge. The browsers Chrome, Firefox,
Internet Explorer, and Microsoft Edge are supported to run tests. Refer to the Certifications tab on My
Oracle Support for current information on supported browsers.

PTF client connects to PeopleSoft application database using a secure HTTPS connection through
PeopleTools Integration Broker web services which runs on the web server. All the recorded tests are
saved to a test repository in the application database. While executing a test, the test repository interacts
with the web server.

Pure Internet Architecture (PIA) verifies a stable Integration Broker setup, and a secured access to the
PTF client. You can define the PTF Configuration Options and evaluate the SSL certificate requirements
using the PIA. The PIA connects to the web server through a web browser using HTTP/HTTPS.

Note: The PeopleSoft application database where test assets are stored and the PeopleSoft application that
is to be tested are not required to be on the same database, but we strongly recommend you use the same
database for both.

Configuring an Environment for PTF

PTF test assets (tests and test cases) are stored in tables in a PeopleSoft application database. Any
application database that is certified to run on PeopleTools 8.51 or greater can be used as a PTF
environment.

To configure an environment for PTF, you need to complete the following tasks:
1. Verify Integration Broker setup.

2. Set up security.

3. Configure the Web Profile.

4. Define PTF Configuration Options.

5. Evaluate SSL certificate requirements.

Verifying Integration Broker Setup

24

To verify that Integration Broker is set up for your application:

1. In your PeopleSoft application, navigate to PeopleTools > Integration Broker >
Configuration > Integration Gateways.

2. Verity that the Gateway URL field references the correct machine name.
3. Click the Ping Gateway button.

4. Verify that the message returns a status of ACTIVE.
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5. Click the Gateway Setup Properties link.

6. Sign on to access integrationGateway.properties file.

7. The default user ID is administrator, and the default password was created when PIA was installed

(please contact your security administrator for the password).
8. Verify that the Gateway Default App Server URL is specified.
This is an example of the Gateways page:

This example illustrates the fields and controls on the Integration Broker Gateways page.

Gateways
GatewayID LOCAL Inbound Gateways
M Local Gateway [T Load Balancer IS Administration
URL | hitp:/fexample.com:8020/PSIGYW/PeopleSoftListeningConnector Ping Gateway
Gateway Setup Properties

Load Gateway Connectors

The port number in the URL (8020 in this example) is the http port of the web server.
This is an example of a Ping message showing ACTIVE status:

This example illustrates a successful Integration Gateway Ping message.

PeopleSoft Integration Gateway

PeopleSoft Listening Connector
Status:ACTIVE

Click the Gateway Setup Properties link on the Gateways page to access the PeopleSoft Node

Configuration page, as shown in this example:
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This example illustrates the fields and controls on the PeopleSoft Node Configuration page.

PeopleSoft Node Configuration
URL: hitp:# example.com:B020/PSIGW/PeopleSoftListeningConnectar
Gateway Default App. Server
App Server URL UserID Password
Hexample com:8020 QEDMO
Teols Release Domain Password Virtual Server Node
8.57-802R_1205160
PeopleSeoft Nodes
5 Q 1-2 of 2 j View Al
Node Name App Server URL User ID Password Tools Release  Domain Password
PSFT_LOCAL ffexample.com: 8010 QEDMO sssvsssssssnes  PTOSTIIGR_18 Ping Node L -
QE_LOCAL fexarnple.com:3020 QEDMD | ssssssssssssss 9.57-B02R_180 Ping Node + -
Advanced Properties Page
OK Cancel Save

The port number in the App Server URL (9010 in this example) generally corresponds with the JSL Port
Number as defined in the Application Server configuration. The default port number is 9000.

When the web server is connected to more than one database you will need to enter a node name, as
defined in PeopleSoft Nodes on the PeopleSoft Node Configuration page, in the Node ID field of the
PTF Signon dialog box. Contact your Integration Broker administrator to determine the correct node
name to use. If no node is defined in PeopleSoft Nodes on this page, leave the Node ID field of the PTF
Signon dialog blank.

See Creating a Connection to a PTF Environment.

Note: If you rerun the PIA installer, the PeopleSoft Node Configuration page data is cleared and needs to
be reentered.

Verify that the Default User ID for the ANONYMOUS node has, at a minimum, a PTF User role.
1. Navigate to Integration Broker > Integration Setup > Node Definitions.

2. Select the ANONYMOUS node.

3. Note the Default User ID.

4. Navigate to PeopleTools > Security > User Profiles > User Profiles.

5. Select the User ID you identified in Step 3.

6. Access the Roles tab.

7. Verify that one of the PTF roles is present.

See Setting Up Security.

If Integration Broker is not set up correctly, contact your Integration Broker administrator.
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Users connecting to a PTF test environment must have one of these roles associated with their user ID:

¢ PTF User
« PTF Editor

*  PTF Administrator

This table details the privileges associated with the PTF security roles:

Privilege PTF User PTF Editor PTF Administrator
Run Tests Yes Yes Yes
Create, Modity, and Delete No* Yes Yes
Tests

Create, Modify, and Delete Yes Yes Yes
Test Cases

Create or Modify Runtime No No Yes
Options

Use Log Manager No No Yes
Define Configuration Options | No No Yes
Create Test Maintenance No No Yes
Reports

Create Test Coverage Reports | No No Yes
Insert Tests/Test Cases into No No Yes
Application Designer projects

PTF administrator can grant privileges to roles for a specific test folder and its content form the Test
Folder Permissions Manager.

See details in Securing Test Folders Using Permissions.

Note: The Default User ID for the ANONYMOUS node must have, as a minimum, a PTF User role.

If PTF security is not configured properly you may receive an error message when signing on to the PTF
client indicating that the UserID and Password are not correct.

Possible causes and solutions for this error are:
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The user ID for the ANONYMOUS node does not have PTF privileges. Add at least the PTF User
role to the user profile.

The user ID you entered in the User field in the Environment Login does not have PTF privileges.
Add at least the PTF User role to the user profile.

For more information on entering roles for a user profile, see “Defining Role Options” (Security
Administration)

Configuring the Web Profile

Complete the following steps to configure the web profile settings for the PeopleSoft application that you
are testing.

L.

Access the Web Profile Configuration page (PeopleTools > Web Profile > Web Profile
Configuration).

Select the profile name for your environment. (This is the web profile that was selected during web
server installation.)

Click the Debugging tab.

Check the Show Connection & Sys Info check box.

If this option is not selected PTF will not record menu, component, and page metadata correctly.
Check the Generate HTML for Testing check box.

If this option is not selected PTF will not record HTML objects correctly.

This example illustrates the fields and controls on the Web Profile Configuration - Debugging page.

General Security Virtual Addressing Cookie Rules Caching Debugging Look and Feel | [®
Profile Name: DEV

¥ Trace Monitoring Server 7

[ Trace PPM Agent ?

[l sShow Connection & Sys Info 7
[ Show Trace Link at Signon 7

1 show Layout ?

] show Overlapping Fields 7

[ show StyleSheet Inline HTML 7
[ Generate HTML for Testing 7

[l write Dump File ?

[ create File from PIA HTML Page ?

[l use Unminified JavaScript ?

Defining PTF Configuration Options

Use the Define Configuration Options page (PSPTTSTCONFIG) to:
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e Define record and runtime options.
* Configure external command processing.

Navigation:

Installing and Configuring PTF

PeopleTools > Lifecycle Tools > Test Framework > PTF Configuration Options

This example illustrates the fields and controls on the Define Configuration Options Page.

Configuration Options
Define Configuration Options

Record Options

Muse Page.Prompt Pluse Process.Run

Fuse Message Recognition Fluse Scroll Variables

Execution Options

“luse Page.Expand

Fluse Browser. Start_Login

Process Server List Find | View All First ‘& 10of1 &' Last
Server Hame
PSNT [+ [=]
External Command Processing
Command List Find | View All First 4/ 1-20f2 (b Last
*Command Name *Command Path *Command File Name ULEE e
(Seconds)
FILEKILL WServerNamelLabs\Commands FILEKILL.BAT 3600 [+] [=]
FILECHECK WServerNamelLabs\Commands FILECHECHK.BAT 3600 ﬂ j
Record Options
Field or Control Description

Use Page Prompt

Select to use Page Prompt and PromptOK steps during
recording in place of menu navigation. The Use Page Prompt
option is also available on the PTF Test Recorder toolbar.

The option selected here is the default for all users in this
environment. The option selected on the PTF Test Recorder

toolbar overrides this selection for that recording session.

See Page.

Use Message Recognition

Select to automatically create entries for the Message
Recognition feature during recording. The Use Message
Recognition option is also available on the PTF Test Recorder
toolbar. The option selected here is the default for all users

in this environment. The option selected on the PTF Test
Recorder toolbar overrides this selection for that recording

session.
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Field or Control

Description

Use Process Run

Select to use Process Run steps during recording in place of
specific object actions. The Use Process Run option is also
available on the PTF Recorder toolbar. The option selected
here is the default for all users in this environment. The
option selected on the PTF Test Recorder toolbar overrides
this selection for that recording session. When this option is
selected, PTF will recognize when a user accesses a run page
and will populate the Process.Run parameters with the process
information. All actions in the run page or process monitor
page will be ignored, because those actions will be handled by

the Run.Process during runtime.

Use Scroll Variables

Select to enable selection of scroll variables during recording.
The Use Scroll Variables option is also available on the PTF
Test Recorder toolbar. The option selected here is the default
for all users in this environment. The option selected on the
PTF Test Recorder toolbar overrides this selection for that

recording session.

When this option is selected, a drop-down list box containing
valid scroll variables appears in the PTF Test Recorder tool
bar. While recording, when the user selects any available
variable from the Variable list, in subsequent recording
actions, the PTF Recorder appends the variable to the name/
ID/comment recognition string in the test.

Use Page Expand

Select to add a Page.Expand step type if the user expands a
section of a page during recording. The Use Page Expand
option is also available on the PTF Test Recorder toolbar.
The option selected here is the default for all users in this
environment. The option selected on the PTF Test Recorder
toolbar overrides this selection for that recording session.

If this option is selected, when a user expands a page section,
two steps are inserted:

1. A Page.Expand step, which is set to active.

2. The specific action used to expand the page, which is set

to inactive.

When this option is not selected, when a user expands a page
section, a step for only the specific user action is inserted.
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Field or Control Description

Use Browser.Start_Login Select this option to set the first step in a test to Browser.
Start Login. When this option is selected, the Ignore Login
Steps option on the PTF Test Recorder tool bar is selected by
default.

When this option is not selected, the first step in a test is set

to Browser.Start, and the Ignore Login Steps option on the
PTF Test Recorder tool bar is not selected, so any immediately
subsequent recorded login steps are active.

The option selected here is the default for all users in this

environment.
Run Options
Field or Control Description
Process Server List Add process server names to the list that can be selected in

Runtime Options.

See Configuring Execution Options in PTF Client.

External Command Processing

Use this section to define the command line programs available to PTF users within any given PTF
environment. When the step/action Command.Exec is defined in the test step, PTF will use the
information supplied to run the command.

Note: Automation engineers may develop many executable utilities that assist in automating functional
test cases. In order to limit the scope of command line programs available to PTF users within any given
PTF environment, the command line program must be defined in the PeopleSoft database.

Field or Control Description

Command Name Enter the name to be used in PTF for the command line

program. The command name will be all caps.

Command Path Enter the path where the command line program is located.

Note: The path to the defined external command and the
executable file must be located on a host accessible to the PTF
client used to run the Command.
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Field or Control Description
Command File Name Enter the name of the command line file.
Timeout Enter the time in seconds before a command will time out.

See Command.

Evaluating SSL Certification Requirements

By default, PeopleSoft Test Framework requires a secure connection to the application database (an
HTTPS connection).

When you launch the PeopleSoft Test Framework client, if the database that you are attempting to connect
to does not have a valid SSL certificate, an error message appears, indicating that the environment does
not allow unsecured connections. You should check with your PeopleSoft Test Framework administrator
to resolve the error.

PeopleSoft Test Framework administrators can activate the PTTST CONFIG _NO_SSL web service if

a connection to an unsecured database is allowed. Once the web service is active, when a user starts the
PeopleSoft Test Framework client and it attempts to connect to an unsecured database, a warning message
appears indicating that the connection is not secure, but it provides an option to connect anyway.

To activate the PTTST _CONFIG_NO_SSL web service:

1. In the application database, access the Service Operations — Search page by selecting
PeopleTools > Integration Broker > Integration Setup > Service Operation Definitions.

2. In the Service Operations field, enter PTTST CONFIG_NO_SSL and click the Search button.

3. In the Service Operations search results, click the PTTST CONFIG_NO_SSL link to access the
Service Operations — General page.

4. Select the Regenerate Any-to-Local check box.

5. Select the Active check box to activate the service operation, then click the Save button.

Installing a PTF Client

A PTF client, which can be installed on an individual user’s machine, is the program that users run in
order to create and run automated tests. PTF test assets are not saved to the client machine. Rather, they
are saved to an application database environment configured to exchange information with the PTF
client. A PTF client does not need to be, and usually is not, installed on the same machine that hosts the
PeopleSoft application environment.

PTF client runs on Microsoft Windows operating systems that are certified for PeopleTools Client
installation.
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Note: If the local host machine or the remote machine are on Windows 10, then make sure the Display
settings of the system is set to 100%. You can set it from the Change the size of text, apps, and other items
drop down options under Scale and Layout section.

To install a PTF client, you need to complete the following tasks:

L.

2.

Verify requirements. See Verifying Requirements.

Configure browser settings. See Configuring Browser Settings.

Install the PTF client software. See Installing the PTF Client Software.

Create a connection to a PTF environment. See Creating a Connection to a PTF Environment.

Select a PTF environment. See Selecting a PTF Environment.

Configure local options. See Configuring Local Options.

Verifying Requirements

PTF client installation has the following requirements:

1.

Microsoft Windows operating system.

Note: PTF requires a 64 Bit OS environment.

Supported Internet browsers:

*  Microsoft Internet Explorer 11, Microsoft Edge, and Chrome are required for recording tests and
for identifying HTML objects using the Message tool, and can be used for test playback.

* Mozilla Firefox is supported, but only for test playback.

Note: For details about supported browser versions, refer to the Certifications tab for your
PeopleTools release on My Oracle Support (https://support.oracle.com/).

Microsoft .NET Framework.

If Microsoft .NET Framework is not present, you see a message stating that Microsoft .NET
Framework is not installed. Install .NET Framework and restart the PTF client installation.

In order to install PTF, you will need read and write access to the PTF home directory (C: \Program
Files\PeopleSoft\PeopleSoft Test Framework) by default.

PTF will need runtime access to the PTF data directory (C: \Documents and Settings
\<User>\ApplicationData\PeopleSoft\PeopleSoft Test Framework) by default.

Note: When using a dual monitor system, PTF must be run in the primary display.
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Browser Security Settings for Chrome

The following Chrome policies can block extensions. PTF is designed to work with or without these
policies. If extensions are blocked as per these policies, then the Chrome-based recorder must be enabled
and installed manually as per the instructions provided in the subsequent section for installing PTF
Chrome Recorder Extension:

* [HKEY LOCAL MACHINE\SOFTWARE\Policies\Google\Chrome
\ExtensionAllowedTypes] "1"="extension"

* [HKEY LOCAL MACHINE\SOFTWARE\Policies\Google\Chrome
\ExtensionInstallBlocklist] "1"="x"

* [HKEY LOCAL MACHINE\SOFTWARE\Policies\Google\Chrome
\ExtensionInstallAllowlist] "1"="boainbfkaibcfobfdncejkcbmfcckljh"

We see the following error message when these policies are configured to block Chrome extensions:

Error Loading Extension b4

Failed to load extension from:
! CihiUsers\ sagesded AppData’ Local Temph2\scoped_dir2304_1414458T92

\extension_bosinbfkaibcfobfdncejkebmfockijh. Loading of unpacked
extensions 15 disabled by the administrator,

Browser Security Settings for Microsoft Edge

The following Microsoft Edge policies can block extensions. PTF is designed to work with or without
these policies. If extensions are blocked as per these policies, then the Microsoft Edge-based recorder
must be enabled and installed manually as per the instructions provided in the subsequent section for
installing PTF Microsoft Edge recorder extension:

* [HKEY LOCAL MACHINE\SOFTWARE\Policies\Microsoft\Edge
\ExtensionAllowedTypes] "1"="extension"

* [HKEY LOCAL MACHINE\SOFTWARE\Policies\Microsoft\Edge
\ExtensionInstallBlocklist] "1"="*"

* [HKEY LOCAL MACHINE\SOFTWARE\Policies\Microsoft\Edge
\ExtensionInstallAllowlist] "1"="boainbfkaibcfobfdncejkcbmfcckljh"

Installing PTF Chrome Recorder Extension

You may want to manually install the recorder extension when certain browser policies block the recorder
extension.

To install PTF Chrome Recorder extension:

1. Close all the Chrome windows that already opened.
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2. Open a new Chrome browser window as administrator.

3. Openthe URL chrome://extensions/.

4. Enable the developer mode by clicking on the Developer mode toggle button.

5. Keep the Chrome window open and then navigate to the PTF installation directory.

6. Select the psTstRecCh.crx file. Next, drag and drop this file on the opened Chrome browser.
An alert box appears with the Add Extension button.

7. Add the extension. A confirmation message appears on the Chrome window.

8. Close the Chrome window, and start PTF to launch the Chrome Recorder.

Installing PTF Microsoft Edge Recorder Extension

To install PTF Microsoft Edge Recorder extension:

1. Close all the Microsoft Edge windows that already opened.

2. Open a new Microsoft Edge browser window as administrator.

3. Open the URL edge://extensions/.

4. Enable the developer mode by clicking on the Developer mode toggle button.

5. Keep the Edge window open and then navigate to the PTF installation directory.

6. Select the psTstRecCh.crx file. Next, drag and drop this file on the opened Edge browser.
An alert box appears with the Add Extension button.

7. Add the extension. A confirmation message appears on the Edge window.

8. Close the Edge window, and start PTF to launch the Edge Recorder.

Browser Security Settings: Test Application URL

You must configure the client browser security settings to accept the test application URL. If browser
security settings are not properly configured you may encounter problems with PTF test playback.

Note: For details on compatible browsers and drivers supported for PTF test playback, see Doc ID
704492.1 on My Oracle Support.

Note: If you find few PeopleSoft application pages are not rendering correctly in Microsoft Internet
Explorer then open the Compatibility View Settings dialog box. Remove the selection from Display
intranet sites in Compatibility View check box and Use Microsoft compatibility lists check box.

Select Tools, Compatibility View settings in the Internet Explorer browser to open the Compatibility View
Settings dialog box.

To configure the browser security settings in Microsoft Internet Explorer:

1. In Microsoft Internet Explorer, select Tools > Internet Options.
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2. In the Internet Options dialog box, access the Security tab.

3. Click the Local intranet zone.

4. Click the Sites button.

5. Click the Advanced button.

6. In the Add this website to the zone field, enter the domains for the test applications.
7. Add entries for both http and https.

For example:

http://*.<domain_ name>
https://*.<domain name>

Determine the domain name based on the URL for the test application. For example, if the URL is:
https://us.example.com:80/PTTRN/signon.html
then the domain name is us .example.com

8. Click the Add button.

9. Click the Close button.

10. Click the OK button to close each open dialog box.

This example shows the Local intranet dialog box:
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This example illustrates the Microsoft Internet Explorer Local intranet dialog box

Local intranet X

You can add and remove websites from this zone. All websites in
this zone will use the zone's security settings.

Add this website to the zone:

| Add
Websites:
https://*.us.example.com Remove
[_]Require server verification (https:) for all sites in this zone
Close

There are no specific browser security requirements for test playback in Chrome, Edge, or Firefox.

Browser Security Settings: Enable Protected Mode Option

For Microsoft Internet Explorer, the Enable Protected Mode setting for each zone must be equivalent —
either enabled or disabled for all zones. In other words, if it is enabled for one zone, it must be enabled for
all zones. Likewise, if it is disabled for one zone, it must be disabled for all zones.

Note: For Microsoft Internet Explorer on Windows 10, ensure that protected mode is enabled for all
zones.

In Microsoft Internet Explorer select Tools, Internet Options, Security to specify the security options for
each zone.
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This example illustrates setting Enable Protected Mode on.

Internet Options ? X

General Security Privacy Content Connections Programs Advanced

Select a zone to view or change security settings.

@ ¢ v O

nternet Local intranet Trusted sites  Restricted
sites

Internet

Site
0 This zone is for Internet websites, .

except those listed in trusted and
restricted zones.

Security level for this zone
Allowed levels for this zone: Medium to High

Medium-high
- Appropriate for most websites
e - Prompts before downloading potentially unsafe
content
- Unsigned ActiveX controls will not be downloaded

Enable Protected Mode (requires restarting Internet Explorer)
Custom level... Default level

Reset all zones to default level

OK Cancel Apply

There are no specific browser security requirements for Chrome, or Firefox.

General Settings

Chapter 2

Verify from the Browser Settings, the Internet Options, General Tab, Startup section has the Start with

home page radio button selected.

See Start Internet Explorer on the Home Page.
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Zoom Settings

Browser zoom settings should be set to 100 percent. Check the lower right-hand corner of the browser
and make sure it displays 100% for the zoom level.

Installing the PTF Client Software

The following options are available for installing the PTF Client:
* Installing from PeopleTools Client Deployment Packages (DPK).

* Installing in silent mode.

Installing PTF from PeopleTools Client Deployment Packages (DPK)

PeopleTools Client deployment is documented in PeopleSoft PeopleTools Deployment Packages
Installation guide, Task 2-12: Deploying the PeopleTools Client DPK.

Download the PeopleTools Deployment Packages Installation guide from PeopleSoft PeopleTools Home
Page on My Oracle Support for the current PeopleSoft PeopleTools release.

For example, for PeopleTools release 8.59, download the DPK Installation guide from PeopleSoft
PeopleTools 8.59 Home Page on My Oracle Support.

The directions here only refer to the PeopleSoft Test Framework portion.

When you deploy PeopleTools Client in standalone mode using (SetupPTClient.bat -t), you will
be prompted whether or not to install PeopleSoft Test Framework.

Do you want to install PeopleSoft Test Framework? [Y/N]:

If you answer y (yes), specify the installation directory, or accept the default, C:\Program Files\PeopleSoft
\PeopleSoft Test Framework:

Please specify the directory to install PeopleSoft Test Framework [C:\Program Files=

\PeopleSoft\PeopleSoft Test Framework]:

If you enter a directory where a previous version of PeopleSoft Test Framework is installed, it will
upgrade that version to the new PeopleTools release/patch.

Next, you will be prompted whether or not to configure PeopleSoft Test Framework.

Do you want to configure PeopleSoft Test Framework? [Y/N]: n

If you choose y (yes) to configure PTF, the deployment process prompts you for setup parameters. You
can configure PTF either at the same time that you install it or later.

This example shows the setup parameters:

Database Name: HCM92
Server:Port: example.com:443
Node ID: node name

User ID: VP1

Proxy [Y/N]: y

Proxy Server: proxyserver.com
Proxy Port: 5000

Proxy User: username

Proxy Password:*****x*xx
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Retype Proxy Password:****xxx

You can even use the deployment process to re-configure PTF in cases where you do not need to re-install
PTF.

See Creating a Connection to a PTF Environment, for details on setup parameters.

Note: You can install PeopleSoft Test Framework as part of the PeopleTools Client deployment, or as a
separate installation.

This example shows PTF installation using SetupPTClient.bat -t, and PTF is done as a separate
installation as PeopleTools 8.58 Client is already deployed (first option is specified as 7.)

Microsoft Windows [Version 6.1.7601]
Copyright (c) 2009 Microsoft Corporation. All rights reserved.

C:\Users\abc>cd C:\dpk 858\909 client

C:\dpk 858\909 client>SetupPTClient.bat -t
*xxxxx SetupPTClient started at 7:23:01.88 ***x**x*

Do you want to deploy PeopleTools client? [Y/N]: n

Do you want to install Change Assistant? [Y/N]: n

Do you want to install Change Impact Analyzer? [Y/N]: n

Do you want to install PeopleSoft Test Framework? [Y/N]: y

Please specify the directory to install PeopleSoft Test Framework [C:\Program F
iles\PeopleSoft\PeopleSoft Test Framework]:

Do you want to configure PeopleSoft Test Framework? [Y/N]: n

Please specify the PSHOME for the PeopleTools Client [C:\PT8.58
_Client]:c:\pt8.58

Starting Tools Client Deployment!

Installing Peoplsoft Test Framework in C:\Program Files\PeopleSoft\PeopleSoft T
est Framework for PTools Version 8.58

Deployment of PeopleTools Client Complete.

Tools Client Deployment Ended.

"rxxxxk SetupPTClient ended at 7:27:30.10 ***x*xkx*n

"Please review C:\users\abc\AppData\Local\Temp\PeopleSoft\PTClientDeploy.log

for additional information."

C:\dpk 858\909 client>

This setup will add the shortcut to the desktop.

Installing PeopleSoft Test Framework in Silent Mode

You can carry out a silent installation of PeopleSoft Test Framework by supplying command-line
parameters to a script.

With silent installation there is no user interaction after you begin the installation.

The PeopleSoft Test Framework installer includes the following files in the directory PS_ HOME\setup
\PsTestFramework:
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» setup.bat — Use this script to upgrade an existing PeopleSoft Test Framework instance or install a new
instance.

» resp_file.txt — This file provides the instructions for silent install.
» response-file.txt — This file provides the path to install PeopleSoft Test Framework.
To use the PeopleSoft Test Framework silent installation script:

1. Inacommand prompt, go to PS HOME\setup\PsTestFramework.

Note: Do not move the file to another location.

2. Run the following command:
setup.bat -f resp file.txt -p <Path>

If <Path> is supplied, and it is valid, then PeopleSoft Test Framework will be installed in that
location. If the path is not supplied or invalid, setup.bat will read the response-file.txt for the location.

Warning! Silent install deletes all content present in the <Path> location.

Note: You cannot configure using silent mode. After installing PTF using silent mode, open it, and
configure.

To uninstall PTF:
1. Inacommand prompt, goto PS HOME\setup\PsTestFramework.

2. Run the following command:

setup.bat -u U

Support for Browser Drivers in PTF

Copyright

PTF supports downloading and using latest browser drivers that are compatible with the version of
Chrome, Microsoft Edge, and Mozilla Firefox browsers so that you can use higher versions of these
browser for test playback.

Chrome, Firefox (Gecko), and Microsoft Edge drivers are not shipped with PTF.
You can download the compatible driver version for the browser installed in your machine.
To download and use the required Chrome driver:

1. Download the required Chrome driver from https://chromedriver.chromium.org/
downloads.

a. Select the Chrome driver release version. For example, ChromeDriver 88.0.4324.27.

b. Download the chromedriver_win32.zip file.

2. Extract the zip file and copy the chromedriver.exe executable file to PTF install directory.

© 1988, 2023, Oracle and/or its affiliates. 41



Installing and Configuring PTF Chapter 2

3.

Rename the copied driver to match the existing Chrome driver naming format, which is
chromedriver <version>.exe, where version indicates the version that you select while
downloading. For example, chromedriver 88.0.4324.27 .exe.

To download and use the required Firefox (Gecko) driver:

L.

Download the required Firefox (Gecko) driver from https://github.com/mozilla/
geckodriver/releases.

a. Select the Gecko driver release version. For example, 0.28.0.

b. From the Assets section, download the winé4.zip file. For example, geckodriver-v0.28.0-
win64.zip.

Extract the zip file and copy the geckodriver.exe executable file to PTF install directory.

Rename the copied driver to match the existing Gecko driver naming format, which is
geckodriver <version>.exe where version indicates the version that you select while
downloading. For example, geckodriver 0.28.0.exe.

To download and use the required Microsoft Edge driver:

1.

Download the required Microsoft Edge driver from https://developer.microsoft.com/
en-us/microsoft-edge/tools/webdriver/.

a. On the Downloads section, select the required version. For example, 89.0.774.4 .

b. Download the edgedriver win32.zip file by choosing your operating system as x8§6.

Extract the zip file and copy the msedgedriver.exe executable file to PTF install directory.

Rename the copied driver to match the existing Microsoft Edge driver naming format, which is
msedgedriver <version>.exe where version indicates the version that you select while
downloading. For example, msedgedriver 89.0.774.4.exe.

Creating a Connection to a PTF Environment

42

To create a connection to a PTF environment:

1.

Run the PTF client.

Either double-click the PTF shortcut on your desktop or navigate to Start, All Programs, PeopleSoft
Test Framework.

The PeopleSoft Test Framework - Signon dialog box appears. If you have not yet created a connection
to a PTF environment, the environment signon dialog box is empty and the fields are disabled.

Click the New button.

Enter details for the following fields:
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Field or Control Description

Database Name Enter a descriptive name for this environment. You can use
any name.

Server:Port Enter the server name and port for the environment.

Contact your Integration Broker administrator or system
administrator for the correct values.

The format for the Server:Port field is:

<machine name>:<https port>

For example:

us.example.com:443

If the https port is the default 443 the port is optional.
You can also enter a complete https URL in this format:
https://<machine name>:<https port>=
/PSIGW/HttpListeningConnector

For example:
https://us.example.com:443/PSIGW/Ht=>

tplisteningConnector

Use Proxy Select this field if using a proxy server.

When you select this check box the Proxy Information link
is enabled.

Proxy Information Click this link to enter details for the proxy server.
Enter the following information for the proxy server:
*  Server: Enter the server name

*  Port: Enter the server port.

+  User: Enter the user ID for the proxy server.

If you use network authentication, use the DOMAIN
\USER format.

*  Password: Enter the password.
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Field or Control Description

Node ID This field is required if more than one database is connected
to the server. Enter the name of the PeopleSoft node with
which the integration gateway is to communicate.

Contact your Integration Broker administrator or system
administrator for the correct values.

See Verifying Integration Broker Setup.

User Enter a valid user ID for the PeopleSoft application that
contains the environment. The user ID must have one of
the PTF security roles assigned. Contact your security
administrator to add the role if required.

If this user ID does not have PTF access, you will receive a
login error:

See Setting Up Security.

Password Enter the password for this user.

4. Click the OK button.
PTF launches with a connection to the designated environment.

This example illustrates a completed environment signon dialog box. In this example the Node ID field is
left blank because the default gateway is used.

PeopleSoft Test Framework - Signon

ORACLE PeapleT ools 8.57.01

Database Mame: |DEMODE g
Server:Port : example. com: S001|
[ ] Usze Proxy Priosy [nformation
MHode D
Uzer 1D : Uzermame
Password - P
ok LCancel = Previouz

Copyright & 1388, 2018, Oracle and/or itz affiliates. All rights reserved.
Oracle and Java are registered trademarks of Oracle and/or itz affiliates.
Other names may be trademark.s of their respective owners. [ntel and Intel
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This example illustrates a PeopleSoft Test Framework - Signon dialog box where the default gateway is
not used. This requires that the Node ID be specified:.

PeopleSoft Test Framework - Signon

ORACLE PeapleT ools 8.57.01

Database Mame: |DEMODE F X
ServerPort example.con 443
[ ] Usze Proxy Frosy Information
Mode 1D : PE_LOCAL
Uzer D : |l zermame
Bazzword : sssssnns
(]9 Cancel M Previous

Copyright © 1988, 2018, Oracle and/ar itz affiliates. All rights reserved.
Oracle and Jawva are registered trademarks of Oracle and/or itz affiliates.
Qther names may be trademark.z of their respective ownerz. Intel and Intel

Note: Contact your Integration Broker administrator to determine the correct value to use for the Node ID
field.

Troubleshooting Tips

This section describes some of the errors you might encounter when attempting to log in to PTF and
suggests possible solutions.

You will receive a login error if PTF security has not been configured correctly. Possible causes and
solutions for this error are:

* The user ID and password you entered are not valid for the PeopleSoft application corresponding to
the entry in the Server:Port field.

*  The user ID you entered in the User field in the Environment Login does not have PTF privileges.
Add at least the PTF User role to the user profile.

*  The user ID for the ANONYMOUS node does not have PTF privileges. Add at least the PTF User
role to the user profile.

You will receive the following error message if you specify the wrong HTTPS port in the environment
login URL:

There was an error when PeopleSoft test Framework was trying to login.
Please, check if the User ID and Password are correct.

ErrMessage:Could not connect to https://example.com:442/PSIGW/HttpListeninConnector.
TCP error code 10061: No connection could be made because the target machine actively
refused it
192.0.2.1:442

ErrSource:mscorlib
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The default port is 443. If a different port was specified during installation, you will need to contact your
system administrator to determine the correct port number.

You will receive the following error message if you try to logon to an environment that is not secured
with an SSL Certificate.

This example illustrates the error message received when trying to login to an unsecured environment.

PeopleSoft Test Framework - Signon X

Secure connection failed due to invalid 55L Certificates. Please
contact the environment administrator.
Click "'OK’ to try an unsecure connection.

OK Cancel

PTF requires use of an HTTPS site for security purposes. Contact your PTF administrator to resolve this
error.

Selecting a PTF Environment

When you launch PTF again, the PeopleSoft Test Framework - Signon dialog box appears, with the last
environment you used automatically selected.

You can enter the password and click the OK button to launch PTF using that environment, or you can
click the New button to create another environment login.

If you have created other environment logins, click the Previous button to select another environment
login.

Click the Edit button to edit the currently selected environment login.

Environment login settings are specific to the machine on which the PTF client is installed. The
environment login settings are stored in the environments.xml file in the PTF data directory (C:
\Documents and Settings\<User>\Application Data\PeopleSoft\PeopleSoft
Test Framework) by default.

Note: The environment password is not stored in the environments.xml file.

Configuring Local Options

To configure local options, access the Local Options dialog box (from the PTF menu, select Local
Options).
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Local options are specific to the machine on which the PTF client is installed. The local options settings
are stored in the localoptions.xml file in the PTF data directory (C: \Documents and Settings
\<User>\Application Data\PeopleSoft\PeopleSoft Test Framework) by default.
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Note: Changes made to the local options settings will take affect the next time you start the PTF client, or

after a PTF test suite r

efresh.

This example illustrates the fields and controls on the Local Options dialog box. You can find definitions
for the fields and controls later on this page.

Proceszs Run Options

Queued :
Fozting :

Processing ;

|ntenim Statuzes ;

Final Statuses :

[ueny Optiong
Output Folder

Cutput Farmat

Default Falder

Process Diztibution Optiong

E xport/lmport Optionz

Test Optionz

Grid: Show Field Label |T|:||:||ti|:| v| Grid: Show Comment | Ma v|

Auto-Check Syntas | Mo W |

Recorder Optionz

File.Download: prompt for path | Mo W |

Terminate E xisting Browser Options

On Exit |Yes W | Frompt ws. Terminate | T erminate W |
| ] | | Cancel |

Local Options -

Tirmeout [rmin.] Log Result |L|:|g"-.-'-.-"arning v|
Tirneaut [rmin.) Log Result |L|:|gWarning V|
Tirneowt [mir. ]

Tirneowt [mir. ] Log Result |L|:|g"-.-'-.-"arning v|
Timeaut [min.] Lag Result |Lu:quarning V|

|E:'\L|sers"\admin'\.-'-‘-.pp[) atatLocalTemp " |

LS v

| C:\UszershadmintappD atahA oamingsPeopleS oft\PeopleSoft Test Fram " " |
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Term

Definition

Queued: Timeout (min.)

Enter the time in minutes for a process to be queued before
PTF logs a warning or a fail message.

Queued: Log Result

Specify whether a timeout causes PTF to log a warning or a
fail message. If LogFail is selected and Stop on Error is set in
the Debug menu, then the run will stop if a timeout occurs.

Posting: Timeout (min.)

Enter the time in minutes for a process to post before PTF logs
a warning or a fail message.

Posting: Log Result

Specify whether a timeout causes PTF to log a warning or a
fail message. If LogFail is selected and Stop on Error is set in
the Debug menu, then the run will stop if a timeout occurs.

Processing: Timeout (min.)

Enter the time in minutes for a process to complete before PTF
logs a warning or a fail message.

Process Distribution Options

Term

Definition

Interim Statuses: Timeout (min.)

Enter the time in minutes, in which the process monitor
matches the distribution_expected value for interim statuses,
such as N/A, None, Generated, Posting.

Interim Statuses: Log Result

Specify whether a timeout causes PTF to log a warning or a
fail message. If the status specified for distirbution_expected is
not matched then PTF logs a failed step.

Final Statuses: Timeout (min.)

Enter the time in minutes, in which the process monitor
matches the distribution_expected value for final statuses, such
as not Posted, or Posted.

Final Statuses: Log Result

Specify whether a timeout causes PTF to log a warning or a
fail message.

Query Options

Term

Definition

Output Folder

Enter or browse to the path to use for query output.
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Term Definition
Output Format Select the file format to use for query output. Options are:
CSV, XLS, or XML.

Export/Import Options

Term

Definition

Default Folder

Enter a default file path to save or retrieve the data file of the
Runtime Options. You can set the default location only from
the PTF client.

You can overwrite the path during the migration process too.

Related Links
Exporting and Importing Execution Options

Exporting Execution Options

Importing Execution Options

Test Options

Term

Definition

Grid: Show Field Label

Select Tooltip to show field labels as tooltips (hover text).
Select Column to show field labels in a column in the test
window.

Grid: Show Comment

Select Tooltip step information according to actual data of
the env which to be tested/under testing. If the option is not
selected, then only missing step information is filled out to
show step comments as tooltips (hover text).

Auto-Check Syntax

Select Yes to be prompted to check syntax every time you save
a test.

Recorder Options

Term

Definition

File.Download: prompt for path

Select Yes to be prompted to specify the path to use for file
downloads when executing tests.
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Terminate Existing Browser Options
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Note: Any change in this section of the Local Options dialog box will be effective after PTF client is
restarted.

These options specify whether to check for active web driver processes when you exit the PTF client, and
how to manage them. Multiple browsers are supported for test run via use of a web driver, which is a web
automation framework that enables test run against different browsers. To assist in debugging, users have
the option of leaving the test run browser session open after test execution, using a toggle available on the
PTF Debug menu. However, the web driver used for each open session consumes machine memory, until
that browser session is closed. Make sure the drivers and their associated browser sessions are properly
managed, to prevent performance issues. There are also related options for managing the web drivers and
test execution browser sessions in the PTF Debug menu and Tools menu.

Note: In the PTF session if Execution Options has Internet Explorer specified as the browser then all
open browser sessions including Chrome, Firefox, and Internet Explorer opened from PTF will get closed.
If any other browser is specified then all the instances of the specific browser opened from PTF will be
closed.

Term Definition

On Exit Determines if PTF should automatically check for leftover
active driver sessions when terminating the client.

Options are:

*  Yes: Select this option to include a check for existing
active driver processes when you terminate PTF. The
value selected in the Prompt vs. Terminate field
determines what action is taken.

e If Prompt is selected, you are prompted to close
existing browser windows.

o If Terminate is selected all open browser windows
will close without any prompt.
*  No: PTF will not check for leftover sessions.
You can check for active driver processes at any time by

selecting Tools, Check/Stop Leftover Drivers from the PTF
client menu.
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Term Definition

Prompt vs. Terminate The value selected in this field controls how PTF manages
existing active web driver sessions. Options are:

*  Prompt: Select this option to view a dialog box that
includes a count and list of the active driver processes,
and a prompt asking if you want to terminate them.
Choose Yes to terminate all active driver processes, No
to leave them active, or Cancel to return to the Test Editor
window.

*  Terminate: Select this option to automatically terminate
all active driver processes. No prompt or preview of
active driver processes appears when you select this
option.

Note: If the test includes steps to open new browser windows, set On Exit as Yes and Prompt vs.
Terminate ficld as Terminate to avoid unexpected issues on the step Browser. WaitForNew.

Configuring Execution Options in PTF Client

You use execution options to configure settings for the PeopleSoft applications that you test with PTF.
Execution options are stored as part of the metadata for a PTF environment and are available to all users
of that environment. Only a PTF administrator (a user with the PTF Administrator role) is able to insert,
delete, or modify execution options. You can configure execution options either in the PTF client, or by
using the Define Execution Options component in the PeopleSoft Internet Architecture.

This section describes how to configure execution options in the PTF Client. For information about
defining execution options in PIA, see Configuring Execution Options in PeopleSoft Internet Architecture

Note: Because test assets are PeopleTools-managed objects, we strongly recommend that you run

tests only against the database on which they are stored. As part of the PTF maintenance process, PTF
synchronizes test definitions with application metadata definitions. If tests are run against a different
application database, you may encounter problems when an application is customized or upgraded. A PTF
administrator can limit execution options to environments running against the same database where test
assets are stored.

To establish execution options in the PTF client, access the Execution Options dialog (select <PTF'
menu>, Execution Options). The PTF menu is labeled with the name of the current PTF environment,
preceded by an @ character, such as @QEDMO. You can also access the Execution Options dialog box
by clicking the execution options link in the lower right corner of the PTF application window. The
execution options link is labeled with the name of the default execution option. In the following example,
the execution options link is QA.
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This example shows how to access the Execution Options dialog in the PTF Client using the PTF menu.

@T5ELGE56 | Test Edit  Create  Tools  Window  Help

Refresh Ctrl+R

Projects...

Local Options..

Execution Options...

Exit Alt+0

=1 PTOA
=-{_] Vignesh_Sam

Database UserlD o

The currently defined execution options appear on the left pane of the Execution Options dialog. The
settings for the selected execution option appear in the right pane.

The following toolbar buttons are available:

Field or Control Description
1ck to add a new execution option.
JH Insert Click to add ion opti
1ck to remove an execution option from the list.
M Delete Click i ion fi he li
Click to export execution option on a PTF environment to a
B.[] Export data file.
Click to import execution options from a data file to a PTF
[ Import environment.
! i Click to save changes and close the dialog box.
1ck to close the dialog box without saving changes.
3 C I Click to cl he dialog b ith ing ch
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Default Execution Option

When you click the Accept button in the Execution Options dialog box, PTF stores the name of the
selected execution option and uses it, by default, in subsequent test recordings and executions. A link in
the lower right corner of the PTF application window displays the name of the default execution option.
You can click the link to open the Execution Options dialog box.

Overriding the Default Execution Option
Use an Execution step with a Set Options action in a shell test to override the default execution option.
See Runtime.

Related Links

Use Configuration and Runtime Options

Export/Import Options

Exporting and Importing Execution Options

Options Tab

Copyright

Use the Options tab to define the application settings and log output options to use during PTF test
execution.

This example illustrates the fields and controls on the Execution Options dialog — Options tab. You can
find definitions for the fields and controls later on this page.

Execution Options
E Insert E Delete ®.[ Export [,H Import ' Accept x Cancel
TESTPTF | | Debugging Advanced Options PeopleTools Log Export Dataloader Browser Settings
Name TESTPTF |
Prompt for Options  No v
Application
URL ‘ https://example.com:8010/PSAPP /signon html
Browser ‘ Chrome V‘ (] Run In Background
User ID XYF ]
Password ‘ senee ‘
Process Server ‘PSNT v l
Date Format ‘ v |
Skip Language No i
Form Factor None b
Output
LogFolder TESTPTF v
Verbose No v
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The following fields are on the Options tab:

Chapter 2

Term

Definition

Name

Enter a name for this execution option.

Prompt for Options

Specify whether the Execution Options dialog appears when a
user executes a test.

URL

Enter the URL of the login page for the PeopleSoft
application. PeopleSoft Test Framework uses this URL for the
Browser.Start_Login step type/action when executing tests and
when you click the Home icon (to start the web client and go
to the default URL) in the test recorder.

If the URL that is specified is not a standard PeopleSoft login
page, PeopleSoft Test Framework will try to determine the
UserID and Password fields, and set their values accordingly.
If that fails, PeopleSoft Test Framework will log a fatal error
message. In that case you should use Browser.Start and the
explicit steps required to log in, instead of using Browser.Start
_Login.

Browser

Specify a browser to record or playback any test script.

The options are Internet Explorer, Chrome, Microsoft Edge,
and Firefox.

For test playback, you can use all these options.

For recording test script, PTF is designed in such a way that it
launches:

* Internet Explorer-based PTF recorder, if you select
Internet Explorer, or Firefox as the browser.

*  Chrome-based PTF recorder, if you select Chrome as the
browser.

*  Microsoft Edge-based recorder, if you select Microsoft
Edge as the browser.

Internet Explorer is the default value for browser. If you
continue with the default value, the recording and test
playback will happen in Internet Explorer.

Run In Background

This option is enabled for Chrome and Microsoft Edge
browsers to run it in headless mode.

Select this option to run the browser window in the
background so that the log viewer of PTF client is in the

foreground for the user to monitor the test status.

You can also set this option through command line.

See Configuring Execution Options from the Command Line.
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Term Definition

User ID Enter a valid user ID for the application database.
Password Enter the login password for the user.

Process Server Select a process server from the drop-down list. This

list is populated by the Process Server List field in the
Configuration Options page.

See Defining PTF Configuration Options.

Date Format Select a date format.

Skip Language Select Yes to bypass the language selection on the PeopleSoft
application login page.

Form Factor Select the form factor size to use when launching the
application.

At test execution, the form size that you specify is selected on
the login page, and a new browser instance will open using
that size. The test will continue to execute in the new browser
instance.

LogFolder Select or enter the folder name to which test logs will be
written. If the folder does not exist it will be created.

Verbose Specify the log format.

Select Yes to log a detail line for each step that is executed in
the test.

Select No to log only the test status (Pass or Fail) at the test
level and to log a detail line for failed steps.

Debugging Tab

Use the Debugging tab to specify how PTF should manage page saves and run requests during test
execution.
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This example illustrates the fields and controls on the Execution Options dialog - Debugging tab. You can
find definitions for the fields and controls later on this page.

Execution Options

E Insert E Delete &, Export & Import vAccept x Cancel
TESTPTF ‘ Options Debugging  Advanced Options PeopleTools Log Export Dataloader Browser Settings
Debugging
Skip PageSave Yes b

Skip RunRequest Y

The following fields are on the Debugging tab:

Term Definition

Skip PageSave Select Yes to prevent a test from executing a save. You would,
for instance, select this option to avoid duplicate values in the
application database if you plan to run a test repeatedly.

Skip RunRequest Select Yes to prevent the test from executing process requests.

Advanced Options Tab

Use the Advanced Options tab to specify the information required to connect to multiple portal URLs and
to enable persistent variables.
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This example illustrates the fields and controls on the Execution Options dialog — Advanced Options tab.
You can find definitions for the fields and controls later on this page.

Execution Options

E Insert E Delete B[ Export (& Import “ Accept x Cancel
TESTPTF Options Debugging Advanced Options  PeopleTools Log Export Dataloader Browser Settings
Portal URL
Add Remove
Portal Name |EMPLO‘|’EE v Total: 1
URL |h1tps:.e',"example.com:801D,f'pspf'pspﬁ'ps,f'EMPLOTEE
Persistent Varables

Enable Persistent Variables

By Execution Option Name

[] By User ID
[C] By Machine Name used for Playback

Usage Monitoring
] Environment is Usage Monitor-enabled

Step Info
Overwrite Existing Step Info

The Portal URL is used to access the component when there is a step in the test to set the browser URL
(Browser.Set URL). See Set URL. To add a portal URL, click the Add link. To remove a portal URL
click the Remove link.

The following fields are on the Advanced Options tab:

Term Definition

Add and Remove Click to add or remove a Portal definition, then complete the
Portal Name and URL fields.

Portal Name Enter a valid portal name or select from a list of previously
added portal names.

Note: The name is saved in upper case.
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URL

Enter the portal URL.

The portal URL is entered in the following format:
http://webserver/psp/domain/portalname/n=
ode

For example: http://myserver.example.com:8010/psp/ps/
EMPLOYEE/QE_LOCAL/

Note: The ending backslash / is optional

Enable Persistent Variables

Select to enable saving and using persistent variables.
Selecting this option enables the other fields in this group.

See Using Persistent Variables

By Execution Option Name

This option is automatically selected when you select the
Enable Persistent Variables check box. Persistent variables
are stored in the database keyed by execution option name.
Persistent variables can also be keyed by User ID, machine
name or both.

By User ID

Select to store and retrieve persistent variables by PTF user ID.

By Machine Name Used for Playback

Select to store and retrieve persistent variables by machine
name.

Environment is Usage Monitor-enabled

Select this option to enable managed object tracking with
usage monitor during test execution. When this option is
selected, PTF passes the test and test case values as parameters
to the usage monitor during test execution when it encounters
the UsageMonitor step type.

When this option is not selected, if a test includes a Usage
Monitor step type, then PeopleSoft Test Framework writes a
warning to the log and skips the step. This enables you to run a
test on environments with and without usage monitor enabled,
without having to modify the test between executions.

Note: The PeopleSoft application must be properly configured
for usage monitor if you select this option.

For more information about configuring usage monitor, see
“Usage Monitor” (Performance Monitor).

For more information about the Usage Monitor step type, see
UsageMonitor.
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Term Definition

Overwrite Existing Step Info Select the option Overwrite Existing Step Info which will
allow PeopleSoft Test Framework to update step information
according to actual data of completed or ongoing tests from
the environment. If the option is not selected, then only the
missing step information is filled out.

For more information on Step Information, see Using Step
Information.

PeopleTools Tab
Use the PeopleTools tab to provide the information required to connect to DataMover.

This example illustrates the fields and controls on the Execution Options dialog — PeopleTools tab. You
can find definitions for the fields and controls later on this page.

Execution Options

E Insert E Delete @[ Export [),& Import VAccept i Cancel
TESTPTF Options Debugging Advanced Options PeopleTools |og Expot Dataloader Browser Settings

Tools Path (PsHome) |C:\PT859 |

Connection Type ORACLE v

Database Name | DEMO

User ID XYF |

Password qu. ‘
Data Mover

DMS Input Path ~ [C:\PT859\data ]
DMS Output Path  |C:\PT859\data |
DMS Working Path  |C:\PT859\temp'\DataMover |

The following fields are on the PeopleTools tab:

Term Definition

Tools Path (PsHome) Enter the path to PS_ HOME for this environment.
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Connection Type

Select the connection type.

Database Name

Enter the name of the database for this environment.

User ID Enter a valid database user ID.
Password Enter the password for this user.
DMS Input Path Enter the DataMover input path.

DMS Output Path

Enter the DataMover output path.

DMS Working Path

Enter the DataMover working path.

Log Export

60

The Log Export tab allows you to archive the result logs to a file system in XML + XSL format at the end
of each test execution, which provides the following benefits:

* The logs are accessible from any browser.

* The PTF client is not required to verify test results.

* The logs are available even after the environment or database is brought down or upgraded.

* Since the log is in XML format, you can write customized utilities to parse or interpret the logs as

needed.
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This example illustrates the fields and controls on the Execution Options dialog - Log Export tab. You can

find definitions for the fields and controls later on this page.
Execution Options
.E Insert E Delete @[ Export [),& Import V Accept P Cancel
TESTPTF Options Debugging Advanced Options PeopleTools Log Expot Dataloader Browser Settings
Use Log Export Yes v
Path [C:\PTFogs |
Style Sheet File |
Add Time Stamp No v
Export Images Yes v
Term Definition
Use Export Log Select Yes to activate the export log functionality.
Path Specify the shared drive to store the log files.
Note: Ensure that the shared drive path allows users full
read/write access. The path can be customized using existing
system variables. See System Variables
Style Sheet File (Optional) Specify the path to the stylesheet. If specified, the

exported XML log will be saved with the stylesheet.

You can create your own stylesheet to format the XML. If this
field is left blank, the XML will not be saved with a stylesheet.

Note: Ensure that the shared drive path allows users full
read/write access. The path can be customized using existing
system variables. See System Variables
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Add Time Stamp

If set to Yes the XML filename will be appended with the Time
Stamp in the following format:

<TEST_NAME>-<LOG_ID>-T<YYYYMMDD>_
<HHMMSS>

Example: FSCM_INS_VER-LOGS5-T20121128 163649. XML

Export Images

If set to Yes the Image will be saved in the same Log folder as
the XML Log in the following format:

<TEST_NAME>-<LOG_ID>-T<OPTIONAL TIME_
STAMP>-<LINE_NUMBER_AS_SHOWN_IN_LOG>

Example: FSCM_INS_VER-LOGS5-T20121128 163649-
Line30.JPEG

This example illustrates an exported log file using customized stylesheet.

€5 PTF LOG - HOME_CLICK_TEST -

Internet Explorer

» | cTemplHomE_cLick TEST-L0GY-T20180820_015141

| A

Ox| 2| 2@ P1FL0G - HowE_cLIck_TEST

PTF EXECUTION LOG

Log Info

Execution Options

System Info

PTF Environment
Info

Step-wise Log Info

Expand Al Collapse All
(5] | Message: Test Start: 820/2015 1:51:41 AM
(& |- Message: Browser Start_Login

[ F- Message: Frame setto "

(5] © Message: Goto URL

(& - Message: Browser Login

(2 @ Message: Doing login in Eng!
y el > ENG

(2] ® Message: combob
(£ @ Message: text Set,
(3] © Message: pwd.Set_Valus [d=pwd] - ===
(2] | Message: button. Click [name=Submit]
[ - Message: Frame setto "
(2 @ Message: Ignore step 3
(£ @ Message: Ignore step 4
(3 @ Message: Ignore step 5
(2 @ Message: Ignore step §
(] Message: Ignore step 7
(3] @ Message: Ignore step 8
(2 @ Message: ignore step 8
(£ 8 Message: Ignore step 10
(2] @ Message: lgnore step 11

(2 F- Message: Page Prompt
(5] 8 Messane Goin URI

Test Name: HOME CLICK TEST

overan resure: [ SN

DatalLoader Tab

Use the Datal.oader tab to enter configurations information similar to PTF login screen.
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This example illustrates the fields and controls on the Execution Options dialog - Log Export tab. You can

find definitions for the fields and controls later on this page.

Execution Options
E Insert E Delete [ Export [),& Import V Accept P Cancel
TESTPTF Options Debugging Advanced Options  PeopleTools Log Export | Dataloader | Browser Settings
Host Name |example ‘
SSL Port | |
Node ID | [
10

Term Definition

Host Name Enter the deployment host name.

SSL Port Enter the SSL port of the server in the current Execution
Options.

Node ID Enter the node ID added to the current Execution Options.
This field is required if more than one database is connected to
the server. Enter the name of the PeopleSoft node with which
the integration gateway is to communicate.

Contact your Integration Broker administrator or system
administrator for the correct values.
See Verifying Integration Broker Setup.

Browser Settings Tab

Use the Browser Settings tab to set SameSite flags based on the browser selected in the Options tab. The
SameSite flag in HTTP cookies enables increased browser security.
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The values selected in this tab will be used when PTF launches an instance of the invoked browser and set

the SameSite flags.

This example illustrates the cookie flag values when a

Chrome browser is selected.

H Execution Options
E Insert E Delete B[ Export [),H Import “ Accept @ Cancel
TESTPTF Options Debugging Advanced Options PeopleTools Log Expot Dataloader Browser Settings
SameSite by default cookies Enabled v
Cookies without Same Site must be secure Default v
Enabled
Disabled
The following fields are on the Browser Settings tab.
Term Definition

<SameSite flag name>

The cookie flag name and the supported values are displayed
based on the browser selected in the Options tab.

Note: Internet Explorer does not support SameSite flag in
cookies.

The following table details the SameSite flag and the supported values based on the browser selected:

Browser SameSite Flag Name Values

Chrome SameSite by default cookies *  Default
*  Enabled
e Disabled
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Browser SameSite Flag Name Values
Cookies without SameSite must be *  Default
secure

*  Enabled
*  Disabled
Firefox network.cookie.sameSite.laxByDefault |«  True
* False
network.cookie.sameSite. *  True
noneRequiresSecure
» False
Microsoft Edge SameSite by default cookies e Default
*  Enabled
»  Disabled
Cookies without SameSite must be e Default
secure
*  Enabled
*  Disabled

Configuring Execution Options in PeopleSoft Internet

Architecture

You use execution options to configure settings for the PeopleSoft applications that you test with PTF.
Execution options are stored as part of the metadata for a PTF environment and are available to all users
of that environment. Only a PTF administrator (a user with the PTF Administrator role) is able to insert,
delete, or modify execution options. You can configure execution options either in the PTF client, or by
using the Define Execution Options component in the PeopleSoft Internet Architecture.

This section describes how to define execution options using the Define Execution Options component
in PIA. For information about defining execution options in the PTF client, see Configuring Execution

Options in PTF Client.

To configure execution options in PIA, complete the following tasks:
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Specify execution options.

Configure debugging options.

Define advanced options.

Specify PeopleTools options.
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Chapter 2

Use the Define Execution Options (PSPTTSTEXEOPTIONS) page to define PTF options for executing

tests.

Navigation:

PeopleTools > Lifecycle Tools > Test Framework > PTF Execution Options
This example shows the Execution Options component - Options page in PIA:

This example illustrates the fields and controls on the Define Execution Options page. You can find
definitions for the fields and controls later on this page.

Options Debugging || Advanced Options

Hame Qg

Application URL hitpsexample.com: 202 0P SAPPIsignon. html

PeopleTools Export Log DiataLoader

Browser | Internet Explorer

User ID QAMGR

Process Server P5TH
*Date Format I MDD ﬂ
Skip Language I Mo "I

Form Factor | Mone

[

Log Folder | Q&TESTS

“ferbose I Ty 'I
[5] save

Password Fassword cannot he modified in PIA. It can only be modified from the Test Framework client.

Q

=

The fields on the Define Execution Options page are the same as the fields on the Options tab in the PTF
client, with the exception that you cannot modify passwords on the PeopleSoft application component.

Field or Control

Description

Prompt

Specify whether the Execution Options dialog appears when a
user executes a test.
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Field or Control

Description

Application URL

Enter the URL of the login page for the PeopleSoft
application. PeopleSoft Test Framework uses this URL for the
Browser.Start Login step type/action when executing tests and
when you click the Home icon (to start the web client and go
to the default URL) in the test recorder.

Browser

Specify a browser to record or playback any test script.

The options are Internet Explorer, Chrome, Microsoft Edge,
and Firefox.

For test playback, you can use all these options.

For recording test script, PTF is designed in such a way that it
launches:

* Internet Explorer-based PTF recorder, if you select
Internet Explorer, or Firefox as the browser.

*  Chrome-based PTF recorder, if you select Chrome as the
browser.

*  Microsoft Edge-based recorder, if you select Microsoft
Edge as the browser.

Internet Explorer is the default value for browser. If you
continue with the default value, the recording and test
playback will happen in Internet Explorer.

User ID

Enter a valid user ID for the application database.

Password

This field is unavailable for entry. The password must be
specified using the Execution Options dialog in the PTF client.
For more information, see Configuring Execution Options in
PTF Client.

Process Server

Select a process server from the drop-down list. This
list is populated by the Process Server List field in the
Configuration Options page.

Date Format

Select a date format.

Skip Language

Select Yes to bypass the language selection on the PeopleSoft
application login page.

Form Factor

Select the form factor size to use when launching the
application.

Log Folder

Select or enter the folder name to which test logs will be
written. If the folder does not exist it will be created.
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Field or Control

Description

Verbose

Specify the log format.

Select Yes to log a detail line for each step that is executed in
the test.

Select No to log only the test status (Pass or Fail) at the test
level and to log a detail line for failed steps.

See Configuring Execution Options in PTF Client.

Configuring Debugging Options

Use the Define Execution Options — Debugging (PSPTTSTDEBOPTIONS) page to define PTF

configuration options.

Navigation:

PeopleTools > Lifecycle Tools > Test Framework > PTF Execution Options

Select the Debugging Options tab.

This example illustrates the fields and controls on the Define Execution Options — Debugging page. You
can find definitions for the fields and controls later on this page.

Ciptions Dehugging Advanced Options

Hame 028

*SKip Save $ ro

*Skip Run Request | Mo :I'

FeopleTools Export Log Dataloader

Field or Control

Description

Skip Save Select Yes to prevent a test from executing a save. You would,
for instance, select this option to avoid duplicate values in the
application database if you plan to run a test repeatedly.

Skip Run Request Select Yes to prevent the test from executing process requests.

Defining Advanced Options

68

Use the Define Execution Options - Advanced Options page (PSPTTSTADVOPTIONS) to define
multiple portal URLs and to enable persistent variables.
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PTF uses the portal URL to access the component when there is a step in the test to set the browser URL
(Browser.Set URL). See Set URL. To add a portal URL, click the Add icon. To remove a portal URL

click the Delete icon.

Navigation:

Installing and Configuring PTF

PeopleTools > Lifecycle Tools > Test Framework > PTF Execution Options

Select the Advanced Options tab.

This example illustrates the fields and controls on the Define Execution Options - Advanced Options

page. You can find definitions for the fields and controls later on this page.

Persistent Variables

¥iUse Persistent Variables

~ By Execution Option Hame
" By User ID
r By Machine Hame

Usage Monitoring

I Enable Usage Monitor

Step Info

I owerwrite Step Info

[5] Save

Cptions Cebugaing Advanced Options
Hame 0a
Portal URL
*Portal Hame URL
EMPLOYEE

FeopleTools Export Log DataLoader

Personalize | Find | View All | IE—'| IE First ‘4" 10f1

hitps:lexample.com:8020/pspfps/EMPLOYEE

B Last

[+] [=]

Field or Control

Description

Portal Name

Enter a portal name.

Note: The name is saved in upper case.
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Field or Control

Description

URL

Enter the portal URL.

The portal URL is entered in the following format:
http://webserver/psp/domain/portalname/n=
ode

For example: http://myserver.example.com:8010/psp/ps/
EMPLOYEE/QE_LOCAL/

Note: The ending backslash / is optional

Use Persistent Variables

Select to enable saving and using persistent variables.
Selecting this option enables the other fields in this group.

By Execution Option Name

This option is automatically selected when you select the Use
Persistent Variables check box. Persistent variables are stored
in the database keyed by execution option name. Persistent
variables can also be keyed by User ID, machine name or both.

By User ID Select to store and retrieve persistent variables by PTF user ID.

By Machine Name Select to store and retrieve persistent variables by machine
name.

Enable Usage Monitor Select this option to enable managed object tracking with

usage monitor during test execution. When this option is
selected, PTF passes the test and test case values as parameters
to the usage monitor during test execution when it encounters
the UsageMonitor step type.

Note: The PeopleSoft application must be properly configured
for usage monitor if you select this option.

For more information about configuring usage monitor, see
“Usage Monitor” (Performance Monitor).

Overwrite Step Info

Select the option Overwrite Step Info which will allow
PeopleSoft Test Framework to update incorrect step
information when a test encounters a failed step. If the option
is not selected, then only missing steps are added.

For more information on Step Information, see Using Step
Information.

Use the PeopleTools page (PSPTTSTTOOLOPTIONS) to supply the information required to connect to

DataMover.
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Navigation:

Installing and Configuring PTF

PeopleTools > Lifecycle Tools > Test Framework > PTF Execution Options

Select the PeopleTools tab.

This example shows the Define Execution Options - PeopleTools page:

This example illustrates the fields and controls on the Define Execution Options - PeopleTools page. You
can find definitions for the fields and controls later on this page.

Options || Debuoging || Advanced Options

Mame Q&

Tools Path [P/FT 857

*Connection Type I :l'

Datahase Hame [EMO

User Ip |=AMGR

Data Mover

DMS Input Path |DAFTESTData
DMS Output Path |DIFTESTDaEt

DMS Working Path |DIFTBSTTernpiDatal over

[5] save

PeopleTools

Password Password cannot be modified in PIA It can only be madified fram the Test Framewark clignt.

Export Log || Dataloader

The fields on the PeopleTools page are the same as the fields on the PeopleTools tab in the PTF client,
with the exception that you cannot modify passwords on the PeopleSoft application component.

Field or Control

Description

Tools Path

Enter the path to PS_ HOME for this environment.

Connection Type

Select the connection type.

Database Name

Enter the name of the database for this environment.

User ID

Enter a valid database user ID.

Password

This field is unavailable for entry. The password must be
specified using the PTF Client.
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Field or Control Description

DMS Input Path Enter the DataMover input path.
DMS Output Path Enter the DataMover output path.
DMS Working Path Enter the DataMover working path.

Establish Export Log Options

72

Use the Define Execution Options - Export Log page (PSPTTSTLOGOPTIONS) to automatically archive
the result logs to a file system in XML + XSL format at the completion of each test.

This option provides the following benefits:

* The logs are accessible from any browser.

* The PTF client is not required to verify test results.

* The logs are available even after the environment or database is brought down or upgraded.

» Since the log is in XML format, you can write customized utilities to parse or interpret the logs as
needed.

Navigation:
PeopleTools > Lifecycle Tools > Test Framework > Define Execution options

Select the Export Log tab.
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This example illustrates the fields and controls on the Define Execution Options - Export Log page. You
can find definitions for the fields and controls later on this page.

Name Qa8

5] Save

Dptions Cebugdging Advanced Options PeopleTools Export Log DataLoader

Use Log Export I Yes 'I

Path |DAptlogi%test path % %te st%

Style Sheet File |D:\ptiogiTestLogStyle xs|

Add Time Stamp I es 'l
Export Imagesl (] vl

Field or Control

Description

Use Log Export

Select Yes to activate the export log functionality.

Path

Specify the shared drive to store the log files.

Note: Ensure that the shared drive path allows users full
read/write access. The path can be customized using existing
system variables. See System Variables

Style Sheet File

(Optional) Specify the path to the stylesheet. If specified, the
exported XML log will be saved with the stylesheet.

You can create your own stylesheet to format the XML. If this
field is left blank, the XML will not be saved with a stylesheet.

Add Time Stamp

If set to Yes the XML filename will be appended with the Time
Stamp in the following format:

<TEST NAME>-<LOG_ID>-T<YYYYMMDD>_
<HHMMSS>

Example: FSCM_INS VER-LOGS5-T20121128 163649.XML
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Field or Control

Description

Export Images

If set to Yes the Image will be saved in the same Log folder as
the XML Log in the following format:

<TEST_NAME>-<LOG_ID>-T<OPTIONAL TIME_
STAMP>-<LINE_NUMBER_AS_SHOWN_IN_LOG>

Example: FSCM_INS_VER-LOGS5-T20121128 163649-
Line30.JPEG

Specify DatalLoader Options

Use the DatalLoader page to enter configurations information of the SSL port.

This example illustrates the fields and controls on the Execution Options page - Datal.oader page. You
can find definitions for the fields and controls later on this page.

Qptions Dehugging

Hame Q&

S5L Port

Hode ID

Advanced Options FeopleTools Export Log Dataloader

5] Save
Term Definition
Host Name Enter the deployment host name.
SSL Port Enter the SSL port of the server in the current Execution

Options.
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Term Definition

Node ID Enter the node ID added to the current Execution Options.
This field is required if more than one database is connected to
the server. Enter the name of the PeopleSoft node with which

the integration gateway is to communicate.

Contact your Integration Broker administrator or system
administrator for the correct values.

See Verifying Integration Broker Setup.

Specify Browser Settings Options

Use the Browser Settings page to set SameSite flag for cookies based on the browser selected in the
Options tab.

This example illustrates the cookie flag values when a Chrome browser is selected.

‘ Options H Debugging H Advanced Options H PeopleTools H Export Log H Dataloader H Browser Settings

Name TRIAL

SamesSite by default cookies ‘Disabled V‘

Cookies Without SameSite must be secure ‘ Enabled V‘

For more information on SameSite flag of cookies, refer Browser Settings Tab

Configuring Execution Options from the Command Line

You can create, export, import, and overwrite an existing execution option from the command line.

Creating Execution Options

You can configure new execution options through the command line. To do this you will need to create a
response file.

A response file is a text file with parameters. It is a secured way to pass parameters to the command line
while creating execution options.

Create a response file for example, c:\resp_file.txt with the parameters described further. Then run
PsTestFw "C:\resp_file.txt" to create an execution option.

If validation fails the execution options are not created.
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PeopleSoft Test Framework provides a template to generate a response file. The response file template

includes the following:

Parameters Description

-CS Server:Port

-CO User name

-CP Password

-CNO (Optional) Node name

-CUA (Optional) Action on the SSL error. Values are:
*  True— Continue with unsecured connection.
»  False— Cancel the login.

-Action Execution option migration type. Values are:
*  exoimp for importing execution options.
*  exoexp for exporting execution options.
*  exogen for generating execution options.
*  testrun for executing a test.

-Log (Optional) Specify the name for the test execution log. The

default is unattended.log.

The following table describes the parameters to create execution options, included in the response file.

Parameters Descriptions
EXECOPTNAME Name of execution options
Please note:
« Itisarequired field.
* Do not use special characters such as: “&”, “\”, “*”, “<”,
wom
URL URL

(Optional) It cannot be validated like the URL configured in
the PTF client.
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Parameters Descriptions
TOOLSPATH File paths
DMSINPUT (Optional) PTF checks for special characters in the file path
such as: “|7, “<7, «“x7 «“9”
DMSOUTPUT
DMSWORKING
LOGEXPPATH
PERSISTVARIABLES If value is set to Yes, then following parameters are also
required.
BYEONAME
BYUSERID
BYMACHINE
BROWSER Browser type where values can be:
*  Internet Explorer
¢ Chrome
*  Firefox
*  Microsoft Edge
NOWINDOW Set the value to Yes (Y) to enable the Run In Background
option.
Note: Use this parameter only if you have selected the Chrome
or Microsoft Edge browser.
FORMFACTOR Form factor type where values can be:
« L
e M
* N
S
« X
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Parameters

Descriptions

PROMPT
SKIPLANGUAGE
VERBOSE
SKIPPAGESAVE
SKIPRUNREQUEST
LOGEXPUSE
LOGEXPDTTMSTAMP

LOGEXPIMAGE

These parameters accept Yes or No values.

SSBYDEFAULT

SSMUSTBESEC

Based on the browser selected, a supported value is set for
these SameSite flag parameters.

The supported values are:

« DEF
« ENA
« DIS
« TRU
« FAL

Note: Internet Explorer does not support SameSite flag.

This table details the SameSite flag parameter values, which are set based on the browser selected:

Browser SameSite Flag Name Response File Parameter | Command Line Value
Chrome SameSite by default cookies | SSBYDEFAULT » DEF
« ENA
« DIS
Cookies without SameSite SSMUSTBESEC « DEF
must be secure
« ENA
« DIS
Firefox network.cookie.sameSite. SSBYDEFAULT « TRU
laxByDefault
+ FAL
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Browser SameSite Flag Name Response File Parameter | Command Line Value
network.cookie.sameSite. SSMUSTBESEC « TRU
noneRequiresSecure
« FAL
Microsoft Edge SameSite by default cookies | SSBYDEFAULT + DEF
« ENA
« DIS
Cookies without SameSite SSMUSTBESEC « DEF
must be secure
« ENA
« DIS

Here is an example of a response file.

# Specify the server:port to connect to.
-CS=example.us.abc.com:8001

# Specify the user name

-CO=XY

# Specify the user
-CP=XY

# Specify the node
-CNO=

# Please keep this
-ACTION=exogen
#Specify action of
-CUA=

# Specify the file
-LOG=eo-create.log
# Following items are the fields of execution options.

# The field EXECOPTNAME is required.

[EXECOPT]

EXECOPTNAME=TESTNK

PROMPT= No
URL=http://example.us.abc.com:8000/h92vknewx/signon.html
BROWSER= Chrome

USER=XY

PASSWORD=XY

VERBOSE= No

NOWINDOW= Y

SSBYDEFAULT=ENA

SSMUSTBESEC= ENA

password
name

item as it is
SS1 error

path of execution options creation log

# Add multiple instances of the execution options
PORTAL NAME 1= CUSTOMER

PORTAL VALUE 1= http://example.com:8000/psp/database/CUSTOMER/FSCM/

PORTAL NAME 2= EMPLOYEE

PORTAL VALUE 2= http://example.com:8000/psp/database/EMPLOYEE/ERP/

Note: To define multiple instances of execution options settings, suffix an index for each execution
options instance. Specify the instance with the parameters PORTAL NAME and PORTAL VALUE.
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Exporting Execution Options

You can export execution options using command line. Enter PsTestFw "C:\export_exo.txt" where
export_exo.txt is the response file. The response file will have following parameters:

Parameters Description

-CS Server:Port

-CNO Node name

-CO User name

-CP Password

-CUA (Optional) Specify the action of SSL error. Values are:

*  True—Continue with the unsecured connection.

»  False—Cancel the login.

-ACTION Specify the migration type. For exporting execution options
enter exoexp

-EXO Specifies the name of the execution option, which is exported.

Add a comma Multiple execution options can be selected

-FILEPATH Specifies the location and the file name where the execution
option data file is stored. For example C:\PsTestFrameWork
\eo-export.dat.

Here is an example of the response file for exporting execution options:

-CS=<Server>

—-CNO=<Nodeid>

—-CO=<username>
-CP=<ConnectionPassword>
—ACTION=exoexp

-EXO=LOCAL

-FILEPATH=<Path & exporting file name>

On successful creation of the export file for the execution options, a log file with the name unattended.log
is also created under the export folder. The location of the export folder is specified in the Local Options
dialog box. See Export/Import Options.

Importing Execution Options

80

You can import execution options from a data file to a database. The response file which is used to import
the execution options include server name, node name, user name, password, instances of execution
options to import, and the file path where the data file is located. See Exporting Execution Options.
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Overwrite Parameter

The overwrite parameter allows overwrite of execution options with same name.

Field or Control Description

-OVWw Y/N

A sample response file for importing execution options and over writing existing execution option is as
follows:

-CS=<Server>

—-CNO=<Nodeid>

—-CO=<username>

-CP=<ConnectionPassword>

—ACTION=exoimp

#Over write exisitng execution option with same name.
-OVW=Y

-FILEPATH=<Path & importing file name>

-LOG= c:\temp\eo-import.log

Related Links

Exporting and Importing Execution Options

Configuring Execution Options in PeopleSoft Internet Architecture

Configuring Execution Options in PTF Client

Exporting and Importing Execution Options

Only users with the PTF Administrator role can export and import Execution Options for a database. You
can use the Export button and Import button on the toolbar of Execution Options dialog box to export
and import. See Configuring Execution Options in PTF Client.

You can also use the command line to export and import execution options. See Using the Command
Line.

Using the PTF Client

You can export and import execution options from the PeopleSoft Test Framework client. Click on the
Accept button after you make any change to the settings on the execution options dialog box, which saves
all the settings. Only saved settings are exported to a data file. Any setting which is not saved will not be
exported.
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The following example shows the fields and controls of the Export Execution Options dialog box.

Export Execution Qptions -
File Path : C:hUzergadmin'AppDatat B oamingPeopleSoft\PeopleSaft Test Fra|| | |
Select Execution Opliohs Select Al | | nzelect All
M arne Il Idzer (D Browser Status
(14, http: A femampleZ. com: 8010/pspdeign...  <uzera.. Internet Explorer Done
[] QamMGR hittp: Afemample. com: 301 O/pspdsignon <userma..  Internet Explorer

(s |

Field or Control Description

File Path Browse to the location where you want to save the exported
data file. By default the file path will show you the location
specified in the Local Options dialog box. See Export/Import
Options.

By default the file name for the data file is executionoptions.
dat.

Select Execution Options Lists the execution options available on the PTF client. You
can select one or many saved execution options to export.

The Status column shows Done when the export process
completes for the selected execution option.

Start Click the Start button to begin exporting.

Close Click the Close button to stop the export. The dialog box will
close and no further action will be taken.

The Import Execution Options dialog box also has a similar interface with fields and controls explained
above. When you click the Open button, all the execution options contained in a data file is listed. The
Status column shows if the execution option is new or is it existing in the database.

If the execution option exists in the database, that item is shown greyed out unless the Overwrite
Existing Items check box is selected.

Note: After import completes the execution option will be available in the database but to use it you will
have to click the Accept button.
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Related Links
Configuring Execution Options in PTF Client

Using the Command Line

You can export more than one instance of execution options or import execution options using the
command line.

Related Links

Configuring Execution Options from the Command Line
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Using PeopleSoft Test Framework

Using PTF Explorer
This section provides an overview of PTF Explorer and describes how to define and apply filters.

Understanding PTF Explorer

PTF Explorer gives you access to the PTF test assets (tests, test cases, libraries, and logs) stored within an
application database. Assets appear in a tree structure with collapsible folders for organizing test assets.
After PTF has been installed and configured, PTF Explorer is the first pane that appears when you start
the client. It is labeled with the name of the PTF environment, QEDMO in this example:

This example illustrates the PTF Explorer user interface.

# Peoplesoft Test Framework 8.54.01A-B0

@QEDMO  Test Edt Create Tooks Window Hep
(@A 0-& X% =

£ GEDMO.

e
Rt
) myFolder (PTDOCBL)

L] PeopleTools Development
L1 PTGA

an

-] TESTSCRIPTS
Qo

a

3 Connected

Om.

(3 Integrated Remote Testing

QP

] Related Cortert

-] Related Content Action Ul Widg

(O 1.Setup

£ T QETRC_ASSIGN_CREF_TO_WIDGET_38
B+ Logs

[ 1.PTDOCBL 2014-05-20 17:27

+ Test Cases

B QETRC_ASSIGN_CREF_ WIDGET_68

T QETRC_ASSIGN_PAGELET_WIDGET_4

B QETRC_ASSIGN_RA_SERVICE_5

B QETRC_ASSIGN_RC_SERVICE_WIDGES

Bl QETRC_CONFIGURE_LAYOUT_RA_9

Bl QETRC_CREATE_PAGELET_1

Bl QETRC_CREATE_RC_SERVICE_2

Bl QETRC_PAGELET_WIDGET_7

1 Workdlow
TEl QETRD_PERSONALIZE_RLIST_PAGELE [04-Personalize report list pag]
121 Vignesh_Sam

[ eomo [ PmoceL Standard

You use PTF Explorer to:

* Create tests and folders.
* Delete tests and folders.
* Copy and move tests.

* Run a test.

¢ Rename tests and test cases.
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* Navigate to and open test assets.

Chapter 3

» Associate tests with Application Designer projects.

Using myFolder

The PTF Explorer tree contains a folder called myFolder. You can use myFolder to store tests that you do
not want to share with other users. Users with the PTF User role can create, edit, and delete tests on/y in

myFolder.

PTF Explorer Menus

This section describes the menus that appear when PTF Explorer has focus. Note that many menu

commands are specific to the currently selected item.

This table describes the PTF Explorer PTF menu commands:

Note: The PTF Explorer PTF Menu name corresponds to the name of the current PTF environment
preceded with an @ character. In the previous example, the PTF Explorer menu name is @QEDMO.

PTF Menu Command (@<PTF_Environment>)

Usage

Refresh Refreshes the current view.
Projects Opens the Projects dialog box.
Local Options Opens the Local Options dialog box.

Runtime Options

Opens the Runtime Options dialog box.

This table describes the PTF Explorer Test menu commands:

Test Menu Command

Usage

Open Opens the selected test or test case.
Delete Deletes the selected test.
Rename Renames the selected test, test case, or folder.

Refresh Selection

Refreshes the view for the selected test.

Expand Selection

Expands all the branches in the selected node.
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Test Menu Command

Usage

Collapse Selection

Collapses all the branches in the selected node.

The PTF Explorer Edit menu contains standard Microsoft edit commands, such as Cut, Copy, and Paste,

and the following menu command.

Edit Menu Command

Usage

Copy Link to Clipboard

Copies the link for the selected test, test case, or log to the
clipboard. You can use this information in conjunction with the
Quick Open command.

Use the PTF Explorer Create menu to create folders and tests.

This table describes the Create menu commands:

Create Menu Command

Usage

Folder Creates a new folder within the selected folder.
Test Creates a new test in the selected folder.
Shell Test Creates a shell test in the selected folder.

This table describes the PTF Explorer Tools menu commands:

Tools Menu Command

Usage

Message Opens the Message tool, which enables you to monitor test
run. The Message tool displays details about the current step,
including name, object type, and value.

Log Manager Opens the Log Manager tool, which enables you to delete logs

from tests.

Mass Update

Opens the Mass Update tool, which enables you to modify
steps from multiple tests based on specific criteria.

Tests PT Upgrade

Opens the Tests PT Upgrade dialog box, which enables you to
upgrade tests from a previous version of PeopleTools.
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Tools Menu Command

Usage

Check/Kill Leftover Drivers

Closes all open test run windows to free up memory used by
web drivers.

This table describes the PTF Explorer Window menu

commands:

Window Menu Command

Usage

Quick Open

Opens a test, test case or a text run log with data that was
copied to the clipboard using the Copy Link to Clipboard
command.

Using the Copy Link to Clipboard command and the Quick
Open command together enables users to easily share tests
without having to navigate to the test in PTF Explorer. You
can select a test and select Edit, Copy Link to Clipboard. Then,
you paste that data into a text message and send it to another
user, who can then copy and paste the data into the Quick
Open dialog box and open the test.

You can also use this menu command to search for and open
multiple tests, test cases, or text run logs.

Close All

Closes all windows.

Multi-Select Functionality

Based on the item or items selected in the tree view, when you right-click a list of valid actions displays.
The tree view supports multiple selections. The following actions are supported with multi-select:

*  Open tests and logs.
* Cut and paste folders and tests.
* Delete tests and folders.

* Expand and collapse tests and folders.

The valid actions are based on the PTF role associated with the logged on user.

Defining and Applying Filters

88

You can create and apply filters to the PTF Explorer tree, to view subsets of test assets based on specific
criteria. This enables you to view only tests with certain characteristics, or that belong to certain
categories, such as: tests with similar names; tests belonging to the same parent folder; tests last updated
by the same user; tests resulting from the same Test Maintenance Report run. When the filter is applied, if

a folder does not contain any tests that meet the filter

criteria, then that folder is hidden.
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Note: The tree view does not refresh automatically with every edit or action on the Explorer Tree. If
you create a test which does not satisfy the active filter requirements, the folder for that test will not
automatically be hidden from the tree; the folder remains visible until you update the filter or refresh the

tree view.

Filter Action Icons

Use the following filter action icons, which appear above the PTF Explorer tree, to define, activate, or

clear a filter:

Term

Definition

'*-_Lf

Click to open the Tree Filters dialog, where you can define

filter criteria.

Indicates that there is no active filter. This icon functions as a

toggle switch; click to activate the filter.

I_:r,r:l:
2

Indicates that a filter is currently active. This icon functions as
a toggle switch; click to clear the filter.

Filter Definition

To define a filter, click the Set Filter icon to open the Tree Filters dialog box, and specify the filter

criteria.

This example illustrates the fields and controls in the Tree Filter dialog box.

x

— Test fiters — Steps filters
Test Name | Recognition |
Test Descr | Component |
Updated By | Page |
Updated Date | 1/ 1/2000  =| [1Z00:00 AM = Record |
Version | 0 Field |

— Mairtenance report filters — Coverage report fiters
User ID | User ID |
Project Name | Project Name |
Seq | 0

—Cthers fitters
Project Name

Clear All I oK Cancel

The filter criteria fields are grouped by these filter categories:
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» Test filters: Includes these test properties: Test Name, Test Description, Updated By, Update Date/

Time, Version.

* Step filters: Includes these step properties: Recognition, Component, Page, Record, Field.

* Maintenance report filters: Includes tests flagged by the test maintenance report by these properties:
UserlD, Project Name, Seq (sequence).

* Coverage report filters: Includes tests flagged by the test coverage report by these properties:

UserlD, Project Name.

*  Others filters: Includes test by their associated Application Designer Project Name.

Filters specifying a comparison against a text value use a starts with condition (when no wildcards are
used) or a Like condition (when wildcards are used). For example, the following filter field entries would

return the values listed:

Filter Criteria Returns Does Not Return
DAY DAY, DAYS, DAY ONE MONDAY

DAY % DAY, DAYS, DAY ONE MONDAY

%DAY DAY, MONDAY DAYS, DAY ONE
%DAY% DAY, DAYS, DAY ONE, MONDAY

The supported standard wildcard characters are:

Wildcard

Search Action

% (percent symbol)

Match one or more characters.

_ (underscore)

Match any single character.

\ (backslash)

Escape character; do not treat the next character as a wildcard.

Filters specifying a comparison against a Date/Time, Version, or Seq (sequence) use a greater than or

equal to condition.

When multiple filters are specified, the filter clauses are all conjoined with ANDs (rather than ORs).
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Using the Test Editor

When you create or open a test, test case, or shell test, it opens in the Test Editor. The Test Editor enables
you to:

* Record and edit test steps.

* Add, copy, and delete test steps.

* Create and edit test cases.

*  View both test and test case in a single view.
*  Debug tests.

This example shows the PTF Test Editor:

This example illustrates the PTF Test Editor. You can find definitions for the menus and controls later on
in this section.

@ Peoplesoft Test Framework 8.54.01-B0 =15 x]
©QEDMO  Test Edt Debug Toos Window Help
(HE S DBD N e & EE DD e |
£ QEDMO + B Test: QET_PVGTEST x
1B Test: QEV_PVGTEST =0
[~ Test Infornation Test Cas
Name: e peresT B Neme: [l [DEFAUT ] [ @ =
Deserpon: [ A O Deseptons [ o O
% cut Bycopy @peste | B ActeAl ~ | B Tnsertstep + | X Dekete Step @Step Information
seq D | Comment | Actve | 530! Tipe Action Recognition Parameters Value 2
»o1 1|l © ~ Browser = | Start_Login -
2 2l O | ® Page = | Prompt ~ |PTPG_WiZ_MENU PTPG_WIZ COMP GBL Add
3 3 O F Tedt ~ | Set_Value ~ 14=PSPGCORE_PTPG_PGRIDNAME QE_PG_CHART_ONLY_GPTION
4 4 O ~ Button = | Cick ~ |Value=Add
5 5 O | ® Ted ~ | Set_vaue ~ 14=FSPGCORE_FTPG_PGRIDTITLE QE_PG_CHART_ONLY_OPTION T
6 s © ~ LongText = | Set_Value ~ |id=PSPGCORE_DESCRLONG Create Pivot Grid with Chart Only
7 71 0| F Buiton = |Gick = |Value-Next >
2 5 O |F Tet ~ | Set_Value - [14-PSPGSETTNGS_PTPG_DSVALUE QE_PIVOT_GRID
9 3 O | m Span ~ | Get_Propety ~ linnerText=Instance prop=idet=3siD
0 w O |F Varable ~ | Set_value ~ | index=Replace(4sIDI'PTPG_QRY_VIEW_PTPG_DSCOLUM.
11 i © | ® CheckBar - | St Value ~ | d=ConCat{'PTPG_QRY VIEW_PTPG_DSSELCOLS"Milndex) N
2 2 O ~ Button = | Cick = | Value=Next >
1 B O | W Span ~ | Get_Propety = [innerText=Morth prop=idet=3siD
1 w O |F Varable ~ | Set_value ~ | sindex=Replace(4siDI'PSPGMODEL_PTPG_DSCOLUMNS'T™)
15 5 O | F Tet - | St Value ~ | d=ConCat{'PSPGMODEL_PTPG_DSCOLUMNALIASS "Miindex) Morth A
% s O | ® Span - | Get_Propety = rerTet-Product prop=det=tsiD
7 7 O | R Vanable = | Set_value + | sindex=Replace(4siDI'PSPGMODEL_PTPG_DSCOLUMMNS'T™)
1 B O | F Tedt ~ | Set_Value ~ ld=ConCat(PSPGMODEL_PTPG_DSCOLUMNALIASS "iindex) Product A
19 19 O ~ Span ~ | Get_Propety ~ innerText =Region prop dyret=8sID
2 n O | F Vanable ~ | set_vaue ~ | index=Replace(4siDI PSPGMODEL_PTPG_DSCOLUMNS'T™)
2 a2 O | " Tedt = | Set_value = Id=ConCat("PSPGMODEL_PTPG_DSCOLUMNALIASS "iindex) Fegion A
2 2 O |F Span - | Get_Propety = linnerTest-nt Gost prop-id-et=3sID
2 n O [ R Variable ~ [ Set_Value ~ | aindex=Replace(tsIDI'PSPGMODEL_PTPG_DSCOLUMNS'T")
2 2 O | F Tea ~ | set_vaue ~ | 14=ConCat'PSPGMODEL_PTPG_DSCOLUMNALIASS "Miindex) Unt Cast A
F 5 O | ® Span = | Get_Propety = linnerTest=Sales prop=id-et=3siD
[~ oMo [ pmocaL | Standard Step: 1

Test Editor Menu

Note that many menu commands in the Test Editor are specific to the currently selected step.

Test Editor PTF Menu Commands

This table describes the Test Editor PTF menu commands:
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PTF Menu Commands Usage
Projects Opens the Projects dialog box.
Local Options Open the Local Options dialog.

Runtime Options

Open the Runtime Options dialog.

Test Editor Test Menu Commands

This table describes the Test Editor Test menu commands:

Test Menu Commands

Usage

Save

Saves the current test.

Save As

Creates a copy of the current test with a new name.

Test Case Save As

Creates a test case as a copy of the current test case.

Export

Export test cases and test case values to a character-delimited

text file, such as comma-separated values (csv) file.

Import

Import test cases and test case values from a character-
delimited text file, such as comma-separated values (csv) file.

Copy Link to Clipboard

Copies a link to the test to the clipboard.

You can send this information to another user, who can use the
Window, Quick Open feature to open the test without having
to navigate to it in PTF Explorer.

Validate Test

Validate the test against the application metadata to identify
changes in the metadata since the test was last modified. As
you modify a test based on the results of a test maintenance
report, you can validate the test by running a test maintenance
report. The report is generated for a single test, using
analyses of compare reports generated in Step 2 of the Test

Maintenance Wizard.

See Creating Test Maintenance Reports.
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Test Menu Commands

Usage

Check Syntax

Validates the parameter syntax and values.

See PTF Test Language

Run

Runs the current test.

Run from Step

Runs the current test from the specified line number.

Pause Pauses runtime of the test.
End Stops runtime of the test.
Open Test Recorder Launches the Test Recorder.

Test Editor Edit Menu Commands

The Test Editor Edit menu contains standard Microsoft edit commands, such as Cut, Copy, Paste, and

Delete, and the following PTF commands:

This table lists the additional PTF commands:

Edit Menu Command

Usage

Find Finds occurrences of a specific text string in the current test.
Select the List all Matching Steps check box to create a list of
matches.

Again Searches for the Find string again.

Test Editor Debug Menu Commands

This table describes Test Editor Debug menu commands:

Debug Menu Command

Usage

Step Into

Runs the current step of the test and advances to the next step.

Step Over

Runs the current step of the test and advances to the next step,
unless the next step calls another test. Steps over called tests.
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Debug Menu Command Usage

Toggle Break Sets a break point at the selected step or removes an existing
breakpoint.

Clear All Breaks Removes all break points.

Stop on Error Stops runtime if the test encounters an error.

Note: This option can be also be enabled through the

command line.

Disable Screen Shots By default, the recorder creates a screen shot with each error.
Select this option to save space in the log by not creating
screen shots.

Highlight Errors Highlights errors in the log in yellow.

Overwrite Log If a log window is open after the most recent runtime of a test,
you can choose whether to append to the open log or overwrite
the open log.

Select this option to overwrite the open runtime log.

Leave Browser Open Keeps the PTF-launched browser window open after running
a test, to assist with debugging. Be aware that if many tests
are run with this option enabled, performance may degrade as
the webdrivers used by PTF consume memory. Use the Kill
Leftover Drivers option if performance is impacted.

Note: This option can be also be enabled through the

command line.

Kill Leftover Drivers Closes open Test Framework browser windows, to release the
memory that is used by their associated web drivers. When the
Leave Browser Open option is enabled, if performance issues
arise, you can use Kill Leftover Drivers at any time to free up
memory.

Enabling Debug Options from the Command Line

You can enable the Stop on Error and Leave Browser Open debug options from the command line by
using the -SOE and -LBO parameters respectively.

These parameters are used when you run a test from the command line using the Ps7estF'W command.
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For Stop on Error (-SOE) parameter, you can specify True, False, or Not Set in the command line. The
default value is Not Set.

The Stop on Error (-SOE) parameter is used as shown in the following example:

-CS=abc.us.oracle.com:443
-CUA=TRUE

-CO=VP1

-CP=VP1

-TST=TEST KILL 1
-TC=DEFAULT

-PFX=

-RTO=LOCAL

-LOG=TEST EXE.log
-SOE=TRUE

Note: Using Stop On Error (-SOE ) parameter in command line runtime will override the StopOnError
runtime action in shell tests script.

The override works as follows:

¢ If-SOE=True in command line and Runtime.StopOnError = False in shelltest, the
command line runtime of the called test is stopped that encounters a Fail.

¢ If-SOE=False in command line and Runtime.StopOnError = True or ALL in shelltest,
the command line runtime of the called test will continue if it encounters a Fail.

* If-SOE is not set, command line runtime of the called test will continue based on the setting of
Runtime.StopOnError.

For details on StopOnError runtime action, see Runtime.

For Leave Browser Open (-LBO) parameter, you can specify True or False in the command line. The
default value is False.

All existing browsers will be terminated by default before runtime when —LBO parameter is set in
command line parameters, unless the —TL parameter is used in command line runtime.

The Leave Browser Open (-LBO) parameter is used as shown in the following example:

-CS=slclOybf.us.oracle.com:443
-CUA=TRUE

-CO=VP1l

-CP=VP1l

-TST=TEST KILL 1

-TC=DEFAULT

-PFX=

—-RTO=LOCAL

—LOG=TEST_EXE.log

-LBO=TRUE

See Running Tests.

Test Editor Window Menu Commands

This table discusses the Test Editor Window menu commands:
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Window Menu Command

Usage

Quick Open

Using information from the Copy Link to Clipboard
command, quickly opens a test without having to navigate to
the log in PTF Explorer. You can also use this menu command
to search for and open multiple tests, test cases, or text runtime

logs.

Close All

Closes all windows.

Test Editor Toolbar

96

In addition to buttons for the standard Microsoft cut, copy, and paste commands, the test editor toolbar

provides the following functions:

Field or Control

Description

=

Check Syntax

1
linl

} Run test.
. End test.
- Show Test Recorder.
@ Debug break.
= Step into.
Step over.

5)

Stop on error.
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Field or Control Description

Disable screen shots.

Highlight errors in the runtime log.

@ Overwrite the open runtime log.

. Specify text that will be added to text fields when the test is
Prefix | | run. The prefix text is substituted for the #PREFIX# reserved
word in the Value field. Using a prefix can help prevent an
error caused by a duplicate entry when the page is saved.

Test Window

You can have multiple tests open in PTF. Each test has its own test window. This example shows a Test
Editor test window:

This example illustrates the fields and controls on the Test Editor test window. You can find definitions
for the fields and controls later on this page.

|@ QEDMO « T Test: BCL_TEST4 x
5 Test: BCL_TESTA. =izl
[~ Test Information Test Case Information
Name: e Teste B & Name: il [OEFAUCT o] (@ & =
= | ;| ® Descrwion: | o O
o ot By Copy [Gpecte | B Alipedl - | B nsertStep - | X 0okte Siep @Step Informatin
Seq 1D | Comment | Active | 550! Tyve Agtion Recognition Parameters Ve
» 1 1| O [ ® Browser v | Stat_Logn
2 2l O | F Browser - | FrameSet
3 3 © |0 Pud - | Set_Value ~ |Neme=pwd
4 4 © |0 Button - |Ciek ~ | Name=Submit
5 s| © | ® Text - | Set_Value ~ | Name=SEARCH_TEXTlindex=1
6 6 O r Div - [Cisk | Classname-ptnav2toggleindex=72
7 7l O [0 Div + |Cieke ~ | Classname=pinavztoggieindex=78
8 s O |0 Linke - |Cicke ~ |innerText=Pivot Grid Wizard
9 sl © [0 Browser - | Frameset ~ | TargetContent
10 0 O |~ Page - | Promet ~ | PTPG_WIZ_MENU.PTPG_ WIZ_COMP.GEL add updiate
1 now e Text - | Set_Value ~ | Name=PSPGCORE_PTPG_PGRIDNAME PTF_PERCENTI
2 2 O | & Page PromptOk -
13 B O | ® Text Set_Value ~ | Name=PSPGCORE_FTPG_PGRIDTITLE Test
e w O | F Button - |Cieke ~ | Name=PTORM_NEXT_PB
15 5 O | ® Text - | Set_Value ~ | Name=PSPGSETTINGS_PTPG_DSVALUE QE_PIVOT_GRID
16 ® O | F CheckBiax - | Set_Value ~ | Name=PTPG_QRY_VIEW_PTPG_DSSELCOLSO N
17 7 O ~ Button - | Cick ~ | Name=PTORM_NEXT_PB
18 B O ~ Button ~ | Click ~ | Name=PTORM_NEXT_PB
19 v O | ® ComboBax. + | Set_Value ~ | Name=PTPG_COL_VIEW_FTPG_CAICFORMULAS3 2
»n n O | F Radio + | Set_Value ~ | Name=PTPG_WORKREC_PTPG_DISPLAYOPT Ghe L
il 7| O | F Page Save >
2 2 O | F Button - | Cick ~ | Name=PTORM_NEXT_PB
2 6 O [F Link = | Vet ~ [innerTexd=100.00% 100.00%

Test Window Fields

The following fields appear in the test window:
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Field or Control

Description

Name

Displays the test name. This field is display-only.

Description

Brief description of the test. You can enter a detailed
description in the Comments.

Test Information Functions

Field or Control

Description

Test Save As.

= Ez

Click to access the Message Recognition dialog box.

Use the Message Recognition dialog box to define how PTF
will respond to messages that are encountered during runtime
of the test. The Message Recognition icon contains a check

mark when the message recognition is enabled for the test.

Open the Test Properties dialog. In the Language field, select
the language for the PeopleSoft application. The default is
English.

Changing the value in the Language field only affects the
language the test selects at sign in. It does not enable the test
to run against a different language. PTF tests should be rund
against the same language in which they were recorded.

Select the Variable Action to use with this test. The variable
action determines whether or not to use persistent variables.
By default the action is set to None and persistent variables are
not used. See Using Persistent Variables

Select the Library Test check box to make the test a library
test.

See Using Library Tests.

Open the Test Comments dialog to enter comments or to insert

a timestamp.
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In the Comments dialog box, you can:

Using PeopleSoft Test Framework

* Enter a long description using rich text and images.

* Insert a screen shot using the snapshot icon.

e Insert timestamp.

This example highlights the timestamp control on the Test Comments dialog box.

NontEE

Test Comments -

|®

2019-11-11 05:44:42 (UTC) USERID

This test works

oK || Cancel

Field or Control

Description

©

Timestamp displays the current date, time, and user ID. Date
and time follows ISO 8601 format, and uses UTC time zone.
For example, 2018-12-10 14:30 (UTC) <User ID>.

To insert timestamp, click the timestamp icon or press F5.

Test Case Information Fields

Field or Control

Description

Name

Displays the name of the current test case. You can select a
different test case using the drop-down list. When you create
a test, the system automatically associates it with a test case
named DEFAULT.

Copyright © 1988, 2023, Oracle and/or its affiliates.

99



Using PeopleSoft Test Framework

Chapter 3

Field or Control

Description

Description

Brief description of the test case. You can enter a detailed
description in the comments.

Test Case Information Functions

Field or Control

Description

i

Test Case Save As.

Create a new test case.

Delete the selected test case.

K

Open the Test Case Properties dialog.

Open the Test Case Comments dialog. You can enter a long

description of the test case using Rich Text and images.
Apart from entering text, you can insert timestamp.

See the preceding section, “Using the Comments Editor,” for
details.

Test Window Toolbar

100

In addition to buttons for the standard Microsoft cut, copy, and paste commands, the test window toolbar

provides the following functions:
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Field or Control

Description

% Active All |~

Selects the Active check box for all steps. Click the drop-down
arrow for additional step activation options, including:

*  Active Selected Steps.

Selects the Active check box for only selected steps.
*  Inactive Selected Steps.

Deselects the Active check box for only selected steps.
* Inactive All

Deselects the Active check box for all steps.

o Insert Step -

Inserts a new, blank step below the current step. Click the
drop-down arrow to insert the new step above the current step.

> Delete Step

Deletes the current step.

@ Skep Information

Displays the Step Information dialog box showing the
PeopleTools metadata associated with the object referenced in
the step. See Using Step Information for more information.

Test Step Fields

A PTF test consists of a series of steps. Each step in a test is composed of the following fields:

Field or Control

Description

Seq (sequence)

A system-generated sequence number. Test steps run
according to Seq order. When you move, add, or delete a step,
Seq is refreshed.

1D A system-generated unique identifier for each step in a test.
This value does not change when you move, add, or delete a
step.
Test maintenance reports use the ID value.

Comment When you click on the comment icon in the comment field

a rich text editor opens that enables you to add detailed
comments for each step. The comment field is gray when it
contains a comment.
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Field or Control

Description

Active

Deselect this field to inactivate a step. PTF will skip inactive
steps when the test runs. PTF syntax check is also skipped
on inactive steps. Each step is active by default. This field is
grayed for inactive steps.

Scroll ID

This field is only required for scroll handling.

Type

The step type. Often, the step type corresponds to the type of
application object the step is to take an action on or to validate,
such as Text, Check box, Browser, and so on. Other step types
perform certain functions, such as running a test or query,
setting a variable, or performing conditional processing.

Action

The action the test is to take . Each step type has a set of
associated actions. The two most common actions used with a
Text step type, for example, are Set and Verify.

Recognition

The means that PTF uses to identify the HTML object within
the application. Often, this is the HTML ID property.

Field Label

Contains the label text of the page control referenced in the
Recognition field.

The value for the Show Field Label option in the Local
Options dialog box determines whether this column appears:

*  If Column is selected, the Field Label column appears.
* If Tooltip is selected, the column does not appear;
instead, the field label appears in a tooltip when you

position the mouse cursor over the Value field.

For more information about setting local options, see
Configuring Local Options.

Parameters

The conditions that apply to this specific step, if applicable.

Note: This field was introduced in release 8.54; in previous
releases, parameters were specified as part of the Recognition
field. When you load and save a test from release 8.53 or
lower, PTF automatically moves any parameters from the
Recognition field to the Parameters field.

Value

In a typical recorded step, this is the value the tester entered
for an object.

In a step recorded in Verify mode, this would be the value that
was present in the object when it was checked.

Value is part of the test case, not the test itself.
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Related Links
PTF Test Language

Creating Tests

Using the PTF Test Recorder with Internet Explorer

You use the PTF Test Recorder to record the steps in a test.

When you record a test, PTF monitors each action you perform in the target application and creates a
corresponding step in the test. As you are recording, you can also add additional steps, such as Verify,
Log, and Conditional, that do not directly correspond to actions performed in the target application.

To launch Internet Explorer-based recorder, select the IE browser in the Execution Options in the PTF
client.

For details, see Options Tab.
This section discusses:

* The Test Recorder toolbar.
* Recording action tools.

»  Step insert tools.

*  Step modification tools.

»  Step utility tools.

Test Recorder Toolbar

To access the Test Recorder toolbar, select Test, Open Test Recorder or click the Show Test Recorder
icon.

This example illustrates the tools and controls on the Test Recorder toolbar. You can find definitions for
the tools and controls later on in this section.

|
DD B I:Select Action= j D I:Select Scroll Varable= j
4 | B

|Ready

Note: To move the Test Recorder toolbar, click in the title bar to the left of the close icon and drag to the
new location.

The Test Recorder toolbar elements can be categorized into these functional areas:

* Recording action tools.
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e Step insert tools.

*  Step modification tools.

* Recorder utility tools.
* Tool hints bar.

e Status bar.

Recording Action Tools

Chapter 3

Use these tools to control recording actions: start the web client; select the browser; and start, stop, or

pause recording.

This list describes the recording action tools that are available in the Recorder Toolbar.

Field or Control

Description

Uy

Hook a browser. Drag and drop this icon onto an active
PeopleSoft browser session to hook the recorder to that
browser. PTF will only hook a browser that was originally
launched by PTF. You can drag the hook icon to any portion of
the PIA application. No page objects will be highlighted.

Launch a PeopleSoft application in a browser window using
the URL of the default execution option and hook the recorder
to that browser.

See Configuring Execution Options in PeopleSoft Internet
Architecture and Configuring Execution Options in PTF
Client.

Begin recording or resume recording. When you begin
recording, the recorder adds or inserts steps following the
current step. When you resume recording after pausing you are
prompted to choose from the following options:

» Insert new steps at the current step (do not delete
subsequent steps in the test)

» Insert new steps at the current step (delete subsequent
steps in the test)

*  Insert new rows at the end of the test

Stop recording and write recorded steps to the test.

1N

Pause recording.
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Step Insert Tools

Use the items in the <Select Action> list box to insert action steps while recording. These items are
grouped into these categories:

* Drag and drop actions.
* Step insert actions.
» Usage monitor actions.

You can add an action manually from the select actions drop down.

Test Recorder .
Einy 8% DD [ | <Select Action: v & = ||1Z| |<5elect Scioll Variabls> V| A

£Select Action:

Link. Click. narne=l. -
4 ¥ ComboBox W alusE stz L]t T,
Div Scrolllt

Field Exists Ready
Get Label

Get Property

Get Style

HTMLCell Get Index

HTMLCell Get ¥ alue

Set Scroll Key

Set Scroll Definition

Show Popup

Werify

------ Step Ingert e

Add Log

Add Y ariable

End-If

[-Then

Scroll Action

Scroll Reset

------ Uzage Monitar -------

Start

Stop

<Select Action> - Drag and Drop Actions

These recording action tools capture page element recognition data using a method called “drag and
drop”, which refers to using the mouse to click an item and drag it then drop it to another location. To use
these options while recording:

1. Select a drag and drop option from the <Select Action> list.
This activates the Target icon, making it available to use.
2. Click and drag the Target icon to the desired page element.
Notice that the mouse cursor changes to a bold question mark.
3. Highlight the page element, then release the mouse button to drop the icon over it.

As you hover over a page element, the page element becomes highlighted. The element that you
intend to reference must be highlighted when you drop the icon over it. If the field is not highlighted,
PTF will not recognize it.

Drag and drop actions are not applicable to all HTML objects.
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This list describes the drag and drop action options that are available in the Recorder Toolbar <Select
Action> list:

Field or Control Description

ComboBox.ValueExists Adds a ComboBox.ValueExists step. Drag and drop over a
combo box element. You are prompted to select the value, and
the variable to store the return value, and to select an expected

value. Valid values are True, False, or Ignore.

Div.Scrolllt Adds a Div.Scrolllt step. Drag and drop over a horizontal/
vertical scroll bar element.

Field Exists Adds an Exists step. Drag and drop over a page element. You
are prompted to enter a variable name or select an existing
variable and to select an expected value. Valid values are True,
False, or Ignore.

See Exists.

Get Label Adds a GetLabel step. You are prompted for the return
variable that will contain the label.

See GetLabel

Get Property Adds a GetProperty step. Drag and drop over a page element.
You are prompted with a list of properties for the selected
page element. Enter a variable name or select an existing
variable name for one or more properties. The recorder adds a
GetProperty step for each property you identify.

See Get_Property.

Get Style Adds a GetStyle step. Drag and drop over a page element. You
are prompted with a list of style definitions for the selected
page element. Enter a variable name or select an existing
variable name for one or more style definitions. The recorder
adds a GetStyle step for each style you identify.

HTMLCell Get Index Returns the index value for an HTML table cell. Drag and
drop over the HTML table cell. You are prompted for the
return variable that will contain the HTML index.

See CellGetlndex
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Field or Control

Description

HTMLCell Get Value

Returns the value for an HTML table cell. Drag and drop over
the HTML table cell. You are prompted for the return variable
that will contain the HTML cell value.

See CellGetValue

Set Scroll Key

Adds a Scroll.Key_Set step. Drag and drop over a key field in
a scroll. Enter a Scroll ID in the Step Modification area and
click the Confirm icon.

See Incorporating Scroll Handling.

Set Scroll Definition

Drag and drop the target icon on the component page to define
the scroll button or the parent grid. The Step:Scroll Definition
dialog box appears where you can select the definition type
and other details.

See Scroll.

Show Popup

Opens field pop-ups or organization chart menu items.

See MouseOver.

Verify

Adds a Verify step. Drag and drop over a page element. The
step is automatically populated with the object ID and value of
the field.

See Verify.

<Select Action> - Step Insert Actions

These recording action tools insert test steps that provide logic constructs, manage scroll actions, and add

variables and logs.

This list describes the step insert action options that are available in the Recorder Toolbar <Select

Action> list:

Field or Control

Description

Add Log

Adds a Log step.

You are prompted to select a Log action and enter text for the

Message and Details.
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Field or Control

Description

Add Variable

Adds a Variable.Set Value step. You are prompted for
Variable Name and Value. User-defined variables and PTF test
variables appear in the <Select Variable> drop down list.

See Variable, System Variables.

End-If

Adds a Conditional.End_If step.

If-Then

Adds a Conditional If Then construct. You are prompted for
an expression, such as &Exists=True. The Recorder inserts a
Conditional.If Then step. Record additional steps, then select
End-If'to add a Conditional.End_If step.

See Conditional.

Scroll Action

Adds a Scroll.Action step. You are prompted to enter a Scroll

ID, return variable, and action. Click the Confirm icon.

Scroll Reset

Select to delete all rows with the specified scroll ID

<Select Action> - Usage Monitor Actions

These recording action tools insert test steps that control usage monitor actions.

This list describes the usage monitor action options that are available in the Recorder Toolbar <Select

Action> list:

Field or Control

Description

Start

Adds a UsageMonitor.Start step.

Stop

Adds a UsageMonitor.Stop step.

Step Modification Tools

As you are recording, you can modify steps recorded during the current session without stopping the

recording and exiting the Test Recorder.

This list describes the step modification tools that are available on the Test Recorder toolbar:
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Field or Control

Description

Move to the previous step in the recording. When you move
to the previous step or the next step, recording is paused. You
must click the Start Recording icon to continue recording.

Move to the next step in the recording. When you move to the
previous step or the next step, recording is paused. You must
click the Start Recording icon to continue recording.

Specify whether the step is active or inactive.

©

Drag and drop to capture page element information. This icon
is used in conjunction with the drag and drop items in the
<Select Action> list.

<Select Scroll Variable>

Select a variable to insert.

This list is used in conjunction with items in the <Select
Action> list that utilize variables.

Accept step modifications. If you move to another step or
continue recording without accepting modifications, the
modifications are lost.

Cancel modifications.

i

Modify the step.

Insert a #PREFIX# keyword at the beginning of the text in the
Value field.

|
e,

Edit test step comments in the Comments dialog.
Apart from editing test steps, you can insert timestamp.

For details, see Test Window Fields

Recorder Utility Tools

This list describes the recorder utility tools that are available on the Test Recorder toolbar:
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Field or Control

Description

Copy the recording to the clipboard.
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Field or Control

Description

R
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Configure recording settings.
*  Use Page Prompt

If you select the Use Page Prompt check box, the Test
Recorder will replace menu navigation steps with a Page.
Prompt step and Page.PromptOK step. The Test Recorder
records menu navigation steps, but they are set to inactive.

Note: When recording a search page with facets, PTF
does not automatically insert Page.Prompt constructs
because all user actions with facets must be recorded.

When using Page Prompt mode, explicitly enter the
values for the key fields. Do not perform a partial search
and pick from the list. If you must click a drop-down list,
search, or take any other action on a search page, do not
use Page Prompt mode, use explicit menu navigation.

Note: Page Prompt uses advanced search mode on search
pages. In certain cases, objects that are available in basic
search mode are not available in advanced search mode.
If you record in Page Prompt mode on a search page

that uses basic search mode, you may encounter ‘Object
not found’ errors. If that occurs, you can either delete

the extra steps or inactivate the Page.Prompt steps and
activate the navigation steps.

See Page.
*  Run Control Recognition

If you select the Run Control Recognition check box, the
Test Recorder will replace all recorded actions on a PsRun
Control (Process Scheduler page) with the Process.Run
Step.

Note: Similar to the Page Prompt with facet, this option is
only applicable to a conventional Process Scheduler page.

See Run
*  Message Recognition

Select the Message Recognition check box to
automatically configure message recognition for any
messages, such as error, warning, or information
messages, that the application generates during recording.
When the Test Recorder adds a new message it also sets
Use Message Recognition to True.

See Handling Application Messages.
» Ignore Login Steps

If you select the Ignore Login Steps check box, the Test
Recorder will ignore all actions on the login page.
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Field or Control Description

*  File Download Prompt

Select the File Download Prompt check box to prompt
for the file path when recording a step that does a file
download.

See Download
e Use Scroll Variables

If you select the Use Scroll Variables check box, when
recording activity in scrolls and grids, the Test Recorder
will replace the row number suffix $» by the selected
PTF variable. For example if the field is FIELDNAME
$0, and the scroll variable is &scrl, PTF will record
FIELDNAME&scrl.

See Scroll

*  Use Page Expand
If you select the Use Page Expand check box, when you
click an image to expand a page section or scroll area,
instead of recording the image click, PTF will record the

page.expand action.

See Page

Using the PTF Recorder with Chrome and Microsoft Edge

You can use the PTF Recorder with Chrome or Microsoft Edge browser to record the steps in a test.

When you record a test, PTF monitors each action you perform in the target application and creates a
corresponding step in the test. As you are recording, you can also add additional steps, such as Verify,
Log, and Conditional, that do not directly correspond to actions performed in the target application.

To launch Chrome-based or Microsoft Edge-based recorder, select the required browser in the Runtime
Options in the PTF client.

For details, see Options Tab
This section discusses:

* The PTF Recorder.

* Adding actions.

* Inserting action steps.

* Adding scroll variables.

e Configuring recorder settings.
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*  Modifying recorded steps.

PTF Recorder

PTF client launches the PTF Recorder as a browser application where you can open the PeopleSoft
application page and start recording.

To access the PTF Recorder, select Test, Open Test Recorder or click the Show Test Recorder icon (red
icon).

This example illustrates the tools and controls on the PTF Recorder. You can find definitions for the tools
and controls later on in this section.

O PTF Recorder * — I X
% A
http:/fexample.us.oracle.com:8000/psp/t59ptfenx/?cmd=login I
( Active ObjectType | Action Recognition | Parameter Value

PTE Recorder Launched

The recorder opens with a 'PTF Recorder Launched' message at the bottom of the window.
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You can control the recording actions with the tools available on the PTF Recorder.

This list describes the recording action tools.

Field or Control

Description

4

Configure the recorder settings.

See Configuring Recorder Settings

()

Launch a PeopleSoft application in Chrome or Microsoft Edge
browser window using the URL configured in the run option
and hook the browser instance to the recorder.

Start or resume recording. When you begin recording, the
recorder adds or inserts steps following the current step.

When you resume recording, after pausing, you are prompted
to choose from these options:

»  After the current step (do not delete the subsequent steps)
*  After the current step (delete subsequent steps)

* At the end of the test.

Note: These options appear only if the current selected step is
not the last recorded step.

If the selected step is the last recorded step, then the recorder
resumes without these options.

Pause recording.

Stop recording to create steps in the test for each recorded
action.

Re-Hooking an Existing Page

After recording few steps in a PIA page, you may want to record again from the point where you stopped
or you may want to navigate to a certain page and then record from that page.

When user stops recording, the recorded steps gets processed and is available in the PTF client, without

closing the PTF recorder and the PIA page.

You can record new steps by re-hooking the already opened PIA page, provided that the PIA page is still
active, or the base URL page depending on the option selected.

To re-hook to an existing PIA page, ensure that you do not manually close the PTF Recorder and the PIA

page.
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This example shows the option to re-hook an existing page

. PTF Recorder * — O X
% A

http://fexample.us.oracle.com:8000 .
P P Launch recording to base URL

Active ObjectType ieter Value
Re-Hook the existing page

On the PTF Recorder, click the Start web client icon, and select the Re-Hook the existing page option.

When you re-hook, the browser becomes active and you can start recording. The recorded step appends to
the unsaved test script.

Note: Re-hook works on the most recently opened or used PIA page instance by the PTF Recorder.

Adding Actions

You can add actions directly on the page elements on the PeopleSoft Application pages.
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You can select and add an action on a page element from the Add Action options.

Back Alt+Left Arrow
Forward Alt+Right w New Window Help
Reload
Nod
Save as... Ctrl+S X .
Enter B /e fields blank for a list of all values.
Print Ctrl+P
Cast...
F
[T
5] Create QR Code for this page
v
Se Translate to English
Searc ©  PTF Recorder > Add Action > ComboBox. ValueExists
Insert Step > Field Exists
View page source Ctrl+U
Olnc Use Scroll Variable Get Label
View frame source
Get Property
Reload frame
Get Style
Inspect
R HTMLCell Get Index
HTMLCell Get Value
Set Scroll Key
Set Scroll Definition
Find an Existing Value | Add a New Value Verify
/ Gi R
( O e PTFisrecording... )
\ J
e 4

To add actions:
1. Right-click on the page element.
2. Select PTF Recorder, Add Action, then select an action.

This list describes the action options:

Field or Control Description

ComboBox.ValueExists Adds a ComboBox.ValueExists step. You are prompted to
select the value, and the variable to store the return value, and
to select an expected value. Valid values are True, False, or
Ignore.

Field Exists Adds an Exists step. You are prompted to enter a variable
name or select an existing variable and to select an expected
value. Valid values are True, False, or Ignore.

See Exists.

Get Label Adds a GetLabel step. You are prompted for the return
variable that will contain the label.
See GetLabel

Get Property Adds a GetProperty step. You are prompted with a list of

properties for the selected page element. Enter a variable name
or select an existing variable name for one or more properties.
The recorder adds a GetProperty step for each property you
identify.

See Get_Property.
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Field or Control

Description

Get Style

Adds a GetStyle step. You are prompted with a list of style
definitions for the selected page element. Enter a variable
name or select an existing variable name for one or more style
definitions. The recorder adds a GetStyle step for each style
you identify.

HTMLCell Get Index

Returns the index value for an HTML table cell. You are
prompted for the return variable that will contain the HTML
index.

See CellGetIndex

HTMLCell Get Value

Returns the value for an HTML table cell. You are prompted
for the return variable that will contain the HTML cell value.

See CellGetValue

Set Scroll Key

Adds a Scroll.Key_Set step. Enter a Scroll ID in the Step
Modification area and click the Confirm icon.

See Incorporating Scroll Handling

Set Scroll Definition

The Step:Scroll Definition dialog box appears where you can
select the definition type and other details.

See Scroll.

Verify

Adds a Verify step. The step is automatically populated with
the object ID and value of the field.

See Verify.

Note: Chrome and Microsoft Edge-based PTF recorders allow recording of right-click, save as action on

a link.

For details on SaveTargetAs action, see SaveTargetAs

Inserting Action Steps

On the PIA page, you can insert test steps that provide logic constructs, manage scroll actions, and add

variables and logs.

To insert test steps:

1. Right-click on the PeopleSoft Application page.

2. Select PTF Recorder, Insert Step, then insert the required step.

This list describes the options for test steps:
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Field or Control

Description

Add Log

Adds a Log step.

You are prompted to select a Log action and enter text for the
Message and Details.

Add Variable

Adds a Variable.Set Value step. You are prompted for
Variable Name and Value. User-defined variables and PTF test
variables appear in the <Select Variable> drop down list.

See Variable, System Variables.

End-If

Adds a Conditional.End_If step.

If-Then

Adds a Conditional If Then construct. You are prompted for
an expression, such as &Exists=True. The Recorder inserts a
Conditional.If Then step. Record additional steps, then select
End-If'to add a Conditional.End_If step.

See Conditional.

Scroll Action

Adds a Scroll.Action step. You are prompted to enter a Scroll
ID, return variable, and action. Click the Confirm icon.

Scroll Reset

Select to delete all rows with the specified scroll ID

Adding Scroll Variables

118

You can add scroll variables on PeopleSoft application pages.

Use scroll variable in conjunction with action or steps that utilize variables.

To add:
1. Right-click on the PIA page.

2. Select PTF Test Recorder, Use Scroll Variable.

On the PIA page, the Use Scroll Variable pop-up page appears where you can select the scroll

variable.
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This example shows the Use Scroll Variable pop-up page.

Use Scroll Variable

Select Scroll Variable

Cancel

O e PTF isrecording...

Configuring Recorder Settings

To configure the recorder settings, click the recorder settings icon on the PTF Recorder.

This list describes the recorder settings:

Field or Control

Description

Use Page Prompt

If you select the Use Page Prompt check box, the Test
Recorder will replace menu navigation steps with a Page.
Prompt step and Page.PromptOK step. The Test Recorder
records menu navigation steps, but they are set to inactive.

Note: When recording a search page with facets, PTF does not
automatically insert Page.Prompt constructs because all user
actions with facets must be recorded.

When using Page Prompt mode, explicitly enter the values for
the key fields. Do not perform a partial search and pick from
the list. If you must click a drop-down list, search, or take any
other action on a search page, do not use Page Prompt mode,
use explicit menu navigation.

See Page.

File Download Prompt

Select the File Download Prompt check box to prompt for the
file path when recording a step that does a file download as
well as a file upload.

See Download
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Field or Control

Description

Message Recognition

Select the Message Recognition check box to automatically
configure message recognition for any messages, such as
error, warning, or information messages, that the application
generates during recording. When the Test Recorder adds a
new message it also sets Use Message Recognition to True.

See Handling Application Messages.

Use Scroll Variables

If you select the Use Scroll Variables check box, when
recording activity in scrolls and grids, the Test Recorder will
replace the row number suffix $n by the selected PTF variable.
For example if the field is FIELDNAMESO0, and the scroll
variable is &scrl, PTF will record FIELDNAME&scrl.

See Scroll

Run Control Recognition

If you select the Run Control Recognition check box, the Test
Recorder will replace all recorded actions on a PsRun Control
(Process Scheduler page) with the Process.Run Step.

Note: Similar to the Page Prompt with facet, this option is
only applicable to a conventional Process Scheduler page.

See Run

Use Page Expand If you select the Use Page Expand check box, when you click
an image to expand a page section or scroll area, instead of
recording the image click, PTF will record the page.expand
action.

See Page
Ignore Login Steps If you select the Ignore Login Steps check box, the Test

Recorder will ignore all actions on the login page.

You can modify steps recorded during the current session by pausing the session and editing the step in

the PTF Recorder.
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O PTF Recorder * - a
{it REC
hitp:// example.us.oracle.com
Active ObjectType Action Recognition Parameter Value
o Variable Seat_Value &vari 123
7 ComboBox Set_Value id=QE_WORK_ c
REC1_QE_MO
DELESS_OPEN
8 CheckBox Set_Value id=QE_WORK_ Y
REC1_QE_CF_
VALUE_YESNO
9 (| ComboBox Get_Property id=0E_WORK_ prop=classNam
REC1_QE_MO e;ret=8&var1;
DELESS_OPEN
10 ComboBox Gel_Froperty Id=0E_WORK_ prop=disabled,r
REC1_QE_MO et=8varz,
DELESS_OPEN
11 ComboBox Get_Property 1d=0E_WORK_ prop=id,ret=8va
REC1_QE_MO r3;
DELESS_OPEN
o Link Exists id=QE_WORK_  expected=true;r
REC1_QE_FUS  et=&var4,
H1_WCB
13 7 Scroil Action expected=false;  find
ret=8var3;
Edit Selected Step
Retumn Variables &vard =
Action find -
Expected false '
Scroll Id
Emor - Scroll ID must be a numeric value.
Recording Paused

When the recording is paused, the PTF Recorder becomes active where you can highlight a recorded step
and edit any of its values.

You can enable or disable the recorded steps by selecting or clearing the Active option.

The Edit Selected Step window appears when you highlight a recorded step to edit. The editable
parameters of the selected step are displayed in this window.

If you enter incorrect parameter value, an error message is displayed in red.

Get_Property, If Then and Scroll Action are examples of action steps that can be edited.
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Whenever you run a test, PTF creates a run log. The log is located in PTF Explorer under the test name, in

the log folder specified in Runtime Options.

After you run a test, PTF automatically displays the log in the Log Viewer.

You can also view a log by opening it from PTF Explorer.

This example shows the Log Viewer:

This example illustrates the fields and controls on the Log Viewer. You can find definitions for the fields

and controls later on this page.

=@ Page Prompt

@ Goto URL

PzPanelPrompt; Trying to do the following action = updste

Click  : #CADw Search [HTMLLink]

Text Set_Value [Mame=PSOPRDEFM_SRCH_OPRID] = GEDMO
L@ Click :#CSearch [PushButton]

M Text Set_value [Mame=DERIVED_CLONE_OPRID] = JGDMO

M Text Set_value [Mame=DERIVED_CLONE_OPRDEFNDESC] = Jim's ID

- Pwd 3et_value [Name=DERIVED_CLOME_OPERPSUD] = *#s

- Pwd 3et_value [Name=DERIVED_CLONE_OPERPSW DCONF] - tstses

™ Page.Save

PTools - Server:
PTaols - Platform :
2. Test Info
Parent Folder :
Test Name

Test Caze Mame :
3. Syztem Info
Maching Mame :
Screen resolultion :
Processor:

Operating System full name:

Operating Sytem version;

$\PE_DEMO
COPY_USER_PROFILE
DEFALLT

jgutenk.a-lap

1920 1200 pisels

Intel BBE. 947724

Microsoft \windows XP Professional
5.1.2600.796602

@ click : #CSave [PushBution] tdermary Total 3510 Mb
M=g: | iarning — Repk User Id definttion for JGDMO? Memory Available : 2067 Mb
8 Logscreenshot Erowser : Internet Explorer 7.05730.13
.| PageSave: ERROR 05 Lang Code: EMG
B 4. Environment Info
Test End: 772202011 11:19:29 PM
b Test User D BEDMO
Enw. URL: httpe: A/tdc 7961 dumc. deinet. peoplesoft com 44
B 5. Extra Info
4 | _>| PsT estFramevork Yersion : 8529011162 -
r— Detailz
Result: - heszage: IMsg. |'w aming -- Replace existing User |d definition for JGDMO? | | This User ID aleady exist:  Time: |23.1 9.28
Unhandled Error. Abarting. ObjM ame=PushButton Field: #ICS ave, Pagelame: USER_SAWEAS
Dretails:
Test Seq: IT Expr. Page -» Save -» Library: I

@ peoplesoft Test Framework 8.52-901-T162 =] 5]
@FE_Demo  Log Detal Tools  Window  Help
v OB = B @
FB_Dema * T Test COPY_USER_FROFILE Log $4PB_DEMOACORY U.. X
Flools - DE User -d

1

\ PE_Demo |

QEDMO

PEDEMO

The Log Viewer has three panes:

e The left pane displays the log details.

Typically, the log will contain one high-level entry for each step in the test.

* The right pane displays the execution options that were used for the test.

* The bottom pane displays details about the selected entry in the log.

Log Viewer Menus

The following menus appear when the Log Viewer has focus. Note that many menu commands are

specific to the currently selected item.

This table describes the Log menu commands:
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Log Menu Command

Usage

Find Find text within a log.

Expand All Expands all the selections in the log.

Collapse All Collapses all the selections in the log.

Change Log View Toggles between a view that shows log results as colored flags
and a view that shows log results as shaded labels.

Highlight Errors Highlights log entries with errors in yellow.

Copy Link to Clipboard

Copies a link to the log to the clipboard.

You can send this information to another user, who can use the
Window, Quick Open feature to open the log without having to
navigate to it in PTF Explorer.

Export

Exports a log to an XML file.

This table describes the Detail menu commands:

Detail Menu Command

Usage

Go to Test Step Accesses the test and selects the step that corresponds to the
selected log entry.
Open Link Opens the application URL in the browser or opens an external

file, such as a DataMover log.

Open Screenshot

Opens the screen shot that corresponds to the selected log
entry.

This table describes the Window menu commands:

Window Menu Command

Usage

Quick Open

Using information from the Copy Link to Clipboard
command, quickly opens a log without having to navigate to
the log in PTF Explorer.
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Window Menu Command

Usage

Close All

Closes all open windows.

Related Links

Reviewing Test Logs

Interpreting Logs
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Creating Tests

This section discusses how to create and manage tests.

Creating a New Folder

Each test, along with the related test cases and logs, is stored in a folder in the PTF Explorer tree
structure.

To create a new folder:

1. In PTF Explorer, highlight the folder in which you want to create the new folder or highlight Home to
create the folder at the root level.

2. Select Create, Folder.
3. Enter a new folder name.

4. Click OK.

Note: Folder names must not contain the following characters:
space & 7 /\*<>""

Creating a New Test
To create a new test:
1. Highlight a folder in PTF Explorer.
2. Select Create, Test.
The Test Editor launches with a new test.
3. (Optional) In the Test Descr field, enter a description for the test case.
4. (Optional) Click the Test Properties icon to enter a long description of the test case.

It is a good practice to provide a good description for a test, such as a description of the product,
feature, or business process being tested. Test names are limited in length and provide little
information.

5. (Optional) Click the Test Comment to add comments for the test.

6. Select Test, Save or click the Save button in the toolbar.
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7. Enter a name for the new test.

8.

Click OK.

Naming Tests

These rules apply to test names:

Test names and test case names are limited to 30 characters in length.

Test names and test case names can consist of letters, numbers, and underscores, but they must begin
with a letter.

PeopleSoft Test Framework (PTF) converts test names and test case names to uppercase.

Two tests in the same database instance must not have the same name, even if they reside in different
folders.

Because PTF data resides in the application database, conflicts may occur if PTF users or
administrators attempt to copy tests or test cases from one database to another database containing
tests or test cases with the same name.

Copying a Test

To copy a test:

1.

2.

3.

4.

5.

Highlight a test in the PTF Explorer.

Select Edit, Copy or press Ctrl + C to copy the test.

Highlight the folder where the copy of the test is to be located.
Select Edit, Paste or press Ctrl + V to paste the test.

Enter a name for the new test.

When you copy and paste a test the test cases are copied as well, but not the logs. When you cut and paste
a test the logs are moved also.

Renaming a Test

126

A PTF Administrator or Editor can rename a test, however the test name must be unique to the database
instance. A PTF User can only rename tests within the myFolder folder. Renaming a test or test case will
update the test or test case name in all tests that make a call to the renamed test or test case.

To rename a test:

1.

2.

Highlight a test in the PTF Explorer.
Right-click and select Rename or select Edit, Rename from the menu.
Enter the new name and click OK.

The test is renamed.
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Renaming a Folder

A PTF Administrator or Editor can rename a folder, however the folder name must be unique within that
level of the PTF Explorer tree. Before you can rename a folder, you must close all of the tests that are
associated with that folder.

To rename a folder:
1. In PTF Explorer, highlight the folder you want to rename.
2. Right-click and select Rename or select Test, Rename from the menu.

3. Enter the new folder name and click OK.

Note: Folder names must not contain the following characters:
space & 7 /\*<>""

Recording Tests

When you record a test, PTF monitors each action you perform in the target application and creates a
corresponding step in the test.

PTF Recorder populates these fields for each step:

*  Seq

- ID

* Active
*  Type

* Action

* Recognition
« Parameters

e Value
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This example illustrates the fields and controls associated with the test steps. You can find definitions for

the fields and controls later on this page.

seq 10 | Commert | Actwe | S Tipe Action Recogniion Parameters Value
»oa i © ~ Browser - | Start_Login
2 8 O ~ Browser - | FrameSet
3 »n O | ¢ Tet - | Set_Value v | Name=ussrd PTDOCBL
. n O | C Pwd + | Set_Value * | Name=pnd 1ENC25CDDODSES30562C4D10DECA7016ECB0S03EEC
5 a1 O |0 Buiton v | ik ~ | Name=submt
6 2 O r Link ~ | Click + |id=pthnavbca_PORTAL_ROOT_OBJECT
7 3B O r Link = | Glick ~ | Name=fid_PT_PEOPLETOOLSIndex=0
8 # O |0 Link - | Gioke - |id-ida_PT_SECURITY
£ B O | O Link: - | cigke ~ | dida_PT_PERMISSIONS_ROLES
10 » O | O Link - | Gk - [ ididra_PT_USER_PROFILES
1 @m O |0 Link - [ Ciek = [inerTest =User Proflesiindex=1
2 B O r Browser - | FrameSet ~ | TergetCortert
e} s O | F Page - | Promet - | MAINTAIN_SECURITY.USERMAINT GEL update
1 0| O 2 Page ~ | PromptOk
5 a O | ® Fage ~ | Prompt ~ | MAINTAIN_SECURITY.USERMAINT GEL update
. @2 O | ™ |2 Scrol = | Action - ret=dvariable ins
7 s O " Variable T | Set_Value v |4Test Test
18 2l O | ® Browser v | FrameSet -
13 3] O[O Prd - | Set_Value - | Name=pnd 1ENC1EED306F6AFCIATESGF 980DBE2BEBAIACECDCIER
20 4 O |0 Buiton - | Gioke - | Name -submt
2 5 O | ® Tet - | Set_Value - | Name -SEARCH_TEXTlindex-1
2 § © |0 Div - | Ciek - | Classname -pinavZoggleindex=72
2 72| © r Div | Clke ~ | Classname ptnav2oggleindex=78
2 8 O |0 Link - | ik - [inerTest=Pivat Grid Wizend
P 8| O r Browser - | FrameSet - | TergetCortert

Seq and ID are system-generated fields.

Recognition, Parameters, and Value are not used with some actions, such as Browser.Start or Page.Save.

The Comment field is populated by the test developer to document the test.

In the Comments dialog, apart from entering text, you can insert timestamp also.

See Using the Test Editor.

Test Action Tools

128

In addition to simply recording your interaction with the target application, the test recorder enables you

to add steps to perform the following functions:
»  Verify the value in a page control.

*  Check for the existence of a page element.
* Get a property of a page element.

* Populate a variable.

* Insert an entry in the run log.

* Insert a conditional construct.

* Reference scrolls.

* Reference HTML table cell contents.

* Add or modify step comments.

Related Links

Using the PTF Test Recorder with Internet Explorer
PTF Test Language
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Recording a Test

To record a test:

1.

2.

10.

I1.

Create a new test or open an existing test.

If you are recording within an existing test, highlight a test step. The system inserts the steps in the
new recording following the highlighted step. If you are recording a new test, recording typically
begins at Step 2. By default, Step 1 is Browser.Start, or Browser.Start Login, depending on your
configuration options.

With a test open, select Test, Open Test Recorder or click the Show Test Recorder button in the
toolbar.

The PTF Test Recorder toolbar appears.

See Using the PTF Test Recorder with Internet Explorer.

Note: To record a test, use the PTF Recorder with Chrome and Microsoft Edge browsers.
For instructions, see Using the PTF Recorder with Chrome and Microsoft Edge

Hook a browser, that is, associate a PeopleSoft application browser with the test.
To hook a browser, you can either:

*  Click the Start Web Client icon on the recorder toolbar. This starts the web browser with the
default test application URL from the current execution option.

* Select a browser window with the test application open and hook the application by dragging the
Select Browser icon to the browser window.

Note: PTF will only hook a browser that was initiated by PTF, either by using the Start Web
Client icon or by running a test.

Click the Start Recording icon in the Test Recorder toolbar to begin recording.
Perform the test steps in the PeopleSoft application.

As needed, insert additional steps using the Test Recorder test action tools.

Modify steps or add step comments using the Test Recorder step modification tools.

Click the Stop Recording icon in the Test Recorder toolbar to end the recording and write the steps to
the test.

Save the test.

Inspect Page Elements

While recording a test script, use the browser's inbuilt element inspector to inspect the page elements such
as types, IDs, properties, and styles.
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This example illustrates the fields and controls associated with the element Inspector.
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Related Links

Using the PTF Test Recorder with Internet Explorer

Using the PTF Recorder with Chrome and Mi

crosoft Edge

Defining PTF Configuration Options

Opening Tests

This section discusses how to open tests.

Opening Tests with PTF Explorer

130

You can open a single test or multiple tests with PTF Explorer.

Opening a Single Test

To open a single test with PTF Explorer:

1. Expand folders to navigate to the desired test.

2. Highlight the test.
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3. Use one of the following methods to open the test:
* Right-click and select Open.

* Select Test, Open from the PTF Explorer menu.

4. The test opens, and the test editor is the active window.

Opening Multiple Tests
To open multiple tests with PTF Explorer:
1. Expand the tree folders to view the desired tests.
2. Select each test that you want to open (use Ctrl+Click to multi-select).
3. Use one of the following methods to open all of the selected tests:
* Right-click and select Open.

* Select Test, Open from the PTF Explorer menu.

4. All of the tests open.

Opening Tests Assets with the Quick Open Dialog Box

Use the Quick Open dialog box to search for and open one or more test assets. To access the Quick Open
dialog box, select Window > Quick Open.

This image illustrates the fields and controls on the Quick Open dialog box.

Quick Open
Open Type: | OpenTest v| [ Only Expand Tree
TestMName: || |
| Open || Cancel |
Test Parent Folder
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The following fields and controls are available on the Quick Open dialog box.

Field or Control Description
Open Type Select the type of test asset to open. Options are:
*  Open Test
*  Open Case
*  Open Log
Only Expand Tree Select this check box to only expand the tree folder the asset is

associated with, not load the test asset.

Test Name Enter the test name.
Case Name This field is available only when Open Type is set to Open
Case.

Enter the test case name.

Log Folder This field is available only when Open Type is set to Open
Log.

Enter the name of the log folder.

Log Name This field is available only when Open Type is set to Open
Log.

Enter the name of the log.

Search Click to search for tests that contain the value entered in Test
Name. Partial matches are supported for Test Name when
using the Search button.

Matching tests appear in the grid. To open one or more tests in
the grid, select the check box adjacent to the test name, then
click Open.

Open Click to open the test asset.

An exact match is required if you do not use Search before you
click Open.

Working with Test Cases

Often, you will want to run the same test multiple times using different values in the Value column. Test
cases enable you to associate different sets of data with a test. You can view and edit both the test and test
case in a single unified window.
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Creating a New Test Case

To create a new test case:

7.

With a test open, click the New button to the right of the Test Case field.

Enter a name for the new test case.

(Optional) In the Test Case Descr field, enter a description for the test case.

(Optional) Click the Test Case Properties icon to enter a long description of the test case.

It is a good practice to provide a good description for a test case. Test case names are limited in length
and provide the user with little information.

(Optional) Click the Test Case Comment icon to add a comment for the test case or insert timestamp.

For details, see Test Window Fields

The new test case provides a set of new, empty Value fields for all the steps of the test.
Enter a new value for each step that requires a value.

Save the test case.

This example illustrates a new test case with blank values.

& Test: COPY_USER_PROFILE

— Test Information — Test Caze Information
Mame: |COPY_USER_PROFILE Mame: [3] [NEw_CASE R ERERE
Description: I D escription: I Q’

a'if, cut [y Copy gPaste | % Active All - | JH Insert Step - | 2 Delete Step @Step InfFormation

Seq ‘ ID | Comment | Active Slc[r)oll Type Action Recognition Walue

P 1 1 2 B rowser * | Start_Login -
2 2 - Link ~ | Click = | innerT ext=Sign in to PeopleSaft
3 3 - Text ~ | Set_Value - | Mame=uzend
4 4 r Pwd * | Set_Value = | Mame=pwd
5 5 I Buttan = | Click = | Name=5ubmit
E E I Link. = | Click = |id=fldra_PT_PEOPLETOOLS
7 7| © r Lirk: = | Click = |id=fldra_PT_SECURITY
8 8 o v Browser ~ | FrameSet = | TargetContent
9 9 )] - Link, ~ | Click = | Mame=defaultinnerT ext=Copy User Profiles
10 10 ] W Page = | Prompt = | MAINTAIN_SECURITY.USER_SAVEAS GBL
11 11 ] I~ Text = | Set_Yalue = |Name=P50PRDEFN_SRCH_OFRID
12 12 O | ¥ Page - | Promptk -
13 13 O v Test * |SetWalue = |Name=DERIVED_CLOME_OPRID
14 14 ] I~ Tent = | Set_Yalue = |Name=DERINED_CLOME_OPRDEFNDESC
15 15 o v Pd = | Set_Values = |MName=DERIVED_CLOME_OPERPSWD
16 16 ] I~ Pwd = | Set_Yalue = |Mame=DERIVED_CLOME_OPERPSWDCONF
17 1w O 72 Pags - | Gave -

* Vv b b
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Creating a Test Case With Values

For convenience, you may want to create a test case with the Value column populated with the values
from the original test or from another test case. Then, you can edit the values in the new test case.

Note: The test case associated with the original test is named DEFAULT. Every test has one test case
named DEFAULT.

You can select an existing test case from the Test Case drop-down list box.

PTF displays the number of test cases associated with the test, including the DEFAULT test case, next to
the Test Case field label.

To create a test case with values:

1. With a test case open, select Test, Test Case Save As.

2. Enter a name for the new test case.

3. (Optional) Enter a short description and a long description for the test case.
4. Highlight each value you want to change and enter a new value.

5. Save.

Managing Values when Pasting Test Steps

When you cut/copy and paste test steps, a dialog box appears providing options for how to manage test
case values. You can select one of the following options.

* Paste only the steps, leaving the test case values blank.
» Paste the current test case values from the source to the target.

* Paste the test case values only for matching test case names.

Exporting and Importing Test Cases

134

You can create or modify a large number of test cases by exporting test cases to a file, editing the file, and
then importing the file back into the test.

You can export a text file using the following delimiter characters:
*+  Comma

*  Semicolon

» Vertical pipe

e Tab
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Exporting Test Cases
To export test cases:
1. With a test open, select Test, Export.
2. Specify a location for the file.

3. Select a separator character.

Note: The default separator character is a comma, which is also the default separator used by
spreadsheet programs. If any of the values in your test case contain commas, the value will be split
into separate fields. If you have commas in your test case values, choose a different separator.

4. Specify whether to export one or all test cases.
5. Click Start.
The bar along the bottom of the dialog box denotes the progress of the export.

This example illustrates export using a tab delimiter for all test cases.

testeosebpot &

Filz Path |D:"utem|:u'\trn_n:aaes.n:sv |
Separator Char: | TABR -
Cases to Export ; Lo " Curent

Importing Test Cases
To import test cases.
1. In PTF, with a test open, select Test, Import.
2. Enter the file path or browse to the file.
3. Specify the separator character.

4. Click Open to display a list of test cases in the file.
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This example illustrates the fields and controls on the Test Case Import dialog box. You can find
definitions for the fields and controls later on this page.

Tesk Case Impork E |
File Path : |D:"utem|:u"utm_n:a$es.n:$v |
Separator Char: | TAE - Open
Select Cazes | Select Al | Unzelect All |

| Mame Action Mew Mame =l
CASE_O1 Replace | case_m
¥ | CasSE_DZ Replace = | case_oz
W | CasE_03 Import as new = || CASE_03
v |DEFAULT Replace j DEFALILT
W | CaSE_D4 Import as new = || CASE_D4
¥ |CASE 05 Import as new = || CASE 05 =
Start | |
Cloze

If the test case already exists in the test, the action is set to Replace. If the test case does not exist in
the test, the action is set to Import as new. If you change the action to Import as new for an existing
case, you must also enter a new test case name in New Name field.

5. Select the test cases to import.

6. Click Start.

Running Tests

This section describes how to run tests and test cases.

Running a Test
To run a test:
1. With a test open in PTF, select Test, Run.
Alternatively, you can press F5 or click the Run button.

2. If Yes is specified in the Prompt for Options field for the default runtime option, then the Runtime
Options dialog box appears.

Select an runtime option from the list and click Accept.
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PTF opens the PeopleSoft application specified in Runtime Options and runs the steps in the test.

3. After the test runs, PTF opens the test log in the Log Viewer.

Note: When PTF runs a test it disables Num Lock and Caps Lock on your keyboard and restores them
when the test completes. If the runtime terminates abnormally, the test does not complete, or hangs up,
and PTF does not restore Num Lock and Caps Lock. Select Test, End or click the End icon in the toolbar
to end the test and restore Num Lock and Caps Lock. Also, you should not press the Caps Lock or Num
Lock keys during test runtime; if you do, subsequent test steps may fail. Also, you should not press the
Caps Lock or Num Lock keys, during test runtime; if you do, subsequent test steps may fail.

Related Links

Reviewing Test Logs

Running a Test Case
To run a test case:
1. With a test open in PTF, select a test case from the Test Case drop-down list.
If you do not select a test case, the system uses the DEFAULT test case.
Alternatively, you can open a test case from PTF Explorer.
2. Select Test, Run.
3. Review the log in the Log Viewer.

Related Links

Reviewing Test Logs

Running a Test from a Specific Step

You can start runtime from a specific step using the Run from Step option in the Test menu.

Important! You are responsible for completing any required preceding steps when running a test using
the Run from Step command, such as Browser.Frameset, assigning variables, and hooking the browser,
for example.

To run a test from a specific step:
1. With a test open in PTF, select Test, Run from Step.
Alternatively, you can press F6.

2. Inthe Run from Step dialog box, enter or select the step sequence number from which to begin test
runtime, and click OK.

If the specified sequence number does not exist, test runtime begins at either the next highest
sequence number, or the last test step sequence, whichever is the lower value.
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If the specified sequence number is an inactive step, then test runtime begins with the next highest
sequence number.

3. After the test runs, PTF opens the test log in the Log Viewer.

The log file will include information about which step the test was started from.

Running a Test from the Command Line
You can run a test from the command line using the PsTestFW command.

Enter a text file argument which contains all the parameters in the command line. The text file is deleted
immediately after PTF client reads it. You can write the text file manually or it is generated from the
Change Assistant during runtime.

The parameters in the file must follow the below guidelines:
* Split the parameter and its value with =.

* Enter each parameter and its value in a new line.

* Enter each parameter and its value in a single line.

For example, your text file will include the following statements.

-CS=<server>:<port>

—-CUA=TRUE

-CO=<userID>

-CP=<password>

-TST=<TestNameFile>

-TC=DEFAULT

-ACTION=testrun /*testrun value is used for running test.*/
-PFX=

-RTO=<RuntimeOptions>

-LOG=<logfile name>.log

Syntax

Use the following syntax to run the test using a fext file argument.
''<Path>\PsTestFw.exe'' ''C:\temp\ptf cmd param.txt''

Use the following syntax to run a test using the existing environment connection:

PsTestFw -CD=ConnectionName -CP=ConnectionPassword -TST=TestName
-TC=TestCaseName [-TL=Line X (integer) ] [-PFX=Prefix] =RuntimeOption [-LOG=LogFileNa=

me] [-ACTION=testrun]
Use the following syntax to run a test using specified environment connection parameters:

PsTestFw -CS=Server -CNO=NodeName -PS=ProxyServer -PU=ProxyUser -PP=ProxyPassword

-CO=UserName -CP=ConnectionPassword -TST=TestName -TC=TestCaseName [-TL=Line X (int=
eger) ]
[-ACTION=testrun] [-PFX=Prefix] =RuntimeOption [-LOG=LogFileName]
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Field or Control

Description

—CD=

Specify the name of the environment login to use for
connection. This is the Database Name you would select in the
PeopleSoft Test Framework Signon dialog box when signing
on to PTF.

The environment login settings are stored in the environments.
xml file in the PTF data directory (C: \Documents

and Settings\<User>\Application Data
\PeopleSoft\PeopleSoft Test Framework by
default). If the environment connection data is not set in

the environments.xml file, then you can explicitly specify

the connection parameters. See the following table for a

description of connection parameters.

See Creating a Connection to a PTF Environment.

—CUA=

(Optional) Action on the SSL error. Values are:
*  True— Continue with unsecured connection.

*  False— Cancel the login.

—_CP=

Specify the user password.

—TST=

Specify the test name.

_TC=

Specify the test case name.

(Optional) Specify the line number from which to start the test.

—PFX=

(Optional) Specify the prefix.

See #PREFIX#

—RTO=

Specify the runtime option to be used in the runtime.

Note: The name of the runtime option must not contain the
following characters:
space & ?/\F¥F<>""

—ACTION=

(Optional) action type. For test runtime, the value is testrun.
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Field or Control

Description

-LOG= (Optional) Specify the name for the log. The default is
unattended.log.

-SOE= (Optional) Stops runtime if the test encounters an error.
See Using the Test Editor

-LBO= (Optional) Keeps the PTF-launched browser window open

after running a test, to assist with debugging.

See Using the Test Editor

If you do not use the —~CD= parameter to specify the connection data, use the parameters in the following

table:
Field or Control Description
—-CS= Specify the server:port to connect to. This is the Server:Port
value you would enter in the PeopleSoft Test Framework
Signon dialog box when signing on to PTF.
—CNO= Specify the node name.
—-CO= Specify the user name.
—PS= (Optional) Specify the ProxyServer:Port.
-PU= (Optional) Specify the proxy user. If you use network
authentication, use the DOMAIN\USER format.
—PP= (Optional) Specify the proxy password.
—ACTION= (Optional) action type. For test runtime, the value is festrun.
Example

The following example uses the -CD= parameter to set connection parameters:

PsTestFw -CD=QE851 -CP=password -TST=TEST CMD LINE -TC=DEFAULT -PFX=Prefix
=QE851 No Folder -LOG=my run_ log -ACTION=testrun /*The -ACTION parameter is optiona=

1*/
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The following example explicitly sets connection parameters:

PsTestFw -CS=rtdc79637vmc:8643 -CNO=PT LOCAL -PS=ProxyServer:2345
-PU=mydomain\username -PP=pwdl23 -CO=username -CP=password -TST=TEST CMD LINE
-TC=DEFAULT -PFX=Prefix =QE851 No Folder -LOG=my run log -ACTION=testrun /*The -ACT=

ION parameter is optional*/

Log File

The runtime will generate an output log file in the PTF data directory (C: \Documents and
Settings\<user>\Application Data\PeopleSoft\PeopleSoft Test Framework
by default).

If the log file exists it will be overwritten.

This is an example of a log file:

<runtime>
<Started>2014-06-18 04:41:46</Started>
<Param>
<Database>L921PDVL</Database>
<TestName>DR DUMMY SHELL</TestName>
<TestCase>DEFAULT</TestCase>
<ExecOpt>L921PDVL</ExecOpt>
</Param>
<Status>Failed</Status>
<Test>
<Execl>
<Name>DR_DUMMY LOOP</Name>
<Case>DEFAULT</Case>
<LogLinel5>case is not DEFAULT2</LogLinel5>
<LogLinel6>Runtime stopped by Runtime.Stop On Error: 6/18/2014 4:41:54 PM</Lo=>

gLinel6>

<Status>Failed</Status>

</Execl>

<Exec2>
<Name>DR_DUMMY_LOOP</Name>
<Case>DEFAULT2</Case>
<Status>Passed</Status>

</Exec2>

<Exec3>
<Name>DR DUMMY LOOP</Name>
<Case>DEFAULT3</Case>
<LogLine44>case is not DEFAULT2</LogLine44>
<LogLine45>Runtime stopped by Runtime.Stop On Error: 6/18/2014 4:41:55 PM</Lo=

gLine45>
<Status>Failed</Status>
</Exec3>
<LogFolder>TEST</LogFolder>
<LogName>4. PS 2014-06-18 16:41</LogName>
<Message>Runtime stopped by Runtime.Stop On Error: 6/18/2014 4:41:55 PM</Messag=

e>
</Test>
</runtime>

Return Code Option For PTF Command Line Runtime

PTF returns an integer value representing the relative success of the runtime, when called from the
command line. The integer value is captured by the calling program.
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Sample syntax for capturing PTF's integer return value (into a variable in a sample batch file called
iRetCode) might be coded as follows:

start /w /MIN PsTestFw -CS=<Environment server port> -CNO=<optional Environment Nod=
e ID> -CO=<Environment User ID> -CP=<Environment User Password> -TST=<ShellTest Nam=
e> -TC=<Test Case Name> =<Runtime options> -LOG=C:\Temp\LOGl.xml set iRetCode=%erro=

rlevel% echo %iRetCode%

Return values are:

Field or Control Description

-1 Failed

-2 Not Completed-FatalError
0 Passed

-3 Starting

-10 Else

Executing a Test on Windows Remote Desktop

If you are running the PeopleSoft Test Framework on a remote host using Windows Remote Desktop
(MSTSC), the Internet Explorer opens on the remote host. To avoid failure of a test on the Internet
Explorer, consider the following:

*  Keep the MSTSC open or maximized and be always connected to the remote host.

* Avoid locking the remote host.

*  Avoid moving the mouse cursor on the remote host.

However, if you need to minimize the MSTSC, then configure your local machine as follows:
1. Close all the open MSTSC windows on your local machine.

2. Run regedit.exe to open the Windows Registry Editor.

3. Open the following location:

* If you are changing settings for the current user, open HKEY CURRENT_ USER\Software
\Microsoft\Terminal Server Client.

* Ifyou are changing settings for all users then open HKEY LOCAL MACHINE\Software
\Microsoft\Terminal Server Client.
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If you are using an x64 machine, in addition to the above path, open HKEY LOCAL MACHINE
\SOFTWARE\Wow6432Node\Microsoft\Terminal Server Client.

Note: Please backup all corresponding entries before applying the new configurations.

4. Create new DWORD value with the following data:
* Name: RemoteDesktop SuppressWhenMinimized
*  Type: REG_ DWORD

¢ Data: 2

5. Close the Registry Editor.

Warning! Using Registry Editor incorrectly can cause issues that may require you to reinstall Windows.
Use the Registry Editor at your own risk.

Related Links
Running Tests

Reviewing Test Logs

Whenever you run a test, PTF creates a run log entry. The log is located in PTF Explorer under the test
name, in the log folder specified in Execution Options.

After you run a test, PTF automatically displays the log in the Log Viewer.

You can also view a log by opening it from PTF Explorer.
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This example illustrates log entries in the Logs folder of PTF Explorer.

E PeopleSoft Test Framework 8.52-80311-B3

@PE_DEMO  Test  Edit  Create  Tools
O-= X |[¢=

FE_DEMO

Window

Help

* T Test COPY_USER_FROFILE

Log: $4PE_DEMONCOPY_LSER...

= Home
@I myFolder
&) AVARGHESE
{1 JGUTENKA

=-_7] PB_DEMD

=+ PBOOKS
W B OEDMO 2011-06-08 09:48

; “o [ 1. DEDMO 2011-06-07 19:41
------ + TestCases
#- PB_HTML_TABLE
=-F PB_SCROLLS
=-_1 PB_EXAMPLES

=T LDG_ACTIONS
+-5 PB_COMDITIONALS
PB_STEPS
=T RESERVED_WORDS

To open a log from PTF Explorer, do one of the following:

* Highlight a log entry and select Test, Open.
*  Double-click a log entry.

» Right-click a log entry and select Open.
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This example illustrates log entries in a test log. You can find icon definitions later on this page.

@ Goto URL

----- © PzPanelPrompt: Trying ta do the following action = update

1D Click : #1CadvSearch [HTMLLink]

M Text Set_Walue [Marme=PSOPROEFN_SRCH_OPRID] == QEDMO
1B Click :#ICSearch [PushBution]

= Page.Save

Frame set 1o "

Ighiore step 2

Ignare step 3

Ignore step 4

Ignare step 5

Ignore step G

Ighore step 7

Frame =et to 'Target Cortert’
Igrore step 9

Page . Prompt

Text Set_Walue [Mame=DERIVED _CLOME_OPRID] = JGDMO
Text Set_Walue [Mame=DERIVED_CLONE_OPRDEFNDESC] == Jim's 1D
P Set_Value [Name=DERIVED_CLONE_OPERP S D] = ##ass

Pusdd Set_value [Name=DERIWVED_CLONE_OPERPSUDCORNF] o #sess

B cClick : #1CSave [PushButton]
1™ mzg: | Warning — Replace existing User Id definition for JGDMO? | | This User 1D alrea

n ============= PEQESE'U'E! ERRI:IR ========
Test End: 65372011 9:50:15 Abkd

Typically, the Log Viewer includes one high-level entry for each step in the test. Entries for complex steps
appear in collapsible sections that can be expanded to view the additional details.

An icon or shaded label appears next to each log entry, indicating the success state of the associated step:

Field or Control Description

OI‘

Information message only.

Info

L,

Information message only.

Info

Fa : Step was successful.
o
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Field or Control

Description

|.|-'I ‘or Wyarning

Step was successful, but with a warning.

|

Step failed.

(LM script Fail

The test encountered a condition that it was not configured
to handle, or the test encountered an error while PTF was
configured to stop on all errors.

Note: Highlight a log entry and select Detail, Go to Test Step or right-click and select Go to Test Step to

open the test with the corresponding step selected.

Related Links
Interpreting Logs

Exporting Test Logs to XML

146

PTF provides the ability to export test logs to XML. Once the logs have been exported to XML, you can
compare the results in a text editor, such as Notepad or EditPlus, or view them in most web browsers. You
can export all fields, or limit the export to specific fields.

To export a test log to XML:

1. In PTF Explorer, open the logs folder.
2. Right-click on a specific log.

3. Select Export.

The Export Log dialog box is displayed:
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This example illustrates the fields and controls on the Export Log Dialog Box. You can find definitions

for the fields and controls later on this page.

Export Log: PB_RUN_PROCESS: 6

EBX

File Path - |

Select Elements to export:

[ Preview:

] E=part Images

= [¥]Log

laglD

lgCaption

cazeMame

lagFalder

lagPrefix

logLineCount

machineM ame

soriptFinalResult

testN ame

uzerlD

[=)- [] executionDptions
databazeMame
databasePlatform
databaseServer
databazelser
dateFaimat
executiond ptionM ame
peopleT oolsPath
[] processServer hd
|

I E xpart H Cancel ]

On the Export Log dialog, the user can see the structure(schema) of the Log XML, include/exclude
elements to export and set the order of the elements, also the user is able to preview the exported result.

By default, all the timestamp (lastUpdate element in the schema tree) fields are excluded, as well as extra
information such as ExecutionOptions, LogParentLinelD, and so forth.

Field or Control

Description

File Path

Enter the file path. The file name is automatically generated
based on the test name and log number. For example PB. RUN
_PROCESS-LOG-6.xml.

Select Elements to Export Column

By default all items are selected, click the check box to
deselect specific items.

Preview

Select this check box to preview the xml.

Export Images

Select this check box to include images in the exported file.

You can also set an option to automatically generate XML log files every time that tests are run. For more
information, see Configuring Execution Options in PTF Client.
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Organizing Tests In PTF Explorer

This section discusses how to use PTF Explorer to organize tests.

Cutting and Pasting Multiple Tests or Folders

PTF Administrators and PTF Editors can cut and paste tests and folders. A user with only the PTF User
role is not able to cut folders that reside outside of the myFolder folder.

To cut and paste (move) multiple tests or folders:

1. Inthe PTF Explorer, select multiple tests and folders to move to a new location on PTF explorer tree.
2. Right-click and select Cut, or select Edit, Cut from the menu.

3. Select the desired target folder location on PTF explorer tree.

4. Right-click and select Paste, or select Edit, Paste from the menu.

All contents are moved to the target folder location.

Deleting Multiple Tests or Folders

PTF Administrators and PTF Editors can delete tests and folders. A user with only the PTF User role is
not able to delete folders that reside outside of the myFolder folder.

To delete multiple tests or folders:

1. Inthe PTF Explorer, select multiple tests and folders to delete.

2. Right-click and select Delete, or select Edit, Delete from the menu.
3. Click OK to confirm the delete.

The folders or tests are deleted.

Expanding or Collapsing Tests and Folders
To expand or collapse multiple tests or folders:
1. Inthe PTF Explorer, select multiple tests and folders to expand or collapse.
2. Right-click and select Expand Selection or Collapse Selection,

PTF expands or collapses all selected tests and folders at the level of selection in the tree.
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Mapping PSQuery to a Test

You can run an existing test using real-time data. The test will use query results to populate test data. The
query results can have real-time data or modified data. You do not have to create a test case each time data
changes. Use the Datal.oader step type to include the modified query results in your tests.

Important! By default, one Datal.oader step type is associated with one query. If you require more than
one query for the test, insert respective DatalL.oader types.

Configuring the DatalLoader

Configure the fields on DatalLoader tab on the Execution Options dialog box in PTF client. See
Datal.oader Tab

Authorizing to Use the DatalLoader

Verify the user included in the Options tab of the Execution Options dialog box has access to the
PTPT2200 permission list.

You can assign the QAS Admin role to the user which includes PTPT2200 permission list.

Related Links

“Understanding Permission Lists” (Security Administration)
“Understanding Roles” (Security Administration)

Editing the DataLoader Step Type
The Dataloader maps a query and the query fields to variables in the test. See Datal oader.

Click the edit button in the Recognition field of the step to open the Edit Datal.oader dialog box.
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The example illustrates the fields and controls on the Edit DatalL.oader dialog box with Query
Parameters and Select Query Fields sections. You can find definitions for the fields and controls later on

this page.

Edit DatalLoader

Dataloader Mame ISDurce 1

Dataloader Tope II]uer_l,l j

— Select Querny

QueryMame  [MESSAGES_FOR_MSGSET |

Mate: Queries in abowe drop-down list are from serwver in current Execution Options

[uer Parameters

tezzage Set Mumber I&message
Load Fields |
— Select Query Fields
Axailable Fields: Ilsed Fields:
MESSAGE_SET_MER MESSAGE_MER
MSG_SEVERITY
MESSAGE_TEXT
L4 |
O, |

Field or Control Description
Datal.oader Name Enter an unique name that associates the test with the query.
DataLoader Type Currently it displays Query and is disabled for change.
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Field or Control

Description

Query Name

Select the required query from the drop-down list.

Note: Queries displayed are according to the Query Security
settings associated with your User ID in current Runtime
Options.

Query Parameters

Enter the parameter values. The section appears if the selected
query has associated parameters.

Load Fields Click the button to select the query fields from the list of
available fields.
Select Query Fields Displays the fields used in the query. Select and shift required

query fields under Available Fields to Used Fields.

When you click the OK button on the Edit DataL.oader dialog box, the variable mapping grid appears
where you can edit variable names.

The example illustrates the fields and controls on the variable mapping grid for the Datal.oader instance.

Source 1

Guery Hame Cuery Params

MESSAGES_.. MESSAGE_SET_MBR:&message

Delete Query | Edit Gluery k.
1D | Source Fields Yariables
ﬁ [rowcount]
R MESSAGE_MER MESSAGE_NER
2 MSGE_SEVERITY EMSG_SEVERITY
3 MESSAGE_TEXT EMESSAGE_TEXT
.

You can edit the variable name on the grid for the source fields.

Click the Edit Query button to open the Edit Datal.oader dialog box to edit the query.

Note: The first row in the variable mapping grid is reserved for the rowcount variable which populates the
total rows in the query result. The rowcount is used for a loop definition. Variable name of the (rowcount)
field is blank by default. If you want to use the rowcount variable then you must provide a variable name.
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Using the Loop Step Type

You can bind the Loop step type to the Datal.oader. To bind the Loop and Datal.oader, add the
variables which are defined in the DataLoader into related steps inside the Loop. PTF binds them
automatically.

The total query result rows is assigned to the rowcount parameter which is used for the Loop step type.

Consider the following when you use the Loop step type with the DataLoader step type:

If rowcount related variable is used to control Loop, all the steps which are in the Loop step type and
use the variables defined in the Dataloader is run multiple times till the loop count is equal to the
number of returned rows of the query.

If there are duplicate rows in a query result, PTF considers them as different rows and runs twice.

Example

This example illustrates using the Loop step type with the DatalLoader step type.

Type Action Recognition Parameters Value

Dataloader |Load name=S6 source=HMAP EMPL

PHOTO;ownType=public;source Type=NMQ;

rowcount=&rowcount;

Loop For &ldx =1 to

&rowcount

Related Links
Loop

Limitations of DatalLoader Step Type
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DataLoader is not supported in a Shell Test.

One Datal.oader step type is associated with only one PSQuery, and only standard queries are
supported

Data with hierarchy can not be recognized in current DataL.oader.
DataLoader doesn’t support changing login user during runtime.
Datal.oader and Loop must be defined in the same test.

Bind a Loop step type with a DataL.oader step type. The Loop uses variables defined in the
DataLoader. Variables from different DataLoader step types cannot be used within the same loop.
Assign the value of a variable from a different Datal.oader step type to a new variable associated
with the Loop.
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» Ifadate field is used as a prompt, the FieldValue must be entered as YYYY-MM-DD in the QASrun
request.

* The query parameter name in Datal.oader Editor is limited to 20 characters, if the length of parameter
name is larger than 20, it will be truncated and suspension points will be added at the end.

Using the Message Tool

Copyright

As you modify a test, you will often need to use the Message tool to capture details about a browser
object. You can then use these details to modify a test step.

You can use the Message tool to display and collect information about fields in the application. The
Message tool also monitors test run. The Message tool displays types, actions, IDs, and values for each
step of a PTF test as the test runs.

Note: The Message tool works only with Internet Explorer.

Select Tools > Message to open the Message tool.

Click and drag the Object Properties icon and hover over a browser object to view details about that
object in the Message window.

This example illustrates Message tool ID values.

Hame: DERIVED_PSWD_OPERPSWD MENU
ObjType: Pwd ,!b’?

To copy and paste recognition information from the application browser to the PTF Test Editor, drag
and drop the Object Properties icon onto a browser object. Object recognition details appear in the
Message tool. Double-click the name in the Message tool to copy it to the clipboard. You can then paste
the information into the Recognition field of a test step. To automatically copy each selection to the
clipboard, select MENU > Auto Copy to Clipboard.

You can also use the Message tool to monitor test run. The Message tool displays types, actions, IDs, and
values for each step of a PeopleSoft Test Framework (PTF) test as the test executes.

The Message tool includes the following items:
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Field or Control

Description

MENU

Click to access the Message tool menu. Menu items include:
*  Clear: Select to clear the message display content area.

*  Auto Copy to Clipboard: Select to automatically copy
object recognition details to the clipboard. This is a toggle
that you can turn on or off. When this option is turned on,
a check appears next to the menu item to indicate that it is
enabled.

*  Auto Collapse: Select to have the message window
automatically collapse when not active. This is a toggle
that you can turn on or off. When this option is turned on,
a check appears next to the menu item to indicate that it is
enabled.

*  Show HTML Browser: Select to open the Object
Properties dialog, where you can view the properties of
browser objects as you hover over them with the Object
Properties icon.

*  Save Windows Settings: Saves message tool window
settings, including size and position, to the C:\Documents
and Settings\<userID>\AppData\Roaming\PeopleSoft
\PeopleSoft Test Framework\PsTstMsgConfig.xml file.

*  Close: Closes the Message tool menu.

»  Exit: Closes the Message tool.

Obj ect Properties Icon

Click then drag and hover over a browser object to view
details about that object in the message area.

Message Area

The message area is the yellow rectangular section of the
Message tool, which displays the following object recognition
information:

*  When you use the Object Properties icon to hover over a
browser object, it displays details for that browser object.

*  During test run, it displays information about each step of
a PTF test as the test runs.

Moving and Resizing the Message Tool Window

Use the following options to move and adjust the width of the Message tool:

* To move the Message tool, select MENU, then drag and drop the window to a new location.

* To change the width of the Message tool, position the pointer over the left border of the Message tool
window until the cursor changes to a double arrow, then click and drag to adjust the width.

To save the Message tool window’s location and width, select MENU > Save Windows Settings.
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Viewing Browser Object Properties

To view additional properties about a browser object, access the Message tool and select MENU >
Show HTML Browser.

This example illustrates the HTML Browser Object Properties window.

Object Properties

Property Value

Frame TargetContent

Object Type Label

htrlFor PSPTTSTCONFIG_PTTST_INVALID_SSL

id PSPTTSTCONFIG_PTTST_INVALID_SSL_LBL
innerText Allow Untrusted SS1L

clazssName PSCHECKBOX

Title

tagName LABEL

sourceindex 163

The Object Properties window displays properties and values of HTML objects as you hover over them
using the Object Properties icon. Double-click a row in the Object Proprieties window to copy the text to
the clipboard.

Capturing Index for Non-unique Objects using the HTML Browser

For certain objects that do not have enough of a unique identifier property, you can use the HTML
Browser to capture the index during recording. An example of this would be leaves on a tree structure. To
capture the index:

1. In PTF Client, select Tools > Message to open the Message tool.

2. Start your recording.

3. Open the tree to the desired location.

4. Click the Object Properties icon in the Message Toolbar and drag it to the leaf image on the tree.
5. Access the Message tool and select Menu > HTML Browser > Show.

6. Right-click on the nameProp in the Object Properties window and select Get Index for.

7. The index will be added to the object Properties.
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This example illustrates the Object properties Dialog Box displaying the properties for a leaf on a tree. To
get the index, you will select Get Index For...

Tree Name ALL_TIME_TC All Time Tree for OLAP TG

Close Display Options Print Format

ALLTIMEROLLUP =Detail

Collapse All | Expand All Find FirstPage 4 130f13 . LastPage
Object Properties E

E ALLTIMEROLLUP - Propetty Walue

O [04A01/2000 - 09/34/2000] alt Select Leaf

- 02/01/2000 - 02/29/2000) clazshlame treettem

- [03101/2000 - 0H31/2000] Frame TargetContent

icd
Mame

2 (0470172000 - 0430/2000]
o 8 [0&/01/2000 - 05/31/2000]

; natmeFrop _LEAF _1.aif

7 [0BI0112000 - 0B/30/2000] Obiect Type Image Copy ta Clipboard
- 0710172000 - 07i3172000] sourceindes: 276 Get Ind= For,.
S 08/0152000 - 08i31/2000] srC it dirtde Ta 25 domemt Ls oracle comics

" 2 (0910142000 - 09/30/2000] taghame M

" 2 [10/01/2000 - 10/31/2000] Title Select Leaf
"2 (1110142000 - 11/30/2000]
S @@ 1200142000 - 12/3172000]

Using Step Information

The Step Information, which is PeopleTools meta data, is used to identify the impact on existing test steps
and to generate maintenance report.

You can access the Step Information dialog box from the Step Information icon available on the test
window toolbar. See, Test Window Toolbar.

The Step Information dialog box:

e Identifies individual commands impacted during application development.

» Displays PeopleTools meta data information such as the menu, page, record, and field.

» Updates step information using the data from the environment on which the tests are run.

The example illustrates the Step Information dialog box.

Step Information -
PeopleT oolz Infarmation
Men |PTPG_WIZ_MENU | PageFieldName |PSPGCORE_PTPG_PGRIDTITLE |
Comparent |PTPG_WIZ_COMP | Market [GBL | Record |PSPGCORE |
Page |PTPG_WIZ_INFO | Fiedd |PTPG_PGRIDTITLE |
0K | | Cancel |
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PeopleSoft Test Framework will update incorrect step information according to the data in the
environment on which the tests are run. Select the Overwrite Existing Step Info check box in the
Runtime Options—Advanced tab to enable the feature.

Step information is updated only for successful steps.
Note the following details regarding step information:
* For test cases created manually, the step information for each step is left blank.

The step information is displayed in the dialog box if the step run is successful, and remains empty if
the run fails.

* For test cases created using PTF Test Recorder, the step information for each step is populated during
recording.

The step information gets updated if the step run is successful, and the original step information is
retained if the run fails.

* In case of a nested test, a single step in the parent step, the step information is similar to any other
stand-alone test cases.

The step information of a nested test is updated and saved even if there is a failed step in the parent
test.

Related Links
Configuring Execution Options in PTF Client

Configuring Execution Options in PeopleSoft Internet Architecture

Using Reserved Words

This section discusses how to use reserved words.
Reserved words enable you to access data available from the PTF program when a test is run.

Reserved words are useful when data is not known before the test is run. For example, suppose you have
the following manual test instruction:

12. Enter the current date into the Voucher Creation Date field.

If, when you record the step, you enter the current date, then you will put specific, or static, data into the
test, similar to the following example, which shows the data created by a test recorded on June 30, 2010:

This example illustrates a test step with static data for the date.

[7ee ~ [ set_value = Name=PA_PROP_VOUCH_CREAT_DT [ [o6/30/2010 |

However, the test instruction calls for the current date, which may be different each time you run the test.
Data that can change is called dynamic data. To make the test data in PTF dynamic, replace the recorded
data with the reserved word, #TODAY, which represents the date at the moment of test run, as shown in
this example:
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This example illustrates a test step using the #TODAY reserved word.

| Ted - [ Set_Value - [Name=PA_FROP_VOUCH_CREAT_DT | [soDAY

Other reserved words enable you to define specific actions in the Value field of a step.

For example, suppose you are required to test two very similar test scenarios:

1. Create a new pension calculation using the following parameters.

2. Open the pension calculation created earlier and verify that the parameters
entered into the application are the same as those specified in the
previous scenario.

You can meet this requirement by using a single test step with two test cases. The first test case might be
named CREATE and the second named VERIFY.

In the CREATE test case, a step that sets the Calculation Description field might look like this:

This example illustrates a step that sets a value.

| Ted - [ set_value - [PA_caLCULATION DESCR | | Sample pension caic |

The VERIFY test case uses the reserved word #CHECK# in the Value field. Using the same step, the
#CHECK# reserved word causes the Set Value action to behave like a Verify action, which satisfies the
second test scenario. Rather than setting the value of the object, the same step now verifies it, as shown in
this example:

This example illustrates a step that verifies a value.

[ = ] [Te « [ Set_Value - [PA CALCULATION DESCR ] HCHECK:Sample pension calc |

Related Links
Reserved Words

Using Variables
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This section discusses how to use variables.

Variables enable you to store a value in one step and access that data in a subsequent step. Variables are
useful when your test requires a value that will not be known until the test is run.

Variables are always prefixed by an ampersand (&) — when you set their value and when they represent a
value.

Store a value for a variable either by placing the ret=&varname parameter in the Parameters field in a
step that supports return values, or by using a Variable.Set Value step.

You can refer to the values stored in a variable in two ways:

»  Use the variable in the Recognition field of a Conditional. If Then step or in the Parameter field for
any step that takes a parameter.

» Use the variable in the Value field of any step that sets or verifies the value of an object on the page.
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Important! Variables are not automatically initialized. If the variable is not assigned a value in either the
recognition or value column, the value will be the variable name. For example, if the variable &varl was
never initialized, it will return &varl.

For example, suppose you have the following test instructions for a test of the Maintain Proposal
component:

1. From the Maintain Proposal page, make a note of the new proposal ID.
2. Click on the version ID link and verify that the same proposal ID appears
on the Resource Estimate page.

The application generates a proposal ID when the test is run, so it is not known ahead of time.

The following example shows one way to automate these steps using a variable. The first step gets the
value of the Proposal ID field from the application and stores it to the &propID variable. The second step
clicks the version ID link, which brings up the Resource Estimate page. The third step verifies the value
of the Proposal ID field on the Resource Estimate page against the value saved in the &propID variable:

This example illustrates using a variable to verify the value of a property on a page.

Text ~ | Get_Property - |ID<GM_PROP_ID prop=Value et=4PropID
Link - | Click - |innerText=v101
Span ~ | Verfy - |ID-GM_PROF_ID &FroplD

The length of PTF fields (Value, Recognition, Parameters) is limited to 254 characters. To construct a
variable string that is longer than 254 characters, you will need to wrap the string into multiple variables
and concatenate them for usage in verification or set value steps.

This example illustrates the steps to create smaller variables and then concatenate the string for use in a
LongText. Verify step.

Variable - | Set_value = |avarl First 254 characler string
Variable - | Set_Value - |avar2 The remaining characters string
Varizble - | Set_vaiue - |avard concat(avarlidvar2)
LongText - | Verfy - |Name=PSU_INSTR_EXP_DESCRLONG 8vard

For additional examples of variable usage, see the “Test Language Reference” chapter, especially the
Conditional.If Then and Variable.Set Value steps.

Wrapping Variables in Quotes

Variable assignments, comparisons, and functions may use special characters (such as the equals sign,
parentheses, and so forth) to manage text string operations. Quotes are necessary in these situations to
help PTF distinguish strings that contain these characters from the actual operators themselves.

Quotes are only necessary in the following situations:
* Around text being assigned to a variable in the Recognition field.
* Around text being provided as a parameter of a function (in either the Parameters or Value field).

* Around text being used in a Conditional step in the Recognition field.

Assigning Variables in the Recognition Field

Use the following guidelines when assigning variables in the Recognition field:
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» Use quotes around all text strings.

(1333

* Use double quotes (“*“) to return one quotes character. When a final text string result is expected to
include leading and trailing quotes characters, the parameters supplied should be lead and trailed by
three quotes characters, for example: ”’Hello™””.

Note: PTF will return an error (unrecognized or illegal variable format) if the user fails to wrap a text
string being assigned to a variable in quotes.

This table displays examples of setting the variable &My Var in the Recognition field and the expected
result:

Recognition Expect Result

&My Var=&PriorVar Contents of the &PriorVar variable
&MyVar="&PriorVar” &PriorVar

&MyVar="Hello” Hello

&My Var=""““Hello™* “Hello”

&MyVar=Hello error message

Assigning Variables in the Value field

It is a good practice to assign variable values in the Value field (rather than the Recognition field) for the
following reasons:

» It simplifies variable assignments.

» It reinforces habits that allow the user to take fuller advantage of dynamic PTF functionality such as
Test Case data and reserved words (which are only recognized in the Value field).

Use the following guidelines when assigning variables in the Value field:

* Quotes are not necessary to identify a text string in the Value field for the purpose of a variable
assignment step.

*  The CONCAT() function should be used to return a text string containing special characters such as
ampersands or pound symbols that could be interpreted as a variable or reserved word.

* Double quotes are generally not needed, because text entered into the Value field is interpreted
literally.

This table displays examples of setting the variable &My Var in the value field and the expected result:
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Recognition Value Expected Result
&My Var &PriorVar Contents of &PriorVar variable
&My Var CONCAT(“&PriorVar”) &PriorVar
&My Var Hello Hello
&MyVar “Hello” “Hello”
&MyVar ““Hello™* ““Hello”*

Copyright

Displaying Variables in Message Logs

You can log variables instead of variable values as a message in a test run log.

To log a variable, prefix an additional ampersand (&) to the variable in the Recognition field of the

selected test step.

Similarly, you can prefix an ampersand to variable string in the Value field so that the variable is
displayed in the details section of the message log.

For example, set “&d&adsname” is my dataset in the Recognition and Value field. When the test run log is
generated, the variable string “&adsname” is my dataset is logged as a message.

This example illustrates how an additional ampersand (&) can be prefixed to variables in test steps to
print the variable string in message logs.

Log v | Message ~ | "4adsname” is my datasst

Type Action Recogrition

Value

detail- "&3adsname” is my dataset

This table shows examples of setting a variable (&adsname) in the Recognition field and the expected

result in the message log:

Recognition

Expected Result

&adsname is my dataset

PIVOTGRID_DEFINITION is my dataset

&&adsname is my dataset

&adsname is my dataset

“&&adsname” is my dataset

“&adsname” is my dataset

“‘&&adsname™” is my dataset

““&adsname

is my dataset

“““&&adsname’”” is my dataset

““&adsname

is my dataset
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Related Links

Log
Parameters
Variable

Conditional

Using Text Strings as Parameters in Functions
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The following rules apply when text strings are used as parameters in functions:

Text strings supplied as parameters for a function must always be wrapped in quotes, regardless of
whether they appear in the Recognition field or the Value field.

The CONCAT() function should be used to return a text string containing special characters such as
ampersands that could be interpreted as a variable reference.

cece

Double quotes (“““) should be used to return one quotes character. Consequently, when a final text
string result is expected to include leading and trailing quotes characters, the parameter supplied
should be lead and trailed by three quotes characters, for example, ”””’Hello™”.

To include a line break within a text string, use <NL>. For example:
prompt=Newline Message Prompt!!<NL>Linel<NL>Line2<NL>Line3
Creates the following text string:

Newline Message Prompt!! Linel Line2 Line3

Newline Message Prompt!!

Linel
Line2
Line3

Note: PTF will return an error (unrecognized / illegal variable format) if the user fails to wrap a text string
being supplied as a parameter for a function in quotes.

This table shows examples of the text string used in the recognition field assuming the variable&My Var is
set to “Hello” (&MyVar="Hello”) and the expected results:

Recognition

Expected Result

CONCAT("&MyVar = "

&My Var = Hello

| &My Var)

SUBSTR("Hello" |1|5) Hello
SUBSTR("""Hello """| 1| 7) "Hello"
INSTR("Hello" | "e" ) 2
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Recognition Expected Result
INSTR(IHHYHeIIONVHI| lle!l ) 3
INSTR(HIHIHellOH"" ‘ |||lel|") 0

INSTR(Hello | e)

PTF returns error message

Using Persistent Variables

If you need to store variables between tests, use persistent variables. PTF stores persistent variables to the

database so that subsequent test run can use them.

Persistent variables are stored in the database keyed by runtime option name. Persistent variables can also

be keyed by User ID, machine name, or both.

There are two key elements required to use persistent variables:

1. Set the variable action in the test.

2. Set persistent variable options.

Setting Variable Option in the Test

To set the variable option in the test, use the Test Property icon.

1. Create a new test or open an existing test.

2. Click on the Test Properties icon.

Field or Control

Description

b}

The test properties icon is located in the Test information
group box.

3. Set the Variable Action field.

* None (default). The test will not use persistent variables. All variables set in the test are only

global to the current test run.

* Read. The test can only read persistent variables from existing persistent variables in the PTF test

database.

e Write.

The test can only write persistent variables to the PTF test database.
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* Read & Write. The test can read and write persistent variables from and to the PTF test database.

Setting Persistent Variable Options

The persistent variable options are available on the Advanced Options page in Runtime Options. You can
set the Advanced Options in the PTF client or PIA.

See Configuring Execution Options in PTF Client or Defining Advanced Options

Managing Persistent Variables
Use the Manage Persistent Variables page (PSPTTSTPERVAR) to modify or delete persistent variables.
Navigation:
PeopleTools > Lifecycle Tools > Test Framework > PTF Persistent Variables

This example illustrates the fields and controls on the Manage Persistent Variables page.

Manage Persistent Variables

Personaiize | Find | View A1 | 88 First Bl 12 0r2 I L ast
Name User ID Machine Name Hame Value
T1B35301 PTFTRM A&RCOLE ADS Designer
o
D T1B35301 FTFTRM EUSERID PTINT

This page will list all the persistent variables stored in the database. The variable is stored when the test
writes the variable to the database.

The variable is always stored with the name of the runtime option. The User ID and Machine Name are
dependent on the selection you made for the persistent variable on the Advanced Options page of the
Runtime Options.

You can delete persistent variables or modify the variable value.

Example of a Test that uses Persistent Variables

This example shows a test where the variable action was set to Read & Write in the Test Properties. The
variable &userid exists in the persistent variable table.

This example illustrates reading a persistent variable (&userid) and writing a persistent variable (&role).

Browser - | Start_Login A

Page - | Prompt *  MAINTAIN_SECURITY. USERMAINT.GEL update
Log - | Meszage * | Step below will read persistent vanable from persistent vanable table

Text - | Set_Walue * | Mame=PSOPRDEFM_SRCH_OFRID Fizerid
Page = | PromptQk ¢

Page | Go_ To ~ | Roles

Log - | Message v | Step below will write persistent variable to perzsistent wariable table

Test - | Get_Property = | Mame=PSROLEUSER_ W\ _ROLENAME$0 ret=krole:prop=\ alue
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Using Conditional Logic

This section discusses how to use conditional logic.

Some test scenarios call for conditional logic—special handling based on information gathered from the
application during the test. Conditional logic uses a Conditional.If Then step with a Conditional.End_If
step. The If Then step evaluates a statement. If the expression evaluates to True, the system executes
the lines between the If Then step and the End_If step or the Else step, if it exists. If the expression
evaluates to False, the system jumps to the Else step, if it exists, or to the End_If step if there is no Else,
and continues the run.

What appears to be simple test instruction, such as the following, may require conditional logic to
automate successfully:

12. In the Modify a Person page, click the Brazil flag if necessary to expand the
Brazil region of the page.

When you record the click on the Brazil flag, PTF creates the following step, which looks deceptively
simple:

This example illustrates an image field that requires conditional logic. The conditional logic is described
later on this page.

| image - [ ik - [Name=DERIVED_IC_GEL BRASmg | | |

The problem is that pages like the Modify a Person page typically use the same image to collapse and
expand a section. The page may remember which regions are expanded and which are collapsed, so that
the next time you run the test, the Brazil section might be expanded when you enter the page, in which
case the Image.Click action in the previous example would collapse the Brazil section and potentially
cause the test to fail.

The solution is to click the flag image only if the section is collapsed, which requires putting the click
action within a conditional If-Then construct.

For example, suppose that you use the Message tool to determine that when the region is already
collapsed, the alt property of the flag image is equal to “Expand section Brazil.” Alternatively, when the
region is already expanded, the alt property of the same image is equal to “Collapse section Brazil.” You
would construct your test such that the click would only occur if the alt property is equal to “Expand
section Brazil.” You could do that with the following steps:

This example illustrates the steps necessary for the conditional logic.

Image - | Get_Property - | Name=DERIVED_IC_GEL_BRASimg prop=alt ret=&flagstate
Condtional - | f_Then - | fiagstate="Expand section Brazi”
Image - | Click - | Name=DERIVED_IC_GBL_BRASima

Condional - | End_¥

Note: The same rules apply for text strings used in the recognition field as described in the Using Text
Strings as Parameters in Functions section.
See Using Text Strings as Parameters in Functions

Related Links

Conditional
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Handling Application Messages

This section discusses how to handle application messages.

Use the Message Recognition feature to specify how PTF will respond to messages, such as warning
messages or error messages, issued by the application being tested.

For example, suppose you have the following manual test instructions:

12. Clear the Calculate all Plans checkbox. If you get the following
warning, click OK:
Warning - Remember all plans must be selected to ensure an accurate 415
limit calculation (48,17)

When you record the test, the step that triggers the message and the step that clicks OK might look like
this:

This example illustrates a step that triggers the message and the step to dismiss a warning.

| cnecksa ~ [ set_value + [ Name=PA_CALCULATION_CALC_ALL_PLANS cds [ [n |
| Buston - [aidk - [ Name=s1c0K | | |

However, some test cases belonging to this test might not deselect the Calculate all Plans check box in the
first step. In these cases, the first step would not trigger the warning message and PTF would fail to find
the OK button in the second step.

You could use conditional logic to evaluate whether the test case deselects the check box. Alternatively,
you could use the Error Handling feature to indicate that PTF should click OK whenever that specific
message appears in the application.

To create a message definition, access the Message Recognition dialog box.
1. With a test open, click the Message Recognition icon.
2. Enter the text of the message, or a portion of the text, in the Message field.
The following example uses the message catalog number rather than the full message text.

You can define message definitions at either the test or test case level. Message definitions defined at
the test case level take precedence over message definitions defined at the test level.

3. Select which button the step should click.
4. Specify what action PTF should take after the button is clicked.
5. To delete a message, select the message line and press the Delete key.

This example shows the Message Recognition dialog box. In this example when the application message
(1040,3) error occurs, PTF will click the Cancel button and abort the test execution.

Note: Test case message definitions take precedence over test message definitions.
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This example illustrates the fields and controls on the Message Recognition dialog box. You can find

definitions for the fields and controls later on this page.

Developing and Debugging Tests

WV Use Mezzage Recognition

Test Mezzage Definitions

Message Recognition E I

hMezzage

Test Caze Meszage Definitionz

| Button

Action

Continue

Continue

hMezzage

| Button

Action

Cancel

Abort

] 4

Continue

o |

Cancel

This table lists the names and definitions of the elements on the Message Recognition dialog box:

Field or Control

Description

Message

Enter the message, or portion of the message, displayed by
the error. For example, you might use the Message Catalog

numbers.

Note: In Fluid pages, message recognition using message
numbering is not available. You can use a portion of the short

message text to recognize message boxes.
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Field or Control Description
Button Enter the button that PTF should click when it encounters the
message.

Valid values are:

+ OK
s Abort
*  Retry
*  Ignore
e Yes
* No
*  Cancel
Action Select the action that PTF will take.

Valid actions are:
*  Continue: Log an Info message and continue processing.

*  Abort: Log a Fail message and stop test execution.

Interpreting Logs

This section discusses how to interpret logs.

This table lists and describes common log messages:

Status Message Description
Fail Access is denied. Check browser PTF is not able to read information from
settings. your browser.

Check browser settings to make sure
your browser is configured properly.

See Configuring Browser Settings.
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Status

Message

Description

Fail

Object not found in the page, or access is
denied to the Frame.

If all of your steps that involve setting
values, verifying values, or getting
properties return a failure with this
message in the log, then it is likely PTF
is having trouble interacting with your
browser in general.

Check browser settings to make sure
your browser is configured properly.

See Configuring Browser Settings.

If this log message appears sporadically
throughout your log, it could mean that
objects within your application have
been removed or renamed.

*  Check the application or the screen
shots in the log associated with the
failed step to see if the object still
appears on the page.

»  If'the object appears where expected
on the page, use the Message tool
to compare the names and IDs of
the objects on the page with those
in the Recognition field of the step.
use the browser's in-built element
inspector.

See Recording Tests

See Using the Message Tool.

* If object names or IDs have changed
since you recorded your tests,
consult with your PTF administrator
about the possible need to run
maintenance on your tests.

See Interpreting Test Maintenance
Reports

Fail

The test was updated by another user,
and it is not possible to save it.

The error is reported when user saves a
test while the same test is already saved
by another user. This happens when
multiple users operate the same test.

For example, two users open a test and
make some changes. One of the users
saves it. Once saved, when the other user
saves it, the error displays. In this case,
previous changes made by this user are
lost. He has to reopen the test and edit it
again.
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Incorporating Scroll Handling
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This section discusses how to incorporate scroll handling in PTF tests.
Data on a PeopleSoft component is organized hierarchically using rowsets, or scrolls, and rows.

A scroll can be implemented as a scroll area or a grid. In scroll areas, the fields appear on the page in a
free form manner. In grids, fields appear as columns similar to those on a spreadsheet. Individual rows of
data within a scroll or grid are uniquely identified by a set of one or more fields, or keys.

PTF references a field on a scroll by the field name and the row number. The PTF scroll handling feature
enables a test to identify a row number at test run time based on the keys for that row.

For example, suppose you have a test requirement that says:

12. Verify that the QEDMO user profile has the PTF Administrator role.
Here is an example of the Roles page for the QEDMO user profile:

This example illustrates the fields and controls on the Example of the User Profile - Roles page.

User ID: QEDMO
Descripion:  QE User
Dynamic Role Rule User Roles customize | Find | View Al [ B0 8 First B0 410 0r 12 B 1 ast
a [RoleMame ~ [Descripon | Dynamic | |ViewDefinition | |
Execute on
Server PTF Administrator C, PTF Administrator = Route Control  View Definition El
Test Rule(s) | Refresh | PeopleSoft User ), PeopleSoft User |l Route Control ~ View Definition =]
Execute Rule(s) | Portal Administrator | G4 Portal Administrator I RouteControl View Definition (=
) Portal Manager 1 Portal Manager = Route Control  View Definition E|
Process Monitor
Service Monitor QE Role C, QERole T  Route Control  View Definition =l
XMLP_ADMIN a )F(;"O':;P LTI e T  Route Control  View Definition =
XMLP_ANALYZER_EXCQ, N Excel Analyzer I RouteControl View Definition =
XMLP_ANALYZER_ONI G S Online Analizer [T RouteControl View Definition =
XMLP_DEVELOPER  C XMLP Developer Role = Route Control  Yiew Definition =
XMLP_SCHEDULER C XMLP Scheduler Role = Route Control  View Definition El

When you record the test, PTF generates a step similar to the following example:

This example illustrates the test step to verify a field on a scroll area. You can find additional information
on this step later on this page.

STS’" Type Action Recognition Value

Text j Verify j Name=PSROLEUSER _VW_ROLEMAMESD PTF Administrator

The step uses two elements in the Name= parameter in the Recognition column to reference the Role
Name field: the name of the field (PSROLEUSER VW _ROLENAME) and its row position index ($0).
A row position index is composed of a dollar sign ($) and an integer. The integer count starts at zero, so
indexes for a scroll containing 11 rows are $0 through $10.
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This test will work as recorded until something changes the grid position of the row that contains PTF
Administrator. For instance, if another row is inserted before PTF Administrator, the PTF Administrator
row position index changes to $1, and the test fails. The same problem occurs if the grid is sorted
differently, or if a test case tests a different user profile, such as QEMGR.

Using a Dynamic Position Index

You can use the Scroll.Key Set action and a Scroll.Action step to locate a row by key and generate a
dynamic position index variable. Then you can use the dynamic position index variable to reference a row
or a field reliably and repeatedly because the variable is regenerated each time the test is run.

For example, instead of looking at the first row, PTF looks for the row where the key equals “PTF
Administrator”.

If the value exists in the scroll, the test finds it, takes the specified action, and returns the position index.

If it does not find the value in the first displayed set of rows, PTF clicks the Show Next Rows icon on
the scroll and continues searching until it has found the key value or searched all rows on all pages of the
scroll.

Follow these steps to use a dynamic position index variable:
1. Create Key Set steps.

2. Create an Action step.

3. Use the index variable for other steps.

4. Specify the Scroll ID.

Note: You can accomplish all of the steps in this section during recording using features of the PTF
Recorder Tool Bar. The manual process is provided to illustrate how information is shared between the
different scroll-handling step types and how it can be manipulated manually after recording, if necessary.
See Using the PTF Test Recorder with Internet Explorer.

Creating Key_Set Steps

Create one Key Set step for each field in the scroll key. If the key consists of three fields, create three
Key Set steps and specify key values for each of the three fields.

You can insert Scroll steps during recording or you can add them afterward. The following process
explains how to insert and modify key steps manually. Even if you record Scroll steps, you may need to
modify them using some of these concepts.

Key_Set requires two parameters in the Recognition column; Type= and Name=. You can get these
values by recording a step with the PTF recorder and then manually modifying the recorded step or by
copying the information from the application using the Message tool and pasting into a step.

Specify the field value in the Value column. You can use the PTF Recorder or Message tool to get the
field value as well.

This example illustrates the Message tool with recognition data for the Role Name field.

Hame: PSROLEUSER_VW_ROLENAMESO MEMU
ObjType: Text; Value: PTF Adminizstrator rIl-r;;l?
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Here is an example of a test step that references a row on a scroll. This step checks for the existence of
PTF Administrator in the Role Name field:

This example illustrates a test step that references a row on a scroll.

STS’" Type Action Recognition Value

Text ]| vesty = || Mame=PSROLEUSER v\ _ROLENAMESD PTF Administrator

This is one way to convert the step in the example to a Scroll.Key Set step:

1. Change the Type to Scroll.

2. Change the Action to Key Set.

3. Add Type=Text, to the Parameter column.

4. Leave the Name parameter in the Recognition column, but remove the row position index ($0).
This signals PTF that the actual row number for the key is not yet known.

This example illustrates a Scroll.Key Set step that sets the key to PTF Administrator.

o Gipe Action Fosmrier Tz Value

1 Scroll = | Key_Set ~ |Name=PSROLEUSER_VW_ROLENAME type=Text PTF Administsrator

This step defines the key value, but PTF does not take an explicit action on the page based on the key
until it runs an Action step.

Creating an Action Step

Create an Action step, based on what action you want to take on the row, such as update, insert, select,
and so on. All of the available actions are detailed in the PTF Language Reference.

In this example, you want to select a row, so enter se/ in the Value field.

The Action step attempts to locate a row defined by Key Set. If a row is found, it returns the index of the
row. Use the ret= parameter of the Action step to populate an index variable with the row index value.

This example illustrates an action step.

5%°” Type Action Recognition Parameters Value

1 Scroll - | Action < ret=45croll1

Using the Index Variable

Now that you have the row position stored in the index variable, you can use that value to reference other
fields on that row.

For instance, suppose you want to verify the Dynamic check box. You can use the PTF Recorder or the
Message tool to get its name and position and create a step similar this one:

This example illustrates a step with a positional reference.

CheckBox ™ | Verify = | Name=PSROLEUSER_VW_DYNAMIC_SWS0 N
| | \ | I
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This step has the problem that the positional reference is static, so it won’t work if the position changes.
To fix that, replace the position index with the index variable.

This example shows a step that uses an index variable following the steps that locate the key and set the
index variable:

This example illustrates a step using an index variable.

5%"” Type Action Recoarition Parameters Value

]

Scroll

- | Key_set

~ |Name=PSROLEUSER_VW_ROLENAME

type=Text

PTF Administsrator

1

Scrol

ret=8Scroll1

sel

CheckBox

= | Very

~ |Name=PSROLEUSER_WW_DYNAMIC_SW&Scroll1

N

Now whenever the test is run, the index variable is updated dynamically by the Key Set and Action steps
and the positional reference is accurate.

Specifying the Scroll ID

Assign a Scroll ID to group Scroll actions for each scroll. Use a different scroll ID and scroll variable for
each different scroll area. You can assign any integer you like, as long as it is unique.

Scroll ID is a required field for Scroll actions.

If you are taking multiple actions in the same scroll, using the same scroll ID and scroll variable improves
performance over using a new scroll ID.

In this example, the test defines two Action steps that both act on the same scroll. The first action verifies
that the user profile does not contain the PTF Administrator role. The second action verifies that the user
profile does contain the PTF User role. You would assign the same Scroll ID number to all four of the
Scroll steps because they all act on the same scroll.

This example illustrates assigning scroll IDs to scroll steps.

Scroll

D

Type

Recogntion

Parameters

Value

Fage

= | Roles

Scroll

= |Name=PSROLEUSER_VW_ROLENAME

type=Text

PTF Administsrator

Scroll

ret=45croll1

nat

Log

Scroll T indes var

riable = &5croll

Seroll

= |Name=PSROLEUSER_VW_ROLENAME

type=Text

PTF User

Scroll

ret=45croll 1

sel

Related Links
Scroll

Calling Tests

This section provides an overview of calling tests and discusses how to use library and shell tests.
e Use library tests.

* Use shell tests.

» Use parameters with library tests.

¢ Share test assets.

Copyright © 1988, 2023, Oracle and/or its affiliates. 173



Developing and Debugging Tests Chapter 5

Understanding Calling Tests

If a test uses a sequence of steps repeatedly, you may want to isolate the repetitive sequence of steps and
move them to another, smaller test. Doing so enables you to call the steps repeatedly and also make them
available to other tests that use the same sequence of steps.

Moving shared test steps to a distinct test (a called, or child, test) provides these benefits:

* Reduces the amount of recording or development you need to do.

* Reduces the amount of debugging you need to do.

* Reduces the effects of development changes that require manual updates to existing tests.

You can use the Test.Exec action to call any other test, but you may be able to manage and identify the
relationships between calling and called tests more easily on the PTF Explorer tree if you use library tests
and shell tests.

Using Library Tests
A library test cannot be executed by itself. It must be called by another test.
To make a test a library test, select the Library Test check box in the Test Editor.
Complete these steps to create a library test from an existing test:

1. Open an existing test.

2. Identify repetitive steps within the test, copy them from the existing test, and paste them into a new
test.

3. Select the Library Test check box on the new test.
4. Save the library test.

5. Remove the repetitive steps from the original test and replace them with a step that uses a Test.Exec
action to call the new test.

6. Save the original test.

Using Parameters with Library Tests
Parameters enable you to pass dynamic values from a calling test to a library test.
To use parameters:
1. Define the parameters in the library test.
2. Assign values to the parameters in the calling test.
3. Use the parameters as you would text strings in the library test.
To define parameters in a library test:

1. Select the Library Test check box in the Test Properties dialog box.
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2. Enter the names of parameters in the Parameter List.

Parameter names can be up to 254 characters, and can contain only letters, numbers, and underscores.

3. Click OK to dismiss the dialog box.

The following example shows a parameter list:

This example illustrates the fields and controls on the Test Properties dialog box with a parameter list.

Test Properties

2]

— Test Properties

Last Updated : |7/1/2011 5:46:33 PM Updated By : |

Language [ : I English j

[] Language: Changing the walue anly affects the language the test selects at sign in. b will not enable the test o
execute against a different language. PTF testz should be erecuted againzt the zame language in which they
were recorded.

V Libram Test

— Parameter lizt

1 | Usetame

Pazzward

Ordertbr

(]S Cancel

In the calling test, place parameter assignments in Test.Exec steps in the Parameters field, separated by

semicolons, with no spaces. You can place multiple parameter assignments, separated by semicolons. The

last semicolon is optional.

Note: The semicolons must not be followed by spaces.

The following example shows a Test.Exec step that calls a library test and passes three parameters.

This example illustrates a Test.Exec step with parameters.

Type Action Recogrition Parameters Value

Test - | Exec - |PB_PARMS_LIB UserName=QEDMO; Password=QEDMO:OrderNbr=1001 DEFAULT

In the library test, place a %param.parameter name% construct wherever you want to use a parameter.

The parameter is replaced at runtime by the text assigned in the calling test.
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This example illustrates library test steps with parameters.

Type Action Recognition Parameters Value

Text - | Set_Value ~ | Name=userid “iparam UserName®

Pud - | set_Value ~ | Name-password %parem Password%

Variable ~ | Set_Value ~ | &0rderNbr="param OrderNbr’

Note: Parameters in library tests need to be assigned a value in the calling test, because variables are not
automatically initialized. The parameters without a variable initialized use default PeopleSoft values on
the page.

If the user makes a call to the library without passing a value for the parameter, the parameter value will
be the parameter name. For example, if the parameter is UserName and the value is not set, the value
would be $param.UserName$%, not blank.

Using Shell Tests

To create a shell test, while in PTF Explorer select Create > Shell Test.

A shell test is a type of test that is meant to be used primarily to call other tests. For this reason, a shell
test only supports these actions:

*  Runtime actions - modify the behavior of tests during execution. Execution actions include
Skip PageSave, Skip RunRequest, Skip Login, StopOnError, and Set_Options.

* Test.Exec - calling other tests. Test.Exec enables you to call multiple test cases with a test and, using
the #Ignore reserved word, skip the test call for certain test cases.

* DataMover.Exec - calling data mover scripts.
e Query.Exec - running queries.

* Log.Message and Log.Screenshot.

* Variable.Set_Value - manipulating variables.

Organizing component tests into shells enables you to identify large business-process oriented type
tests (that is, the type that cross multiple components and online activities). The steps available in shell
tests are intentionally limited in order to represent high-level business process flows through called test
routines.

PTF variables are global, so you can set a variable in the shell test and use it in the called tests, or you can
set a variable in a test and use it in the shell test or other called tests.

Sharing Test Assets

176

Often, test developers, application developers, testers, and others collaborate to develop tests. PTF
enables you to send links to tests, test cases, and logs to other users, saving them from having to navigate
through PTF Explorer to locate them.

To share the location of a test asset:
1. Copy the link to the clipboard.

* In PTF Explorer, highlight the name of a test asset and select Edit > Copy Link to Clipboard.
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* Inthe Log Viewer, with a log open, select Log > Copy Link to Clipboard.

2. Paste the link text into a message or document to send to another user.
3. The recipient copies the text and selects Window > Quick Open.
The Quick Open feature is available in PTF Explorer, Test Editor, and Log Viewer.
The system automatically copies the link for the asset to the Quick Open dialog box.
4. The recipient clicks OK to open the asset.

You can also use Copy Link to Clipboard with the Quick Open feature to locate a folder in PTF Explorer.
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Managing PTF Logs
This section describes how to use PeopleSoft test Framework (PTF) Log Manager to manage test logs.

Understanding Log Manager

Over time, as you run tests, you will create a number of test logs. Because they reside in your application
database, test logs, especially those containing many screen shots, can affect the storage demands on your
database. PTF Log Manager enables you to minimize this demand and remove clutter from PTF Explorer.

To help you decide which logs to remove from your database, Log Manager lists log entries from the test
environment based on the criteria you specify. If all the fields are empty, then Log Manger lists all the
logs in an environment that were created within the specified date range. The default date range is the
current date.

To access the Log Manager, select Tools > Log Manager.

Note: Only an administrator (a user ID with the PTF Administrator role) is able to open Log Manager.

Copyright © 1988, 2023, Oracle and/or its affiliates. 179



Administering PTF

Chapter 6

This example illustrates the fields and controls on the PTF Log Manager page. You can find definitions

for the fields and controls later on this page.

PeopleSoft Test Framework - Log Manager [_ (O] x| I
Retrieve Delete Undelete | Purge | Close
r— Folder / Test
Folder Path |$\F'TF Course |
Test | TRN_D3_INSTRUCTOR |
— Criteria Extra Options
Log Folder | x| Mo Logs to Keep by Folder I VI I Bypass Selaction
ime | 10:00
[ ByDate Range  From: | 1172012 vl Ter | 5;1—_l1 N I Use Start Time |
(l By Log Status I~ FatalEirar. I Fail - W arming | Fass ™| Mone

Selection | Tizes |

Unselect Al |

Clear | Hefleshl | Selected

5 Processed 1} Error 1] |
Test Path | Log Falder | Log D | Log Status | Log Mame | Last Update | Llzer |
$\PTF Course\TRMN_03_INSTRUCTOR CATHY 5 Pasz 5 PTFTRM 20120511 11:21 51142012 12:21:47 PM PTFTRN
$\PTF Course\TRMN_03_INSTRUCTOR CATHY 4 Fail 4. PTFTRMN 2012-0511 11:17 51142012 12:18:48 PM PTFTRN
$\PTF Course\TRMN_03_INSTRUCTOR CATHY 3 Pasz 3. PTFTRMN 2012-05-09 18:25 5/9/2012 5:26:27 PM PTFTRN
$\PTF Course\TRMN_03_INSTRUCTOR CATHY 2 Fail 2 PTFTRMN 2012-05-09 18:24 5/9/2012 5:24:56 PM PTFTRN
$\PTF Course\TRMN_03_INSTRUCTOR CATHY 1 Fail 1. PTFTRN 2012-05-09 18:18 5/9/2012 5:23:39 PM PTFTRN

Completed getting database list

Using Log Manager Toolbar

The log manager toolbar has the following options:

Field or Control

Description

Retrieve

criteria.

Select to populate the selection pane based on the specified

Note: The user can cancel the retrieval process at any time by
pressing the Abort button, and thus getting a partial result.

Delete

Select to delete the selected logs.

Undelete

Select to cancel logs marked for deletion. When you click
Delete, the selected logs are only marked for deletion. They
are not removed from the database until you click Purge Log.
Until then, you can undelete logs.

Purge

Select to remove selected logs from the database if they are
marked for deletion.
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Field or Control

Description

Close

Select to close log manager.

Using Log Manager Fields

Log Manager has these fields:

Folder / Test

Field or Control

Description

Folder Path

Browse to a folder in PTF Explorer. If a folder is specified,

the system retrieves only the logs in that folder, including sub-
folders. If no folder is specified, the system retrieves all logs in
the environment.

Test

The system retrieves the logs associated with the selected
test. The drop-down list is restricted to the tests in the folder
specified in Folder Path. If no test is selected then all logs
associated with all the tests in the folder path is displayed.

Criteria

Field or Control

Description

Log Folder

Select a log folder. Log folders associated with the selected
test are available in the list.

No. Logs to Keep by Folder (number of logs to keep by
folder)

Select the number of logs to include in the folder. For instance,
if the folder contains six logs and you specify three, then the
three newest logs will be retained (that is, they will not be
included in the list as candidates for deletion) and the three
oldest logs will be retrieved. Select zero to retrieve all logs.

By Date Range

The system retrieves only logs created within the date range.

By Log Status

When you select this check box, the statuses are available.
Select the status(es) to list and click the Refresh button in the

Selection pane. The results are updated in the Selection pane.
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Extra Options

Field or Control Description

Bypass Selection Select to perform the selected action on all log entries listed
according to the criteria, regardless of user selections.

Use Start Time Select and enter a value to start the process at the designated
time.

Using the Selection Pane

The selection pane displays the logs based on the selection criteria. By default all the logs are selected.

When you click Retrieve, the system populates this pane with logs based on the criteria you specified.
Using the check boxes, select the logs that will be processed when you click Delete, Undelete, or Purge.

The selection pane contains a status bar that displays the number of logs selected, processed and errors,
and the following buttons:

Field or Control Description

Unselect All Click to deselect all logs.

Clear Click to clear the selection list.

Refresh Click to refresh the selection after changing the criteria.
Note: The refresh is based on the new criteria only. If you
change the folder path or test, you must use do a new retrieve.

All of the columns in the selection section are resizable.

Example Purge

When you select logs in the selection pane and then select Purge from the toolbar, the selection pane
status is updated and the focus is set on the log lines being processed.
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This example illustrates PTF Log Manager after Purge.

Administering PTF

PeopleSoft Test Framework - Log Manager
Retrieve Delete Undelete | Purge | Close

— Folder / Test

M= B3

Folder Path |$\F‘TF Course

|

et | TRN_D3_INSTRUCTOR |
— Criteria Extra Options

Lag Falder I

j Mo, Logs to Keep by Falder I vl

I Bypass Selection

[T Use Start Time I'ID:DD

- By Diate Range  From: I 4112012 VI Ta: I BA12012 'l
v By Log Status [~ FatalEmor [ Fail r Wiarning vV Pass " Nene
Selection | Trace |
Clear | | Refresh I | Selected 2 Processed Error 0 |
Test Fath | Log Folder | Log ID | Log Statug | Log Mame | Last Update
@ $\PTF Cowrse\TRN_03 INSTRUCTOR CATHY E Pass 5 PTFTRN 2012-05-11 11:21 BA1/20121221:47 F
@ $\PTF Cowse\TRN_02 INSTRUCTOR CATHY El Pass 3. PTFTRM 2012-05-0318:25 5/9/201 2 5:26:27 PM

Using the Trace Pane

The trace pane displays a history of processing actions for this session.

Upgrading Tests

The Tests PT Upgrade tool enables you to update tests from previous versions when you upgrade to a
newer version of PeopleTools. When you launch the PTF client, it checks for tests from prior versions,
and if they exist, a prompt window appears that enables you to run the upgrade tool. You can run the
upgrade tool when prompted, or defer it to a later time. You can upgrade all tests, or just those within a
specific folder of the PTF Explorer tree. The Tests PT Upgrade tool makes any necessary syntax changes
in the test steps, and then saves the test files. If you defer the upgrade, and you open a test from a prior

release, it is automatically updated to the new release at that time.

Note: You cannot reverse the upgrade process.

Using the Tests PT Upgrade Tool

Access the Tests PT Upgrade dialog box (Tools > Tests PT Upgrade, or click Yes if you are prompted to

upgrade tests when you launch the PTF client).
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This example illustrates the Tests PT Upgrade dialog box.

B
Folder: | Folder | Start

Total: Ll
Log: i | Time | Test Name | old Version | Status | Eort |

:

Close

Field or Control Description

Folder Specify the folder of the PTF Explorer tree that contains the
tests you want to upgrade.

You can click the Folder button to open a view of the PTF
Explorer tree and navigate to the desired folder, or enter
the folder path directly into the Folder field. Use the ‘$\’
characters to indicate the root level of the tree.

Total After you specify the folder, this lists the number of tests to be
upgraded.

After you click the Start button, a progress bar appears next
to the total, to provide a visual indicator of how many tests
have been processed. The start time and an estimated end time
appear below the progress bar.

Start Click to upgrade the tests in the specified folder. This option is
not available until the Folder field has been populated.

Stop Click to interrupt the upgrade process, once it has started. This
action is available only after the upgrade process has started.

Log This grid is populated as tests are upgraded. It lists each test
that is updated, the time it was updated, the version it was
updated from, and its upgrade status.
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Field or Control Description

Export Click to save the test upgrade log to a text file.

This action is available only after all tests are upgraded, or
when the upgrade process has been stopped.

This example shows the Tests PT Upgrade dialog box during the upgrade process.

Tests PT Upgrade

Folder: [s\PTQA Folder | Start
] Tow:23 _ Stp

il

Started: 05:03:01 Estimated End Time: 09:03:33
Log: # | Time | Test Name | old Version | Status | Export
1 090301 PTD_SF_AJAX_SELECT_LOOKUP_IT.. 8.54-802-1 upgraded
2 090304 PTD_SF CO_DOCLVL _DEPLOY_CBJ 8.54-104-R2 upgraded
3 050305 PTD_SF CO_DOCLYL QUERY TEST  8.54-802-1 upgraded
4 090306 PTD_SF_CO_DOCLVL SCHED_SEARC  8.54-802-1 upgraded
5 0590307 PTD_SF CO_DOCLYL SEARCH_CAT 8.54-802-11 upgraded
& 050308 PTD_SF CO_DOCLYL SEARCH_DEF 8.54-802-11 upgraded
7 050309 PTD_SF CO_TEST_PAGE 1 8.54-802-11 upgraded
g8 0590309 PTD_SF CO_TEST_PAGE_NIL_DATA  8.54-802-1 upgraded
% 0590310 PTD_SF_DELETE QUERY 8.54-802-11 upgraded
10 0590311 PTD_SF_DEL QRY_CAT 8.54-802-11 working...
Close

Securing Test Folders Using Permissions

PeopleSoft Test Framework (PTF) restricts user privileges on a test folder for specific PTF roles. Users
are required to have appropriate permissions on test folders and its content to perform actions like add,
modify, or delete.

Defining Roles for PTF

PeopleSoft administrator defines new roles for PeopleSoft Test Framework (PTF) from PeopleSoft
Internet Architecture.

Assign one of the following PTF permission lists to the role:
*  PTF Administrato—PTPT3400
* PTF Edito—PTPT3700

*  PTF User—PTPT3600
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Describing the Permissions on Test Folders
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For a specific test repository only one PTF administrator role is required. The PTF administrator grants
privileges to the PTF editor and user roles from the Test Folder Permissions Manager.

Note: There is no privilege granted to a new role by default.

Related Links

Security Administration

Setting Up Security

There are three types of privileges, which can be assigned to a role. These privileges allow actions on a
test folder and its content. The table describes the actions possible with each privilege.

Privilege Description
Read/Run *  Open

* Run

*  Copy
Modity «  Open

* Run

+ Copy

* Paste

*  Create

*  Modify
Full Control ¢ Open

* Run

*  Copy

e Paste

*  Create

*  Modify

« Cut

*  Delete

¢ Rename
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Using the Test Folder Permissions Manager

Note: The Test Folder Permissions Manager only authorizes actions on the test folder and tests. The test
cases cannot be given specific permission but it inherits the same permission as the parent test.
You can edit test cases as long as your role has read and run privileges for the parent test.

The PTF administrator assigns privileges to these roles from the Test Folder Permissions Manager.

Access the Test Folder Permissions Manager from the Tools menu in the PTF client. The link under
Tools menu is only visible to PTF administrators.

If some test folders are invisible to a specific PTF role, then all the tests under that test folder and the sub

folders are also hidden to the users who are assigned the particular PTF role. This is also applicable for

PTF command line.

Also see, Understanding the Messages and Warnings.

The example illustrates the fields and controls on the Test Folder Permissions Manager.

i~ N

Role

Fols Name | PTF User

Test Folder Pemissions

W Insert | % Select All | X Delete |%CopyFrom

Test Folder

Fead/Execute b adify Full Contral

Horme

HomebmpFolder

Home'WPeopleTool: DevelopmentyReparting ToolssPivat Grid [PIYOTGRID)Fluid Pivot E

Field or Control Description
E Saves any modifications to test folder permissions for the
current role.
Refreshes test folder permissions for the current role. A
+ warning message displays if changes are not saved.
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Field or Control

Description

Role Name

Switch to a role to display the test folders and permissions

granted to it.

Test Folder Permissions

Field or Control

Description

Insert permissions for a new test folder.
o Insert
Select all the permissions displayed on the grid.
B Select Al P P s
X Delete Delete test folder permissions for an existing PTF role.
} Copy existing test folder permissions from an existing role.
Copy From . .
The Copy from an existing Role dialog box prompts you to

select a folder. A warning message The following Test
Folders are duplicated. isdisplayed, if a folder
already exists in your Test Folder Permissions Manager.

Click to display the test folder selection dialog box.

See Understanding the Messages and Warnings for related messages and warning.
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Understanding the Messages and Warnings
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The section explains messages and warnings generated from the Test Folder Permissions Manager on

an action.
Action Message Description
Insert Test Folder XXX already When you are selecting a folder or test
exists. which already has permissions assigned
for the role, and exists in the Test
Folder Permissions grid, the message is
generated.
Copy From The following Test Folders While copying from the Copy from an
are duplicated. existing Role dialog box, if the selected
test folder already exists in the parent
grid, the message is generated.
Delete Are you sure you want When you want to delete selected rows
to delete selected Test from the grid, the message is displayed
Folders? to confirm.
Save Invalid Test Folder If any data is invalid then the message
Permission. is displayed and the invalid row is
highlighted, when you save the test
folder permissions.
Refresh The data are not saved yet. |Ifyou refresh the data in the Test Folder

Do you want to continue?

Permission Manager or switch to a
different role, but the current data is not
saved then the message is displayed to
confirm.

Run tests from the command line.

Test XXX not found.

If you are running tests from the
command line and you do not have
permission on a folder or any test within
it, the warning is displayed.

Run shell tests from the command line.

Called Test not found.

If you do not have required permissions
on a shell test or the folder that includes
the shell test, then the system displays
the warning.

Related Links

Using the Test Folder Permissions Manager

Running Tests

Configuring Execution Options from the Command Line
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Managing Privileges Using Rules

Only the PTF administrator can configure permissions on test folders using the Test Folder Permissions
Manager. While granting permissions on folders the PTF administrator needs to keep the following rules
in mind:

» Test Folder Permission Manager is only available for PTF administrator role.
* Users with same PTF roles have the same privileges for specific test folders.
» Each PTF role may have different privileges on a test folder.

* PTF administrator can configure privileges on My Folder like any other folder in PTF.

Note: Sub folders, tests, and test cases under My Folder inherits the permissions configured on the
parent folder.

* Privileges on a folder are merged for an user who has multiple PTF roles. The role with higher
permissions take precedence.

» Test folder permission management does not have any impact on the below scenarios:
» Updating Step Information after the run completes.

» Testing PeopleTools upgrade.

Migrating Test Folder Permissions

Test folder permissions depend on the role and the test folder to which the permission is applied.
Migrating roles between PeopleTools upgrades are completed using the application designer. See
Lifecycle Management Guide.

Use the DataMover tool to migrate the relationship between role and test folder. See “Understanding
PeopleSoft Data Mover” (Lifecycle Management Guide).

Related Links
Migrating PTF Tests

Working with Application Designer Projects in PTF Client
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The PTF client enables you to inspect and maintain the test contents of an Application Designer project,
and complete the following tasks:

* Create new Application Designer projects.
e Open existing Application Designer projects.
» Insert tests into Application Designer projects.

* Remove tests from Application Designer projects.
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* Set the upgrade action type for the tests within Application Designer projects.

Access to this feature is limited to PTF Administrators. In addition, the appropriate PeopleTools security
roles and permissions necessary to administer Application Designer projects are required. Only test-
related data within a project is modified; any other content that exists within the project is not affected.

Note: This section assumes you are already familiar with Application Designer projects. For detailed
information about Application Designer Projects, see Application Designer Developer’s Guide.

Managing Application Designer Projects in PTF Client
Use the Projects dialog box to manage Application Designer projects within the PTF client.
To access the Projects dialog box, select the @<PTF Environment Name> > Projects menu command.

This example illustrates the fields and controls in the Projects dialog box.

Project  |BBEE =l open | New |
Test | Folder | UpdBy | Updated | Version | Action | Status Select Al |
PTD_PIA_COMMON_ACCESSIBILITY “\PeopleTools Development'Core Tools'PIA Core Technology {TECH) A PPLSOFT | 5/6/2014 6:43:12PM 56 copy | new
PTO_PIA_COMMON_LOGIN “People Tools DevelopmentCore Tools\PIA Core Technology (TECH) | PPLSOFT  5/6/2014 6:43:12PM 56 copy | new Deselect Al |
PTD_PORTAL_TOGGLE_SIGNIN_LANG “\PeopleTools Development'Core Tools'Partal (PORTAL) PPLSOFT 5/6/2014 6:43:16 PM 56 delete | removed Action - Cor |
GQEMPA_POPUP_GETTEXT \PTQANFLAAJAX _Gen WP1 5/24/2013 3:56:32 PM | 26 copy e
GQEMSF_PRCS_WAIT_FOR_DST_STATUS “\PTQAMFL\PROCESS_SCHEDULER WP1 5/24/2013 3:56:35 PM | 26 delete | changed Action - Delete |
Remove
Insert Tests |
Apply
Close |
Use these fields and controls to open or create a project:

Field or Control Description

Project Select a project.

Open Click to open the selected project. This option is not available
if the Project field is blank, or a project with pending changes
is open.

New Click to create a new project. At the prompt, enter a unique

project name.

This option is not available if a project with pending changes
is open.

Note: New projects are not saved until a test object is inserted
and you click the Apply button.
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The grid area serves as a worksheet that lists the following information about the project’s tests.

Field or Control

Description

Test The test name.

Folder The name of the folder the test belongs to.

Upd By The user ID of the person that last updated the test.

Updated The date and time the test was last modified.

Version The test version.

Action The upgrade action associated with this project test record,
either Copy or Delete.
By default, the action is set to Copy when the test is initially
inserted into the project.
To change the upgrade action, click the Action - Copy or
Action - Delete button.

Status The status of the project test record. This updates

automatically while you interact with the project using this
dialog box to show the changes made during the current
session. Once you apply the changes, the status resets.
Values are:
* New

Indicates the test record was inserted during this session.

»  Changed

Indicates the upgrade action was changed during this
session.

e  Removed

Indicates the test record was set to Removed during this
session.

*  No entry (blank).

Indicates no changes were made during this session.

Initially, when you open the Projects dialog box, the grid is empty. It populates when you:

* Open a project that contains tests.

* Add tests by using the Insert button.

Use these buttons to interact with the project worksheet.
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Field or Control Description

Select All Click to select all of the tests in the grid.
Deselect All Click to deselect all of the tests in the grid.
Action - Copy Click to set the upgrade action type to copy.
Action - Delete Click to set the upgrade action type to delete.
Remove Click to remove selected tests from the project.
Insert Tests Click to insert tests into the current project.

A window appears that enables you to select the tests from to
insert. Currently active filters are applied to the view. You can
select multiple tests or folders. If a parent folder is selected,
tests from its associated child folders are included.

Apply Click to commit all pending changes to the project. The
Projects dialog box remains open.

Close Click to close the dialog box. If there are any pending changes,
you are prompted to save.

Important! Project content is not dynamic; it is a snapshot of the test data at the time it was inserted into
the project. If you modify a test after you have included it in a project, you must re-insert that test into the
project in order for the project to contain the revised test data.

Creating a New Project

To create a new project:

1. Select the @<PTF Environment Name> > Projects menu command.
The Projects dialog box opens.

2. Click the New button.

3. At the prompt, enter a name for the new project, and click OK.

The Projects dialog box reappears. The Project field displays the new project name, and becomes
unavailable. The Open and New buttons are disabled.

Opening an Existing Project
To open an existing project:

1. Select the @<PTF Environment Name> > Projects menu command.
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The Projects dialog box opens.
Select a project from the Projects list box.
Click the Open button.

If any tests are currently associated with the project, they appear in the grid.

Inserting Tests into a Project

To insert tests into a project:

L.

Select the @<PTF Environment Name> > Projects menu command.
The Projects dialog box opens.

Open an existing project, or create a new project.

Click the Insert button.

The PTF Explorer tree appears in the PTF Suite window.

Expand folders as needed to access and select the tests to insert (use Ctrl-Click to select multiple
tests).

Click OK.

Click Apply to insert the tests into the project.

Removing Tests from a Project

To remove tests from a project:

1.
2.
3.
4.

Open an existing project.
Select one or more tests in the grid.
Click Remove.

Click Apply.

Setting the Upgrade Action Type for Test(s) in a Project

To set the upgrade action type for test(s) in a project:

1.
2.

Open an existing project.

Select one or more tests in the grid.

Click Action - Copy or Action - Delete to set the desired upgrade action type for the selected test(s).
Click Apply.
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Migrating PTF Tests

Because PTF tests and test cases are PeopleTools managed objects, they can be copied from one database
to another in the same way as other PeopleTools objects, such as record definitions, SQL definitions, and
PeopleCode programs.

You can create a project (in either the PTF client or in Application Designer) that includes tests and test
cases, and export the project to another database using the Copy Project tool in Application Designer.

You can also include tests and test cases in an upgrade project.

Related Links

“Inserting Definitions Into Projects” (Application Designer Developer’s Guide)

Performing Mass Updates

This section describes how to use the PTF Mass Update tool.

Understanding Mass Update

As the applications you are testing are updated, you will find various situations where many of your
tests need to be modified. The Mass Update tool provides this capability, enabling you to perform mass
updates to your tests.

For example, suppose in a new release, a component name has changed, and every test you have that
references that component must now be modified in order to run successfully. Using the Mass Update
tool, you retrieve the impacted tests, search for steps that include that component and replace the previous
component name with the new name.

Mass Update Steps

To perform a mass update, complete these steps:

1. Open the Mass Update page.

2. Define the filter criteria.

3. Apply the filter to retrieve the test steps.

4. Find/replace the test step values that need to be modified.

5. Save.

Using the Mass Update Page

To access the Mass Update page, select Tools > Mass Update.
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This example illustrates the fields and controls on the Mass Update page.

# Mass Update

Chapter 6

JSETEY

D> B

[ Crteria

Test | Siep | Maintenance Repors | Goverage Reports | Giner |

Test Name Updated Date 1/ 1/2000 >| [12:00:00 AM 3:
Test Deser Version 0
Upcated By

Resuts |Log |

When you first open the Mass Update page, the Results grid is empty; no test records appear in the grid.

When you use the mass update tool, you define and apply a filter to retrieve tests that match specific
criteria, returning the results in a grid format similar to the Test editor, but including steps for multiple
tests. The grid includes two additional columns: Folder and Test so you can identify which test the steps
are from. Once the grid is populated, you can use a find/replace dialog box to search for specific test step

field values, modify the steps, and save your changes.

Mass Update Toolbar

The Mass Update Toolbar includes the following icons:

matching test steps.

Term Definition
Click to clear all criteria fields.
E Click to apply the filter and populate the grid with the

= Click to open the Find and Replace dialog box.

{-' Click to save all modified test steps.
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Mass Update — Criteria Group Box

Use the Criteria group box to define the filter criteria. When you open the Mass Update window, if filters
for the PTF Explorer Tree have been defined, they are included automatically, but you can change the
filter criteria as needed; the same filter fields are used in Mass Update and the PTF Explorer Tree. For
best performance, specify more criteria to reduce the number of test steps that are retrieved.

The criteria types are grouped by the following tabs: Test, Step, Maintenance Reports, Coverage Reports,
Other. Click each tab to define the criteria fields for that group.

For details about the filter criteria fields, see Defining and Applying Filters.

To include test cases, select the Other tab and check the Include Test Cases check box.

Mass Update — Results Grid

Use the Results grid as a worksheet area for retrieving and modifying test steps. Initially, this grid

is empty. To populate the grid, define the filter criteria, then click the Retrieve icon. A status of
Processing. .. appears in the status bar during retrieval. Once processing is complete, the status bar
states the number of records retrieved.

This example illustrates the Results grid after applying the filter.

JBEIE
Dy B W |
[~Citeria
Test |Step | Maintenance Reports | Coverage Repots | Other |
Test Name [FTOFVOTGRID  Updsied Dae [77mm =] [zo00an =
Test Descr Vemm [ o
Updated By —
Resuts | Log |
Folder Test D Seq Type Acton Recogriion Parameters Meru Componert Page Record Feld
PespleToaks De... |PTD_PVOTGRI 2 13| ComboBox v Set Naue  + |Name=PTPG_COL VIEW_P... PTPG_WIZ MENU PTPG_WIZ_ COMP PTPG_WIZ_OPT PTPG_COL_VIEW PTPG_GRIDAXIS
PeapleTools De... |PTD_PVOTGRI 2| 14 Buen ~ | ciek ~ | Name=pTORM NEXT_PB PTPG_WIZ_MENU PTFG_WIZ_COMP PTPG_WIZ OPT PTPG_WORKREC PTPG_NEXT_PB
PeopleTodls De... | PTD_PIVOTGRI. 23| 15 Page - | save - PTPG_WIZ_MENU PTFG_WIZ_COMP PTPG_WIZ_DISP
\PecpleTools De... |PTD_PIVOTGAI 2| 18] San - [k - [1D=PT_cHaRT_scrowLL PTPG_WIZ_MENU PTPG_WIZ_COMP PTPG_WIZ_DISP
PeopleTools De.. |PTD_PVOTGRI 25|  17)CheckBox v |SetVale v |Name=PT_CHART SCROL... PTPG_WIZ_MENU v PTPG_WIZ_DISP
PespleToaks De... |PTD_PVOTGRI 2|  18|CheckBox - |SetVaue v |Name=PT_CHART SCROL.. PTPG_WIZ_MENU PTPG_WIZ_DISP
PeapleTools De... |PTD_PVOTGRI 27| 19 Buton ~ | ciek ~ |Name=pT_cHART sCROL... PTPG_WIZ_MENU PTPG_WIZ_DISP
PeopleTodls De... | PTD_PIVOTGRI. 28| 20 Spn - | ciok - |m=pT_craRT scRoLLL... PTPG_WIZ_MENU PTPG_WIZ_DISP
\PecpleTools De... |PTD_PIVOTGAI 2| 21[CheckBox |- [SetNaue = |Name-PT_CHART SCROL... PTPG_WIZ_MENU
PeopleTools De.. |PTD_PVOTGRI 30|  22|CheckBo v |SetVale v |Name=PT_CHART SCROL... PTPG_WIZ_MENU
PeopleTodls De... |PTD_PVOTGRI. 31| 23[Buton - [click = [Name=pT_caRT_scRoL.. PTPG_WIZ MENU v Wiz
PeopleTocls De... | PTD_PVOTGRI 2| 24 Sen ~ | ciek ~ | m=pT_chanT scrow1. PTPG_WIZ_MENU PTPG_WIZ_COMP PTPG_WIZ_DISP
PeopleTooks De... |PTD_PIVOTGRI 33| 25 CheckBax - |SetVae v |Name=PT_CHART SGRGL.. PTPG_WIZ_MENU PTPG_WIZ_COMP PTPG_WIZ_DISP
\PecpleTools De... |PTD_PIVOTGAI 3| 26[CheckBox |- [SetNaue = |Name-PT_CHART SCROL... PTPG_WIZ_MENU PTPG_WIZ_COMP PTPG_WIZ_DISP
PeopleTools De.. |PTD_PVOTGRI 35| 27 Buton + | cick + | Name=pT_CHART sCROL.. PTPG_WIZ_MENU PTPG_WIZ_COMP PTPG_WIZ_DISP
PespleToaks De... |PTD_PVOTGRI %| 28 Buton - | Cick - | Name=pToRM PREV_PB PTPG_WIZ MENU PTPG_WIZ COMP PTPG_WIZ_DISP PTPG_WORKREC PTPG_PREV_PB
PeapleTools De... |PTD_PVOTGRI 37| 29| Rado v |setVale v |Name=PTPG WORKREC_P. PTPG_WIZ_MENU PTFG_WIZ_COMP PTPG_WIZ OPT PTPG_WORKREC PTPG_DISPLAYOPT
PeopleTooks De... |PTD_PIVOTGRI 38| 30| Buton - | ciok - | Name=pTORM NEXT_PB PTPG_WIZ_MENU PTFG_WIZ_COMP PTPG_WIZ_OPT PTPG_WORKREC PTPG_NEXT_PB
\PecpleTools De... |PTD_PIVOTGAI B 31| Page - [save - PTPG_WIZ_MENU PTPG_WIZ_COMP PTPG_WIZ_DISP
PeopleTools De.. |PTD_PVOTGRI 47| 32| Bowser - |Famese =
PespleToaks De... |PTD_PVOTGRI 5| 38|Te - [SetVake - |Name=PTPG WORKRECL .. PTPG_WIZ MENU PS_PG_VIEWER PTPG_PSPGVIEWER PTPG_WORKREC! PTPG_PGRIDNAME
PeapleTools De... |PTD_PVOTGRI 52| 19 Buton ~ | ciek ~ | Name=pTPG_WORKREC1 PTPG_WIZ_MENU PS_PG_VIEWER PTPG_PSPGVIEWER PTPG_WORKRECT PTPG_SRCH_BTN
PeopleTooks De... |PTD_PIVOTGRI 53| 40|unk - | ciok - | Name=pTPG_viEW_BTNSH PTPG_WIZ_MENU PS_PG_VIEWER PTPG_PSPGVIEWER PTPG_WORKRECT PTPG_VIEW_BTN
\PecpleTools De... |PTD_PIVOTGAI 5| 41 Bowser - [FameSet < |ptodFrame_s#
PeopleTools De.. |PTD_PVOTGRI 55| 43 CheckBox v |SetVale v Name=PTPGMDLVWRSFTP. PTPG_WIZ_MENU PTPGVIEWER PTPG_PGVIEWER PTPGVWRGRDREC
PespleToaks De... |PTD_PVOTGRI 59|  48Lnk - | Cick = [innerText=Pivot Grid Adni...
PeorleTocla Da_|PTO PNOTGRL ol 40 e - FmmeSet e [Tammetcontent =

Done! | 2615 raw(s) retrieved.

The grid contains the same fields as the Test Editor, with two additional columns: Folder, and Test so you
can identify which test the steps are from.

Term Definition

Folder Lists the folder hierarchy of the test the step belongs to.

Test Lists the name of the test that contains the step.
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For information about the test step fields, see Test Step Fields.

Mass Update — Log Grid

The Log grid displays a log of mass update activity.

Finding and Replacing Test Step Data

Click the Find icon on the Mass Update toolbar to open the Find and Replace dialog box. Two tabs are

available:

Term Definition

Find Select the Find tab to find test step data.

Replace Select the Replace tab to find and replace test step data.

Finding Test Step Data
To find test step data:
1. Click the Find icon on the Mass Update toolbar.
The Find and Replace dialog box appears, with the Find tab active.

This example illustrates the fields and controls on the Find and Replace Dialog Box: Find tab.

i

Find I Replace I
Find what: |
— Dlirection
& Down € Up
Find | Cancsl
—Search Options —¥  Select/Deselect Al
IV Test Name V¥ Command ID r Type
[ Action W Recognition V¥ Parameters
¥ Menu v Component v Page
¥ Record ¥ Field ¥ Case Name
¥ Case Value ¥ Folder
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2. In the Search Options group box, select the test step fields to include in the search.
3. In the Find what edit box, specify the search value.
For text fields, enter a search string; wildcards are supported.
For Action or Type, select a value from the list.
4. To specify the search direction, select Down or Up; the default is Down.
5. Click Find to find the next match.
Review each step and make any modifications needed.
6. Continue to click Find to review all the matching test steps.

A message appears when there are no more matches. Click OK, then click Cancel to exit the Find
dialog box.

7. Click the Save icon on the Mass Update toolbar to save your changes.

Replacing Test Step Data
To replace test step data:
1. Click the Find icon on the Mass Update toolbar.
The Find and Replace dialog box appears, with the Find tab active.
2. Click the Replace tab to access the Replace dialog.

This example illustrates the fields and controls on the Find and Replace Dialog Box: Replace tab.

i

‘Find  {Heplace']
Find what: |
Replace with: I
— Direction
* Down © Up
Find | Feplace Replace Al Cancel

— Search Options — v Select/Deselect Al

r Type ™ Action v Recognition
¥ Parameters ¥ Menu v Component
V' Page W Record v Field

V¥ Case Value
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3.
4.

In the Search Options group box, select the test step fields to include in the search.

In the Find what edit box, specify the search value.

For text fields, enter a search string; wildcards are supported.

For Action or Type, select a value from the list.

Enter the replacement value in Replace with.

For text fields, enter the text string, for Action or Type, select a value from the list.

To specify the search direction, select Down or Up; the default is Down.

To replace all occurrences, without individually reviewing each match, click Replace All.

A message box appears indicating the number of replacements made. Click OK, then click Cancel to
close the Find and Replace dialog box.

To review each match, click Find.

Either click Find to move to the next match without making any changes, or click Replace then Find
to change the value and move to the next match.

Continue to click Find or Replace, as appropriate, to review all the remaining matching test steps.

A message appears when there are no more matches. Click OK, then click Cancel to exit the Find
dialog box.

Click the Save icon on the Mass Update toolbar to save your changes.
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Identifying Change Impacts

Understanding Change Impacts

In the course of customizations and upgrades, changes are made to, among other elements, application
menus, components, pages, records, and fields. Tests that were developed prior to these changes may fail
when executed against the new application. For instance, if a field is deleted, moved to another page, or
renamed, any step that references that field will fail. Test developers must identify and update every step
in each test that is affected by the change.

One way to identify the effects on tests is to run each test against the new application and note where the
test fails. This manual process is time-consuming, expensive, and prone to errors. It also fails to identify
those areas in the new application that are not covered by existing tests.

Because PeopleSoft Test Framework (PTF) test assets are PeopleTools metadata and because PTF tests
incorporate references to PeopleTools metadata—that is, menus, components, pages, records, and fields—
PTF is able to automate the process of correlating metadata changes with existing tests.

PTF delivers two tools that help test developers to determine the effect of changes:
* Test maintenance reports

A test maintenance report correlates PeopleTools compare report data with PTF test metadata to
identify certain changes to menus, components, pages, records, and fields that may impact the PTF
tests.

e Test coverage reports

A test coverage report correlates PeopleTools project data with PTF test metadata to identify menus,
components, pages, records, and fields that are referenced in PTF tests.

When used in conjunction with Usage Monitor, test coverage correlations can be extended to include
information on additional managed objects.

A test coverage report identifies which objects included in the change project are referenced by which
PTF test. Any object included in the change project that is not referenced in the PTF test metadata
appears in the report identified as a coverage gap.

Defining Analysis Rules

This section discusses the page used to define analysis rules.
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Defining Analysis Rules

Use the Define Analysis Rules page (PSPTTSTANLMENU) to define the priority for each of the attribute
checks in a test maintenance report.

Navigation:
PeopleTools > Lifecycle Tools > Test Framework > Configure PTF Analysis Rules

This example illustrates the fields and controls on the Define Analysis Rules page.

Menus Components Pages Records Fields Translates

Define Analysis Rules

. " I - [ .
Find | View Al | B | 88 First B0 13 052 B Last

Analysis Cat *Priori

| Menu does not exist |2 - Medium 'I

Moz Component deleted from Menu |E - Medium j

MO3 Caomponent added to Menu |2 - Medium j

Use the Define Analysis Rules page to define the priority for each of the attribute checks in a test
maintenance report.

A test maintenance report is sorted by test name. Within each test name grouping, the report items are
sorted by priority according to the values specified on the Define Analysis Rules page.

If the priority for an analysis category is set to 4 — Ignore, then identified impacts meeting the category
criteria will not be printed in the report.

Note: Priorities are used as filters and groupings in a test maintenance report. They do not affect the
actual analysis process or change what is analyzed.

The following table describes the analysis categories:

Analysis Category Description

MO1 Menu does not exist

MO02 Component deleted from Menu
MO03 Component added to Menu
C01 Page deleted from Component
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Analysis Category Description

C02 Page added to Component

Co03 Search Record changed on Component
P01 Field deleted on Page

P02 Required Field added to Page

P03 Fieldname changed on Page

P04 Field Type changed on Page

P05 Field Label changed on Page

P06 Non-Required Field added to Page
P07 Recname changed on Page

P08 Recname & Fieldname changed on Page
RO1 RecordField now required on Page
RO2 RecordField no longer required on Page
RO3 RecordField is now a Search Key

RO4 RecordField no longer a Search Key
RO5 RecordField is now a List Box Item
RO6 RecordField no longer a List Box Item
Fo1 Field Type changed

F02 Field Length changed

F03 Field Format changed

F04 Field Decimal Positions changed
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Analysis Category Description
X01 Translate Value does not exist
X02 Translate Value added

Creating Test Maintenance Reports

This section discusses how to create test maintenance reports using the Create Test Maintenance Report
wizard.

Access the Create Test Maintenance Report wizard (PeopleTools > Lifecycle Tools > Test
Framework > Create Test Maintenance Report).

The wizard consists of four steps:

* Step 1: Manual Tasks

* Step 2: Analyze Compare Data

e Step 3: Select an Analyzed Project

* Step 4: Generate Report

Step 1 of 4: Manual Tasks

204

The tasks for Step 1 only to be run once for the change project.

The first step in creating a test maintenance report is comprised of five manual tasks that you will
complete in Application Designer to create a compare report that PTF will use as a basis for the
maintenance report.

Perform these tasks to create a compare report from a project file.

Access the Create Test Maintenance Report wizard (PeopleTools, Lifecycle Tools, Test Framework,
Create Test Maintenance Report).
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This example illustrates the fields and controls on the Create Test Maintenance Report Wizard: Step 1 of
4.

Create Test Maintenance Report Step 1 0f 4

Create a Test Maintenance Report based on compare data and test metadata.

o G e o Restart Next =

Manual Tasks Process Monitor

Using App Designer, follow these tasks to create a compare report for the test maintenance process:

Task Completed  Description

Task 1: Import only the project definition for the change project.

Task 2: Rename the change project imported in Task 1 to create the snapshot project.

Task 3: Create a snapshot of the original metadata definitions by exporting the snapshot project
created in Task 2 tofile.

Task 4: Import the change project (definition and objects).

Task 5: Compare the snapshot project (from file) to the database, saving the compare output to

tables.

As you progress through the Test Maintenance wizard the wizard tracks which tasks you have completed
and which page you are on. When you exit the wizard and then return to the wizard again, the wizard
sends you to the last visited page.

This tracking is done according to user ID. This means that if two users share the same user ID, the
second user might not enter the first page when accessing the wizard. The wizard will take the second
user to where the previous user left the wizard.

If two users with different user IDs work on the same project, the wizard does not track the state for the
second user. For instance, if the first user completed the tasks for Step 1, the second user needs to check
the five tasks on Step 1 to bypass that step.

Task 1: Import only the project definition for the change project.

Suppose you are about to apply a change project named SA PROJ UPGD. Before the change project is
applied, import the change project, SA PROJ UPGD, as a project definition only.

1. In Application Designer, select Tools > Copy Project > From File.
2. In the selection box, highlight the change project, SA PROJ UPGD.
3. Click Select.

The Copy From File dialog box appears.

4. Click the Deselect All button to deselect all of the definition types so that only the empty project
structure is imported.

At this point, you are importing only the names of the definitions into the project. None of the actual
definitions in the upgrade project are copied.
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If a definition exists in the original database with the same name as a definition in the upgrade project,
the upgrade project in the database will (correctly) contain the original, unmodified definition of the
object.

5. Click Copy.

Task 2: Rename the change project imported in Task 1 to create the snapshot
project.

Create a copy of the change project, SA_PROJ UPGD.

Select File > Save Project As and name the new project SA PROJ SNAP.

Note: Creating the Snapshot Project is required to avoid naming conflicts later in the process.

Task 3: Create a snapshot of the original metadata definitions by exporting the
snapshot project created in Task 2 to file.

Export the snapshot project, SA_ PROJ_SNAP, to file:
1. Select Tools > Copy Project > To File.

2. If this project is large, as upgrades often are, you can save time during the compare process by
deselecting all definitions in the Copy Options window, except for the five definitions that are
referenced by PTF tests:

¢  Menus

*  Components

* Pages
e Records
¢ Fields

3. Accept the defaults and click OK.

Task 4: Import the change project (definition and objects).
Import the original change project, SA_ PROJ UPGD, from file:

1. Select Tools > Copy Project > From File.

2. Include all the definition types.

At this point, the database contains the new metadata.

Task 5: Compare the snapshot project (from file) to the database, saving the
compare output to tables.

Compare the current (target) database with the pre-change (source) project, SA PROJ SNAP:

1. Select Tools > Compare and Report > From File.
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2. Highlight the snapshot project, SA PROJ _SNAP, and click the Select button.
The Replace existing SA_ PROJ_SNAP? dialog box appears.

3. Click Yes.
The Compare and Report From File dialog box appears.

4. Click Options to access the Upgrade Options dialog box.

5. Select the Report Options tab.

6. Select the Generate Output to Tables check box.

7. Select the Report Filter tab.

8. Click Select All.

9. Click OK.

10. Click Compare.

The wizard will use data from this compare report to create the test maintenance report.

Step 2 of 4: Analyze Compare Data

This example shows Step 2 of 4:

This example illustrates the fields and controls on the Create Test Maintenance Report Wizard: Step 2 of

4.

Create Test Maintenance Report Step 2 of 4

Create a Test Maintenance Report based on compare data and test metadata.

Restart < Previous Next >

Analyze Compare Data e Process Monitor  Instance 2751

Analyze existing compare data and generate data on impact to PeopleSoft Test Framework metadata.

CHANGES_TO_RCF_DEFINITION 09/10/2019 5:17:35PM

Select a Compare Report to Analyze Find | View 100 | & First ‘4 1-300f 3038 ' Last
Project Name Compare Date/Time Compare Type Status Analysis Date/Time
PTUVIEW | 09/10/2019 5:17:35PM v Success 11/05119 12:34:35AM

For a given change project the tasks for Step 2 only need to be run once. This analysis is based only
on the compare data, not on the test data; so changes to tests do not affect the result. The relationship
between this analysis and test data is calculated in Step 3: Generate Impact Report. You may generate

multiple Impact Reports based on a single analysis as tests change.

In this step, PTF analyzes data from the compare you performed in Wizard Step 1, Task 5.

1. For the project compare report you created in Wizard Step 1, Task 5, specify whether the Compare

Type is From File or To Database.

2. Click Analyze.
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This will launch the Application Engine program PSPTANALYSIS in Process Scheduler.

Chapter 7

Note: A pop-up appears stating that the request is submitted to Process Scheduler. Click OK to

proceed.

3. You can click the Process Monitor link or check the Status column to know the progress of the

Application Engine program.

4. When the analysis is complete, the Status column shows Success or Fail. Click Next to continue.

Note: A project name can appear more than once in the list because the Compare Output to Table feature
stores data by both project name and compare date/time. The most recent compare will appear first in the

list.

Step 3 of 4: Select an Analyzed Project

This example shows Step 3 of 4:

This example illustrates the fields and controls on the Create Test Maintenance Report Wizard: Step 3 of

4.

Project Name Compare Date/Time

09/10/2019 5:17:35PM

Analysis Date/Time
{®) PTUVIEW

Create Test Maintenance Report Step 3 of 4
Create a Test Maintenance Report based on compare data and test metadata.
@_@_@_@ Restart = Previous Next =
Select an Analyzed Project Process Monitor
Select an analyzed project to report its impact on the PeopleSoft Test Framework metadata.
Please select a project. Find | View All | L2 First ‘4 10f1 '}

11/05/2019 12:34:35AM

Delete Selected

Last
Delete

O

Use this page to select the analysis data PTF will use to generate the report.

Sets of compare data are listed by project name, the date and time the compare was generated, and the

date and time the analysis was run.

Select the Delete check box and click Delete Selected to delete analyses.

Step 4 of 4: Generate Report

This example shows Step 4 of 4:

208
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This example illustrates the fields and controls on the Create Test Maintenance Report Wizard: Step 4 of
4.

Create Test Maintenance Report Step40of4

Create a Test Maintenance Report based on compare data and test metadata.

o e e o Restart < Previous

Generate Report for project PTUVIEW Process Monitor

Generate a report of the impact to existing tests for the selected compare data.

Folder | v
Search For Tests
By
Search
Select Test(s) for Test Maintenance Report Find | View All | & | E First ‘4 10f1 '} Last
Test Parent Folder Test Name Description

\PeopleTools Development\Analytic
Tools\Analytic Engine {ACE) PTD_ACE_ACCESS CUBE_FILTER

Select All Clear All

Generate Report

Generate Report = Success Instance 2865

View PIA Report View PDF Report

For a given change project you will use this page to generate multiple reports as changes are made to
the PTF test metadata. As you make changes to tests based on the results of this report, rerun the report
to verify that the issues were corrected. You can run this report repeatedly as you make changes to tests
without having to redo steps 1 through 3 of the Create Test Maintenance Report wizard.

To generate a report:
1. Select one or more tests in the Select Test(s) for Test Maintenance Report grid to use for the report.

Use the Folder and Search for Tests By fields along with the Search button to filter the list of tests
that are available to select for the report:

* Select a value in the Folder list to specify the PTF Explorer Tree level to include. To include test
from all folders, leave this field blank.

* To include only tests that match a test name or description, select Name or Desc from the Search
for Tests By list, then enter the search string in the adjacent edit box.

Click Search to populate the Select Test(s) for Test Maintenance Report grid with the tests that
match the criteria specified.
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2. Select the report format.
3. Click Generate Report to create the report.
This will launch the Application Engine program PSPTMAINTRPT in Process Scheduler.

The following fields are on the Create Test Maintenance Report Wizard: Step 4 of 4 page:

Field or Control Description

Folder To limit the report to tests from a specific folder, select the
level of the PTF Explorer Tree to include. To include tests
from all folders, leave this field blank.

Search for Tests By Select Name to search for reports by test name, or Desc to
search for reports by their description.

Enter the search string in the adjacent edit box. To retrieve all
reports, leave the edit box blank.

Search Click to populate the Select Test(s) for Test Maintenance
Report grid with the tests that match the criteria specified.

Select All Click to select all tests that are listed in the Select Test(s) for
Test Maintenance Report grid.

Clear All Click to deselect all tests that are listed in the Select Test(s)
for Test Maintenance Report grid.

Generate Report Click to create the report.
Process Monitor Click to check the progress of the Application Engine program
PSPTMAINTRPT.

Note: The run details, such as run status and process instance,
are displayed on the Wizard after you click Generate Report.

View PIA Report Click to view the report in the application browser.

This link is enabled after the report is created.

View PDF Report Click to view a PDF report.

This link is enabled after the report is created.

Running a Test Report from PTF Client

As you modify a test based on the results of a maintenance report, you can validate the test by running a
test report from the PTF client. The report is generated for a single test, using analyses generated in Step 2
of the Test Maintenance Wizard.
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1. In PTF Explorer, right-click on a test.

2. From the context menu, select Validate Test.

3. The Validate Test — Analysis Project list dialog box appears.

4. Select an analysis from the list and click Open.

The test maintenance report opens in a new window in the PTF client.

Identifying Change Impacts

Interpreting Test Maintenance Reports

A test maintenance report lists the tests that have been impacted by changes to menus, components,

records, pages, and fields, and details the changes that impacted those tests. You can choose to output the
report to PIA or to BI Publisher .

This example illustrates a test maintenance report in PI Publisher format.

Test Maintenance Report
Project Name SA_PROJ_SNAP_852

Test Name: INSTRUCTORS

2 -Medium | FO1F Field INTERNAL_EXTERMNAL Changed
Step ID: 31 Seq. Nbr: 31 Status: Active Language: EN
Pre Object Value: INTERNAL_EXTERNAL
Post Object Value: INTERNAL EXTERNAL.Character

2 - Medium | FO4F Field INTERNAL_EXTERNAL Changed
Step ID: 31 Seq. Nbr: 31 Status: Active Language: EN
Pre Object Value: INTERNAL_EXTERNAL
Post Object Value: INTERNAL EXTERNAL.O

2 - Medium | PO1F Page PSU_INSTR Deleted
Step ID: 32 Seq. Nbr: 32 Status: Active Language: EN
Pre Object Value: PSU_INSTR_TBL. MANAGER
Post Object Value:

2 - Medium | PO5F Page PSU_INSTR Changed
Step ID: 11 Seq. Nbr: 11 Status: Active Language: EN
Pre Object Value: PSU_INSTR_TBL.FIRST_NAME.First Name
Post Object Value: PSU_INSTR_TBL.FIRST_MNAME.First

Test Name: RESERVED WORDS

2 -Medium | CO1F Caompaonent PSU_STUDENT GBL Deleted
Step ID: 6 Seq. Nbr: & Status: Active Language: ENG
Pre Object Value: PSU_STUDENT_SKED
Post Object Value:

2 - Medium | CO1F Component PSU_STUDENT GBL Deleted
Step ID: 7 Seq. Nbr: 6 Status: Active Language: ENG
Pre Object Value: PSU_STUDENT_SKED
Post Object Value:

2 - Medium | CO1F Component PSU_STUDENT GBL Deleted
Step ID: & Seq. Nbr: 7 Status: Active Language: ENG
Pre Object Value: PSU_STUDENT_SKED
Post Object Value:

2 -Medium | CO1F Component PSU_STUDENT GBL Deleted
Step ID: 13 Seq. Nbr: & Status: Active Language: ENG
Pre Object Value: PSU_STUDENT_SKED
Post Object Value:

This example illustrates a test maintenance report in PIA format.
Project Name: 5A_PRO.J_SNAP
Compare Date/Time: 07/16/2010 5:14:06PM Analysis Date/Time: 0771612010 5:15:09PM
=

Test Hame Priority. Category.
INSTRUCTORS:
INSTRUCTORS
INSTRUCTORS:
INSTRUCTORS:
INSTRUCTORS
STUDENTS
TRN_STUDENT_04

Medium PO
Medium P03
Medium  PO03
Medium  PO0G
Medium  PO0E
Medium  PO03
Medium  PO03

Obiect Tvpe  Obiect Hame
Pages PSU_INSTR
Pages PSU_INSTR
Pages PSU_INSTR
Fages PSU_INSTR
Pages PSU_INSTR
Pages PSU_STUDENT_PERS
Pages PSU_STUDENT_PERS

Market Command 1D

£l
[
i
il
32
i
i

Seq Obiect
Hbr Action
32 Active | Deleted PSU_INSTR_TBLMANAGER
Active | Added
Active | Added

Status Pre Obiect Value Post Obiect Value

33 Active | Changed PSU_INSTR_TBLMANAGER Manager
0 Active | Added
Active | Added

PSU_INSTR_TBL CURR_DEV_FLAG
PSU_INSTR_TBL CURR_DEV_FLAG
11 Active | Changed PSU_INSTR_TBLFIRST_NAME FirstName  PSU_INSTR_TBLFIRST_NAME First
PSU_INSTR_TBL MANAGER
PSU_STUDENT_TEL PHONE
PSU_STUDENT_TBL. PHONE

Description

Field deleted on Page
Field added to Page {Compare Type Filg)
Field added o Page (Compate Tye File)
Field Label changed on Page

Field Label changed on Page

Field added o Page (Compate Type File)
Field added o Page (Compare Type File)
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From a PIA report, you can click the Download icon to output the report to a spreadsheet. The foll
example shows a report in spreadsheet format:

Chapter 7

owing

This example illustrates a test maintenance report that has been downloaded in spreadsheet format.

] ps.s [Read-Oniy]

A B C D E F G H [} ] K L M

1 Test Name Priority |Category |Object Type|  Object Name | Market|Step ID|seq Nbr | Status| Object Action Pre Object Value Post Object Value Description
2 |INSTRUCTORS 2-Medium |[FO1F |Field INTERNAL_EXTERNAL 31 51|Active |Changed INTERNAL_EXTERNAL haracter Type File]

Fizld Decimal Positions chanzed
3 |INSTRUCTORS 2-Medium |[Fo4F  |Field INTERNAL_EXTERNAL 31 51|Active |Changed INTERNAL_EXTERNAL INTERNAL_EXTERNALO | (Compare Type File)
4 |INSTRUCTORS 2 - Medium [PO1F Page PSU_INSTR 32 32|Active |Deleted PSU_INSTR_TBL. MANAGER Type File)

PSU_INSTR_TBLFIRST_NAME|PSU_INSTR_TBLFIRST_|Field Label changed on Page

5 |INSTRUCTORS. 2 - Medium |POSF Page PSU_INSTR 11 11|Active |Changed First Name MAME First (Compare Type File)

Paze deleted from Component
6 RESERVED_WORDS |2 -Medium [COLF  |Component |PSU_STUDENT Global 3 5|Active |Deleted PSU_STUDENT_SKED (Compare Type File)

Paze deleted from Component
7 |RESERVED_WORDS |2 -Medium [COLF  |Component |PSU_STUDENT Global 7 6|Active |Deleted PSU_STUDENT_SKED (Compare Type File)

Fagze deleted from Component
8 |RESERVED_WORDS |2 - Medium [COLF  |Component |PSU_STUDENT Global 5 7|Active |Deleted PSU_STUDENT_SKED (Compare Type File)

Page deleted from Component
9 |RESERVED_WORDS |2 -Medium [COLF  |Component |PSU_STUDENT Global 13 8|Active |Deleted PSU_STUDENT_SKED (Compare Type File)

Page deleted frem Compenent
10 RESERVED_WORDS |2 - Medium [COLF  |Component |PSU_STUDENT Global 14] 5|Active |Deleted PSU_STUDENT_SKED (Compare Type File)

This example illustrates a test maintenance report in the PTF Client.

Maintenance Report x|
Test Mame: IINSTHUETDHS Project Mame: ISA_F'F!DJ_SNAP_852
Analysiz Seq I‘I
Run DateTime: |?£22J2D11 9:40:05 PM D ateTime Stamp: |?£22£2D11 3:41:15 PM
AnalvsisCategary | Pricrity Step D LanguageCode Seqghbr CommandStatus OhjectType ObjectDescription ObjectM ame
2 32 EM 32 B 5 Page PSU_INSTR
POSF 2 1 EN 1 A 5 Page PSU_INSTR
FIF 2 il EM il A 2 Field INTERMAL_E.
FO4F 2 il EM kil A 2 Field INTERMAL_E

4

The following columns are on a Test Maintenance report (test data may be positioned differently
depending on the report format):

page.

See Defining Analysis Rules.

Column Name Description
Test Name The test that is impacted by a change.
Priority A test maintenance report is sorted by test name. Within each

test name grouping, the report items are sorted by priority,
according to the values specified on the Define Analysis Rules
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Column Name

Description

Category

Which category the change belongs to, as detailed on the
Define Analysis Rules page.

See Defining Analysis Rules.

Object Type

The type of definition that was changed:
*  Menu

*  Component

* Page

*  Record

*  Field

Object Name

The name of the object that was changed.

Market

For components, the market; for instance, GBL.

Step ID

A unique and unchanging identifier for a step in a test. Each
step has a Step ID and a Sequence Number, but the Sequenc

€

Number, unlike the Step ID, changes when steps are added or

deleted from a test.

Seq. Nbr

The sequence number for the test step reflects the relative run

order position of the step within the test.

Status

Indicates whether, within the test, the step is active or inactive.

Object Action

Indicates whether the object was:
*  Changed
* Added

e Deleted

Pre Object Value

The value before the object was changed.

Post Object Value

The value after the object was changed.

Description

A brief description of the change.
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Understanding Test Coverage Reports

In addition to being a record and playback tool, PTF is one element of the broader PeopleTools Lifecycle
Management framework, which provides greater visibility into how organizations use their PeopleSoft
environments, and how changes to PeopleSoft managed objects might impact their business processes.

Documenting business process tests in PTF enables you to correlate business processes to the underlying
managed objects. Using PTF in conjunction with Usage Monitor provides you with even greater levels of
information about the objects used in your system.

Test Coverage reports leverage PTF integration with PeopleTools to provide this information to you in a
usable form.

Creating Test Coverage Reports

By default, a test coverage report correlates PeopleTools project data with PTF test metadata to identify
components, menus, pages, records and fields that are referenced in PTF Tests.

When used in conjunction with Usage Monitor, test coverage correlations can be extended to include
information on additional PeopleTools managed objects, such as PeopleCode.

A test coverage report identifies which objects included in the change project are referenced by which
PTF test. Any object included in the change project that is not referenced in the PTF test metadata will
appear in this report, identified as a coverage gap.

All the projects in the database are listed, sorted with most recent first. Click the column headings to
change the sort order.

PTF generates a coverage report based on a change project. Select the project you want PTF to use to
generate the report.

The wizard consists of two steps:
e Step 1: Select a Project.

+ Step 2: Generate Report.

Step 1 of 2: Select a Project

Use the Create Test Coverage Report page (PSPTTSTCOVERAGESEL) to select the projects to include
in the test coverage report.

Navigation:

PeopleTools > Lifecycle Tools > Test Framework > Create Test Coverage Report
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This example illustrates the fields and controls on the Create Test Coverage Report Wizard: Step 1 of 2.
You can find definitions for the fields and controls later on this page.

OCCOO00000C0000 00

Please select a Project.

Select a Project for the Test Coverage Report

QES54_90311
PTFTLSPROJ
PPLDELETE
PPLTLS84CUR
PELTOOLS
PT854_90311
QEDMOS54
QEDMOALL
QE_ASIVADAS_854_9031
PT854_902R1
QES854_90211
PTPCRECOMPFILE
PTa254_ 90211
QES54_901R1
PT854_901R1

Ql::reate Test Coverage Report

Creale a Test Coverage Report based on a project definition and test metadata.

On

MNext

Find | View 100 | (2|

[ [Proiect Name Project Description

Increm Proj for QES.54_90311

Deleted PeopleTools Objects
Composite PeopleTools Maintena
Composite PeopleTools Project
Increm Proj for FT2.54_90311
Comp Proj for QES.54

Composite QE Project

Increm Proj for PT8.54_902R1
Increm Proj for QES.54_90211

Increm Proj for PT2.54_90211
Increm Proj for QES.54 901R1
Increm Proj for PT8.54_901R1

First B0 14501202 O Last

Update Date/Time

03/06/2014 6:44:27FPM
05/06/2014 6:43:01PM

05/06/2014
05/06/2014
05/06/2014
03/06/2014
05/06/2014
05/06/2014
03/05/2014

04/22/2014 5:01:28PM
04/22/2014 3:57:03PM
04/22/2014 10:23:00AM
04/15/2014 4:31:16PM
04/14/2014 4:10:34PM

6:42:34FM
6:40:38PM
6:38:26PM
3:24:25FM
8:53:14AM
8:51:08AM
5:34:54FM
04/29/2014 11:08:52AM

Select a change project to be correlated with PTF metadata and click Next.

Step 2 of 2: Generate Report

This example shows step 2 of 2:
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This example illustrates the fields and controls on the Create Test Coverage Report Wizard: Step 2 of 2.

Create Test Coverage Report

Create a Test Coverage Report based on a project definition and test metadata.

| 2O

Previous

Project Name PT354_901R1

Last Update Date/Time 04/14/2014 4:10:34PM

Search For Tests By |Name

Generate report for either all Tests or select a maximum of 10 Tests
Select Test(s) for the Test Coverage Report

Test Parent Folder Test Name

Folder |

[PTD_AC

=

First n 16 of & u Last

O \PeopleTools Developmentiinalytic

Tools\Analytic Engine (ACE)

\PeopleTools Developmentianalytic
Tools\Analytic Engine (ACE)
\PeopleTools Developmentianalytic
Tools\Analytic Engine (ACE)
\PeopleTools Developmentiinalytic
Tools\Analytic Engine (ACE)

\PeopleTools DevelopmentiPorting,
Database and Platform\Automated
Config Manager {ACM)

\PeopleTools DevelopmentiPorting,

[] Database and Platform\Automated

Config Manager {(ACM)

PTD_ACE_ACCESS_CUBE_FILTER
PTD_ACE_GEN_TESTCASES
PTD_ACE_MDL_VWR

PTD_ACE_Z_DUMMY

PTD_ACM_TEMFLATE_CREATION

FTD_ACM_TEMPLATE_RUN

ACM Template Creation

ACM Template Run Configuration

select Al | Clear Al

Report Format

® pia

 BI Publisher

Include Usage Monitor Data

O Usage Monitor Rpt

Generate Report |

To generate the report:

L.

Select one or more tests in the Select Test(s) for the Test Coverage Report grid to use for the report.

Use the Folder and Search for Tests By fields along with the Search button to filter the list of tests
that are available to select for the report:

» Select a value in the Folder list to specify the PTF Explorer Tree level to include. To include tests
from all folders, leave this field blank.

* To include only tests that match a test name or description, select Name or Desc from the Search
for Tests By list, then enter the search string in the adjacent edit box.

Click Search to populate the Select Test(s) for the Test Coverage Report grid with the tests that

match the criteria specified.
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2. Select the report format.

3. Click Generate Report to create the report.

Identifying Change Impacts

The following fields are on the Create Test Coverage Report Wizard: Step 2 of 2 page:

Field or Control

Description

Folder

To limit the report to tests from a specific folder, select the
level of the PTF Explorer Tree to include. To include tests
from all folders, leave this field blank.

Search for Tests By

Select Name to search for reports by test name, or Desc to
search for reports by their description.

Enter the search string in the adjacent edit box. To retrieve all
reports, leave the edit box blank.

Search

Click to populate the Select Test(s) for Test Coverage Report
grid with the tests that match the criteria specified.

Select All

Click to select all tests that are listed in the Select Test(s) for
Test Coverage Report grid.

Clear All

Click to deselect all tests that are listed in the Select Test(s)
for Test Coverage Report grid.

Report Format

Select the report output format. Options are:
*  PIA - View the report in the application browser.

* XML Publisher - Create an XML formatted text file.

Usage Monitor Rpt

Select to include Usage Monitor data in a test coverage report.
You need to generate Usage Monitor data while creating your
tests.

See Using Usage Monitor Data with PTF.

Generate Report

Click to create the report.

Using Usage Monitor Data with PTF

PTF used by itself tracks the use of five step types — records, menus, fields, pages, and components.
You can use PTF together with Usage Monitor to track additional PeopleTools managed objects used in
the course of a test. This data can then be correlated with change projects (that is, fixes or bundles) to
determine which tests need to be run to test the change project.
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For example, suppose you have 100 PTF tests in your test repository. You receive a bundle from
PeopleSoft that consists of updates to ten PeopleCode objects. Based solely on the data stored by PTF,
you cannot determine which PTF tests you need to run to test the bundle, because PTF does not track
references to PeopleCode.

You can use Usage Monitor in conjunction with PTF to address this issue. Usage Monitor tracks
references to additional PeopleTools managed objects, including PeopleCode. When you associate a test
and test case with Usage Monitor all the actions taken while Usage Monitor is active are associated with
the test and test case you specified.

A test coverage report correlates project data, PTF data, and Usage Monitor data to identify, in this
example, which PTF Tests in the test repository reference one or more of the PeopleCode objects
delivered in the bundle.

Configuring Usage Monitor

Your system administrator must configure Performance Monitor and Usage Monitor before you use
Usage Monitor with PTF.

See PeopleTools: Performance Monitor

Generating Usage Monitor Data

218

Follow these steps to generate Usage Monitor data along with PTF test data:
1. Create a new test in PTF.

2. Launch the Recorder.

3. Hook the browser.

4. Start recording.

5. In the PeopleSoft application browser, select Test Usage Monitoring from the main menu.

Note: Your PTF environment and the application you are testing must be on the same database.

6. The Test Data page appears.

7. Enter Test Name and Test Case.

8. Click Start test.

9. Record the test steps.

10. When you are finished with the test steps, return to the Usage Monitoring page and select Stop Test.

11. In the PTF Recorder click the Stop Recording icon.

Note: The manual steps of starting and stopping the Usage Monitor are included here during the
recording process to capture them in the PTF test. PTF does not have to be in record mode to generate
Usage Monitor data.
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Administering Usage Monitor for PTF

Before Usage Monitor data can be used in a coverage report it must be aggregated.

To aggregate the Usage Monitor Data:

1.

2.

Navigate to PeopleTools > Process Scheduler > Schedule Process Requests.
Enter a run control ID or create a new one.

Click Run.

Select Usage Monitor Aggregator (PTUMAGR) from the list.

Click OK to Run the process.

Note: We recommend that you schedule the Usage Monitor Aggregator Process to run hourly or daily
to keep the data in the aggregated data table current. Once data has been aggregated the raw data can be
purged to reduce disk space usage.

To verify that Usage Monitor is collecting data, run this query in your query tool:

SELECT * FROM PSPMTRANS35 VW;

The PSPMTRANS35 VW represents the correct logical view of the raw Usage Monitor data.

Note: For any Usage Monitor data to appear in the view, the Usage Monitor buffers need to have been
flushed at least once. By default the buffer size is set to 500 unique object references. While you are
configuring and testing your Usage Monitor setup you might find it useful to reduce the size of the buffer
(PeopleTools, LifeCycle Tools, Lifecycle Tools Options).

To verify that Usage Monitor Data has been aggregated correctly, run this query in your query tool:

SELECT * FROM PSPTUMPMTAGR;

Interpreting Test Coverage Reports

Use a Test Coverage report to determine which objects in a change package have tests and which do not.
Objects without a test represent a potential gap in the test coverage.

This is an example of a test coverage report in PIA format:
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This example illustrates a test coverage report in PIA format.
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Project Name:  SA_PROJ_SNAP_852

Impacted Objects and Objects with No Coverage

Test Name

** Mo Test Coverage = Page

** Mo Test Coverage ** FPage

** Mo Test Coverage =* Page

*x » = Panel Group
Mo Test Coverage PeopleCade

Panel Group Record
Field PeopleCode
Panel Group Record
Field PeopleCode

** No Test Coverage =

**No Test Coverage *

** No Test Coverage ** Translate
INSTRUCTORS Component
INSTRUCTORS Field
INSTRUCTORS Page
INSTRUCTORS Record
RESERVED_WORDS Component

PSU_COURSE
PSU_COURSE_MATL
PSU_INSTR_FHOTQ

PSU_CUST

PSU_INSTR

PSU_INSTR

INTERMAL_EXTERMAL
PSU_INSTR
INTERMAL_EXTERMAL
PSU_INSTR
PSU_INSTR_TBL
PSU_STUDENT

Find | View a1 ] B |

GBL.SavePostChange

GBL.DERIVED_ED_SVCS.DELETE_BTN  FieldChange

GBL.DERIVED_ED_SVCS.INSERT_BTN  FieldChange

0.2010-07-16

Mo Data
Mo Data
Mo Data

Mo Data

Mo Data

Mo Data

Mo Data
Active
Active
Active
Active
Active

Mo Data
Mo Data
Mo Data

Mo Data
Mo Data

Mo Data

Mo Data
Mo Data
Mo Data
Mo Data
Mo Data
Mo Data

The following columns are on a Test Coverage report (test data may be positioned differently depending

on the report format):

Column Name

Description

Test Name The test that is impacted by a change.

Object Type The type of definition that was in the change project.

Object Name The primary key of the object.

Object Detail The additional keys (as applicable) required to uniquely
identify the object.

Test Metadata If the object is referenced in a PTF test, this value will be

Active or Inactive, reflecting whether within the test, the
referenced step is active or inactive.

If the object is not referenced in a PTF test, this value will be
No Data. This scenario can occur when the Include Usage
Monitor Data check box is selected and the value in the
Usage Monitor Data column is Yes.

Usage Monitor Data

When the Include Usage Monitor Data check box is selected
this value will be Yes or No. When the Include Usage
Monitor Data check box is deselected the value will be set to
No Data.

Running Test Details Reports

A test details report is an HTML file with details for a PTF test and its associated test cases, including

comments in rich text format with images.

Use the Create Test Details Report page (PSPTTSTDTLRUNCNTL) to run a test details report.

220
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Navigation:
PeopleTools > Lifecycle Tools > Test Framework > Create Test Details Report

This example illustrates the fields and controls on the Create Test Details Report page.

Create Test Details Report

Create a Test Details Report based on test metadata.

Report Manager Process Monitor Run Report |

Folder [\PeopleTools DevelopmentiAnalytic Tools\Charting (CHART)

Search For Tests By |Name |

Search |

Select from 1 to 10 Tests Find | View A1 | 2 First Bl 13073 B Last
Test Parent Folder Test Name Description

O] (oiparery o DevelopmentiAnalylic Tools\Chartng prp_cHART_ORG_BASICS Basic tests for Org Chart

O (riarery e DevelopmentiAnalytic Toos\Charting - p1p)_ caRT RB_BASICS Basic test for RE chart

] EFc’:eople_;l')onls DevelopmentiAnalytic Tools\Charting PTD_CHART Z DUMMY

To run the Test Detail report:

1. Select a minimum of one to a maximum of ten tests in the Select from 1 to 10 Tests grid to use for

the report.

Use the Folder and Search for Tests By fields along with the Search button to filter the list of tests

that are available to select for the report:

* Select a value in the Folder list to specify the PTF Explorer Tree level to include. To include tests

from all folders, leave this field blank.

* To include only tests that match a test name or description, select Name or Desc from the Search

for Tests By list, then enter the search string in the adjacent edit box.

Click Search to populate the Select from 1 to 10 Tests grid with the tests that match the criteria

specified.

2. Click Run Report to create the report.

Note: The run control is automatically generated by the system and the report is scheduled. You can use

the Process Monitor link to check the report status and the Report Manager link to view the report.
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This example illustrates a test details report.

Chapter 7

PeopleSoft Test Framework
Test Details Report

Test Name:

PB_USER, PROFILE SHORT

Type:

Message ¥

Test s
R ecognition:

Example for Test Details

Test Comments:

the report.

This test example has the first few steps remowved to show details far a typical step. All test cases have been remowed except CASE_01 to simplify

Test Case Information

Test Case Name:

CASE 01

Comments:

Test Steps

1| Active |Page.Prompt

MATNTAIN_SECURITY.USER_SAVEAS.GEL Command Id: 10 |Language: ENG

IMern: MATMTATN SECTURITY

Comparnent: T3EE_SAVEAS GEL

Object Page: (SEARCH)

PageField:

Praparties

Recond:

Field:

Comments:

The step uses the Page Prompt construct instead of explicit navigation.

Test Case Details:

CASE 01

Value: update

Creating a Test Compare Report

222

Use the Create Test Compare Report page (PSPTTSTCOMPARESEL) to run a test compare report based
on a project file.

See Creating Test Maintenance Reports

Navigation:

PeopleTools > Lifecycle Tools > Test Framework > Create Test Compare Report
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This example illustrates the fields and controls on the Create Test Compare Report Page. You can find
definitions for the fields and controls later on this page.

Create Test Compare Report

HFrevious

| 2O

Project Name EP92PROD_C358_CHANGED

Run Date/Time 05/30/14 9:38:52AM

*Search For Tests By |Nam'3 v

Generate report for either all Tests or select a maximum of 10 Tesis

Select Test(s) to Create Compare Report

Test Name

TC_12_06_COPY_TEMPLATE_03

Select All Clear All

Report Format

(OF=TY J Excel

Generate Report

Create a Test Compare Report based on output data from previcus project compares.

Description

My Profile page

[Next

Search

Find | View Al | 2 First'd 1 of 1 &' Last

To generate the report:

1. Select one or more tests in the Select Test(s) to Create Compare Report grid to use for the report.

To list only tests that match a test name or description, select Name or Desc from the Search for
Tests By list, enter the search string in the adjacent edit box, then click Search to populate the Select
Test(s) to Create Compare Report grid with the tests that match the criteria specified.

2. Select the report format.

3. Click Generate Report to create the report.

The following fields are on the Create Test Compare Report page:

Field or Control

Description

Search for Tests By

Select Name to search for reports by test name, or Desc to
search for reports by their description.

Enter the search string in the adjacent edit box. To retrieve all
reports, leave the edit box blank.
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Field or Control

Description

Search Click to populate the Select Test(s) to Create Compare
Report grid with the tests that match the criteria specified.

Select All Click to select all tests that are listed in the Select Test(s) to
Create Compare Report grid.

Clear All Click to deselect all tests that are listed in the Select Test(s) to

Create Compare Report grid.

Report Format

Select the report output format. Options are:
*  PIA - View the report in the application browser.

«  Excel - Create a Microsoft Excel file.

Generate Report

Click to create the report.

This example illustrates a test compare report in PIA format.

Run Date/Time 05/30/2014 9:38:52AM

Test Compare Report

TC_12_06_COPY_TEWMPLATE 03
TC_12_06_COPY_TEMPLATE_03
TC_12_06_COFY_TEMPLATE_03
TC_12_06_COPY_TEMPLATE_03
TC_12_06_COPY_TEMPLATE 03
TC_12_06_COPY_TEMPLATE_03
TC_12_06_COPY_TEMPLATE_03
TC_12_06_COPY_TEMPLATE_03
TC_12_06_COPY_TEMPLATE_03
TC_12_06_COPY_TEMPLATE_03
TC_12_06_COPY_TEMPLATE_03

Project Name EP92PROD_C358_CHANGED

Test Name Test Case Hame

Report Type PlA

Find | View All | 2 First ‘4 1-11 of 11 '*' Last

Command ID Attribute Source Target

version 853124 25310481
17 Rec&Field GROUP_NAME
65 ObjectID TUS$535825501_Row TUS$675&25591_Row
67 ObjectID E$565825501_Row1 91_Rowd
68 ObjectID SURE$585825591_Row 825591_Row
69 ObjectID $605825591_Row $535825591_Row
74 ObjectID ID=VENDOR_NAWE1825591_ROW2 ¢ ;;?fgf;:f"‘"EmD
75 ObjectID TUS$535825501_Row2 TUS$675825591_Row2
77 ObjectID E$565825591_Row2 91_Row2
78 ObjectID SURE$585825501_Row?2 SURE$52525591_Row?2
79 ObjectID $605825501_Row2 3535 1_Row2

Creating Test Matrix Reports

The Matrix Details report enables you to view the top level parent and child test(s) for the test(s) that you

specify.

To create a Matrix Details report, access the Matrix Details Report page (PSPTTSTRELGEN).

Navigation:

PeopleTools > Lifecycle Tools > Test Framework > Create Test Matrix Report

224
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This example illustrates the fields and controls on the Matrix Details Report page.

Test Matrix Report

Search Criteria

Search For Tests By |Name |PTD_SF_D

Folder [\PTQATESTSCRIPTS

Project [PTFTLSPROJ

] \PTOA\TESTSCRIPTS\SES_SearchFrameWork PTD_SF_DELETE_QUERY

[1 \PTOATESTSCRIPTS\SES_SearchFrameWork\DELETE_QUERY PTD_SF_DEL_ORY_CAT

] \PTOA\TESTSCRIPTS\SES_SearchFrameWork\DELETE_QUERY PTD_SF_DEL_QORY_DEF

[1 \PTOA\TESTSCRIPTS\SES_SearchFrameWork\DELETE_QUERY PTD_SF_DEL_ORY_DEPLOY

[] \PTOA\TESTSCRIPTS\SES_SearchFrameWork\DELETE_QUERY PTD_SF_DEL_QORY_SRCH_INDEX

] \PTOATESTSCRIPTS\SES_SearchFrameWork\DELETE_QUERY PTD_SF_DEL_QRY_SRCH_INDX_FULL
[] \PTOA\TESTSCRIPTS\SES_SearchFrameWork\DELETE_QUERY PTD_SF_DEL_ORY_TEST_PAGE1

] \PTOA\TESTSCRIPTS\SES_SearchFrameWork\DELETE_QUERY PTD_SF_DEL_QORY_TEST_PAGE_SEC
1 \PTOA\TESTSCRIPTS\SES_SearchFrameWork\DELETE_QUERY PTD_SF_DEL_QORY_TST_PAGE

First n 19 of9 u Last
Description

Select Al clearal |

Generate Report |

To generate the report:

1.

2.

Select one or more tests in the Select Test(s) to Matrix Report grid to use for the report.

Use the Folder and Search for Tests By fields along with the Search button to filter the list of tests
that are available to select for the report:

Select a value in the Folder list to specify the PTF Explorer Tree level to include. To include tests
from all folders, leave this field blank.

To include only tests that match a test name or description, select Name or Desc from the Search
for Tests By list, then enter the search string in the adjacent edit box.

To include only tests within a specified Application Designer project, select a Project.

Click Search to populate the Select Test(s) to Matrix Report grid with the tests that match the
criteria specified.

Click Generate Report to create the report.

The following fields are on the Matrix Details Report page:
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Field or Control Description

Folder To limit the report to tests from a specific folder, select the
level of the PTF Explorer Tree to include. To include tests
from all folders, leave this field blank.

Search for Tests By Select Name to search for reports by test name, or Desc to
search for reports by their description.

Enter the Search string in the adjacent edit box. To retrieve all
reports, leave the edit box blank.

Project Select a project from the list to limit the report to tests from a
specific Application Designer project.

Search Click to populate the Select Test(s) to Matrix Report grid
with the tests that match the criteria specified.

Select All Click to select all tests that are listed in the Select Test(s) to
Matrix Report grid.

Clear All Click to deselect all tests that are listed in the Select Test(s) to
Matrix Report grid.

Generate Report Click to create the report.

This example illustrates the generated Matrix Details report.

Personalize | Find | View All | @| mil First n 112 of 12 n Last
|_ Test Parent Folder Test Name I%I% i:{:ted ’%
1 \PTQATESTSCRIPTSISESSearchFrameWork PTD_SF_DELETE_QUERY ?2:1" X
2 \PTQAITESTSCRIPTSISES_SearchFrameWork\DELETE_QUERY PTD_SF_DEL_QRY_SRCH_INDEX Test X X
3 \PTQAITESTSCRIPTS\SES_SearchFrameWorllDELETE_QUERY PTD_SF_DEL_QRY SRCH_INDX_FULL Test X X
4 \PTQA\TESTSCRIPTS\SES_SearchFrameWorkiDELETE_QUERY PTD_SF_DEL_QRY_DEF Test X
5 \PTQAIFL\AJAX_Gen PTD_SF_AJAX_SELECT_LOOKUP_ITEM Library X
6 \PTQAIFLVAJAX_Gen PTD_SF_FRAMESET Library X
7 \PTQA\TESTSCRIPTS\SES_SearchFrameWorllDELETE_QUERY PTD_SF_DEL_QRY TST PAGE Test X
8 \PTQAIFLISES PTD_SF_DEL_QRY_SEARCH Library X
9 \PTQA\TESTSCRIPTS\SES_SearchFrameWorkiDELETE_QUERY PTD_SF_DEL_QRY_TEST_PAGE_SEC Test X
10 \PeopleTools DevelopmentiSearch Framework PTD_SF_PRCS_WT_FR_DIST_ST Library X
11 \PTQATESTSCRIPTSISES SearchFrameWorkiDELETE_QUERY PTD_SF_DEL_QRY_CAT Test X
12 \PTQATESTSCRIPTS\SES_SearchFrameWorkiDELETE_QUERY PTD_SF_DEL_QRY_DEFLOY Test X
Retumn
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Querying PTF Report Tables

You can query these tables using PS Query to produce your own maintenance and coverage reports:
* PSPTTSTMAINTRPT

This PTF table contains the data that is used to create the Test Maintenance report.
+ PSPTTSTCOVRGRPT

This PTF table contains the data that is used to create the Test Coverage report.
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Incorporating Best Practices

Incorporating PTF Best Practices

This section discusses how to incorporate PTF best practices.

Keep your Desktop Simple

Close all programs other than PTF and the PeopleSoft application browser during recording and runtime
of PTF tests. Other applications — especially those that alert the user with spontaneous notifications,
such as e-mail and instant messaging programs — can interfere with PTF and the PeopleSoft application
browser and thus cause unexpected results during record and playback.

Adopt Naming Conventions
You should understand these PTF test asset naming limitations:

e Test names and test case names must be unique.

Tests and test case are PeopleTools managed objects, a very important type of PeopleSoft metadata.
As a result, test names must be unique to a database and test case names must be unique to a test.

¢ Test and test case names are limited to letters, numbers, and underscore characters.
The first character of any test or test case name must be a letter.
» Test and test case names are limited to 30 characters.

You will find it easier to manage test assets if you adopt a systematic naming convention that
reflects important characteristics of the tests and test cases you create. Here are a few suggested test
characteristics that you can incorporate in your PTF test names:

* Functionality being tested.
Include a brief indication of the functional area or business process validated by the test.

* Priority. A short code, such as “P1,” to indicate priority can help testers more easily locate the tests
that are critical or likely to be run most often.

¢ Runtime order.

PTF Explorer sorts tests alphabetically within each folder. It is sometimes useful to view tests in order
of intended runtime, especially if some tests depend on other tests having been run previously in the
same database. Include a numeric component early in the name of the test to make alphabetic order
equal to runtime order.
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It may seem simpler to use folders to categorize tests by the above characteristics. However, folder names
are often not visible to the tester and do not appear on some PTF reports, such as the Test Maintenance
Report. So, regardless of whether you categorize tests by folder, it is helpful to build test characteristics
into the names of your tests.

The following three test names are examples of a naming convention that reflects functionality, priority,
and intended runtime order:

« WRKFRC Pl 01 HIRE REQD FLDS
«  WRKFRC_P1 02 PERSON_CHNG 21

«  WRKFRC_P1 03 _JOB _DATA UPDAT

Record First

A critical best practice when automating with PTF is to record first, and record whenever possible, to
drive as much information, including PeopleTools metadata, into the recorded test as possible.

You must assertively record every test step from the test. That is, even if the input fields are already set
to the expected value, you must explicitly set or verify that value when recording. The recorder only
captures actions that you take against objects during record time. If you skip an object during recording
because it is already set to the desired value, the test will ignore it and fail if the default value of the same
object is different during runtime.

When you record a date field that includes a calendar object that enables the user to select a date, it is best
to explicitly enter the date value in the edit box.

You may need to perform two actions instead of one. For instance, if the test instructions say to select a
check box but the check box is already selected, then you will need to pause the recording, deselect the
check box, restart the recording, and then select the check box. Alternatively, you could click the check
box twice and then delete the extra step from your test.

If you need to add a new step to a test, select the spot in the test where the new step will occur and record
the step at the insertion point. Recording a step is more likely to drive accurate information into your test
than trying to construct the entire step by editing the fields through the Test Editor.

Related Links
Recording Tests

Document Tests

230

Make it part of your automation routine to take advantage of the description fields in PTF tests and

test cases as often as possible. PTF test and test case names tend to be short and abstract, so longer
descriptions will help you and future testers understand the functional purpose of available PTF tests and
test data.

You can find description fields in:
*  Test description.

»  Test properties.
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* Test case description.
» Test case properties.
*  Step information.

Use the Log actions to make your tests self-documenting. For instance, you can add a Log.Message
before a Test.Exec step to describe the test you are calling, and you can put a Log.Message in the called
test to document what the test does.

You can add comments in RTF format to the test, test case, and steps to document your tests. Comments
can include application snapshots.
Clean Up Tests

Immediately after recording a test, review the recorded test data in the Test Editor and correct actions
taken inadvertently during recording, such as:

* Unnecessary or extra clicks on a clickable item, such as a check box.

* Clicks on the wrong objects, such as links and images.

* Incorrect text entered into text boxes.

Revise the recorded values in the Value field (for editable fields) and delete unneeded steps.

This might be a good time to evaluate whether you should incorporate reserved words and variables to
replace static values that may be different when the test is processed.

Related Links
Make Tests Dynamic

Use Configuration and Runtime Options

Employ configuration options and runtime options to take login information out of the test whenever
appropriate. Suppose you have the following manual test step:

1. Log into your database as a user with the PeopleSoft
User role.

Coding user-specific information into many tests may make future updates difficult if user IDs in the test
environment are changed.

The following example shows how to make a recorded test easier to maintain by setting configuration
options to use Browser.Start Login (it automatically inactivates the sequence of steps that records logging
in (Steps 2 through 4) and replaces those steps with the single action, Browser.Start Login) and using
runtime options for the user ID and password at the login page:
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This example illustrates inactivating the sequence of steps that record logging in (Steps 2 through 4) and
replacing those steps with the single action, Browser.Start Login, which takes the user ID and password
from the runtime options and enters them at the login page:

Seq ‘m Commert | Actve | 57! Type Action Recognion Parameters Value
» [s] Browser ~ | Start_Login -
[=] lue -

me =userid PTDOCBL
1ENC2SCDDODES30662C4010DE2CA37016ECE0S09EEC

avbea_PORTAL_ROOT_OBJECT
Link = | Click * | Name=fida_MANAGE_ASSETS|index=0
Link - |k - |id-flda_MANAGE_ASSETS1

Link - |cick - [id=fd_USE3 111

Lnk - |ciek = [[rnerText-Enter Alocation Basis

ww\lmmawm
EINIEIEICIE i il
=
o

Related Links

Defining PTF Configuration Options
Configuring Execution Options in PTF Client

Start Login

Use Page Prompting

Use of PTF page prompting steps make tests more robust and repeatable by simplifying test data and
replacing it with intelligence built into the step.

Page prompting functions replace explicit navigation in the test and instead directly access the component
search page by URL manipulation. A test with the navigation explicitly defined can break when the
navigation changes, even though the application is working fine. Page prompting avoids this problem.

Tests that use page prompting are more repeatable. Consider the following test instruction:

1. At the Define Calculation search page, add a calculation with the name KUSPTEST
or, i1f it already exists, update it.

Using page prompting, a single step can navigate directly to the search page and either update or add a
key, whichever is needed.

PTF can be configured to insert page prompt constructs automatically during recording. The default
behavior is set by the PTF administrator on the Define Configuration Options page and can be overridden
during recording using the recorder utility tools.

See the Page type actions Prompt and PromptOK for more details.

Related Links

Prompt

PromptOK
Using the PTF Test Recorder with Internet Explorer

Using the PTF Recorder with Chrome and Microsoft Edge
Defining PTF Configuration Options

Use the Process Step Type

The Process step type with a Run action is useful for running processes through Process Scheduler.
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When you select the Use Process Run check box before you record a process request, all actions in
the run request standard page will be replaced by the step action Process.Run and any Process Monitor
actions that are recorded will be ignored.

You can set the Use Process Run check box using PeopleSoft Internet Architecture (select

PeopleTools > Lifecycle Tools > Test Framework > PTF Configuration Options) for all tests, or
you can select the check box from the Toolbar when you are ready to record a test (Configure Recording
Settings icon).

The Process.Run step will handle the runtime and return the process status. You can modify the
parameters on the Process.Run step to indicate the expected results.

Suppose you have the following test scenario:

From the Request Calculation page, click the Process Monitor link.
In Process Monitor, click the Refresh button until either Success
or Error appears in the Run Status column for your process instance.

The Process.Run step will capture all of the process information and you can modify the step parameters
in PTF.

Related Links

Process

Make Tests Dynamic

Many tests involve values and conditions that are not known until a test runs. Advanced functionality in
PTF enables you to build tests that adapt to the application when necessary.

These test scenarios show examples of how to exploit the dynamic test features of PTF:
*  Variables

Requirement: A test that creates an entry in the application with a system-generated ID number and
later has to verify that same ID number elsewhere in the application.

Solution: Store the system-generated ID to a variable in one step, and then reference that variable to
verify the value in another step.

* Conditional logic

Requirement: A test that specifies that the user click an icon to expand a section of a page, but only if
that section is not already expanded.

Solution: Place the step in an If Then construct that evaluates whether the section is expanded.

* Scroll handling
Requirement: A test that updates an item in a grid regardless of the position of the item in the grid.
Solution: Use a Scroll action to identify the row by key rather than by position.

* Reserved words

Requirement: A test that instructs the user to enter the date the test is processed into the application.
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Solution: Use the #TODAY reserved word to enter the current date.
Dynamic steps improve the reusability and maintainability of tests.

As you are recording, be sure to make a note of situations that require dynamic handling so you can take
advantage of the appropriate dynamic construct that will ensure that the test will work at runtime time.

Related Links

Using Variables
Using Conditional Logic

Incorporating Scroll Handling

Using Reserved Words

Reduce Duplication

Avoid creating tests and test steps that are duplicated elsewhere. When multiple tests validate similar
functionality, it increases the complexity of test maintenance and the amount of manual work necessary to
add or change test functionality later.

Follow these recommendations to help keep test duplication to a minimum:
* Drive similar tests into test cases.

Do this any time multiple tests have the same logic and where the only difference among the tests is
the data entered or validated. A test to hire two employees or to create ten new vouchers would be a
good candidate for taking advantage of test cases.

* Isolate sequences of test steps into called tests or libraries whenever the steps are identical.

A procedure that verifies or sets the same setting on an installation table would be a good candidate
for putting into a library if multiple products or tests modify the same setting.

Related Links
Calling Tests

Start Internet Explorer on the Home Page

Verify the Internet Explorer Startup section has the Start with home page seclected. Otherwise, it may get
difficult to record and playback.

Related Links
Installing a PTF Client
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Understanding the PTF Test Structure

A PTF test is composed of a series of steps. This example shows the steps in a simple test.

This example illustrates the fields and controls for a simple PTF test.

[E Test: PTD_PORTAL_CN_WEBPROFPROPSAVE
- Test Information Test Case Information

Name: [PTD_PORTAL_CN_WEBPROFPROPSAVE  [5 T Name: [1]  [DEFAULT B B =
Description: d @ Description: o O

% cut Rycopy [@raste | 3 acie Al - | 5 mertstep + | X Delete step @)step nformaton

Seq ‘\D Commert | Acive | S5 Tipe Acton Recogndion Parameters Value
P = Browser - | Statt_Login -
2 2l © | F Browser - | FrameSet ~
3 B O | F Page - | Prompt ~ | WEB_PROFILE WEB_PROFILE GBL update
4 4 ~ Browser + | FrameSet ~ | TargetCortent
5 47 ~ Button ~ | Click ~ |id=HICSearch
6 49 [ Browser - | FrameSet ~ | TangetCortent
7 50 |7 Link - | cick ~ |id-SEARCH_RESULT1
8 51 ~ Browser - | FrameSet ~ | TamgetContent
5 2 ~ CheckBox - | Get_Propery ~ | Name =PSWEBPROFWRK_DISABLEFLUID prop=Value et Adsablefiidprop
10 21 ~ CheckBox | Get_Property ~ | Name=PSVWEBPROFWRK_PTOVERIDEFLUIDFORD prop=Value ret =8overidefluicfordeskiopprop
n 2 o CheckBax - | Set_Value ~ | Name -PSWEBPROFWRK_DISABLEFLUID N
2 2 |7 CheckBox - | Set_Value ~ | Neme -PSWEBP ROFWRK_PTOVERIDEFLUIDFORD Y
13 24 e Page - | Save B

Each step in a test is composed of the following fields:

Term Definition

Seq (sequence) A system-generated sequence number. Test steps run
according to the Seq order. When you copy, move, add, or
delete a step, Seq is refreshed.

1D A system-generated unique identifier for each step, in a test.
The ID value does not change when you move, add, or delete
a step.

Test maintenance reports use the ID value.

Comment Click in this field to add a comment for the step.

Active Deselect this field to inactivate a step. PTF skips inactive steps
when executing the test. This field is grayed for inactive steps.

Scroll ID This field is required only for scroll handling.

Type The type of application object to take an action on or to
validate. Common step types are Text, Check box, Browser,
and so on.
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Term

Definition

Action

The action the test is to take on the object. The two most
common actions used on a Text object, for example, would be
Set Value and Verify.

Recognition

The means that PTF uses to identify the object within the
application. Commonly, this is the HTML ID property.

Parameters

The conditions that apply to this specific step, if applicable.

Note: This field was introduced in release 8.54; in previous
releases, parameters were specified as part of the Recognition
field. When you save a test from release 8.53 or lower, PTF
automatically moves any parameters from the Recognition
field to the Parameters field.

Field Label

Contains the label text of the page control referenced in the
Recognition field.

The value for the Show Field Label option in the Local
Options dialog box determines whether this column appears:

*  If Column is selected, the Field Label column appears.
+ If Tooltip is selected, the column does not appear;
instead, the field label appears in a tooltip when you

position the mouse cursor over the Value field.

For more information about setting local options, see
Configuring Local Options.

Value

In a typical recorded step, this is the value the tester entered
for an object.

In a step recorded in verify mode, this would be the value that
was present in the object when it was verified.

In general, a test has a single step for each instruction in a manual test case. For example, consider the
following manual test instruction:

12. Enter the wvalue "KUOOOl" into the text box labeled "Employee ID".

This test instruction could be represented in PTF as a step, as shown in this example:

This example illustrates the step to enter a value in an edit box.

Type

Action

Parmeters

Sea |\D‘Cummem|ﬁdwe‘ == ‘
10 o | e

- [set vaue

- [ Name=EMPLID

[kuaom |

The PTF test language syntax and vocabulary are designed to read like a technical version of English.
As a result, the function of most steps should be apparent from their construction and the context of

surrounding steps.

For a detailed reference of PTF step types and actions, see PTF Test Language
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PTF Test Language

This section discusses the components of the PTF test language.

Validation

Each step type allows only certain actions. Similarly, each action can only be used with certain step types.
The PTF Test Editor automatically limits your choice of actions based on the step type selected.

For example, if a step has the Type field set to 7ext and the Action field set to Set Value, you can change
the Action field to Verify since it is included in the list of available values for a text object.

This example shows a drop-down list with Verify as one of the values for the Action field when the Type
field is set to 7ext:

This example illustrates the drop-down list showing available actions for the step type:Text.

Teut * | Set_Value -
Ll « |Exists
ol Gell.absl

Link * |Get Propert
Lirk: i |"u-’erify |

Parameters

Typically, you place parameters in the Parameters field and use the following structure:
param=value;

Separate parameters with a semi-colon.

For example:

prcname=RCOM01; wait=true;

With a Radio object, you can also place parameters in the Value field.

See Radio.

Steps that return a value require the parameter ret=¢variable;

For example:

ret=&chart val;

The system ignores unneeded parameters. For example, Browser.Start and Browser.Start_Login do not
take any parameters, so the system ignores any values in the Recognition field for Browser.Start or
Browser.Start Login.
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Prompting

The PTF Test Editor provides context sensitive help for recognition and parameters. In the Recognition
column or Parameters column you can either press the F4 key, or double-click and then click the More
icon that appears, to view the help and enter the corresponding values.

For examples see Context Sensitive Help within Grid for Function Parameter Details

Variables

Variables enable you to work with steps in which the information or values are not known when you
create the test or the information or values for a step change each time the test executes.

You prefix variables with an ampersand (&).

In this example, the first step stores the value in the userid field to the variable & USERID. The second
step populates the pwd field with the value in the variable & USERID.

This example illustrates how variables can be used in test steps.

Type Action Recagrition Parameters Value

Text - | Get_Propety - | Name-userid ret=3USERID
Prd - | Set_Value = | Name=pwd USERID

Related Links
Variable

Using Variables
System Variables

Reserved Words
Similar to variables, you use reserved words to supply information that is not known until a test executes.

Prefix reserved words with a pound sign (#) and use them in the Value field of a test to verify a condition,
change the value in an application field, or both. In this example, the #70ODAY reserved word sets the
EFFDT_FROM field to the current date.

This example illustrates how the reserved word #TODAY can be used in a test step.

Type Action Recognition Parameters Value

Text ™ | Set_Value = |Name=EFFDT_FROM HTODAY

Related Links
Reserved Words

System Variables

System variables are predefined variables that PTF populates at runtime. System variables provide data
about the current environment, runtime options, test, and application.
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Because system variables are replaced with a text string at runtime, you can place a system variable
wherever you would place a text string. Commonly, test developers assign a system value to a user-
defined variable.

The following example shows two methods of assigning system variables to user-defined variables:

This example illustrates 2 methods for assigning system variables to user-defined variables.

Wariable * | Set_Value

ElLlzer

Zeo dbuser®

“Wariable = | Set Value

LT et=%tast

Related Links
System Variables

Syntax Check

If the syntax or value in a test step is not correct, the test will produce an error when the test is executed.
The Check Syntax option allows a user to validate the parameters provided in their steps either on save or
on demand prior to the run.

Check Syntax will:

Display an error message for any invalid or missing required parameter values.

Display a error message for any invalid optional parameter values.

Display a warning message when the return value of a step has not been entered.

Display an error window listing all errors and warnings found in sequential order for a test.

Note: There may be multiple errors in a single step.

Display an error when syntax is incorrect or missing, such as verifying that all Conditional.If steps are
paired with Conditional.End_if steps.

Note: Check syntax validates only active steps. Only syntax is validated, not data.

Check Syntax does not validate:
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PTF functions.

System variables.
Reserved words.
Condition sign.

File and folder names.
Duplicated parameters.

Missing values.
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* Parameter that is not available for the action.

* Missing parameter name.

Running On Demand Syntax Check

Chapter 9

After you have edited your test, select Test, Check Syntax or click the Check Syntax icon. The errors and
warnings will be displayed. When you click on the error or warning in the Test Check Syntax window, the

step is highlighted

in the test.

This example illustrates the check syntax dialog box with 2 errors.

@gedmo-denidd0z  Test  Edit  Debug  Tools Wwindow

DE S DB E e N DD ] ]

Help

qedme-deniddi2 ~ T& Test PB_OI_CHECK_SYN..

=
B Test: PB_01_CHECK_SYNTAX*

Test Infarmation

Mame: |FELI]LEHEEK75YNTA><

Description: |

S cut Bucopy [@Paste 2 activeal v E InsertStep ~

x

|5 =
| o @

Test Case Infoimation

Mame: (1] [DEFAULT v BB 2
Description: | | d D

2 Delete Step . Step Information

Seq 1D Comment | Active S%DH Tupe Action Recognition Valug
1 Browser = Start_Login

2 2| H-r [ - [ CNTR.GEL

3 z O Test +  Set_Value v [

4 = O Page - Promptk -

5 24 ] Link + | Get_Property = | Mame=PSIBINTMNET _WRE_IB_DOMAINS TAT ret=tstatus

B EI] Conditional = | IF_Then ~ | tstatus="No Domain Aclive"

! 13 = Link - Test Check Syntax \§|

8 14 2 ComboBox - g =
3 15 O Bulton T8 seq Type Action Enar | Calumn Message |
10 16 Button -d B 2 Prompt / 5

n | v O Buton 0 Coders B i Gymmas s, o e 1, |
12 1|8 O Link -0

13 w O Link - |
14 a7l O Conditional ol |
15 EI] Lag - e

* o |

If the syntax check does not detect any errors or warning, the dialog box will not return any rows of data:
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This example illustrates the check syntax dialog box with no errors.

@gedmo-denid002  Test  Edit  Dsbug  Tools  Window  Help
i E B N M5S0 D e By P erefic
) gedmo-denid02 v T Test CAT_D2_IB_GATEWAY Test PB_ON_CHECK_SYN.. X
Test Infarmation Test Caze |nformation
Name: |PB_O1_CHECK_SYNTAX | = B Mame: [1] |DEFALLT v B EE
Description; ‘ | g’ (] Description: | ‘ 43’ (¢D]
& By B 2 active Al JHInsertStep X (@) Step Information
Scroll
Seq ID Comment Active D Type Action Fecognition Walue
1 1| © Biowser - | Start_Login -
2 21 o] Page = | Prompt = | IB_INTNETwORK.PSIBNET_wRKCNTR.GEL update
3 2z O Text + | Set_Value v .
4 22 O Page = | PromptQlk -
5 24 @] Link. - | Get_Property = | Mame=PSIBINTNE T_WREK_IB_DOMAINSTAT ret=kstatus prop=innerT ezt
B Bl O Condiional 2ol chicotilo o 0
7 13 O Link Test Check Syntax
[ 1 O Combo
il Sl Seq Type Action Eror Column Message
3 = Button
1 16 & Buttan
11 1w O Bution
12 18 O Lirk
13 1@ O Link
14 7 O Condiional
15 @B O Lag
18 F ] Canditional
*

Automatically Running Syntax Check on Save

To have Syntax Check run automatically every time you save a test:

1. In PTF Explorer, click on your environment name and select Local Options.
2. In the Auto-Check Syntax field select Yes and click OK.

3. When you save a test, you will be prompted to run the syntax check.

Context Sensitive Help within Grid for Function Parameter Details
For any step type/action that includes parameters, you can press the F4 key or double-click in the

Parameters cell to display and enter the parameters. For each parameter, an explanation and example are
displayed. This is an example of the step Process.Run:
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This example illustrates the fields and controls on the Parameter dialog box for Step:Process.Run.

x|

prctype |BI Publisher

wait [false |
outtype | web =]
outformat [xmL |
outfile |CAPTFTEST\Output

expected | success |
ret |&Status

Outfile is the name of the output file location.
Bample: ““abc1000svrpubsitemp

[ ox |

Cancel

For some step types, for example Query, you can also double-click in the Value column to display and

enter parameters.

242
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Step Types

This section lists each of the PTF step types and defines the actions associated with the step type. The step
types are listed in alphabetical order.

Browser

Use the Browser step type to manage browser instances during test run.

Note: Beginning with release 8.55, PTF supports running multiple browser instances from a single PTF
client. This enables you to toggle between any or all open browsers. For example, you could use this
functionality to verify that an action from one browser instance would change the data displayed in
another browser instance.

To identify and manage each instance, you can assign a name, using a string or a variable, when it is
launched. If you do not specify a name parameter, then PTF will assign “browser 0 as a name for the
first browser, then “browser_1” for the second browser, and so on. If the 2nd browser is opened due to
using a specific FormFactor, then PTF uses the name “FormFactor”, similarly if it is opened due to a
query, the name assigned is “query”.

PTF also assigns each instance an index value automatically, and you can use the index to refer to

a specific instance. The first browser instantiated is assigned an index value of 0. The next browser
instantiated will have an index value of 1, and so on. If a given browser is closed, then the index value
for any browsers that were instantiated after that browser will decrease by 1, in other words the index is
dynamically updated by PTF.

These are the actions associated with the Browser step type.

Close

Description

Closes the current browser window (that is, the one with the execution focus).

CloseAll

Description

Closes all browser instances that were instantiated by the PTF client.

Note: Only browser instances that were instantiated by the same PTF client execution instance are closed.
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Count

Description

Determines the number of currently open PTF client-initiated browser instances.

Note: Counts only browser instances that were instantiated by the same PTF client execution instance.

Parameters

Parameter Description

ret=&variable Specify a variable to store the return value.
Exists

Description

Checks if a browser instance exists. Evaluates to true if it exists, false if it does not.

Parameters
Parameter Description
name=value The name of the browser instance, such as browserl.
ret=&variable Optional parameter. Specify a variable to store the return
value.
FrameEXxists
Description

Checks if a frame exists on a browser page. Specify the frame name in the value column.
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Parameter

Description

expected=value

Optional parameter. If used, PTF writes either a Pass or Fail
for the step in the test log, based on whether the matching
frame exists. If this parameter is not included, then only step
information is logged during execution.

For example:

expected=true Logs an error when the frame is not found;
logs Passed if found, logs Failed if not found.

expected=false Logs an error when the frame is found;
logs Passed if not found, logs Failed if found.

ret=&variable

Optional parameter. Specify a variable to store the return
value.

FrameSet

Description

Sets the focus in a browser frame.

Embedded frames include a number, such as ptModFrame 1. You can substitute ## for the number, for
example ptModFrame ## and PTF will search through all frames starting with ptModFrame and use the

one with the highest number.

Get_Active

Description

Gets the currently active browser instance’s name or index. Use in combination with Set_Active when
working with multiple browser instances, to control which one is active.

Parameters

Parameter

Description

name=<value>

index=<value>

ret=&variable

Optional parameter. Specify a variable to store the return
value.
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Example

The following example shows a PTF test step that uses the Browser.Get Active type/action.

Type Action Recognition Parameters Value

Browser Get_Active ret=&hook1

Set_Active

Description

Sets the active browser instance, when working with multiple browser instances. Use in combination with
Get_Active to control which browser instance is active when working with multiple browsers instances.

Example

The following example shows a PTF test step that uses the Browser.Set_Active type/action.

Type Action Recognition Parameters Value
Browser Set_Active &hookl

Set_URL
Description

Sets the portal type. Uses the URL for the selected portal type defined in the execution option to access
the component. This is the URL that is used with Page.Prompt.

Example

The following example shows a PTF test step that uses the Browser.Set URL type/action.

Start

246

Type Action Recognition Parameters Value
Browser Set URL EMPLOYEE
Description

Starts the browser instance where the test will be run. Uses the URL from the currently active runtime

option.
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Start_Login

Description

Test Language Reference

Starts the browser instance where the test will be executed and logs into the PeopleSoft application. Uses
the URL, user ID, password, and form factor from the currently active runtime option, and the language

selected in the test Language field.

Parameters

Parameter

Description

name=value

Optional parameter.

Assigns a name to the browser instance. This enables you
to manage multiple browser instances by referring to them
by their assigned name. You can use a string or a variable to
specify the name.

WaitForNew

Description

Waits for a new browser instance to open, then continues test run in that browser instance.

Specify a timeout value in seconds in the Value column. The default is 10 seconds.

Note: Microsoft Internet Explorer must be set to open pop-ups in a new window for PTF to recognize
new browser windows. To set this option, in Internet Explorer select Tools, Internet Options. Click the
Tabs button, then select Always open pop-ups in a new window, then click OK.

Parameters

Parameter

Description

name=value

Optional parameter.

Assigns a name to the new browser instance. This enables you
to manage multiple browser instances by referring to them

by their assigned name. You can use a string or a variable to
specify the name.

max=value

True — maximizes the window for the new browser instance.

False — keeps the existing window size for the new browser
instance.

The default is true.
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Example

The following example shows a PTF test step that uses the Browser. WaitForNew type/action. This

step launches a new test application browser instance with the window maximized, assigns the name
“browser1” to the browser instance, and waits 30 seconds before proceeding to the next test step. Test run
then continues in the new browser instance.

Type Action Recognition Parameters Value
Browser WaitForNew name="browserl”; 30
max=true

Button

This step type performs an action on a button. These are the actions associated with the Button step type.

Click

Description
The description for this action is in the Common Actions section.

See Click.
Exists

Description
The description for this action is in the Common Actions section.

See Exists.
Get_Property

Description

The description for this action is in the Common Actions section.

See Get_Property.
Get_Style

Description

The description for this action is in the Common Actions section.
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See Get_Style
Verify

Description

The description for this action is in the Common Actions section.

See Verity.

Chart

These are the actions associated with the Chart step type. The following actions are deprecated but
PeopleSoft still provides support for them:

e ChartGetType
*  GetText

¢ SectionCount

ChartClick

Description

Performs a mouse click on a clickable area of the chart. PTF recognizes the following HTML ID

properties:

HTML ID Property Usage

tag Returns an HTML SVG tag for the target clickable area. The tags are:
+ Circle
* Path
*  Polygon
*  Rectangle

fill Returns RGB values of an HTML object.
It is recorded if the tag attribute has no unique identifier.

index Returns the specific HTML object based on the HTML source. It
returns a number value.
It is recorded when multiple elements are present with same attributes.
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Type Action Recognition Parameters Value
Chart ChartClick tag=polygon|fill=rgb(83,110,209)|index=2

Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

Different business charts like Charts, Status Meter Gauges, LEG Gauge, Rating Gauge, and Spark Charts
support different properties, for example Charts support the following properties:

* FootNote

*  GroupCount
¢ MainTitle

»  SeriesCount
» SubTitle

*  Type

*  XAxisTitle

*  YAxisTitle

Note: Get Property on a Charts business chart does not support object oriented properties of a chart such
as series and so on.

See Get Property.

Example

The example is for Get Property action for JET Chart type.

Type Action Recognition Parameters Value
Chart Get_Property chart=2DBar idx=0;prop=XAxisTitle;
ret=&xtitle

Related Links
Get Property
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Verify

Description
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Compares the value in the browser to the expected value, and adds a pass or fail log entry for the

validation.

When you drag the Verify icon and drop it on a chart on the browser page, the chart is highlighted and the
Chart. Verify dialog box opens.

Chart. Verify dialog box appears where you enter the required properties of the chart.

Chart.Yerify ]
Chart Type 2DBar Froperty j IEI
Index 1] Expected INatiDnaI Fark.z T Advanced
Parameter Description
Chart Type Populated from the HTML tag.
Index Populated from the HTML tag. It is the index value of a chart
object when there are more than one chart on the same page.
Property Select from the available properties for a particular Chart
Type.
Expected Displays the value to be verified which depends on the
Property field. It is populated when a property is selected.
The field in some instances may remain blank if there is no
value to be verified.
Example

The table illustrates the Verify action for Chart step type.

Type Action Recognition | Parameters Value

Chart Verify chart=2DBar | idx=0;prop=MainTitle National Parks

Chart Verify chart=2DBar | idx=0;prop=ReferenceArea(1). Reference Area2
Description

Chart Verify chart=2DBar | idx=0;prop=DateSeries(1) GLACIER
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Related Links
Verify

ChartGetType

Description

Returns the chart type from a displayed chart.

Parameters
Parameter Description
chart=value; The index for the chart image on the page.
ret=&variable; The return value.
GetText
Description

Returns the text value for the specified chart section.

Parameters

Parameter Description

chart=value; The index for the chart image on the page.

idx=value; url=value; alt=value; The section recognition string. It can be the section index, the
section URL, or the alternative text.

ret=&variable; The return value.

Example

This is an example of the GetText action for a Chart step type:

Type Action Recognition Parameters Value

Chart GetText chart=0 idx=3;ret=&chart_val
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Type Action Recognition Parameters Value
Log Message The value for index 3 is
&chart val
Chart GetText chart=0 idx=2;ret=&chart
Log Message The value for index 2 is
&chart_val
SectionCount
Description

Counts the number of regions in a chart.

Parameters
Parameter Description
chart=value The index for the chart image on the page.

ret=&variable

The variable to store the return value.

The Chart.SectionCount returns the real value (not zero-
based). If you are using this variable in combination with zero-
based indexes, such as a For loop, you may need to subtract 1.

Example

This example illustrates using the SectionCount action with a loop to retrieve the text for each section.

Type Action Recognition Parameters Value
Browser Start Login
Browser FrameSet TargetContent
Page Prompt QE_CHART MENU. | urltype=default update
QE _CHART2.GBL
Text Set Value Name=QE_CHART CAR SALES
_RECORD_QE
CHART CATEGORY
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Type Action Recognition Parameters Value
Page PromptOk
Chart SectionCount chart=0 ret=&chart_count
Log Message ChartCount => &chart
_count
Loop For &var=0 to Subtract

(&chart_count|1)

Chart GetText chart=0 idx=&var;ret=&chart _
value
Log Message ChartValue => &chart_
value
Loop Next

CheckBox

These are the actions associated with the CheckBox step type.

Exists

Description
Checks whether the object exists on the page.

See Exists.
Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

See Get_Property.
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Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style

GetLabel

Description
Gets the label of the specified HTML object.

See GetLabel.
Set_Value

Description
Gets the label of the specified HTML object.

See Set Value.
Verify

Description

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the
validation.

See Verity.

ComboBox

These are the actions associated with the ComboBox step type.
Exists

Description
Checks whether the object exists on the page.

See Exists.
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Get_Property

Description
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Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to

the variable in ret=¢variable.

See Get Property.

Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to

prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style.

GetlLabel

Description

Gets the label of the specified HTML object.

See GetLabel.

Set_Value

Description

Sets the field value in the ComboBox to the value specified in the Value column.

You can also use this action with the #LIST# reserved word to verify whether items exist in the list.

When used with #LIST#, Set Value returns an error if the expected value (the bracketed value) is not the
same as the actual value.

Example
This example sets the field value to French and verifies that the values English, French, and Finnish exist
in the list.
Type Action Recognition Parameters Value
ComboBox Set_Value name=PSOPRDEFN_ #LIST#English|
LANGUAGE _CD [French]|Finnish
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Related Links
#LIST#

ValueEXxists

Description

Checks whether a specified value exists in a combo box. Enter the value to be verified in the Value field.
The full text entry or the metadata translation (XLAT) value can be specified for the value; PTF will
consider either as a match.

Parameters

Parameter Description

expected=value Specify expected=true or expected=false. Logsa
Pass or Fail based on whether the ret parameter matches the
expected parameter.

ret=&variable; ret=true — the value exists
ret=false — the value does not exist

Example

This example checks if the PA CALCULATION_ TYPE combo box contains Automatic, and logs a Fail if
it does not exist.

Type Action Recognition Parameters Value
ComboBox ValueExists name=PA _ expected=true;re Automatic
CALCULATION _ t=&CalcType
TYPE
Verify
Description

Compares the value in the browser to the expected value and adds a Pass or Fail log entry for the
validation. Use a vertical pipe (|) to separate values to be verified. Use square brackets ([]) to specify
which value is expected to be selected.

Example

This example verifies that the field value is set to Two and verifies that the values One and Three exist:
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Type Action Recognition Parameters Value
ComboBox Verify name=DUMMY _ One|[Two]| Three
FIELD
Command

Use the Command step to run a command line program. The command step has one associated action:
Exec.

Exec

Description

Runs a command line program.

Parameters

Parameter Description

name=commandname The command name as defined on the Define Configuration
Options page.
See Defining PTF Configuration Options.

timeout=seconds The number of seconds before the program times out.

ret=c&variable The variable to store the return value.

Example

This is an example of a command line program that requires multiple parameters.

Type Action Recognition Parameters Value
Command Exec name=TEXT COMP timeout=60; WORDVP c:\temp
ret=&return \base.txt c:\temp\actual.
txt c:\temp\comparison.
doc

If the command line program is used in multiple tests, you should create a library test for the command.
This example shows a test library created for the FILEKILL command. The command has one parameter
FILENAME.
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Note: FILEKILL and FILECHECK commands are examples of possible utilities to call from PTF, they
are not delivered with PTF. Customers are responsible for creating their own command line programs.

This example illustrates the FILEKILL command.exec step, it has one parameter FILENAME. This
command will look for a specific file and delete it if it exists. If the file cannot be deleted it returns a 1.

Test Information

Hame: [FILEKILL_LIB

K=K

Desciption: |

[« ©

S ocut Bycopy [@Paste 2 Active sl -

X

o Insert Step =

Test Case Infarmation

Mame: [1]  [DEFAULT

v

Desciiption: |

Test Properties

Test Properties

Last Updated:  8/1/2012 £:43:58 PM

Updated By : E

Delete Step ®Step Information

Seq

3 K=
2 5 O
3 =
4 8 O

1D Comment  Active

HEEEE

Scroll
1D

Type
Command
Conditional
Log

Conditional

afafafaf4

Exec
If_Then
Fail
End_If

Action

Recaognition
name=FILECHECK timeout=B0 1et=tRetvar
&Retvar =1
Unable to kill file

Language [*]: English -~

[*] Language: Changing the value only affects the language the test selects at

exeoute agains! a diferent language. PTF tests should be execuled against thel

were recorded.

Library Test

Parameter list

This is an example of the calling test, which illustrates how the command can be called from a test. This
test will delete the file before running a process to create a new file.

Type Action Recognition Parameters Value
Browser Start_Login
Variable Set_Value &filename c:\Labs\files\menu.pdf
Test Exec FILEKILL LIB; DEFAULT
FILENAME=&filename
Browser FrameSet TargetContent
Page Prompt PROCESS add update
SCHEDULER.
PRCSMULTI.GBL
Text Set_Value Name=PRCSRUNCNTL test
_RUN_CNTL_ID
Page PromptOk
Process Run prename=XRFWIN pretype=BI
Publisher;outtype=File;
outformat=PDF;outfile=&filename
Text Exec FILECHECK DEFAULT
LIB;FILENAME
=&filename
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Conditional

Else

You can control the flow of execution of tests using conditional constructs. A conditional construct begins
with an If Then action and ends with an End_If action. You can optionally include an Else action.

Conditional constructs can be nested.

These are the actions associated with the Conditional step type.

Description

(Optional) If the logical expression evaluates to False, the system runs the steps between the Else step and
the End_If step.

End_If

Description

The close statement of the If Then construct.

If_Then

260

Description

The first step in a conditional construct. The system evaluates the logical expression in the Recognition
field of the If Then step. If the expression evaluates to True, the system runs the steps between the

If Then step and the End_If step or the Else step, if it exists. If the expression evaluates to False, the
system jumps to the Else step, if it exists, or to the End If step if there is no Else step, and continues the
run.

If Then supports these logical operators:
<> >= <= > < =

You can use the AND and OR logical operators to specify multiple conditions.

Example

This example shows the use of multiple conditions and nested conditionals:

Type Action Recognition Parameters Value

Variable Set_Value &lInteger 3
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Type Action Recognition Parameters Value

Conditional If Then &lnteger>=1 AND
&lInteger<=10 OR
&lInteger=0

Log Message Determine if integer is
odd or even

Log Message Enter first nested
conditional

Conditional If Then &lInteger=0

Log Message Do not divide by 0

Conditional Else

Variable Set Value &Half=Divide
(&Integer|2|dec=1)

Log Message Enter second nested
conditional

Variable Set_Value &0dd=Substr(&Half]3)

Conditional If Then &0dd=5

Log Message The number is odd

Conditional Else

Log Message The number is even

Conditional End If

DatalLoader

Use the DatalLoader step type to map a query to a test. You can run the test using query results. You do not

have to create test cases each time you want to use new data for an existing test.

Load is an action associated with DataL.oader step type.
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Related Links

Mapping PSQuery to a Test
Configuring Execution Options in PTF Client

Load

Description
Loads the query and its parameters to the test. The Edit Datal.oader dialog box accessed from the
Recognition field displays options to map the query. See Editing the Datal.oader Step Type.
Parameters

Parameter Description

source Specifies the name of the PSQuery in current Dataloader.
sourceType Specifies the source of the data, for example ‘NMQ’ means the

data source is PSQuery.

params=<SOURCE_PARAM1>:<PARAM VALUEI> Specifies the parameter names and their values of the
[,<SOURCE_PARAM?2>:<PARAM_VALUE2>] PSQuery.

ownType Specifies the type of owner, whether the query is public or

private.

rowcount=c&variable Returns the row count of query result set.

Example

This example shows the Dataloader step type with MESSAGES FOR_MSGSET query and the
parameters.

Type Action Recognition Parameters Value
DataLoader Load name=Sourcel source=MESSAGES FOR
MSGSET;ownType=public;params=MESSAGE _ SET _
NBR:&message;
DataMover

This is the action associated with the DataMover step type.
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Exec

Description
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Runs a PeopleSoft Data Mover script. Specify the script name in the Value column. PTF uses the
locations specified in the Data Mover section of the Execution Options - PeopleTools tab as the paths for

the DMS files. If the DMS Output Path is not defined, it uses the system temp folder.

Example

This example shows the use of the Exec action:

Type Action Recognition Parameters Value
DataMover Exec C:\Temp\emp_imp.dms
DateTime

These are the actions associated with the DateTime step type.

Exists

Description

Checks whether the object exists on the page.

See Exists.
Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to

the variable in ret=¢variable.

See Get_Property.
Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to

prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style
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GetLabel

Description
Gets the label of the specified HTML object.

See GetLabel.
Set_Value

Description
Gets the label of the specified HTML object.

See Set_Value.
Verify

Description

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the
validation.

See Verify.

Div
Use the Div step type to interact with Div objects. These are the actions associated with the Div step type:

Click

Description
Performs a mouse click on the specified object.

See Click.

Drag_From

Performs the action of dragging a PTF object. It is followed by the Drop_Over action where a previously
selected object is dragged and released over a newly selected object on the same page.

See Drag_From.
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Drop_Over

Performs the action of dragging and releasing a PTF object over a newly selected object on the same
page. It is preceded by the Drag_From action where a previously selected object is dragged from a
position.

See Drop_Over.

Exists

Description
Checks whether the object exists on the page.

See Exists.
Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

Use the HTML Browser feature of the Message tool to identify the properties and values of an object.
When this step type is recorded tagName and id properties are always shown.

See Using the Message Tool.

Use the browser's in-built element inspector to identify the properties and values of an object.

See Recording Tests

See Get_Property.
Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

You can use the HTML Browser feature of the Message tool to identify the properties and values of an
object.

See Using the Message Tool.

You can use the browser's in-built element inspector identify the properties and values of an object.

See Recording Tests

See Get_Style.
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MouseOut

Description

Gets the hexadecimal value of the background color of an object when the mouse cursor moves away
from it.

If during playback the same background color value is not found, then the step will fail. You can find the
details in the log.

The action is only recorded on grids which has class ps_grid-row psc_rowact and type Div

Example

The following example shows test steps where a mouse out is recorded with background color as
transparent. On playback if the background color value is not transparent when the mouse rolls out from
the object, the step will fail.

Type Action Recognition Parameters Value

Div MouseOut Id=Book$0_row 0 Prop=background-color|bgover_
value=transparent

MouseOver

Description
Gets the hexadecimal value of the background color of an object when the mouse cursor rolls over it.

If during playback the same background color value is not found, then the step will fail. You can find the
details in the log.

The action is only recorded on grids which has class ps_grid-row psc_rowact and type Div

Example

The following example shows test steps where a mouse over is recorded with background color as #ded.
On playback if the background color value is not #ded when the mouse is on the object, the step will fail.

Type Action Recognition Parameters Value
Div MouseOver 1d=Book$0_row 0 Prop=background-color/bgover
value=#tded
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Scrolllt

Description

Activates the scroll in a Div object to refresh the data with the next set of records. The Recognition field
should contain the Div id property.

Typically this step.action is inserted during recording (recommended), by using the recorder toolbar;

however, you can also use the Message tool browser's inbuilt element inspector to determine the Div id
property when adding Div.Scrollit steps as you edit a test. A Div.Scrolllt step should be added for each
browser refresh that is required to access the desired record; multiple Div.Scrolllt steps may be needed.

Runtime

Use the Runtime actions in shell tests to modify the behavior of tests during runtime. You typically set
these options as you are developing tests to facilitate the development process.

The Runtime step type is available only in shell tests.
Set_Options

Description
Override the default runtime option. Specify the name of a valid runtime option in the Recognition
column.

Skip_Login

Description
Specify True or False in the Recognition column. Specify True to skip Browser.Start Login steps.

Specify False to run Browser.Start Login steps.

Skip_PageSave

Description

Specify True or False in the Recognition column. Specify True to skip Page.Save steps. Specify False to
run the Page.Save steps. You would, for instance, select this option to avoid creating duplicate values if
you plan to run a test repeatedly.

This action overrides the Skip PageSave setting in Runtime Options.
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Skip_RunRequest

Description

Specify True or False in the Recognition column. Specify True to skip Process.Run steps. Specify False
to run the Process.Run steps.

This action overrides the Skip RunRequest setting in Runtime Options.

StopOnError

Description

Specify True, False or ALL in the Recognition column.

Specify True to stop runtime on the current called Test when a Fail is logged.

Specify False to continue runtime when the called test encounters a Fail.

Specify ALL to stop shelltest runtime when any called test encounters a Fail.

This action overrides the Stop on Error setting (located in the Debug menu of the Test Editor).

However, Stop On Error (-SOE ) parameter in command line runtime overrides the StopOnError runtime
action in shell tests script.

For details on -SOE parameter, see Using the Test Editor

Related Links
Configuring Execution Options in PTF Client

File

The File step type corresponds to the object in the PeopleSoft Internet Architecture that enables users to
upload and download files to/from the PeopleSoft application.

These are the actions associated with the File step type.

Download

268

Description
Used to download a file.

The File.Download step needs to be preceded by the appropriate click (such as Image.Click, Link.Click,
or Button.Click). In the Value column specify a full file path name.

Select the File Download Prompt check box in the Settings dialog box to be prompted for a file download
path when recording the test.
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To set the file download prompt check box:

1. Click the Show Test Recorder icon.

2. Click the Configure recording settings icon.

3. Select File Download Prompt check box and click OK.

Test Language Reference

4. Record your test and you will be prompted for the file download path when you record a download

step.

Example

The following examples show the use of File.Download.

This example illustrates the Download action for downloading a Query to Excel

Type Action Recognition Parameters Value
Link Click Name
=QRYRUNEXCELS$0
File Download CA\TEMP\EXCEL
TEST.XLS
This example illustrates the Download action from a button.
Type Action Recognition Parameters Value
Button Click Name=FILE ATTACH
_WRK_ATTACHDET
File Download CATEMP\TEXTI1.TXT
Upload
Description

Uploads a file from an HTML file object.

In the Recognition column specify the name of the HTML file object. In the Value column specify a full

file path name.

Example

This example shows the use of the Upload action:
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Type Action Recognition Parameters Value

File Upload name=#OrigFileName CA\TEMP\MyFile. TXT

Upload_ByLink

Description
Uploads a file from an HTML link object.

In the Recognition column specify the name of the HTML link object. In the Value column specify a full
file path name.

Header

These are the actions associated with the Header step type:

Exists

Description
Checks whether the object exists on the page.

See Exists.
Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

See Get Property.
Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style.
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Verify

Description

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the
validation.

See Verity.

HTMLTable

These are the actions associated with the HTMLTable step type.

CellClick

Description

Clicks on a specific HTMLTable cell based on the index parameter.

Parameters
Parameter Description
index=I/R/C: The table, row, column index string.
For example:
index=&CellIndex
index=1/2/3 ;
In the second example, CellClick clicks on the third column of
the second row of the first table.
CellClickOnChkB
Description

Clicks the check box specified in the table cell location based on the index parameter.
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Parameter

Description

index=I/R/C:

The table, row, column index string.
For example:
index=&CellIndex
index=1/2/3;

In the second example, this function clicks on a check box
within the third column of the second row of the first table.

chkidx=value;

The CheckBox object index inside the cell.

check=value;

check=Y — Select the check box.
check=N — Deselect the check box.

This parameter is optional. The default value is Y.

CellClickOnlmage

Description

Clicks the image specified in the table cell location based on the index parameter.

Parameters

Parameter

Description

index=1/R/C

The table, row, column index string.
For example:
index=&CellIndex
index=1/2/3;

In the second example, this function clicks on an image within
the third column of the second row of the first table.

alt=value

Optional parameter. The alt property value of the HTML
image to click.

title=value

Optional parameter. The title property value of the HTML
image to click.
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CellClickOnLink

Description
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Clicks the link specified in the table cell location based on the index parameter.

Parameters

Parameter

Description

index=I/R/C:

The table, row, column index string.
For example:
index=&CellIndex
index=1/2/3;

In the second example, this function clicks on a link within the
third column of the second row of the first table.

link=value;

The link text value.

CellExists

Description

Determines whether a cell exists.

Parameters

Parameter

Description

index=I/R/C:

The table, row, column index string.

For example:

index=&CellIndex

index=1/2/3;

In the second example, this function verifies whether a cell

exists within the third column of the second row of the first
table.

ret=&variable

The return value.

True — the cell exists.

False — the cell does not exist.

Copyright © 1988, 2023, Oracle and/or its affiliates.

273



Test Language Reference

CellGetindex

Description

Chapter 10

Searches the page for the text value specified in the text parameter and returns the index string for the first
cell that contains the text. The index string is in the form of I/R/C, where [ is the table index, R is the row
number, and C is the column number. Other actions, such as CellClick, CellGetValue, and so on, use an

index string to reference a specific cell.

Use the GetCelllndex button on the recorder toolbar to capture the text value and return a variable for the

index.
Parameters
Parameter Description
text=value; The text to look for on the page.

index=value;

Optional. If a value is entered it is used to start the search for
the text. If the value is blank, PTF will start to look for the text
in the index 1/1/1.

equal=value;

equal=true performs an exact match on the text to search
for. This is the default for this optional parameter.

equal=false uses a LIKE statement when performing the
search.

expected=value

Optional. If used, PTF writes either a Pass or Fail for the step
in the test log based on whether a matching object exists. If
this parameter is not included, then only step information is
logged during execution.

For example:

expected=true Logs an error when the expected value is
not found; logs Passed if found, logs Failed if not found.

expected=false Logs an error when the expected value is
found; logs Passed if not found, logs Failed if found.

ret=&variable

The return value is an index string in the form of I/R/C, where
1 is the table index, R is the row number, and C is the column
number.

For example:

ret=&CellIndex
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This example illustrates using the CellGetIndex to return a variable for the index, then creating a variable
for the html cell that is to the left of the original cell using the sum function, and then clicking that cell. In
this example PTF will start to look for the text in table 7, row 1, column 1.

Type Action Recognition Parameters Value
Browser Start_Login
Browser FrameSet
Link Click id=pttabpercontent
Browser FrameSet PtModFrame ##
HTMLTable CellGetIndex text=BI Publisher index=7/1/1;equa
I=true;ret=&htmlindex
Variable Set_Value &htmlindex sum(&htmlindex|-1|
317/)
HTMLTable CellClick index=&htmlindex
Page Save Name=PORTAL _
HPWRK_HTMLAREA
CellGetValue
Description

Returns the contents of an HTMLTableCell.

Use the CellGetValue button on the recorder toolbar to capture the index value and return a variable for

the value.
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Parameter

Description

index=I/R/C:

The table, row, column index string.
For example:
index=&CellIndex
index=1/2/3;

In the second example, this function returns the contents of the
third column of the second row of the first table.

ret=&variable

The return value.

ColCount

Description

Returns the number of columns for the HTMLTable row.

Parameters
Parameter Description
table=value; The table index.

row=value;

The row index.

index=I/R/C:

An index string in the form of I/R/C, where I is the table
index, R is the row number, and C is the column number.

As an alternative to specifying the table and row parameters,
you can specify an index string, such as the return value from
a CellGetIndex action.

For example:

index=&CellIndex;

ret=&variable

The return value.

RowCount

Description

Returns the number of rows for the HTMLTable.
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Parameters
Parameter Description
table=value; The table index.

index=I/R/C:

An index string in the form of I/R/C, where I is the table
index, R is the row number, and C is the column number.

As an alternative to specifying the table parameter, you
can specify an index string, such as the return value from a
CellGetIndex action.

For example:

index=&CellIndex;

ret=&variable

The return value.

Image

These are the actions associated with the Image step type.

Click

Description
Performs a mouse click on the specified object.

See Click.
Exists

Description
Checks whether the object exists on the page.

See Exists.
Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to

the variable in ret=¢variable.

See Get_Property.

Copyright © 1988, 2023, Oracle and/or its affiliates.

277



Test Language Reference Chapter 10

Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style.

RightClick

Description

Performs a right-click on the image. This action is supported only for a related-content image glyph.

Label

These are the actions associated with the Label step type:
Exists

Description
Checks whether the object exists on the page.

See Exists.
Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

See Get_Property.
Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style.
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Verify

Description

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the
validation.

See Verity.

Link
These are the actions associated with the Link step type.

Click

Description
Performs a mouse click on the specified object.

See Click.

Drag_From

Performs the action of dragging a PTF object. It is followed by the Drop_Over action where a previously
selected object is dragged and released over a newly selected object on the same page.

See Drag_From.

Drop_Over

Performs the action of dragging and releasing a PTF object over a newly selected object on the same
page. It is preceded by the Drag_From action where a previously selected object is dragged from a
position.

See Drop_Over.
Exists

Description
Checks whether the object exists on the page.

See Exists.
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Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

See Get Property.
Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style.
SaveTargetAs

Description

Performs a right-click, save as action on a link. Enter the link name in the Recognition column and the
fully-qualified file name in the Value column.

Example

This example shows test steps that save a report to a target location. From the View Log/Trace page
(PMN_CDM INDEX) in the Process Monitor, it clicks on the report name link, verifies it is the correct
report, and then saves the report to a file.

Type Action Recognition Parameters Value
Link Click Name=PMN _
DERIVED INDEX
BTN
Link Verify Name=URLS$0 DDDAUDIT_532.PDF
Link SaveTargetAs Name=URLS$0 CA\TEMP\DDDAUDIT.
PDF

280 Copyright © 1988, 2023, Oracle and/or its affiliates.




Chapter 10 Test Language Reference

Verify

Description

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the
validation.

See Verity.

List

These are the actions associated with List step type.

Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to the
variable in ret=&variable.

Related Links
Get_Property

Log

Use the Log step type to add entries to the PTF execution log.

Text specified in the Recognition field is written to the log and is displayed as a line in the tree view and
in the Message field in the Details pane. Text in the Value field is written to the log and is displayed in the
Details field in the Details pane when the corresponding line is selected in the tree view.

These are the actions associated with the Log step type.

Fail

Description

Logs an entry with a status of Fail.
Message

Description

Logs a message with a status of Info.
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Note: A message is not written to the log if the Verbose field is set to False in execution options.

Pass

Description

Logs an entry with a status of Pass.

SnapShot

Description

Logs an entry with an image of the current screen.

Warning

Description

Logs an entry with a status of Warning.

Example

This example illustrates Log actions:

Type Action Recognition Parameters Value

Browser Start_Login

Variable Set Value &Var Place this text in the

variable

Log Message This is the text of the
variable - &Var

Log Fail Fail, Pass, and Warning
are used in conditional
constructs

Log Pass Text in the Recognition Text in the Value field
field is written to a line appears in the Detail
in the tree pane.

Log Warning This text is in the This text is in the Value
Recognition field field
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Type

Action

Recognition

Parameters

Value

Log SnapShot

Double-Click to view
the image

This log example shows how text from the Log actions appears in the Log Viewer:

This example shows the test execution log that is generated when the test above is executed.

$\Users\PTFTRNILOG_ACTIONS\2. PTFTRN 2016-09-23 16:47

[~ Details:

Test Start: 92372016 4:47:07 FM

< Browser Start_Login

I Frame setto”
@ Goto URL
B Browser.Login
=@ Doing login in English
L@ combobox.Set_Value [id=ptiangsel] = ENG
O text.Set_Value [id=userid]
@ pog.Set_Value id=pad]
I h% Click [rame=Subrmit]
© Variskle 8Var setto Place this text in the varisble
© This is the text of the variable - Place this tesxt inthe variable
P Fail, Pass, and Warning are used in conditional constructs
il LogScreenshat
[ Text inthe Recognilion field s writtento  ine in the tree
1 This text i in the Recognition field
8l Screenshot: Double-Click to wiew the image
o Test Enet: 9r232016 447:21 PM

5 1. Execution Options
Name
PromptOptions
Appl- Uil
Appl - User
Appl - Process Server
Appl - Date Fomat :
Quiput - LogFolder:
Output - Verbose
Debug - Skip PageSave
Debug - Skip RunFlequest
PTook - Path
FTook - DB Name
FTook - DB User
FTook - Server
FTook - Platform
Appl - Skip Language
Appl - Fom Factor
2 TestInfo
Parent Folder
Test Name
Test Case Name
3. System Info
Machine Name
Sereen resolution
Processar
Operating System full name:
Operating Sytem version
Memary Total
Memory Avaiable
Biowser :
05 Lang Code:
B 4 Environment Info

UserID

Env. URL

m

o

B 5 Estra Info

T1B85501
Na

it dedddr! 8p1. us. oracle. com: 801 0/psp 185501 /Zemd-loginblanguageCd

PTFTRN
PSNT

MMADD Ay
CATHY

Yes

o

Na

Ho
N

$\sars\PTFTAN
LOG_ACTIONS
DEFAULT

EDDDR1SFT
1600 X 900 pivels

Irtel[R) Core[TH) i7-4770 CPU @ 3 40GH2
Micrasoft Windows Server 2008 A2 Enterpiise

£.1.7601.65536
16178 Wb

9182 Mb

internet explorer 11
ENG

PTFTRN

hittps: //EDDDR18P1:4430/PSIGW HttpListeningConnector

Detaits:

| Warning  Message: [This test is in the Recogrition field Time:  [1B:47:20
(This text is in the Value field
TestSeq | 6 Evpre Loa > Waming - This tetis in the Flecogriion field Ly, |

LongText

These are the actions associated with the LongText step type.

Exists

Description

Checks whether the object exists on the page.

See Exists.

Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.
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See Get_Property.
Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style

GetLabel

Description
Gets the label of the specified HTML object.

See GetLabel.

Set_Value

Description
Gets the label of the specified HTML object.

See Set Value.
SetValue_InModal

Description

Use the SetValue InModal action to set the value of a long text field on a modal page.
Verify

Description

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the
validation.

See Verify.

Loop

These are the actions associated with the Loop step type.
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Do
Description
Executes the steps between a Loop.Do step and a Loop.End_Loop step, until a Loop.Exit_Loop step is
encountered.
Example
This example illustrates a Loop.Do construct.
Type Action Recognition Parameters Value
Variable Set Value &Var =0
Loop Do
Log Message The variable is & Var
Conditional If Then &Var>3
Loop Exit Loop
Conditional End-If
Loop End Loop
End_Loop
Description
Terminates a Loop.Do or Loop.While construct.
Exit_Loop

Description

Exits a Loop.Do, Loop.For, or Loop.While construct. Execution continues with the step after the
End_Loop step. Typically, a Loop.Exit_Loop step is placed within a conditional construct.
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For

Next

286

Syntax

&variable=begin_value to end value;

Description

Executes the steps between a Loop.For step and a Loop.Next step until the expression in the Recognition
field evaluates to False, at which point the execution skips to the step immediately after the Loop.Next
step.

Parameters

Parameter Description

&variable The variable to be used in the comparison. This variable is
incremented in the Loop.Next step.

begin_value The starting value.

end value The ending value.

Description

Terminates a Loop.For construct. Loop.Next increments the variable in the Loop.For step.

Example

This example illustrates using the Loop.For with Loop.Next to terminate the loop.

Type Action Recognition Parameters Value
Variable Set_Value &Var =0

Loop For &Var=1to 5

Log Message The variable is & Var

Loop Next
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While

Description

Executes the steps between a Loop.While step and a Loop.End_Loop while the expression in the
Recognition field evaluates to True.

When the expression evaluates to false, execution skips to the step after the Loop.End_Loop step.

Example

This example illustrates a Loop.While construct.

Test Language Reference

Type Action Recognition Parameters Value
Variable Set_Value &Var =0

Loop While &Var <=3

Log Message The variable is & Var

Variable Set Value &Var = add[& Var|1]

Loop End Loop

MsgBox

Use the MsgBox step to insert manual steps in your test for steps that cannot be automated in PTF. For

example, if your test includes a step to drag and drop on a page, you will not be able to automate the drag
and drop feature. By using the MsgBox step, the message will be displayed allowing the user to perform
the action manually, once the user dismisses the message box PTF execution will continue.

All of the actions associated with MsgBox step type use the same parameters.

Actions for MsgBox Step Type

The following actions are associated with the MsgBox step type, all of the actions use the same

parameters.
Action Description
AbortlgnoreRetry Creates a message box that contains 3 buttons- Abort, Ignore,
and Retry.
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Action Description

OKCancel Creates a message box that contains 2 buttons- OK and
Cancel.

OKOnly Creates a message box that contains 1 button- OK.

RetryCancel Creates a message box that contains 2 buttons- Retry and
Cancel.

YesNo Creates a message box that contains 2 buttons- Yes and No.

YesNoCancel Creates a message box that contains 3 buttons- Yes, No, and
Cancel.

Parameters

Parameter Description

prompt=value;

The text string displayed in the message dialog box.

To include a line break within a text string, use <NL>. For
example:

prompt=Newline Message Prompt!!
<NL>Linel<NL>Line2<NL>Line3

Creates the following text string:

Newline Message Prompt!!
Linel
Line2
Line3

title=value;

The text string displayed in the title bar of the message dialog
box.

ret=&variable;

The variable name that will store the integer indicating which
button the user clicked.

Return Values

The return value is based on the button that was pressed by the user during test execution:

Button Pressed

Return Value

OK
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Button Pressed Return Value
Cancel 2

Abort 3

Retry 4

Ignore 5

Yes 6

No 7
Example

In this example variables are created to store the text for the prompt and title. The message box is created
as a YesNo message box. If the Yes button is pressed by the user, the return value will be 6.

Type Action Recognition Parameters Value
Variable Set Value &TestStep Manually drag and drop
Variable Set Value &Prompt Was manual test
successful?
MsgBox YesNo prompt=&Prompt;title
=&TestStep;ret=&ret
Conditional If Then &ret=06
Log Pass Manual step & TestStep
Passed
Conditional Else
Log Message Manual step & TestStep
Failed
Conditional End If
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Based on the test steps in the example above, the message box is created.

E ——
Manually drag and drop |§|

Was manual kest skep successful?

Yes l [ Mo ]

MultiSelect

MultiSelect allows you to select multiple values. The values are separated by a pipe (|). These are the
actions associated with the MultiSelect step type.

Exists

Description
Checks whether the object exists on the page.

See Exists.
Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

See Get_Property.
Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style.

GetLabel

Description
Gets the label of the specified HTML object.

See GetLabel.
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Set_Value

Description
Gets the label of the specified HTML object.

See Set_Value.
Verify

Description
Checks whether the object exists on the page.

See Verify.

MultiSelect Example

This is an example of using MultiSelect on the Portal Layout page. In this example, you select 3 values in
the first column (col0) and move them to the second column (coll), then verify the values.

Type Action Recognition Parameters Value
Browser Start_login
Browser FrameSet
Link Click id=pttabperlayout
Browser FrameSet ptModFrame ##
MultiSelect Set_Value Name=col0 Calculator|Calendar|
Dictionary
Image Click Name=moverightimg
MultiSelect Verify Name=coll Calculator|Calendar|
Dictionary
Page Save Name=PORTAL
HPWRK_HTMLAREA
$178

Copyright © 1988, 2023, Oracle and/or its affiliates. 291



Test Language Reference Chapter 10

Number

These are the actions associated with the Number step type:
Exists

Description
Checks whether the object exists on the page.

See Exists.
Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

See Get_Property.
Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style.

GetLabel
Gets the label of the specified HTML object.

See GetLabel.

Set_Value
Gets the label of the specified HTML object.

See Set Value.

Verify

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the
validation.

See Verity.

292 Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 10 Test Language Reference

Page
These are the actions associated with the Page step type.
Expand

Description

Attempts to expand all the collapsed sections on the current page.

Go_To

Description

Accesses a page by selecting a page tab. Enter the tab name in the Recognition field.

Example

This example illustrates the Go_To action for a page.

Type Action Recognition Parameters Value
Page Go_To Roles
Prompt
Description

Opens a component based on the MENU.COMPONENT.MARKET recognition string.

If the component has a search page, use the Page.PromptOk action to close the search page.
In the Value field, you must provide an action. The valid values are:

* add

e addupdate

» add correct

* update

e update all

e correction
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Parameters

Parameter Description

urltype= value Specify the URL format (if it contains ‘psp’ or ‘psc’). Valid
values are:
+  content
e default
*  portal

waitForTime=value Specify the time in seconds. The test execution will proceed
after the specified time. Using the parameter you can provide
time for the page to load before the next steps in the test are
executed.
Note: Use the waitForTime parameter with
urltype=portal.

PromptOK

Description

Closes the search page. If the action specified in the Value field is update, then this action selects the first

returned value.

Example

This example illustrates the use of the Prompt and PromptOK actions.

Type Action Recognition Parameters Value

Page Prompt SQA_MENU.SQA urltype=portal add update
SIMPLECOMP.GBL

Text Set Value name=SQA Us001
SIMPLEREC_SQA _
DATAID

Page PromptOK
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Save

Description

Attempts to save the current page. This action checks for the SkipSavePage flag in the execution options.
For non-standard pages, the non-standard save object is recorded in the recognition column.

Example

This example illustrates a non-standard page save, where the non-standard save object is defined in the
recognition field.

Type Action Recognition Parameters Value

Page Save Name=PORTAL
HPWRK_HTMLAREA

SecPage_Close

Description

Closes the secondary page. No parameters are used.
SecPage_Open

Description

Opens a secondary page.

Parameters

Parameter Description

page= value Specify the name of the secondary page.
Example

This example illustrates the SecPage Open action.

Type Action Recognition Parameters Value
Page SecPage Open Name=SQA _ page=SQA _
SIMPLEREC SIMPLESUBPAGE
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Process
The Process actions run processes through Process Scheduler.
Run

Description

Runs a Process Scheduler process.

Parameters

Parameter Description

precname=value; The process name.

pretype=value: The process type.

wait=value; True - the test waits for the process to finish.
False - the test does not wait for the process to finish.

The default is False.

distribution_expected=value The status of the file to be posted.
Values are:

+ NA

* None

*  Generated

*  Posting

»  Not Posted

*  Posted

If the distribution final status equals the distribution expected
status, then a Pass is logged; if not, a Fail is logged.

distribution_ret=&variable True or False value which captures the distribution status of
the file in Process Monitor.
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Parameter

Description

click refresh=value

On or Off value determines if PTF refreshes process monitor
status in fixed intervals or the status gets auto-refreshed.

The default value is On.

On - PTF refreshes the Process Monitor page every six
seconds to verify the process and distribution status.

Off - PTF does not refresh the Process Monitor page. Instead,
the Process Monitor page auto-refreshes to display the updated

process status.

No value- takes the default value.

Note: If the PIA does not support auto-refresh of process
monitor, then the value must be set to Off.

See “Viewing the Status of Processes” (Process Scheduler)
See “Monitoring Jobs and JobSets” (Process Scheduler)

outtype=value;

The process output type.

outformat=value;

The process output format.

outfile=value;

The process output file.

expected=value;

Defines the expected status for the process when it completes.

Expected status is based on status values returned in the Run
Status column in Process Monitor.

For example:
expected=Success;
expected=No Success;

If the final status equals the expected status, then a Pass is
logged; if not, a Fail is logged.

ret=&variable

The return value.
True - the process completed successfully.

False - the process did not complete successfully.

Example

This example shows use of the Run action, followed by a conditional If Then to verify that the process

ran to success.
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Type Action Recognition Parameters Value
Browser Start Login
Browser FrameSet TargetContent
Page Prompt APPMSGMONITOR. add update
RUN_APPMSGARCH.
GBL
Text Set Value Name= archive
PRCSRUNCNTL
_ RUN_CNTL_ID
Page PromptOK
CheckBox Set Value Name=IB_ARCH Y
_RUNCNTL_IB_
STATUS_CANCEL
Process Run prcname pretype=
=APPMSGARCH Application
Engine;outtype
=Web;outformat
=TXT;expected
=Success;ret=&Status
distribution_
expected=Posted;
distribution_ret=
&ProcessDistributionOK;
click_refresh=on
Log Message status is &status
Conditional If Then &status=True
Log Message Worked
Conditional End If
Run_Def
Description

Changes the default behavior of the run process. Insert these steps prior to the Process Run step that they
modify. This action only supports one parameter per step. For multiple parameters, you will need multiple

steps.
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Parameters
Parameter Description
RunButton=value; The run button name.
ProcessMonitorLink=value; The Process Monitor link name.
ProcessInstanceField=value; The field where the process instance ID will appear.
QueuedTimeout=value; Overwrites the local option value (in minutes).
PostingTimeout=value; Overwrites the local option value (in minutes).
ProcessingTimeout=value; Overwrites the local option value (in minutes).
ExceptionTimeout=value; General timeout, in minutes, for all the states that are not in the
local option.
QueuedResult=value; Overwrites the local option value. Valid values are FAIL and
WARN.
PostingResult=value; Overwrites the local option value. Valid values are FAIL and
WARN.

Related Links
Configuring Local Options

Pwd

These are the actions associated with the Pwd step type.
Exists

Description
Checks whether the object exists on the page.

See Exists.
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GetLabel

Description

Gets the label of the specified HTML object.

See GetLabel.
Set_Value

Description

Gets the label of the specified HTML object.

See Set_Value.

Chapter 10

Query

These are the actions are associated with the Query step type.

Exec
Description
Runs a public query in PeopleSoft Query and downloads the results. To run a private query, use the
Exec_Private action.
Note: Context sensitive help is available by double-clicking in the Value column to display and enter the
query parameters.
Parameters
Parameter Description
outFile=value; The query output file.
outFolder=value ; The folder where the result will be saved. If this parameter is
missing, the system will use the value in the Local Options
dialog box.
outFormat=value; The file format that will be used to download the result file. If
this parameter is missing, the system will use the value in the
Local Options dialog box.
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Parameter Description

param=value; The list of comma delimited values for all the query
parameters.

Orows=value; If the query returns zero rows, add a log entry of type value.

Valid values are Pass, Fail, or Warning.

Nrows=value; If the query returns one or more rows, add a log entry of type
value. Valid values are Pass, Fail, or Warning.

Exec_Private

Description

Runs a private query in PeopleSoft Query and downloads the results.

Parameters

Parameter Description

outFile=value; The query output file.

outFolder=value ; The folder where the result will be saved. If this parameter is
missing, the system will use the value in the Local Options
dialog box.

outFormat=value; The file format that will be used to download the result file. If
this parameter is missing, the system will use the value in the
Local Options dialog box.

param=value; The list of comma delimited values for all the query
parameters.

Orows=value; If the query returns zero rows, add a log entry of type value.
Valid values are Pass, Fail, or Warning.

Nrows=value; If the query returns one or more rows, add a log entry of type
value. Valid values are Pass, Fail, or Warning.

Note: Query steps do not support simultaneous usage of both Orows= and Nrows= parameters in the same
step.

Use the following formats to specify query parameters:
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Page Control Format

Text param=value
Radio button param={RB}value
Combo box param={CB}value
Check box param={CH}value
Text box param={EB}value
Example

This example shows the Query.Exec step type, with the dialog box for the values open. In this example,
the query has 3 prompts: a text field, a date field and a check box. The query is expected to return rows.

This example illustrates entering the value parameters for the Query.Exec action.

Type Action R ecognition YWalue

Browser = | Start_Login -
Guem = | Exec = | name=CRS_SESSIOM_BY_BUZ2 | :outfolder=D: 4L abs outiormnat=CSY param=Mal 01,00 407 /201 2 ICHYY rrows=] .

Step: Query.Exec

ouitfile:

outfolder ID Labs

aoutfarmat IESV

para |NAMD1 /02201 24CHRY

Oraws I

nrows IF'ass

Outfile iz the query output file name. This parameter is provided in the PTF
step's Walue figld.
Example: MypQuenB esultsFile

Ok I Cancel

Radio

302

These are the actions associated with the Radio step type.
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Exists

Description

The value property is required to validate whether a radio button exists on the page. It can be defined in
the Parameters field using value=value or in the Value field.

See Exists.

Example

In the following example, in the first step the value property is set in the Value field. In the second step,
the value is set in the Parameters field using the Value= parameter.

Type Action Recognition Parameters Value
Radio Exists Name=SQA _ ret=&RadioEx1 2
SIMPLEREC _
SQAOPTION
Radio Exists Name=SQA ret=&RadioEx2;
SIMPLEREC value=3
SQAOPTION

Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

See Get_Property.
Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style.

GetLabel

Description

Gets the label of the specified HTML object.
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See GetLabel.

Set_Value

Description
Gets the label of the specified HTML object.

See Set_Value.
Verify

Description

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the
validation.

See Verify.

Range

These are the actions associated with the Range step type.

Exists

Description
Checks whether the object exists on the page.

See Exists.
Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

See Get_Property.
Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.
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See Get_Style.

GetlLabel
Gets the label of the specified HTML object.

See GetLabel.

Set_Value
Gets the label of the specified HTML object.

See Set_Value.

Verify

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the
validation.

See Verify.

RichText

These are the actions associated with the RichText step type.

GetLabel

Description
Gets the label of the specified HTML object.

See GetLabel.
Set_Value

Description
Gets the label of the specified HTML object.

See Set_Value.

Scroll

These are the actions associated with the Scroll step type.

The Scroll ID field is required for all Scroll action types.
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Related Links
Incorporating Scroll Handling

Action

Description

Chapter 10

Takes an action based on the row specified by Key Set. Specify the action in the Value column.

This table lists the valid values for the Action action.

Action Value Description

ins Insert a row. If the current row is the first row, then use the
existing row.

ins+ Always insert a row.

delins Delete all rows, and then insert into the first row.

del Delete the row specified by the Key Set action.

delall Delete all rows. No further processing.

delsel Look for the row and delete it. Do not add a fail if the row
does not exist.

upd Find a specified row to work with. If the row is not found,
insert a new row or use the first row for the first time.

upd+ Find a specified row to work with. If the row is not found,
always insert a new row.

sel Find a row specified by the Key_Set action.

find Use the scroll Find link. Format: find=text to_find

not Check that the row is not in the scroll. Add a Fail to the log if
the row is found.

306

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 10

Parameters

Test Language Reference

Parameter

Description

ret=&variable;

The return value. It returns the position index for the field
acted upon, based on the row identified using Key_Set.

expected=value;

Optional. Applies only to the find action. If used, PTF
writes either a Pass or Fail for the step in the test log based
on whether a matching object exists. If this parameter is
not included, then only step information is logged during
execution.

For example:

expected=true Logs an error when the expected value is
not found; logs Passed if found, logs Failed if not found.

expected=false Logs an error when the expected value is
found; logs Passed if not found, logs Failed if found.

Definition

Description

Use the Definition action to override the default name object of scroll buttons and the scroll parent. This
is necessary, for example, when a page uses custom objects (such as links or pushbuttons) to handle
conventional scroll actions such as adding or deleting rows from the scroll.

Parameters
Parameter Description
def=value; The default name object type. Example:

def=PARENT;

Valid def values are:

*  ADD: Overrides the Add new row button.
* DEL: Overrides the Delete row button.

*  NEXT: Overrides the Next button.

*  PREV: Overrides the Previous button.

*  FIRST: Overrides the First button.

*  LAST: Overrides the Last button.

*  PARENT: Reassigns the parent for a specific scroll area.
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Parameter

Description

type=value;

The object type for the new action.
Example 1:

type=Image;

Example 2:

type=PushButton;

value=value;

The scroll parent variable or the new object recognition string.
Example 1:

value=&Scrl;

Example 2:

value=Name=$ICField3$newm$0$$imgs$0;

start=value;

Used to set the scroll area index when the index is not $0 .
In this example the index will start the scroll index at $1.

def=START;Value=1

skipvalidation=value;

Used to skip the validation if the defined scroll has 1 or
multiple rows in the scroll when the user deletes or adds a row
to it.

PTF handles scroll validation assuming the new row is added
to the bottom of the scroll area. There are many cases where
the row is added as the top row which will cause the PTF
internal scroll validation to fail after the row is inserted. Use
the SKIPVALIDATION to handle this situation.

Example 1:

This example will skip the validation when a single row is
inserted or deleted from the scroll area.

def=SKIPVALIDATION; type=S INGLE ROW
Example 2:

This example will skip the validation if multiple rows have
been inserted or deleted from the scroll area.

def=SKIPVALIDATION; type=MULTIPLE ROW

Examples

This example uses the Definition action with the de f=ADD parameter to assign the Add action to the

image $ICField3$newm$0$$mg$0:
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Type

Action

Recognition

Parameters

Value

Scroll

Definition

value=Name=
$ICField3$newm$0$
$mg$0

def=ADD;type=Image

In this example the Definition action with a de f=PARENT parameter reassigns the parent:

Scroll ID Type Action Recognition Parameters Value

1 Scroll Key Set Name=PSU EMP_ | type=Text 2009
REVIEW_REVIEW
_YEAR

1 Scroll Action ret=&Scrl upd

Text Set Value Name=PSU _EMP_ | Scroll 1 index 365

REVIEW_REVIEW | variable = &Scrolll
_DAYS&Secrl

2 Scroll Definition value=&Scrl def=PARENT

stype=Button

2 Scroll Key Set Name=PSU EMP | type=ComboBox 00013
_RVW_RVR
REVIEWER ID

2 Scroll Action ret=&Scr2 upd

ComboBox Set Value Name=PSU_EMP S
_RVW_RVR
REVIEWER
TYPE&Scr2
Key_Set
Description

Defines each key field of a scroll. Use multiple Key Set steps for scrolls with multiple key fields.

Specify the step type and field name as parameters. Specify the key value in the Value column.
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Parameters
Parameter Description
type=value; The step type for the key field.

Example:

type=Text;

name=value;

The name of the key field.

Example

This example illustrates using Key Set and Action:

Scroll ID Type Action Recognition Parameters Value
1 Scroll Key Set Name=PSC SCR_ | type=Text ROW1
RECO01_PSE KEY
_LVLI1
1 Scroll Action ret=&Scrl upd
Text Verify Name=PSC SCR ROWI1
RECO1 PSE KEY
LVL&Scrl
ComboBox Set_Value Name=PSC_SCR | type=Text second
RECO1 PSE KEY
COMBO&Scrl
Text Set_Value Name=PSC_SCR updated
_RECO01_CON_
CHAR_01&Scrl

ModalGrid_Close

Description

Closes a modal grid.

ModalGrid_Open

Description

Opens a modal grid.
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PageNumberField

Description

Test Language Reference

Returns the grid page number, for example Scroll.PageNumberField = 11-20 of 23

Use the action on a Scroll step type for Classic and Classic Plus pages. The pages display the sets of rows
using a drop down list. The grid shows the rows included in the row set.

Parameters

Parameter

Description

ret=&variable;

Returns the grid page number of the row identified using Key
_Set action.

Example

This example illustrates using PageNumberField with Key Set.

Scroll ID Type Action Recognition Parameters Value
1 Scroll Key Set id=PSROLEUSER VW _ type=Text Search Server
ROLENAME
1 Scroll Action ret=&scrl sel
1 Scroll PageNumberField ret=&nub
Reset
Description

Resets all the scroll variables and closes the scroll section in the log.

RowCount

Description

Returns the number of rows for the defined scroll.

Example

This example illustrates using the RowCount action to perform a loop:
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Scroll ID Type Action Recognition Parameters Value
Browser Start Login
Browser FrameSet TargetContent
Page Prompt MAINTAIN _ update
SECURITY.
USERMAINT.GBL
Text Set_Value Name= STU1
PSOPRDEFN _
SRCH_OPRID
Page PromptOk
Page Go_To Roles
1 Scroll Key Set name= type=Text Dummy
PSROLEUSER
VW_ROLENAME
1 Scroll RowCount ret=&Count
Variable Set_Value &EndCount Add(&Count|-1)
Loop For &RowCount =0 to
&EndCount
Text Get_Property name= prop=Value;
PSROLEUSER ret=& Value
VW_ROLENAME
$&RowCount
Log Message The role of
row number
&RowCount is
&Value
Loop Next

Span
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These are the actions associated with the Span step type.
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Click

Description
Performs a mouse click on the specified object.

See Click.

Drag_From

Performs the action of dragging a PTF object. It is followed by the Drop_Over action where a previously
selected object is dragged and released over a newly selected object on the same page.

Note: The action is only supported for PTF playback.

See Drag_From.

Drop_Over

Performs the action of dragging and releasing a PTF object over a newly selected object on the same
page. It is preceded by the Drag_From action where a previously selected object is dragged from a
position.

Note: The action is only supported for PTF playback.

See Drop_Over.
Exists

Description
Checks whether the object exists on the page.

See Exists.
Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

See Get_Property.
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Get_Style

Description

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style

GetLabel

Description
Gets the label of the specified HTML object.

See GetLabel.
MouseOver

Description
Fires the mouseover event to show a popup page. Enter the page name in the Recognition field.

See “Using Pop-up Pages” (Application Designer Developer’s Guide)
MouseOverClose

Description

Fires the mouseout event to close a popup page. Enter the page name in the Recognition field.

Example
The following examples show how MouseOver and MouseOverClose can be used with popup pages.
To record a verification of a field value in a mouseover popup window:

1. From the recorder tool bar, click and drag the Target icon for the Verify action and hover over the field
with a popup window.

2. Wait until the popup window appears.
3. Move the cursor to the field you want to check, then release the mouse button.

4. PTF Recorder generates the following steps:

Type Action Recognition Parameters Value

Browser Start
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Type Action Recognition Parameters Value
Span MouseOver id=QE_EMPLOYEE EMPLID en
Span Verify Comment=QE_EMPL2 DEPTID 22000
Span MouseOverClose id=QE_EMPLOYEE_EMPLID

To record an action for an object inside a mouseover popup window:

1. Click and drag the Target icon for the Verify action and hover over the field with a popup window.

2. Wait until the popup window appears, then release the mouse button.

3. Perform the action you want to record, such as clicking a URL link.

4. PTF Recorder generates the following steps:

Type Action Recognition Parameters Value
Browser WaitForNew

Span MouseOver id=QE_EMPLOYEE EMPLID

Link Click Name=QE_EMPL PHOTO2 URL

Span MouseOverClose id=QE_EMPLOYEE EMPLID

Related Links

“Using Pop-up Pages” (Application Designer Developer’s Guide)

Verify

Description

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the

validation.

See Verity.

Example

This step validates a Span object that contains informational text:
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Type

Action

Recognition

Parameters

Value

Span

Verify

ClassName=PSTEXT

Select an option

Test

This is the action associated with the Test step type.

Exec

Description
Calls another test or library test.

Specify the child test or library test name in the Recognition field and one or more test case names in the
Value field, separated by commas.

You can also click in the Recognition field then click the ellipsis icon and select a test case to populate
the Recognition and Value fields with the test name and the test case name.

Test.Exec supports the use of parameters that enable you to pass dynamic values from a calling test to a

library test.

Right-click the test name in the Recognition field and select Open Test to open the child test.

Use the #IGNORE reserved word in the Value field to skip the call to the child test for a given test case.

See Using Parameters with Library Tests.

Example

This test calls the test CHILD_ ONE with the CASE 01 test case, then skips the call to CHILD_TWO:

Type Action Recognition Parameters Value
Test Exec CHILD_ONE CASE 01
Test Exec CHILD TWO #IGNORE

Text

These are the actions associated with the Text step type.
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Exists

Description
Checks whether the object exists on the page.

See Exists.
Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

See Get_Property.

Get_Style

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

See Get_Style.

GetLabel

Description
Gets the label of the specified HTML object.

See GetLabel.

Set_Value

Description
Gets the label of the specified HTML object.

See Set_Value.
Verify

Description

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the
validation.

See Verify.
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UsageMonitor

Use the UsageMonitor step type to control managed object tracking during test run. This step type must
be used as a pair of start/stop actions. Also, the Environment is Usage Monitor Enabled option, which
is located on the Advanced Execution Options (or page), must be selected for usage monitoring to be
active.

See Configuring Execution Options in PTF Client or Configuring Execution Options in PeopleSoft
Internet Architecture

These are the actions associated with the UsageMonitor step type.

Start
Description
Initiates usage monitoring.
Stop
Stops usage monitoring.
Variable
This is the action associated with the Variable step type.
Set_Value
Description
Assigns a value to the given variable.
Example
This example includes test steps that use the Variable step type to set a value for a variable:
Type Action Recognition Parameters Value
Log Message This is a test of
variables.
Variable Set_Value &Varl This is Varl.
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Type Action Recognition Parameters Value
Log Message The value of Varl =
&Varl
Variable Set_Value &Var2 This is Var2
Log Message The value of Var2 =
&Var2
Variable Set_Value &Var3 &Varl
Log Message Var3 is a clone of Varl.
The value is &Var3

Related Links

Variables

Wait

Use the Wait step type to pause test execution.

These are the actions associated with the Wait step type.
For_Seconds

Description

Wait the number of seconds specified in the Recognition field before proceeding to the next step.

For_Value

Description

Wait until the field contains the value specified in the Value field.

Parameters

Parameter Description

type=value Specify the object type, such as Text, Combobox, Link, and so
on.
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Parameter

Description

timeout=value

[Optional] Specify the time out value, in seconds. The default

is 300 seconds.

refresh=value [Optional] Specify the identifier of the target refresh button,
link, or image. If the refresh= parameter is specified, PTF
waits five seconds between each validation process and the
click on the Refresh button.

The Refresh parameter can be defined in the below formats:

*  refresh=<buttonName>- the identifier will be converted
to Name=<buttonName>

*  refresh=Name=<buttonName>-the identifier will be
converted to Name=<buttonName>

*  refresh=Id=<buttonld>- the identifier will be converted
to Id=<buttonld>

*  refresh=InnerText=<buttonInnerText>- the identifier will
be converted to InnerText=<buttonInnerText>

Example

This example shows PTF test steps that use the Wait step type:

Type Action Recognition Parameters Value
Wait For_Seconds 60
Wait For_ Value id=PB_GO_ALLS$0 type=Link; P
timeout=120;
refresh
=Name=#ICRefresh

Reserved Words

This section describes PTF reserved words, listed in alphabetical order.

#CHECK#

Description

The #CHECKH# reserved word modifies the behavior of a Set Value action to be more like a Verify action.
This can be useful when you want to set data in a particular field for one test case and verify the data in
the same field for a different test case.
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Note: If the values are not equal, PTF will always try to update the value (unless the object is display-
only). If the values are equal, PTF will not update the value.

Example

For example, a text box could be set and verified with the following two steps:

Type Action Recognition Parameters Value

Text Set_Value ID=PA_CLC_ KUSPTEST
SUMMARY CALC_
NAME

Text Verify ID=PA_CLC_ KUSPTEST
SUMMARY_CALC_
NAME

Suppose, however, that the test calls for using two test cases: the first test case sets the calculation name
equal to KUSPTEST, the second test case verifies the value of KUSPTEST.

The test case that sets the value to KUSPTEST would be constructed as shown in the first step of the
previous example. The test case that verifies the value as KUSPTEST would be constructed as shown in
the following example:

Type Action Recognition Parameters Value
Text Set Value ID=PA CLC _ #CHECK#KUSPTEST
SUMMARY CALC_
NAME
#DIS#
Description

This reserved word verifies a value and also checks whether the object is display-only. It logs a Fail if the
object is not display-only or if the expected value does not match the application value.

If you use #DIS# without a value, then the value is ignored and #DIS# only checks for whether the field is
disabled.

This reserved word is useful when, for example, PeopleCode is expected to make an object visible but not
editable.

Example

The following example checks whether the Benefit Commencement Date field date is display-only and
the value is equal to 07/12/2000:
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#DTTM

Type Action Recognition Parameters Value

Text Set Value Name=PA #DIS#07/12/2000
CALCULATION BEN
_CMDT_DATE

Description

Similar to #TODAY, the #DTTM reserved word inserts the current date and time into a field in the
application.

Related Links
#TODAY

#EXIST#

Description
Verifies the existence of a field.
If the field exists in the application, a Pass is logged. If the field is not found, a Fail is logged.

If a value is passed after the closing # and the field exists, PTF tries to set the field to that value.

Example

In this example, the first step checks for whether the Benefit Plan field exists in the application and logs
a Fail if it is not found. The second step not only checks for the existence of the field, it attempts to enter
the value KUHP into it:

Type Action Recognition Parameters Value

Text Set_Value Name=PA CLC PLN #EXIST#
_INPT_BENEFIT _
PLAN

Text Set Value Name=PA_CLC_PLN #EXIST#KUHP
_INPT_BENEFIT
PLAN

Related Links
#NOTEXIST#
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#FAIL#

Description

This reserved word works like #CHECK# but does not update the value after performing the comparison.
If a mismatch is found, a Fail is logged; otherwise, a Pass is logged. You would use #FAIL# rather than
#CHECK# when you do not want to update the field if a mismatch exists.

Example

In this example, the PTF test logs a Fail if the Summary Calculation Name field is not equal to
KUSPTEST:

Type Action Recognition Parameters Value

Text Set_Value ID=PA_CLC_ #FAIL#KUSPTEST
SUMMARY _CALC_
NAME

Related Links
#WARN#

#IGNORE

Description

Place the #IGNORE reserved word in the Value field of a Test.Exec step to skip the call to the child test.
Suppose you have a parent test with two test cases. In the first test case, the parent test calls a child test. In
the second test case, the parent does not call the child. Use the #IGNORE reserved word in the Value field
with the second test case to skip calling the child for that test case.

In this example, the first step for the test case calls the test CHILD ONE with test case CASE _01. The
second step skips the call to CHILD TWO for this test case.

Type Action Recognition Parameters Value
Test Exec CHILD ONE CASE 01
Test Exec CHILD TWO #IGNORE
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#LIKEF#

Description

The #LIKEF# and #LIKEW# reserved words are similar to the #FAIL# and #WARN# reserved words
except that they look for similar values, not an exact match. If a similar match is not found, #LIKEF# logs
a Fail and #LIKEW# logs a Warning.

Similar to the behavior of #FAIL# and #WARN# (and unlike the behavior of #CHECK#), if the
comparison fails, PTF does not update the value. The steps only affect the error state of the execution log.

This table details ways #LIKEW# or #LIKEF# can match strings:

Type of Match Pattern Match (Log a Pass) No Match (Log a Fail or
Warn)
Multiple characters a*a aa, aBa, aBBBa ABC
Multiple characters *ab* abc, AABB, Xab aZb , bac
Multiple characters ab* abcdefg, abe cab, aab
Special character a[*]a a*a Aaa
Single character a?a aaa, a3a, aBa ABBBa
Single digit a#ta a0a, ala, a2a aaa, alOa
Range of characters [a-Z] f,p,] 2, &
Outside a range [la-z] 9, &, % b,a
Not a digit [10-9] A a, &, 0,1,9
Combined a[!b-mJ# ~ An9, az0, a99 abc, aj0
Example

Suppose a test requires verification of only the first several characters of a text entry. In the following
example, the first step logs a Fail if the first two characters of the Benefit Plan field are not equal to US.
The second step logs a Fail unless the first two characters of the Benefit Plan field are equal to US and
the last character is equal to 1:
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Type Action Recognition Parameters Value
Text Set Value Name=PA BENEFIT PLAN #LIKEF#US*
Text Set_Value Name=PA BENEFIT PLAN #LIKEF#US*1

#LIKEF# and #LIKEW# only compare the date text of a date/time value. For example, some fields
contain the current date and time. Use the #LIKEF##TODAY * construction to compare just the date
portion of a Datetime field and ignore the time portion.

For example:

Type Action Recognition Parameters Value
Text Set_Value Name=PA PROP VOUCH_DTTM #LIKEF
##TODAY *
#LIKEW#
Description

The #LIKEW# reserved word is used the same as #LIKEF# except it logs a Warning rather than a Fail.
For complete details for using #LIKEW# see #LIKEF#.

Related Links
#LIKEF#

#LISTH#

Description

This reserved word checks the values of a ComboBox. It works with either the full text entries in the
combo box or the metadata translation (XLAT) values of the entries.

Use #LIST# with a Set_Value action to check one or more values and then set an item in a drop-down list
box, list the items separated by a vertical pipe (]) and place brackets ([]) around the item that you want to
select. If the value in the field is not the same as the value in brackets, PTF logs an error and sets the value
in the field to the value in brackets.

Example

This example shows the use of the #LIST# reserved word:

In this example, the first step verifies the existence of items in the list. The second step verifies that the
items exist and verifies that Individual is selected.
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Type Action Recognition Parameters Value

ComboBox Set Value Name=PA CALC CALC TYPE #LIST#
Individual
|[Pre-Defined
Group|Pre-
Defined List

ComboBox Set_Value Name=PA CALC CALC TYPE HLIST#
[Individual]|Pre-
Defined
Group|Pre-
Defined List

This example is similar to the previous example, but it refers to the entries by the metadata translation
(XLAT) values rather than the text that actually appears in the combo box:

Type Action Recognition Parameters Value

ComboBox Set_Value Name=PA_CALC_CALC_TYPE HLISTHI|G|L

ComboBox Set Value Name=PA CALC CALC TYPE #LIST#[I]|GIL
#NOTEXIST#

Description

The opposite of the #EXIST# reserved word, #NOTEXIST# verifies that a field does not exist.

If the field does not exist, a Pass is logged. If the field does exist, a Fail is logged.

Related Links
#EXIST#

#NOTHING

326

Description

PTF ignores any step with a Set Value or Verify action where the Value field is empty, or blank. The
#NOTHING reserved word enables you to use SET VALUE to set a field to blank or select a blank value
from a drop-down list box. You can use #NOTHING with a Verify action to verify that a field is blank.

The #NOTHING reserved word does not have a closing pound sign (#). It cannot be used in combination
with other reserved words.

Note: Leaving the Value ficld of a test step blank does not have the same effect as using the #NOTHING
reserved word. PTF ignores any Set Value or Verify action where the Value field is blank.
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Example

In the following example, in the first step #NOTHING selects a blank value in the Calculation Reason
field and then, in the next step, it verifies that the field is blank:

Type Action Recognition Parameters Value

ComboBox Set_Value Name=PA CALC_REASON #NOTHING

ComboBox Verify Name=PA CALC REASON #NOTHING
#PREFIX#

Description

The #PREFIX# reserved word substitutes the text in the Prefix field in the Test Editor for the #PREFIX#
string in the Value field. This substitution is useful when developing a test that adds new data. It enables
you to modify each new added record slightly so that the test is able to successfully add unique data each
time the test is executed.

Example

Suppose you entered add in the Prefix field, as in this example:

This example illustrates the Prefix field with the value add.

@gedmo-denidddz  Tesk Edit  Debug  Tools  Window  Help
iHE (b DED N @ "= D E P erefic

gedrmo-denid002 v Test: COPY_USER_FPROFIL.. 3

The following test step would enter the value addUSER into the DERIVED CLONE_OPRID field:

Type Action Recognition Parameters Value
Text Set_Value Name=DERIVED CLONE OPRID #PREFIX#
USER

Note: The #PREFIX# reserved word can only be used at the beginning of the text in the Value field.

#TODAY

Description

Substitutes the current date.
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Note: The #TODAY reserved word does not have a closing pound sign (#). It cannot be followed by
another reserved word.

Example
Suppose you have the following test instruction:
12. Enter the current date into the Event Date field.

The following step sets the value of the Event Date field to the date at the moment of test execution:

Type Action Recognition Parameters Value
Text Set_Value ID=PA_CLC_EMP_VW_EVENT _ #TODAY
DT

You can use the + or — operators in conjunction with the #TODAY reserved word to reference a date in
the future or past. In this example, the test verifies that the calculation event date is 10 days in the future:

Type Action Recognition Parameters Value
Text Set Value ID=PA_CLC_EMP_ VW _EVENT #TODAY+10
DT
#WARN#
Description

This reserved word works the same as #CHECK# but does not update the value after performing the
comparison. If a mismatch is found, a Warning is logged; otherwise, a Pass is logged.

You would use #WARN# rather than #CHECK# when you do not want to update the field if a mismatch
exists.

Related Links
#EAIL#

Common Actions

The actions in this section can be used with multiple step types. The step types that support the action are
listed with each action.
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Click

Description

Performs a mouse click on the specified object.

The following step types support this action:

* Button.
e Ima

« Link.

e Number
+ Range.

+  Span.
Example

Test Language Reference

This example shows the use of the Click action with a Button object and a Link object:

Type Action Recognition Parameters Value
Button Click Name=PB_FILTER
Link Click Name=LAST NAME
$0
Drag_From
Description

Performs the action of dragging a PTF object. It is followed by the Drop_Over action where a previously
selected object is dragged and released over a newly selected object on the same page.

PTF throws an error when a drag action is not immediately followed with a drop action or a drop action
is not preceded with a drag action. You can select the Check Syntax option to display any errors or

warnings. See Syntax Check.

The following step types support Drag_From and Drop_Over actions:

* Div.

Keep in mind:
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* The actions are associated with Div step type when the HTML code includes div tag with
attributes draggable="true” and droppable="true”.
e Link.
Keep in mind:
e The Drag_From and Drop_Over actions are supported for PTF recorder and playback.

*  When PTF records tests for Tree Manager, instances of step definitions with Link step type and
these actions can be found.

* Span.
Keep in mind:
* The Drag_From and Drop_Over is only supported for PTF playback.

» The actions are associated with Span step type when the HTML code includes the Span tag nested
in the div tag with attributes draggable="true”” and droppable="true”.

See Drop_Over.

Example
Type Action Recognition Parameters Value
Div Drag_From id=win0divPTNUI LAND_REC
GROUPLETS1
Div Drop_Over id=win0divPTNUI_LAND REC
GROUPLETS6
Type Action Recognition Parameters Value
Span Drag_From id=PTNUI_LAND REC
GROUPLET LBLS$0
Span Drop_Over id=PTNUI_LAND_REC_
GROUPLET LBLS$I
Type Action Recognition Parameters Value
Link Drag_From id=PTPG_SIMPL_WRK PTPG
CHARTSERIES
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Type Action Recognition Parameters Value
Link Drop_Over id=PTPG_SIMPL WRK PTPG
CHARTXAXIS
Drop_Over

Performs the action of dragging and releasing a PTF object over a newly selected object on the same
page. It is preceded by the Drag_From action where a previously selected object is dragged from a
position.

For details and examples, see Drag_From.

Exists

Description

Checks whether the object exists on the page.
The following step types support this action:
* Button.

e CheckBox.

¢« ComboBox.

* Header.

* Image.

+ Label.

« Link.

» LongText.

¢ MultiSelect.

«  Pwd.
* Radio
Span.
«  Text.
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Parameters

Parameter Description

ret=cvariable; ret=True — the object exists
ret=False — the object does not exist

expected=value Specify expected=True or expected=False. Logsa
Pass or Fail based on whether the ret parameter matches the
expected parameter.

Example

This example shows the use of the Exists action:

This example illustrates the Exists action.

u Text * | Exists * |name=USERID;retlexists

Get_Property

Description

Gets the property value of an HTML object and assign to the prop=value parameter. Also stores it to
the variable in ret=¢variable.

Use the HTML Browser feature of the Message tool to identify the properties and values of an object.
When this step type is recorded tagName and id properties are always shown.

See Using the Message Tool.

Use the browser's in-built element inspector to identify the properties and values of an object.
See Recording Tests
Some objects have properties that are different from what you might expect. For example:
* The value property for a check box returns Y for selected, N for deselected.
* Combo boxes return the translate value of the selection for the value property.
The full text of the selected item is available as the text property.
» Radio buttons return the translate value of the selection for the value property.
» The label of the selected item is a separate label object.
The following step types support this action:

¢ Button.
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Chart.
CheckBox.
ComboBox.

Div.

Label.

Link.

List
LongText.
MultiSelect.
Radio.

Span.

Text.

Parameters

Test Language Reference

Parameter

Description

prop=value;

The property name.

ret=&variable;

The return value.

Example

Type Action Recognition Parameters Value

Text Get_Property Name=UserID ret=&TxtPropp;
prop=Status

Log Message This is the status: & TxtProp

Button Get_Property Name=Submit ret=&BtnProp;
prop=tagName

Log Message This is the tagname for the button:

&BtnProp
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Type Action Recognition Parameters Value
Button Get_Property Name=Submit ret=&BtnProp;
prop=Value
Log Message This is the Value for the
button:&BtnProp
Get_Style
Description

334

Gets the style value of properties in a class from the HTML stylesheet. The value is assigned to
prop=value parameter and stores it to the variable in ret=¢variable.

You can use the HTML Browser feature of the Message tool to identify the properties and values of an

object.

See Using the Message Tool.

You can use the browser's in-built element inspector identify the properties and values of an object.

See Recording Tests

The following step types support this action:

¢ Button

¢ CheckBox
¢ ComboBox

¢« DateTime

* Div

* Header.

* Image

« Label.

« Link.

* LongText.

¢ MultiSelect.

¢ Number.
* Radio.
* Range.
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Parameter

Description

prop=value;

The property name.

Supported property values are: font-face, font-family, font-
weight, font-style, color, font-size, background-color.

ret=&variable;

The return value.

GetLabel

Description

Gets the label of the specified HTML object.
The following step types support this action:
*  CheckBox.

+ ComboBox.

* LongText.

¢ MultiSelect.

¢ Number.

e Pwd.

¢ Radio.

* Range.

¢ RichText.

e Span.

e Text.
Set_Value

Description

Sets the field value in a browser object.
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LongTest = | Set_Walue name=504_SIMPLEREC_SQA_DESCRIFTION long
Teut - | Set_Value name=S0E_SIMPLEREC_PSE_DESCR ehox
CheckBox = [ S5et_Yalue name=504_SIMFLEREC_SQ4 CHECKBO: iy
ComboBox = [ Set_Yalue name=504_SIMPLEREC_S0A_COMBO_OPTION |2
Radia - [ Set_Yalue name=504_SIMPFLEREC_SGA_OPTIOM 2
Verify
Description

336

The following step types support this action:

CheckBox.

ComboBox.

LongText

Chapter 10

Use the SetValue InModal action to set the value of a long text field on a modal page.

MultiSelect.

Number.

Pwd.

Radio.

Range.

Text.

Example

This example illustrates the Set Value action.

Compares the value in the browser to the expected value, and adds a pass or fail log entry for the

validation.

The following step types support this action:

Button

Chart.

CheckBox.

ComboBox.

Header.

Label.

LongText.
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¢ MultiSelect.
¢ Number.
¢ Radio.

ange.

.
g
>

—

Example

Test Language Reference

Type Action

Recognition Parameters

Values

Textg Verify

ID=PSE_DATES_SQA | #TODAY
_DATE

System Variables

System variables are populated by PTF at runtime. The following table lists PTF system variables.

Db2

Variable Description

Y%case% Current test case name.

%component% Current component name.

%env.appserver% Application server name.

%env.database% Database name and database type. For example: T852U11 /

%env.toolsrel%

The PeopleTools version.

%eo.dbname%

Execution option database name.

%eo.dbuser%

Execution option database user name.

%eo.logfolder%

Execution option log folder.

%eo.name%

Current execution option name.
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Variable Description

%eo.platform% Execution option platform.

%eo.pserver% Execution option process server.

%eo.pshome% Execution option PS_HOME path.

%eo.url% Execution option URL.

%eo.user% Execution option user.

%eo.verbose% Execution option verbose flag.

Y%frame% The current frame name.

%log.id% Current log number.

%menu% Current menu name.

Y%page% Current page name.

Y%parenttest% Returns the value of root test name of current test.

Y%pid% The last process instance number.

Yotest% Current test name.

Y%test.path% Full parent folder path for the executing test
Functions

This section lists the PTF functions.

Note: Regarding the use of strings in functions: Typically, variables are used within functions, however, if
you are using a string directly, it must be enclosed in quotes.

Add

Syntax

Add(number l\number2[|number3]...)
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Description

Use the Add function to add a series of numbers. Decimals and negative numbers are supported.

Parameters

Parameter Description

numberl Number to be added.

number2 Number to be added.

number3 (Optional) A series of additional numbers to be added.
Returns

Sum of the numbers in the parameters.

Example

The following table presents examples of using Add.

Expression Result

Add(10] -12| -3| 4] 6) 5

Add(10.43]| 10.55| -6.789| -178) -163.809
Concat

Syntax

Concat(stringl|string2||string3...])

Description

Concatenates the strings in the parameters.

Parameters
Parameter Description
stringl Beginning string for concatenation
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Parameter Description

string?2 A string to be concatenated to string].

string3... (Optional) Additional strings to be concatenated.
Returns

Returns a string resulting from concatenating the strings in the parameters.

Example

The following table presents examples of using the Concat function:

Expression

Result

Concat("hello "|"and "|"welcome '"to "|"PTF")

hello and welcome to PTF

Date

Syntax

Date()

Description

Returns the current date, using the date format specified in the current execution option.

Returns

The current date.

Example

The following table presents an example of using the Date function, where the current date is July 4,
2011:

Expression Result

Date() 07/04/2011
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Day
Syntax
Day(date value)
Description
Returns the day portion of the date value provided as a parameter.
Parameters
Parameter Description
date value A date value, such as the value returned by the Date() function.
Returns
Returns the day portion of the date value provided as a parameter.
Example
The following table presents examples of using the Day function; the second example assumes that the
current day of the month is 13:
Expression Result
Day(February 13, 2012) 13
Day(Date()) 13
Divide
Syntax

Divide(number|number2|dec=dec places)

Description

Use the Divide function to perform division. Decimals and negative numbers are supported. Optionally

specify the number of decimal places.
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Parameters

Parameter Description

numberl The dividend.

number2 The quotient.

dec=dec_places (Optional) The number of decimal places. The maximum is 10.
The default is zero. Note that "dec=" must be included in the
parameter.

Returns

The result of dividing numberl by number2 rounded to dec=dec places decimals.

Example

The following table presents examples of using the Divide function:

Expression Result

Divide(75| 13.5) 6

Divide(-75| 13.5| dec=5) -5.55556
GetField

Syntax

GetField(string, segment, delimiter)

Description

GetField returns the substring from a specified segment of a character-delimited text string.

Parameters
Parameter Description
string A character-delimited text string.
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Parameter Description
segment An integer specifying which segment of the string will be
returned, counting left to right. Specify a negative integer to
count right to left.
delimiter The character that delimits each segment in the string.
Returns

Returns the substring between the delimiters in the specified segment of the string.

Example

The following table presents examples of using GetField.

Expression Result
GetField("a/b/c"| 1] "/") a
GetField("a/b/c"| 2] /") b
GetField("a/b/c"| 5] "/") blank

GetField("a/b/c"| -1 "/")

Hour

Syntax

Hour(time_value)

Description

Returns the hour portion of the time value provided as a parameter.

Parameters
Parameter Description
time_value A time value, such as the value returned by the Time()
function.
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Returns

Returns the hour portion of the time value provided as a parameter.

Example

The following table presents examples of using the Hour function; the second example assumes that the
current time is between 1:00 PM and 1:59:59 PM.:

Expression Result
Hour(13:07:25) 13
Hour(Time()) 13
InStr
Syntax

InStr(within_string|substring)

Description

Locates a substring within a string of text and returns the starting position of the substring as an integer..

Parameters
Parameter Description
substring The text you are searching for.
The string parameter is not case sensitive.
within_string The text string you are searching within.
Returns

Returns an integer indicating the starting position of substring in within_string.

InStr returns 0 if substring does not appear in within_string. It returns 1 if substring is empty.

Example

The following table presents examples of using the InStr function.
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Expression Result

instr("ABCDEFG"|"c") 3

instr("ABCDEFG"|"C") 3

instr("ABCDEFG"|"CDE") 3

instr("ABCDEFG"|"zz") 0

instr("ABCDEFG")) 1

instr("ABCDEFG"['A") 1
LCase

Syntax

LCase(string)

Description

Converts a string to lowercase.

Parameters

Parameter Description

string The string to be converted.
Returns

Returns a string resulting from converting string to lowercase.

Example

The following table presents an example of using the LCase function.

Expression Result

Icase("Hello World 1234") hello world 1234
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Left
Syntax
Left(stringl|length)
Description
Extracts a substring of a specified number of characters from the left side of a string.
Parameters
Parameter Description
string A string from which to extract a substring.
length A number specifying the number of characters in the substring.
Returns
Returns a substring length characters long from the left side of a string.
Example
The following table presents an example of using Left function.
Expression Result
left("Hello World"|5) Hello
Len
Syntax
Len(string)
Description

Returns the length of string as an integer.
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Parameters
Parameter Description
string A text string.
Returns

Returns an integer indicating the length of string.

Example

The following table presents an example of using Len function.

Expression Result

len("Hello World") 11
MakeDate

Syntax

MakeDate(year value | month_value | day value)

Description

This function returns a date value based on the year, month, and day values passed to the function as

parameters.
Parameters
Parameter Description
vear value A number representing the year, such as the value returned by

the Year() function.

A number representing the month, such as the value returned

month_value
by the Month() function.

A number representing the day, such as the value returned by

day value
the Day() function.

Returns

Returns a date value.
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Example

The following table presents examples of using the MakeDate function. In these examples, the current
date was February 13, 2012:

Expression Result

MakeDate(Add(Year(Date())|1)|Add(Month(Date())|11)|Add | January 14, 2014
(Day(Date())[1))

MakeDate(Add(Year(Date())|1)|Add(Month(Date())|-1)|Add January 12,2013
(Day(Date())|-1)

MakeTime

Syntax

MakeTime(hour value | minute_value | second value | rollover_boolean)

Description

This function returns a time value based on the hour, minute, and second values passed to the function as

parameters.
Parameters
Parameter Description
hour_value A number representing the hour, such as the value returned by
the Hour() function.
minute value A number representing the minute, such as the value returned
by the Minute() function.
second _value A number representing the second, such as the value returned
by the Second() function.
rollover_boolean (Optional) Rolls over the hour to 0 when hour _value reaches
24.
True - Returns (hour value — 24) when hour_value is greater
than 24.
False - Returns hour_value even when hour value is greater
than 24.
The default value is True.
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Returns
Returns a time value.

Example

The following table presents examples of using the MakeTime function:

Expression Result
MakeTime(Add(Hour(Time())|12)|Add(Minute(Time())|-30)| | 7:00:00 AM
Second(Time()))

MakeTime(23]Add(60[30)|0|False) 24:30:00
MakeTime(23|Add(60|30)|0True) 00:30:00
MakeTime(23|Add(60]-30)|0) 23:30:00

Minute

Syntax

Minute(time_value)

Description

Returns the minute portion of the time value provided as a parameter.

Parameters

Parameter Description

time_value A time value, such as the value returned by the Time()
function.

Returns

Returns the minute portion of the time value provided as a parameter.

Example

The following table presents examples of using the Minute function; the second example assumes that the
current time is seven minutes past the hour:
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Expression Result

Minute(13:07:25 ) 7

Minute(Time()) 7
Month

Syntax

Month(date value)

Description

Returns the month portion of the date value provided as a parameter.

Parameters

Parameter Description

date_value A date value, such as the value returned by the Date() function.
Returns

Returns the month portion of the date value provided as a parameter.

Example

The following table presents examples of using the Month function; the second example assumes that the
current month is February:

Expression Result
Month(February 13, 2012) 2
Month(Date()) 2
Multiply
Syntax

Multiply(number 1 |number2||dec=dec_places])
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Use the Multiply function to perform multiplication. Decimals and negative numbers are supported.

Optionally specify the number of decimal places.

Parameters

Parameter Description
numberl First factor.
number2 Second factor.

dec=dec_places

(Optional) The number of decimal places. The maximum is 10.
The default is zero. Note that "dec=" must be included in the
parameter.

Returns

The result of multiplying numberl by number2 rounded to dec=dec_places decimals.

Example

The following table presents examples of using Multiply function.

Expression Result
Multiply(10.3| 13.45) 139
Multiply(10.3| -13.45|dec=3) -138.535

Now

Syntax

Now()

Description

Returns the current datetime, using the date format specified in the current execution option.

Returns

The current datetime.
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Example

The following table presents an example of using the Now function, assuming that the function was called
at 12:20 PM on July 4, 2011.

Expression Result

Now() 07/04/2011 12:20 PM
Replace

Syntax

Replace(sourcelfind|replace)

Description
Use the Replace function to replace every occurrence of a substring found in a string with a new
substring.
Parameters
Parameter Description
source A string in which you want to replace substrings.
find A string equal to the substring of source you want to replace.
replace A string with which to replace occurrences of find in source.
Returns

Returns a string resulting from replacing every occurrence of find found in source with replace.

Example

The following table presents an example of using the Replace function.

Expression Result

replace(“original text”|“i”|77) Or77g77nal text
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Right

Syntax

Right(string|length)

Description

Use the Right function to extract a substring of a specified number of characters from the right side of a

Test Language Reference

string.

Parameters

Parameter Description

string A string from which to extract a substring.

length A number specifying the number of characters in the substring.
Returns

Returns a substring length characters long from the right side of a string.

Example

The following table presents an example of using the Right function.

Expression

Result

right("Hello World"|5)

World

Round

Syntax

Round(number|[|dec=dec_places])

Description

Use the Round function to round a number. Decimals and negative numbers are supported. Optionally

specify the number of decimal places.
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Parameters

Parameter Description
numberl First factor.
number2 Second factor.

dec=dec_places

(Optional) The number of decimal places. The maximum is 10.
The default is zero. Note that "dec=" must be included in the
parameter.

Returns

The result of rounding numberl to dec=dec_places decimal places.

Example

The following table presents examples of using the Round function.

Expression Result
Round(-130.456) -130

Round(-130.456|dec=2) -130.46
Round(-130.455|dec=2) -130.45

Second

354

Syntax

Second(time_value)

Description

Returns the second portion of the time value provided as a parameter.

Parameters
Parameter Description
time_value A time value, such as the value returned by the Time()

function.
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Returns the second portion of the time value provided as a parameter.

Example

The following table presents examples of using the Second function; the second example assumes that the

current time 1s 25 seconds after the minute:

Expression Result

Second(13:07:25) 25

Second(Time()) 25
SubStr

Syntax

SubStr(source_str|start_pos[|length])

Description

Extracts a substring of a specified number of characters beginning at a specified location in a source

string.

If length is not specified, SubStr returns the substring starting at the position specified in start_pos and

continuing to the end of the string.

Parameters

Parameter Description

source_str A string from which to extract a substring.

start_pos A number representing the character position in source_str
where the substring starts, starting at 1.

length (Optional) A number specifying the number of characters in
the substring.

Returns

Returns a string equal to a substring /ength characters long beginning at character start_pos of source_str.
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The following table presents examples of using SubStr function.

Expression Result
substr("12345678"|2|3) 234
substr("12345678"2) 2345678

Subtract

Syntax

Subtract(number l|\number2[|number3]...])

Description

Use the Subtract function to subtract a series of numbers. Numbers can be decimal and negative.

Parameters

Parameter Description

numberl Initial number.

number2 Number to be subtracted.

number3... (Optional) A series of additional numbers to be subtracted.
Returns

The result of subtracting number2, number3, etc., from numberl.

Example

The following table presents examples of using the Subtract function.

Expression Result
Subtract(10]2/3) 5
Subtract(10]-2|-3) 15
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Sum

Syntax

Sum(/ndex|Value|Section|Delimiter)

Description

Sum works with the HTMLTable indexes.

Note: In PeopleTools releases prior to 8.53 commas were supported as a delimiter for the sum function
parameters. If any tests exist in the database using that format, the commas will be converted to pipes in

the upgrade.
Parameters
Parameter Description
Index The HTMLTable index string, such as 2/5/4. An index string is
the return value of CellGetIndex.
See CellGetIndex.
Value The value that you want to add or subtract. The default action
is addition.
Section The section of the index that will be modified.
Delimiter The character that delimits each section in the text value.
The character must be enclosed in quotes.
Example

The following table presents examples of using the Sum function.

Expression Result

sum("2/5/4"2[1]"/") 4/5/4

2 is added to the first section of the string.

sum("2/5/4"-13]"/") 2/5/3

1 is subtracted from the third section of the string.
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Expression Result

Sum(&index|-4/3]"/") 4 is subtracted from the third section of the string in the
variable &index.

Time
Syntax

Time()

Description

Returns the current time, using the date format specified in the current execution option.

Parameters

None

Returns

Returns a string with the current time.

Example

The following table presents examples of using the Time function with the regional options set to 24 hour
format and 12 hour format, respectively:

Expression Result

Time() 13:07:25

Time() 1:07:25 PM

Trim

Syntax

Trim(string)

Description

Returns a string with all leading and trailing spaces removed.
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Parameters
Parameter Description
string A text string.
Returns

Returns a string with all leading and trailing spaces removed.

Example

The following table presents an example of using trim function.

Expression Result

trim(" Hello World ") Hello World

UCase

Syntax

UCase(string)

Description

Converts a string to uppercase.

Parameters

Parameter Description

The string to be converted.

string

Returns

Returns a string resulting from converting string to uppercase.

Example

The following table presents an example of using UCase function.
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Expression

Result

ucase("Hello World 1234™)

HELLO WORLD 1234

Weekday

360

Syntax

Weekday(date value)

Description

Returns an integer value, ranging from 1 through 7, which represents the day of the week for the date
value provided as a parameter, where Sunday equals 1 and Saturday equals 7.

Parameters

Parameter Description

date_value A date value, such as the value returned by the Date() function,
or “10/29/2104”

Returns

Returns an integer value, ranging from 1 through 7, which represents the day of the week for the date
value provided as a parameter, where Sunday equals 1 and Saturday equals 7.

Example

The following table presents examples of using the Weekday function; the second example assumes that

Tuesday is the weekday of the current date:

Expression Result
Weekday(October 18, 2014) 6
Weekday(Date()) 3
Weekday("07/29/2013") 2
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Year

Syntax

Year(date value)

Description

Returns the year portion of the date value provided as a parameter.

Test Language Reference

Parameters

Parameter Description

date value A date value, such as the value returned by the Date() function.
Returns

Returns the year portion of the date value provided as a parameter.

Example

The following table presents examples of using the Year function; the second example assumes that the

current year is 2012:

Expression Result
Year(February 13, 2012) 2012
Year(Date()) 2012

Copyright © 1988, 2023, Oracle and/or its affiliates.

361



Test Language Reference Chapter 10

362 Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 11

Reserved Words Quick Reference

Reserved Words

The following table briefly explains PTF reserved words.

Field or Control

Description

#CHECK#

Checks a value in an object against the expected value defined
in the PTF test. Updates the value if no match exists.

See #CHECK#.

#DIS#

Checks whether an object is display-only.

See #DIS#.

#DTTM

Enters the current date and time into the application.

See #DTTM.

#EXIST# and #NOTEXIST#

Check whether a field exists or does not exist on the page.

#Exist can update the field if a value is passed following the
closing # sign.

See #EXIST#, #NOTEXIST#.

#FAIL# and #WARN#

Same as #CHECK# but do not update the value. If the values
do not match, PTF logs a Fail or Warning.

See #FAIL#, #WARN#.

#IGNORE

Place the #1GNORE reserved word in the Value field of a Test.
Exec step to skip the call to the child test.

See #IGNORE.

#LIKEF# and #LIKEW#

Match strings using LIKE. If no match exists, PTF logs a Fail
or Warning. PTF does not update the value.

See #LIKEF#, #LIKEW#.
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Field or Control

Description

#LIST#

Checks the values in a drop-down list box. Use a | to separate
items in the Value field.

This reserved word is used only with a ComboBox object.

See #LIST#.

#NOTHING

Deletes a value in the object or verifies that it is blank. If the
object is a ComboBox and the action is Set, then PTF selects a
blank item.

See #NOTHING.

#PREFIX#

Substitutes the text in the Prefix field in the Test Editor for
#PREFIX# in the Value field.

See #PREFIX#.

#TODAY

Enters the current date into the application.

See #TODAY.
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